New York Customer Service Management

Last updated: November 15, 2019
Some examples and graphics depicted herein are provided for illustration only. No real association or connection to ServiceNow products or services is intended or should be inferred.

If you have comments about this documentation, submit your feedback to:
docfeedback@servicenow.com
# Table of Contents

**Customer Service Management**

- Customer Service Management ................................................................. 4
  - Customer Service Management overview ............................................... 5
  - Activate Customer Service Management ................................................. 8
  - Configure Customer Service Management ............................................. 15
  - Integrate Customer Service Management with other applications ....... 98
  - Administer Customer Service Management ........................................ 117
- Agent Workspace for CSM ........................................................................ 133
- Mobile experience for Customer Service Management .......................... 160
- Manage customer service cases ................................................................. 168
- Additional Customer Service Management features ............................... 190
- Customer Service Performance Analytics Solutions ................................. 247
- Major issue management ........................................................................... 279
- Use the Customer Service Portal ............................................................... 290
- Use the Consumer Service Portal .............................................................. 313
- Reference information ................................................................................ 320
- Components installed with Customer Service Management .................. 331
- Components installed with additional plugins for Customer Service Management 349
- Computer telephony integration (CTI) ...................................................... 360

**Communities**

- Activate Communities plugins ................................................................. 378
- Properties installed with Communities ....................................................... 379
- Communities roles .................................................................................... 389
- Community setup guide for admins ............................................................ 390
- Domain separation in Communities ............................................................ 392
- Quick start tests for Communities ............................................................... 392
- Configure a community ............................................................................ 393
- Moderate a community ............................................................................. 434
- Use a community ....................................................................................... 439
- Gamification ............................................................................................... 473

**Index** ........................................................................................................ 488
Customer Service Management

Use the Customer Service Management (CSM) applications to provide your customers with multiple methods of engagement and collaboration, omni-channel communication, product knowledge and notifications, quick response to questions and issues, and efficient case resolution.

These applications provide the core of the customer service solution:

Customer Service Management

The Customer Service Management application enables you to provide service and support for your external customers through communication channels such as web, email, chat, telephone, and social media. Use the personalized self-service web portal to provide information and assistance. Create cases as needed and automatically route cases to available customer service agents with the required skills, availability, and location. Connect customer service agents to other departments to assist with case resolution.

Communities

The Communities application enables you to connect, engage and collaborate with your employees, customers, partners and prospects. Users can get quick responses to their issues by posting questions, reviewing blogs or videos, and searching for previous discussions. Users can also subscribe to forums and topics and provide feedback on content they find useful.

These applications integrate with Customer Service Management and Communities to provide additional customer information and support:

- The Field Service Management application helps organizations manage work tasks of any kind that need to be performed on location. Use Field Service Management to match tasks to agents based on agent skills, geographic territory assignments, and available inventory. Agents complete assigned tasks and then record the details, including travel and work time.
- The Knowledge Management application enables the sharing of information in knowledge bases. These knowledge bases contain articles that provide users with information such as self-help, troubleshooting, and task resolution. Knowledge Management supports processes for creating, categorizing, reviewing, and approving articles. Users can search and browse articles as well as provide feedback.
- The Planned Maintenance application works with Service Management applications to help organizations manage regular, preventive maintenance of their assets. Customers can use maintenance plans to automatically create work orders or facilities requests.
- The Notify application allows you to integrate with the Twilio telephony service to manage phone calls and SMS messages from within your instance.
- OpenFrame provides a communication frame that customers can use to integrate telephony systems into the Now Platform. The OpenFrame API can be used to communicate between the Now Platform and the domain opened in the OpenFrame window.

Using guided setup to implement the CSM applications

Guided setup for Customer Service Management, Field Service Management, and Communities provides a sequence of tasks that help you configure these applications on your ServiceNow instance. To open guided setup, navigate to:

- Customer Service > Administration > Guided Setup
- Field Service > Administration > Guided Setup
- Community > Administration > Guided Setup
Customer Service Management

The ServiceNow® Customer Service Management application enables you to provide service and support for your external customers through communication channels such as web, email, chat, telephone, and social media. Create cases as needed and route cases to available customer service agents with the necessary skill sets.

**Explore**
- Customer Service overview
- Integrate Customer Service with other applications
- Agent Workspace for CSM
- Mobile experience for Customer Service Management
- Additional Customer Service Management features

**Set up**
- Activate Customer Service Management
- Activate additional plugins for Customer Service Management
- Set up customer information
- Set up the case management features
- Set up communication channels

**Administer**
- Flow Designer actions
- Extension points
- Quick start tests
- Domain separation in Customer Service Management
- Limit knowledge base access to internal users

**Use**
- Create and resolve cases
- Major issue management
- Case and account escalation
- Agent calendar
- Assignment workbench
- Special handling notes

**Develop**
- Components installed with Customer Service Management
- Components installed with additional plugins for Customer Service Management
- openFrameAPI

**Troubleshoot and get help**
- Ask or answer questions in the Customer Service Management forum
- Search the HI knowledge base for known error articles
- Contact ServiceNow Technical Support

Customer Service overview

With the Customer Service Management application, you can provide your employees, including agents, with a variety of tools to engage and respond to external customers, answer questions, and resolve issues. For external customers, you can provide both self-service and assisted service options using multiple communication channels.

Watch this short video for an overview of the Customer Service Management application.

This video provides an overview of the case routing and assignment features available with Customer Service Management.

**Agent and manager features**

Agents and managers can use the Customer Service Management application to create cases for customers, route cases to agents with the required skills and availability, manage customer information and case activity, and connect with other applications and departments to assist with case resolution.

*Case management*
Create and route cases; manage customer information and interactions; monitor case activity, including case status and SLAs; and work to resolve customer issues. Use response templates and search tools to search the knowledge base and community and provide timely, informative responses to customers.

**Major issue management**
Manage the communication and case resolution process for issues that impact multiple customers.

**Customer data management**
Provide your agents with view of customer accounts and contacts, consumers, entitlements, contracts, products, assets, and install base.

**Intelligent routing**
Use Advanced Work Assignment with Agent Workspace for CSM to automatically assign work items to agents based on their availability, capacity, and skills.

**Predictive Intelligence**
Use machine learning to predict fields during case creation, such as the category, priority, and assignment group.

**Agent Workspace for CSM**
Agent Workspace for CSM takes the agent functionality available on the ServiceNow platform and puts these features in a multi-tab interface. The optimized Agent Workspace layout makes it easy for agents to efficiently manage multiple cases, accounts, customers, and consumers.

**Mobile experience for Customer Service Management**
The Customer Service Management mobile application enables agents to access and manage cases in real time from a mobile device.

**Support for external customers**
Provide assisted support for your external customers using multiple communication channels and self-service options with the Customer and Consumer Service Portals.

**Omni-channel communication**
Provide service and support for your external customers through communication channels such as web, email, chat, telephone, and social media.

**Self-service web portals**
Use the [Customer Service Portal](#) and the [Consumer Service Portal](#), based on the ServiceNow Service Portal application, to provide customer self-service options and access to information and assistance with Knowledge Management, Communities, and Service Catalog.

**Virtual Agent**
Improve the customer self-service experience with conversational guidance using a chatbot. Activate [Virtual Agent for CSM](#) to use predefined conversations with Virtual Agent on the Customer Service Portal.
Integration with other applications

Use these integrations with Customer Service Management to expand the application’s capabilities.

Field Service Management
Create and manage work orders based on technician skills, availability, and inventory. Integrate with Customer Service Management to create work orders for customer service cases and add case information to work order forms.

Service Management for issue resolution
Identify, diagnose, and permanently resolve customer issues by integrating Customer Service Management with the Incident, Problem, Change, and Request Management applications. Connect customer service agents to other departments to assist with case resolution.

Proactive Customer Service Operations
Integrate the Customer Service Management and Event Management applications to proactively identify customers and propose customer service cases for issues involving install base items.

Continual Improvement Management with CSM
Use the Continual Improvement Management (CIM) application with Customer Service Management to request improvement opportunities and to implement phases and tasks to meet performance goals, track progress, and measure success.

ServiceNow applications and tools

Use these other ServiceNow applications and tools to enhance Customer Service Management capabilities.

Visual task assignment
Assign customer requests and tasks to other departments with visual task boards.

Visual workflow and automation
Automate assignments, tasks, and service processes with a simple drag-and-drop interface.

Surveys
Use surveys to gather feedback after customers accept case solutions or close cases.

Performance Analytics
Analyze trends with Key Performance Indicators (KPIs), metrics, and role-based dashboards for Customer Service Management.

Reports and dashboards
Generate and distribute customized reports and dashboards on demand.

IT Operations Management
Track service health with the Event Management, Discovery, and Operational Intelligence applications.

Financial modeling
Gain visibility into expenses by connecting real costs to service users and consumption.

Project Portfolio Management
Manage your entire project lifecycle and program portfolio with the ServiceNow Project Portfolio Management application.

**Using guided setup to implement Customer Service Management**

Customer Service Management guided setup provides a sequence of tasks that help you to configure Customer Service Management on your ServiceNow instance. To open Customer Service Management guided setup, navigate to **Customer Service > Administration > Guided Setup**. For more information about using the guided setup interface, see *Using guided setup*.

**Activate Customer Service Management**

You can activate the Customer Service plugin (com.sn_customerservice) if you have the admin role. This plugin includes demo data and activates related plugins if they are not already active.

Role required: admin

The Customer Service Management plugin activates these related plugins if they are not already active.

<table>
<thead>
<tr>
<th>Plugins automatically activated with Customer Service Management</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Plugin</strong></td>
</tr>
<tr>
<td>Assessment (com.snc.assessment_core)</td>
</tr>
<tr>
<td>Asset Management (com.snc.asset_management)</td>
</tr>
<tr>
<td>Assignment Workbench (com.snc.assignment_workbench)</td>
</tr>
<tr>
<td>Connect Support (com.glide.connect.support)</td>
</tr>
<tr>
<td>Connect Support Routing (com.glide.connect.support.routing)</td>
</tr>
<tr>
<td>Consumer Service Portal (com.glide.service-portal.consumer-portal)</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>CSM Workspace (com.snc.agent_workspace.csm)</td>
</tr>
<tr>
<td>Plugin</td>
</tr>
<tr>
<td>--------</td>
</tr>
</tbody>
</table>
| Customer Service Portal (com.glide.service-portal.customer-portal) | This plugin enables the Customer Service Portal, a version of the web portal based on the Service Portal application. The Customer Service Portal plugin activates these related plugins if they are not already active.  
  - Service Portal Social QA (com.glide.service-portal.sqanda) |
| Customer Service Social Integration (com.sn_cs_social) | Adds the necessary data schema changes for social integration scenarios. |
| Openframe (com.sn_openframe) | An interface used to integrate external communication systems with the Now Platform. This plugin provides a UI frame that is accessible and available anywhere within ServiceNow application screens. The Customer Service Management application uses a combination of Computer Telephony Integration (CTI) and OpenFrame to provide phone support for customers. |
| Process Flow Formatter (com.snc.process_flow_formatter) | Provides a graphical summary of the stages in a process. The formatter is typically shown at the top of forms that are part of a process. |
| Skills Management (com.snc.skills_management) | Implements user and user group skills; based on the same principle as roles management with the mechanism of inheritance between user groups and users. |
| Special Handling Notes (com.sn_shn) | Activates the Special Handling Notes application, which enables users to quickly view brief messages about records. These notes can be displayed in an embedded list or related list on a record form or in a pop-up window. This plugin is installed with the Customer Service Management and Field Service Management applications. To use special handling notes with other tables:  
  - Configure the table and any related fields to use special handling notes.  
  - Configure the form to show special handling notes. |
<p>| State Flows (com.snc.state_flows) | Customize transitions from one state to another in tables derived from the Task (task) table and configure the system to perform work during transitions to specific states. |</p>
<table>
<thead>
<tr>
<th>Plugin</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Subscriptions and Activity Feed Framework (com.snc.activity_subscriptions)</td>
<td>Provides a generic set of artifacts to handle subscriptions for any defined subscribable object. Any entity can be defined as a subscribable object and a set of subscribers can subscribe to the objects. When an event occurs related to the subscribable object, activities can be tracked and subscribers can be notified.</td>
</tr>
<tr>
<td>Task Activities (com.snc.task_activity)</td>
<td>Enables support for activities on task tables.</td>
</tr>
<tr>
<td>Virtual Agent Service Portal Widgets (com.glide.va.sp_widgets)</td>
<td>Activates the Service Portal as a Virtual Agent web client.</td>
</tr>
</tbody>
</table>

1. Navigate to **System Definition > Plugins**.

   A banner notifies you that you are in the All Applications page, which contains plugins and ServiceNow Store applications.

   **Note:**

   To redirect to the legacy list view for plugins, click the link.

   ![You have been redirected to All Applications. To see the Plugins list click here](image)

2. Find the plugin using the filter criteria and search bar.

   You can search for the plugin by its name or ID. If you cannot find a plugin, you may have to request it from ServiceNow personnel. To request a plugin, follow the steps in **Request a plugin**.

3. Activate the plugin.

   You can activate the plugin directly from the All Applications page or you can view more details about the plugin before you activate it.

   - If you are certain that you have the correct plugin, click **Install**, and when you see the dialog box, click **Activate**.
To view plugin details before activation:

1. Click the plugin name.
2. On the form, click the **Activate/Update** related link.
3. In the dialog box, review the dependent plugins.
   
   If your plugin requires dependent plugins, they are activated automatically when you activate your plugin if they are not active already.

4. If demo data is available and you want to install it, click **Load demo data**.
   
   Some plugins include demo data, which are sample records that describe plugin features for common use cases. Load demo data when you first activate the plugin on a development or test instance. You can always load demo data later by clicking **Load demo data only** on the plugin form.

5. Click **Activate**.

You can activate several related plugins after activating the Customer Service Management plugin (com.sn_customerservice). For details, see [Additional plugins for Customer Service Management](#).

### Additional plugins for Customer Service Management

After Customer Service Management is activated, you can activate additional plugins that provide demo data and enable various features.

You must have the admin role to activate these additional plugins. For details, see [Activate a plugin](#).

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Agent Schedule</td>
<td>Enables customer service agents and field service technicians to see work schedules and assignments and also add personal events such as meetings or appointments.</td>
</tr>
</tbody>
</table>

© 2019 ServiceNow, Inc. All rights reserved.

ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Plugin</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Anonymous Connect Support (com.glide.connect_anonymous_support)</td>
<td>Enables consumers to chat with consumer service agents from the Consumer Service Portal without logging in.</td>
</tr>
<tr>
<td>Case Assignment Workbench Demo (com.snc.case_assignment_workbench_demo)</td>
<td>Provides demo data, such as sample cases and users, so that the Assignment Workbench product features can be demonstrated on a non-production instance.</td>
</tr>
<tr>
<td>Case Digests (com.sn_csm_case_digest)</td>
<td>Enables users to send case status updates and root cause analysis to customers and key internal stakeholders.</td>
</tr>
<tr>
<td>CSM Account Hierarchy (com.snc.sn_csm_account_hierarchy)</td>
<td>Helps customer service agents navigate the account hierarchy and open specific accounts to view details.</td>
</tr>
<tr>
<td>CSM Extension for Proxy Contacts (com.snc.csm_proxy_contacts)</td>
<td>Enables users who are internal to an organization to be the proxy case contact on behalf of customers.</td>
</tr>
</tbody>
</table>
| CTI Softphone (com.snc.cti)                                           | This plugin is a demo application that enables Twilio integration using the Notify application and OpenFrame to provide soft phone functions and call center capabilities. The application includes the capabilities to make, receive, transfer, hold, and mute calls. The Customer Service Management and Incident Management applications provide Computer Telephony Integration (CTI) demo workflows. Activate the respective applications to run the workflows. The CTI Softphone plugin activates these related plugins if they are not already active:  
  - **Notify (com.snc.notify):** Provides platform features for workflow-driven voice calls, conference calls, and SMS messages.  
  - **Notify - Twilio Driver (com.snc.notify.twilio):** Provides Notify support for the Twilio product. Requires a separate contract with Twilio for SMS/Voice capabilities.  
  - **Openframe (com.sn_openframe):** Provides an interface that can be used to integrate external communication systems with the Now Platform. |
<p>| Customer Communities (com.sn_customer_communities)                    | Enables users to connect, engage, and collaborate with employees, customers, partners, and prospects. Available to customers who are licensed for Customer Service Management.                                                |
| Customer Service Case Action Status (com.snc.csm_action_status)       | Provides a Customer Service-specific application of the Action Status Automation feature. Use this plugin to display and track blocking tasks for customer service cases.                                                      |
| Customer Service CTI Demo Data (com.snc.customerservice_cti_demo)     | Provides demo data for the CTI Softphone application.                                                                                                                                                        |
| Customer Service Document Template (com.sn_csm_doc_template)          | Enables you to configure the fields from a table record that are included in an output document.                                                                                                             |</p>
<table>
<thead>
<tr>
<th>Plugin</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Customer Service Install Base Management</td>
<td>Enables customers to capture the current state of a customer’s install base and establish the relationship to any downstream entities that might impact their functioning.</td>
</tr>
<tr>
<td>(com.snc.install_base)</td>
<td></td>
</tr>
<tr>
<td>(com.snc.customerservice.demo)</td>
<td></td>
</tr>
<tr>
<td><strong>Customer Service Management for Orders</strong></td>
<td>Extends Customer Service Management to support order-related issues by integrating with order management systems to create and resolve customer requests.</td>
</tr>
<tr>
<td>(com.snc.csm.order)</td>
<td></td>
</tr>
<tr>
<td>Customer Service Mobile</td>
<td>Enables the mobile user interface for Customer Service Management.</td>
</tr>
<tr>
<td>(com.sn_csm_mobile)</td>
<td></td>
</tr>
<tr>
<td>Customer Service Virtual Agent Conversations</td>
<td>Provides predefined Customer Service Virtual Agent topics (chatbot conversations) designed to help your customers complete common self-service tasks.</td>
</tr>
<tr>
<td>(com.sn_csm.virtualagent)</td>
<td></td>
</tr>
<tr>
<td>Customer Service with Field Service Management</td>
<td>This plugin provides an integration between the Customer Service Management and Field Service Management applications. Customers and consumers can view case-related work orders from the Customer Service and Consumer Service Portals. In the Field Service Management application, users can view account and contact information on work orders and work order tasks.</td>
</tr>
<tr>
<td>(com.snc.csm_fsm_integration)</td>
<td></td>
</tr>
<tr>
<td>(com.sn_cs_sm_request)</td>
<td></td>
</tr>
<tr>
<td>(com.sn_cs_sm)</td>
<td></td>
</tr>
<tr>
<td>Incident Assignment Workbench Demo</td>
<td>Intelligent agent recommendation through dynamic matching rules/criteria.</td>
</tr>
<tr>
<td>(com.snc.incident_assignment_workbench_demo)</td>
<td></td>
</tr>
<tr>
<td>Knowledge Product Entitlements</td>
<td>This plugin enables customer service administrators to restrict customer access to designated knowledge bases and knowledge articles on the customer self-service portal.</td>
</tr>
<tr>
<td>(com.snc.kb_product_entitlements)</td>
<td>This plugin adds the Knowledge Product Entitlements menu to the application navigator.</td>
</tr>
<tr>
<td>Major Issue Management</td>
<td>A set of capabilities used to manage customer-facing communications and resolution processes for common issues.</td>
</tr>
<tr>
<td>(com.sn_majorissue_mgt)</td>
<td></td>
</tr>
<tr>
<td>Plugin</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Performance Analytics - Content Pack - Customer Service</td>
<td>Performance Analytics content pack that includes Customer Service base system KPIs.</td>
</tr>
<tr>
<td>(com.snc.pa.customer_service)</td>
<td></td>
</tr>
<tr>
<td>Note:</td>
<td>Customer Service Performance Analytics solutions are an optional feature available for the Customer Service Management application. To use these solutions, you must have a subscription to Performance Analytics. Then you can enable the Performance Analytics Premium for Customer Service and the Customer Service Performance Analytics solutions on the instances where you wish to leverage the enhanced functionality.</td>
</tr>
<tr>
<td>Performance Analytics - Content Pack - Customer Service Management -</td>
<td>Updates the Customer Service dashboard and incorporates indicators for the following plugins:</td>
</tr>
<tr>
<td>Advanced</td>
<td>• Major Issue Management</td>
</tr>
<tr>
<td>(com.snc.pa.customer_service_advanced)</td>
<td>• Customer Service Case Action Status</td>
</tr>
<tr>
<td></td>
<td>• Customer Service with Request Management</td>
</tr>
<tr>
<td></td>
<td>• Customer Service with Service Management</td>
</tr>
<tr>
<td></td>
<td>• Agent Chat</td>
</tr>
<tr>
<td></td>
<td>• Advanced Work Assignment for CSM</td>
</tr>
<tr>
<td></td>
<td>• Performance Analytics - Content Pack - Advanced Work Assignment.</td>
</tr>
<tr>
<td>Activate these plugins to view the related indicators. Without these</td>
<td></td>
</tr>
<tr>
<td>plugins, indicators may not display correctly.</td>
<td></td>
</tr>
<tr>
<td>Note:</td>
<td>Customer Service Performance Analytics solutions are an optional feature available for the Customer Service Management application. To use these solutions, you must have a subscription to Performance Analytics. Then you can enable the Performance Analytics Premium for Customer Service and the Customer Service Performance Analytics solutions on the instances where you wish to leverage the enhanced functionality.</td>
</tr>
<tr>
<td>(com.snc.pa.fm.csm)</td>
<td></td>
</tr>
<tr>
<td>Performance Analytics - Context Sensitive Analytics for Customer Service</td>
<td>This plugin allows you to open context-sensitive dashboards in customer service forms based on UI actions.</td>
</tr>
<tr>
<td>(com.snc.pa.cs.context_sensitive_analytics)</td>
<td></td>
</tr>
<tr>
<td>Note:</td>
<td>Customer Service Performance Analytics solutions are an optional feature available for the Customer Service Management application. To use these solutions, you must have a subscription to Performance Analytics. Then you can enable the Performance Analytics Premium for Customer Service and the Customer Service Performance Analytics solutions on the instances where you wish to leverage the enhanced functionality.</td>
</tr>
</tbody>
</table>

© 2019 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Plugin</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Performance Analytics Premium for Customer Service</td>
<td>Installing this plugin removes the limitations of the out-of-box Performance Analytics.</td>
</tr>
<tr>
<td>(com.snc.pa.premium.cs)</td>
<td></td>
</tr>
<tr>
<td><strong>Note:</strong> Customer Service Performance Analytics</td>
<td>solutions are an optional feature available for the Customer Service Management application. To use these solutions, you must have a subscription to Performance Analytics. Then you can enable the Performance Analytics Premium for Customer Service and the Customer Service Performance Analytics solutions on the instances where you wish to leverage the enhanced functionality.</td>
</tr>
<tr>
<td><strong>Note:</strong> Customer Service Performance Analytics</td>
<td>solutions are an optional feature available for the Customer Service Management application. To use these solutions, you must have a subscription to Performance Analytics. Then you can enable the Performance Analytics Premium for Customer Service and the Customer Service Performance Analytics solutions on the instances where you wish to leverage the enhanced functionality.</td>
</tr>
<tr>
<td>Proactive Customer Service Operations</td>
<td>Enables customers to create cases proactively from alerts either manually or through automation and track the accounts and the corresponding install base items affected by the alert.</td>
</tr>
<tr>
<td>(com.snc.proactive_cs_ops)</td>
<td></td>
</tr>
<tr>
<td>Self Service Password Reset</td>
<td>This plugin allows locally authenticated users to request a temporary password if they forget their current one. Customer contacts can request a new password from the customer self-service portal. The Self Service Password Reset plugin activates the Password Reset plugin (com.glideapp.password_reset) if it is not already active.</td>
</tr>
<tr>
<td>(com.snc.password_reset)</td>
<td></td>
</tr>
<tr>
<td>Special Handling Notes Demo Data (com.snc.shn_demo)</td>
<td>Provides demo data for the Special Handling Notes application.</td>
</tr>
<tr>
<td>Targeted Communications</td>
<td>Provides a tool for publishing and distributing content and articles to both internal and external customers.</td>
</tr>
<tr>
<td>(com.sn_publications)</td>
<td></td>
</tr>
<tr>
<td>Targeted Communications Demo Data</td>
<td>Provides demo data for the Targeted Communications application.</td>
</tr>
<tr>
<td>(com.snc.publications_demo)</td>
<td></td>
</tr>
<tr>
<td>(com.snc.csm_time_recording)</td>
<td></td>
</tr>
</tbody>
</table>

**Configure Customer Service Management**

**Foundation data**

Customer services cases store a variety of customer information such as accounts and contacts, consumers, assets, products, and service contracts. The Customer Service Management application also stores information about account and contact relationships. Configuring this foundation data enables agents to quickly and easily access case-related information.

Each type of customer information is considered an entity with its own particular attributes. For example, the customer service case is the primary entity of the Customer Service management application. Agents use cases as the main tool for tracking and resolving customer questions and issues. Customer information is linked to a case as associated entities, including accounts, assets, and service contracts. This provides the customer service agent with easy access to a
customer's information. All of these entities make up the foundation data for the Customer Service Management application.

To configure foundation data:

1. Create or import data for associated entities.
2. Assign roles to groups or to individual users.
3. Create service contracts and entitlements.
4. Create customer relationships, asset relationships, and account teams.

For Business-to-business (B2B) customers, configure these entities:

- Accounts
- Contacts
- Users and groups (agents and managers)
- Product models and assets
- Service contracts
- Entitlements
- Customer relationships
- Asset relationships
- Account teams

For Business-to-consumer (B2C) customers, configure these entities:

- Consumers
- Users and groups (agents and managers)
- Product models and assets

Create customer and consumer information

Customer information includes the account and contact information for a customer or partner. Consumer information includes the name, phone number, and one or more addresses for a consumer.

An account is a supported external customer and the Account form stores the customer's information, including the company name, contact names, addresses, phone numbers, and web and email addresses. An account can be a customer account, a partner account, or both.

A contact is a user who is an employee of an account. A contact record stores information about a contact, such as the name, phone number, email and web address. An account can have multiple contacts but a contact can be associated with only one account. A contact can have one or more associated assets and service contracts. A contact can also have a user ID and can log in to the customer portal.

An account can have one or more associated assets, service contracts, entitlements, and SLAs. An account can also be associated with the following entities:

- case
- contact
- service contract
- entitlement
- asset

A partner is a supported external customer that, in turn, sells to and supports one or more customers. A partner account record stores information about a partner's company, similar to
a customer account. On a partner account record, the Partner field is enabled. A partner can report and manage cases on behalf of customers. A partner can also be a customer.

A consumer is a customer of a business-to-consumer (B2B) use case. A consumer record stores similar information as a contact record, such as the name, phone number, address, and email address. Consumers can have multiple addresses, one of which is the primary address.

Create a customer or partner account
Use this procedure to create either a customer or partner account.
Role required: sn_customerservice_agent, sn_customerservice_manager, or admin

1. Do one of the following:
   - To create a customer account, navigate to Customer Service > Customer > Accounts.
   - To create a partner account, navigate to Customer Service > Customer > Partners.

2. Click New.
3. Fill in the fields on the Account form, as appropriate.

<table>
<thead>
<tr>
<th>Field</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the company.</td>
</tr>
<tr>
<td>Number</td>
<td>The automatically generated account number for this customer.</td>
</tr>
<tr>
<td>Primary Contact</td>
<td>The name of a user who is the main contact for this company.</td>
</tr>
<tr>
<td>Parent Account</td>
<td>The parent account for this account. Use this field to create an account hierarchy.</td>
</tr>
<tr>
<td>Registration Code</td>
<td>A unique code for this account. The customer administrator can provide this code to customers for use when requesting a login on the customer portal. The registration code provides a method for validating the customer and the company before the login request is granted. Enter an alphanumeric code in this field or click the Generate Code icon to generate a unique code.</td>
</tr>
<tr>
<td>Customer</td>
<td>Denotes this account as a customer, as opposed to a partner. If creating a customer account, this field is enabled by default.</td>
</tr>
<tr>
<td>Partner</td>
<td>Denotes this account as a partner. A partner can report and manage cases on behalf of customers. A partner can also be a customer. If creating a partner account, this field is enabled by default.</td>
</tr>
<tr>
<td>Website</td>
<td>The web address for the company.</td>
</tr>
<tr>
<td>Phone</td>
<td>The phone number for the company.</td>
</tr>
<tr>
<td>Street</td>
<td>The street address of the company.</td>
</tr>
<tr>
<td>City</td>
<td>The city in which the company is located.</td>
</tr>
<tr>
<td>State/Province</td>
<td>The state or province in which the company is located.</td>
</tr>
</tbody>
</table>
4. Click Submit.

Import customer account information

After importing customer account information, update the `com.snc.cs_base.last.generated.code.tree.path` property with the correct account code value.

The `com.snc.cs_base.last.generated.code.tree.path` system property stores the Account Code value for the most recently created customer account in the Account (customer_account) table.

When you create a new customer account record, the system uses this property to determine a unique account code value for the account. The property is then updated with this latest assigned value so that the next account code value can be set as a unique value for the next account record insert.

The value of the `com.snc.cs_base.last.generated.code.tree.path` property must match the value of the Account Code field for the last inserted customer account record. When you create customer account records by importing data from other sources or instances, these values can get out of sync. If these values do not match, the system generates an error upon creation of the next new record in the Account table:

```
java.sql.BatchUpdateException: Duplicate entry for key account_path
```

To fix this error:

1. Determine the account code for the last created account.
2. Navigate to the System Property (sys_properties) table.
3. Set the `com.snc.cs_base.last.generated.code.tree.path` property to that value.

Create a contact

Use this procedure to create contact information for an account.

Role required: sn_customerservice_manager, admin

A contact is a user in the system. If you create a contact, that person is also added to the User list.

2. Click New.
3. Enter the requested contact information, such as the name, email address, and phone number.
4. Enter the name of the contact's company in the Account field.
5. Select the Timezone.
6. Select a Notification setting.
7. Click Submit.

After a registration request is approved, the customer contact receives an email with a user ID and temporary password. When logging in for the first time, the contact is asked to change the password.
Create additional account addresses
An account can have multiple addresses, such as a main address as well as shipping and billing addresses.

Role required: sn_customerservice_manager or admin

The main address for an account is stored in fields on the Account form. Shipping and billing addresses for an account are created and stored in the Addresses related list. An account can have multiple shipping and billing addresses.

2. Click the number of the desired account.
3. In the Addresses related list, click New.
4. Fill in the fields on the Location form.
5. Select an address type, either Billing or Shipping.
6. Optional: Enable the Primary field.
   - If you have multiple billing or shipping addresses, use this field to designate one as the primary address.
7. Click Submit.

Create a consumer record
Consumer service agents and managers can create a consumer record from the Customer Service Management application.

Role required: sn_customerservice.consumer_agent, sn_customerservice_manager or admin

1. Navigate to Customer Service > Customer > Consumers
2. Click New.
3. Fill in the fields on the Consumer form as necessary.
4. Fill in the fields on the Primary Address tab.
   - A consumer can have multiple addresses but only one primary address. The primary address is stored in the Primary Address tab on the Consumer form and in the Addresses related list.
5. If desired, set any of the fields on the Preferences tab.
6. Click Submit.
   - The record is added to the Consumers table (csm_consumer). The primary address is added to the Addresses related list and the Primary field is set to true.

Create additional consumer addresses
Consumers can have multiple addresses, including one primary address.

Role required: sn_customerservice.consumer_agent, sn_customerservice_manager, or admin

The primary address is stored in the Primary Address tab on the Consumer form and in the Addresses related list. When you fill in the fields in the Primary Address tab and click Submit, this information is added to the Addresses related list as the primary address, with the Primary field set to true. Any changes made to the Primary Address fields are also updated in the related list.

Note: A consumer can have only one primary address.

Other addresses, such as billing or shipping addresses, can be created and stored in the Addresses related list. For these other addresses, the Primary field is set to false.

2. Click the number of the desired consumer.
3. In the Addresses related list, click New.
4. Fill in the fields on the Location form.
5. To denote this address as the primary address for the consumer, enable the **Primary** check box.
   A consumer can have multiple addresses but only one primary address.

6. Click **Submit**.

### Create contracts and entitlements

Contracts and entitlements define the type of support that a customer receives.

#### Service contracts

A service contract record stores information about the type of support that is provided to a designated company. A contract can include a company and contact and the specific assets that are covered. A contract can also include multiple service entitlements and SLAs.

The Customer Service Management application leverages the existing ServiceNow Contract application to create and maintain service contracts. The Customer Service Management application uses the Contract form and adds the **Company** field so customer service agents can quickly see the company associated with a contract.

#### Entitlements

An entitlement defines the type of support that a customer receives as well as the supported communication channels. An entitlement can be associated with a product, an asset, an account, or a contract.

An entitlement check is performed when a case is opened. This check takes into consideration the existing cases for the specific account, product, asset, and service contract. Entitlements can have associated workflows that drive recommended activities for a case.

Entitlements are counted on a per unit basis. The **Unit** field on the Service Entitlement form defines the unit type, either cases or hours.

Entitlements can also be tracked on a per unit basis. The **Total Units** field defines the total number of cases or hours available for this entitlement and the **Remaining Units** field tracks the number of units remaining. These counters are active if the **Per Unit** field is enabled.

The **Remaining Units** field is updated using business rules.

- When using cases as the unit type, the **Update case entitlement on Close** business rule updates this field when a case for a product, asset, company, or contract that has an associated entitlement is closed.
- To use hours as the unit type, customers must create a separate business rule. For example, create a rule that is applied to the amount of time an agent spends on a case. When a case is resolved, deduct the hours spent from the total service hours available in the entitlement.

Keep these guidelines in mind as you create entitlements.

- **Product entitlements**: when creating an entitlement for a product, select the product from the **Product** field. If you select only a product and not a company, contract, or asset, this creates a generic entitlement and the entitlement counter fields cannot be used.
- **Asset entitlements**: when creating an entitlement for an asset, select a company first and then the only assets that are shown are those belonging to that company.
- **Contract entitlements**: when creating an entitlement for a contract, select the contract and then the assets that are covered as a contract line item. The resulting contract entitlement is valid for the assets listed within that contract.
SLAs

The Customer Service Management application uses the standard ServiceNow SLA with customer service cases. An SLA can be attached to a service contract, to a company, and to a product and can be configured to start, pause, and stop based on any customer service case attributes.

Create a service contract
Create a service contract for a customer account.

Role required: sn_customerservice_manager or admin

1. Navigate to **Customer Service > Contracts > Service Contracts.**
2. Click **New.**
3. Fill in the fields on the Contract form, as appropriate.

**Contract form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>The automatically created contract number.</td>
</tr>
<tr>
<td>Account</td>
<td>The name of the company associated with this contract.</td>
</tr>
<tr>
<td>Contract administrator</td>
<td>The individual who is responsible for managing the contract.</td>
</tr>
<tr>
<td>Approver</td>
<td>The user who approves or rejects the contract.</td>
</tr>
<tr>
<td>Contract number</td>
<td>The number assigned to the contract by the customer.</td>
</tr>
<tr>
<td>State</td>
<td>The current state of the contract:</td>
</tr>
<tr>
<td></td>
<td>· Draft</td>
</tr>
<tr>
<td></td>
<td>· Active</td>
</tr>
<tr>
<td></td>
<td>· Expired</td>
</tr>
<tr>
<td></td>
<td>· Canceled</td>
</tr>
<tr>
<td>Starts</td>
<td>The date that the contract starts.</td>
</tr>
<tr>
<td>Ends</td>
<td>The date that the contract ends.</td>
</tr>
<tr>
<td>Short description</td>
<td>A brief description of the contract.</td>
</tr>
</tbody>
</table>

4. Click **Submit.**
   You can also click **Submit For Review** to place the contract in the **Draft** state and send an email to the **Approver** to review the contract.

Approve a service contract
Approve a service contract for a customer account.

Role required: sn_customerservice_manager or admin

1. Navigate to **Self-Service > My Approvals.**
2. Select a contract for review from the Approvals list that has a state of **Requested.**
3. Review the contract details in the summary at the bottom of the approval form.
4. Add review comments to the **Comments** field.
5. Click one of the following:
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Approve</strong></td>
<td>The review state changes to <strong>Approved</strong> on the Approvals list.</td>
</tr>
<tr>
<td><strong>Reject</strong></td>
<td>The review state changes to <strong>Rejected</strong> on the Approvals list. If you reject a contract, you must enter a rejection reason in the <strong>Comments</strong> field.</td>
</tr>
</tbody>
</table>

Create an entitlement for a customer service entity

Create an entitlement for a customer service entity.

Role required: sn_customerservice_manager or admin

1. Navigate to **Customer Service > Contracts > Entitlements**.
   You can also create an entitlement from the **Entitlements** related list on the Account and Contract forms.

2. Click **New** at the top of the Entitlements list.

3. Fill in the fields on the Entitlement form.

**Service Entitlement form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Name</strong></td>
<td>The name of the entitlement.</td>
</tr>
<tr>
<td><strong>Product</strong></td>
<td>The product model associated with this entitlement.</td>
</tr>
<tr>
<td><strong>Account</strong></td>
<td>The name of the account associated with this entitlement.</td>
</tr>
<tr>
<td><strong>Contract</strong></td>
<td>The contract number associated with this entitlement.</td>
</tr>
<tr>
<td><strong>Asset</strong></td>
<td>The asset tag number or the serial number of the asset associated with this entitlement.</td>
</tr>
<tr>
<td><strong>Active</strong></td>
<td>Check this box to enable the entitlement. Active entitlements are available for selection when creating a new case.</td>
</tr>
<tr>
<td><strong>Channel</strong></td>
<td>One or more communication channels associated with this entitlement.</td>
</tr>
</tbody>
</table>

- Email
- Web
- Phone
- Chat

| Install Base Item | The install base item associated with the entitlement. Configure the form layout to add the **Install Base Item** field. |

**Note:** This field is only available if the Customer Service Install Base Management plugin (com.snc.install_base) is installed.
<table>
<thead>
<tr>
<th>Field</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sold Product</td>
<td>The sold product associated with the entitlement. Configure the form layout to add the <strong>Sold Product</strong> field.</td>
</tr>
<tr>
<td>Note: This field is only available if the Customer Service Install Base Management plugin (com.snc.install_base) is installed.</td>
<td></td>
</tr>
<tr>
<td>Business hours</td>
<td>The schedule associated with this entitlement.</td>
</tr>
<tr>
<td>Start date</td>
<td>The start date for this entitlement.</td>
</tr>
<tr>
<td>End date</td>
<td>The end date for this entitlement.</td>
</tr>
<tr>
<td>Total Units</td>
<td>The total number of units designated for this entitlement. This field is active if the <strong>Per unit</strong> check box is enabled.</td>
</tr>
<tr>
<td>Remaining Units</td>
<td>The number of available units that are remaining for this entitlement. This field is active if the <strong>Per unit</strong> check box is enabled. This field is updated using business rules.</td>
</tr>
<tr>
<td>Unit</td>
<td>The type of unit being measured for this entitlement: <strong>Cases</strong> or <strong>Hours</strong>.</td>
</tr>
<tr>
<td>Per unit</td>
<td>Select this check box to enable unit counters. If enabled, the <strong>Total Units</strong> and <strong>Remaining Units</strong> fields are activated.</td>
</tr>
</tbody>
</table>

4. Click **Submit**.

**Associate an entitlement with a product, account, contract, or asset**

Associate an entitlement with a customer service entity such as an account, contract, asset, or product.

Role required: admin

1. Navigate to **Customer Service > Contracts > Entitlements**.
2. Select an entitlement from the Entitlements list.
3. Click the lookup icon to the right of one of the **Product**, **Account**, **Contract**, or **Asset** fields.
4. Select the desired entity from the list.
Create service level agreements

A service level agreement (SLA) is a record that specifies the time within which service must be provided.

The Customer Service Management application uses the standard ServiceNow SLA with customer service cases. An SLA can be attached to a service contract, to a company, and to a product and can be configured to start, pause, and stop based on any customer service case attributes.

Define an SLA for a customer service case

The system administrator can define a new service level agreement (SLA) for a customer service case.

Role required: admin

1. Navigate to Customer Service > Cases > All.
2. Select the desired case from the Cases list.
3. From the SLAs related list, click New.
4. Fill in the fields on the Task SLA form.
5. Click Submit.

Create product data

Set up customer product data to give customers and customer service agents a common understanding of the products and assets being used at a customer site.

Products and assets identify the product models and individual product instances owned by a customer.

An asset is a specific product instance that is supported for a customer. Assets can have serial numbers or asset tag numbers and can be allocated to individual accounts or to a contact within an account. Assets can also have associated support contracts. Customer Service Management leverages the Asset application to create and maintain assets.

A product is a good or a service that a company sells to and supports for their customers. A product has specific features or components which determine the agents best qualified to provide support. A product model is a specific version or configuration of a product. A product can be installed at a customer site or in-house with access provided on a subscription basis.

Plugins

- Asset management requires the Asset Management plugin (com.snc.asset_management).
- Product models requires the Model Management plugin (com.snc.model).

Create a product model

Create a record for a type of product that your company sells and supports.

Ensure that the Model Management plugin (com.snc.model) is installed.

Role required: model_manager

A product model is a specific version or configuration of a product. Build hierarchical product models that represent the set of products that your organization offers to its customers and
define relationships between different product models. Define whether a product is tracked as an asset, a CI or both as well as identifying or creating the CI and asset class that captures the configuration information for product models.

Product models provide customer service agents and customers with a common understanding of the products being used by a particular customer. Customers can view the products purchased on the Customer Service Portal and can open cases for any issues they are facing.

2. Click New.
3. Select the type of product model to create:
   - Application Model
   - Consumable Model
   - Contract Model
   - Facility
   - Hardware
   - Service
   - Software

4. Fill in the fields for the selected product model, as appropriate
   See Model form fields for field descriptions.
5. Click Submit.

   Note: In the Sold to Accounts or Sold to Consumers related list, you can see all the accounts and consumers that the product model has been sold to.

Create an asset
Create a record for a specific instance of a product.

Ensure that the Asset management plugin (com.snc.asset_management) is installed.

Role required: sn_customerservice_manager or admin

2. Click New.
3. Select the type of asset to create:
   - Hardware
   - Software License
   - Consumable
   - License
   - Facility

4. Fill in the fields for the selected asset type, as appropriate.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display name</td>
<td>Name of the asset as it appears in record lists. Automatically set when asset is created, based on Asset Tag and Model fields.</td>
</tr>
<tr>
<td>Model category</td>
<td>Model grouping of the asset. Based on the model category selected, the asset can be linked to a configuration item.</td>
</tr>
<tr>
<td>Model</td>
<td>Specific product model of the asset.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Configuration Item</td>
<td>CI automatically created when this asset is created. The name that appears in this field is based on <strong>Model category</strong> and <strong>Model</strong>. Point to the reference icon to see the configuration item details inherited from the asset record.</td>
</tr>
</tbody>
</table>
| Quantity   | Number of items this asset represents. An asset always has a quantity of one unless one or more of these points are true.  
> - It is a consumable. Quantity is unrestricted because consumables are tracked in groups.  
> - It is pre-allocated. Quantity is unrestricted when **Model category** and **Model** are defined and **Substate** is set to Pre-allocated.  
> - It has no model and no model category. |
<p>| General    |                                                                                                                                               |
| Asset tag  | Alphanumeric information assigned by your organization to help track the asset.                                                                 |
| State      | Current state of the asset, such as <strong>On order</strong> or <strong>In use</strong>.                                                                                  |
| Stockroom  | Current stockroom in which the asset is physically located.                                                                                     |
| Reserved for | Person for whom the asset has been ordered. This field is visible when the asset state is <strong>On Order</strong>.                                             |
| Assigned to | Person using or primarily responsible for this item. This field is visible when the asset state is <strong>In Use</strong>.                                   |
| Managed by | Person who maintains the asset. This can be different from the person in the <strong>Owned by</strong> field.                                                 |
| Owned by   | Person who has financial ownership of the asset. This can be different from the person in the <strong>Managed by</strong> field.                             |
| Parent     | Parent asset of the asset. For example, a monitor or peripheral can have a workstation as their parent asset. When a parent link is defined, the fields related to assignment and state of the child assets is set to read-only and are populated based on the parent assignment and state fields. For more information, see <em>Creating Bundled Models</em>. |
| Class      | Asset group, for example, base, hardware, license, or consumable.                                                                                 |
| Serial number | Serial number of this asset.                                                                                                                     |</p>
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Substate</td>
<td>Current substate of the asset. The available substate settings depend on the state selected. For example, the Retired state contains the Substate options Disposed, Sold, Donated, and Vendor credit.</td>
</tr>
<tr>
<td>Location</td>
<td>Current physical location of the asset.</td>
</tr>
<tr>
<td>Department</td>
<td>Department to which the asset belongs.</td>
</tr>
<tr>
<td>Company</td>
<td>Company or organization to which this asset belongs.</td>
</tr>
<tr>
<td>Assigned</td>
<td>Date on which the asset was assigned to a user.</td>
</tr>
<tr>
<td>Installed</td>
<td>Date on which the asset was installed.</td>
</tr>
<tr>
<td>Comments</td>
<td>Information about the asset that would be helpful for others to know.</td>
</tr>
<tr>
<td>Financial</td>
<td></td>
</tr>
<tr>
<td>PO number</td>
<td>Purchase order under which the asset was purchased.</td>
</tr>
<tr>
<td>Order received</td>
<td>Date on which the asset was received.</td>
</tr>
<tr>
<td>Request line</td>
<td>Requested item to which the asset is linked.</td>
</tr>
<tr>
<td>Purchase order line</td>
<td>Purchase order line item to which the asset is linked.</td>
</tr>
<tr>
<td>Receiving line</td>
<td>Receiving slip line to which the asset is linked.</td>
</tr>
<tr>
<td>Invoice number</td>
<td>Invoice under which the asset was billed.</td>
</tr>
<tr>
<td>Cost</td>
<td>Price at which the asset was purchased.</td>
</tr>
<tr>
<td>Vendor</td>
<td>Vendor from which the asset was purchased. For assets automatically created from purchase orders in Procurement, the default value of the Vendor field is the vendor specified on the purchase order.</td>
</tr>
<tr>
<td>Purchased</td>
<td>Date on which the asset was purchased.</td>
</tr>
<tr>
<td>Ordered</td>
<td>Date on which the asset was ordered.</td>
</tr>
<tr>
<td>Opened</td>
<td>Date on which the requested item record was opened. The system automatically populates the field when a request line is specified.</td>
</tr>
<tr>
<td>GL account</td>
<td>General ledger account number with which the asset is associated.</td>
</tr>
<tr>
<td>Cost center</td>
<td>Group financially responsible for the asset.</td>
</tr>
<tr>
<td>Acquisition method</td>
<td>How the asset was acquired. Base system choices are Purchase, Lease, Rental, and Loan. For assets automatically created from purchase orders in Procurement, the default value is Purchase</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Expenditure type</td>
<td>The type of expenditure.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Capex</strong>: Capital expenditure is a one-time expenditure, where the value is realized over the years. For example, a photocopier.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Opex</strong>: Operational expenditure is an ongoing expenditure. For example, toners for the photocopier.</td>
</tr>
<tr>
<td>Disposal</td>
<td></td>
</tr>
<tr>
<td>Disposal reason</td>
<td>Text explaining why the asset is being retired.</td>
</tr>
<tr>
<td>Beneficiary</td>
<td>Organization that receives the asset when it is retired.</td>
</tr>
<tr>
<td>Resale price</td>
<td>Value of the asset when it is retired. For example, if the asset is donated, the value used when reporting taxes.</td>
</tr>
<tr>
<td>Scheduled retirement</td>
<td>Scheduled date on which the asset is retired.</td>
</tr>
<tr>
<td>Retired date</td>
<td>Actual date on which the asset was retired.</td>
</tr>
<tr>
<td>Depreciation</td>
<td></td>
</tr>
<tr>
<td>Depreciation</td>
<td>Depreciation method that is applied. Base system choices are Declining Balance and Straight Line. The depreciation value is defaulted from the associated Model.</td>
</tr>
<tr>
<td>Depreciation effective date</td>
<td>Date on which the specified depreciation method begins.</td>
</tr>
<tr>
<td>Salvage value</td>
<td>Estimated value of an asset at the end of its useful life. This value must be less than or equal to the Cost of the asset.</td>
</tr>
<tr>
<td>Residual date</td>
<td>(Read-only) Number of days that have passed since the <strong>Depreciation effective date</strong>.</td>
</tr>
<tr>
<td>Residual value</td>
<td>(Read-only) Value in the Cost field with the depreciation method applied.</td>
</tr>
<tr>
<td>Covered by Fixed Asset</td>
<td>List of all fixed assets that contain the asset. To add the asset to another fixed asset, double-click in the <strong>Fixed asset</strong> column, click the reference lookup icon, select an asset, and click the green check mark.</td>
</tr>
<tr>
<td>Contracts</td>
<td></td>
</tr>
<tr>
<td>Lease contract</td>
<td>Name of the lease contract that applies to the asset.</td>
</tr>
<tr>
<td>Warranty expiration</td>
<td>Expiration date of the asset warranty.</td>
</tr>
<tr>
<td>Support group</td>
<td>Group managing the contract covering the asset.</td>
</tr>
<tr>
<td>Supported by</td>
<td>Person managing the contract covering the asset.</td>
</tr>
</tbody>
</table>

Entitlements (available for hardware assets)
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hardware Entitlements</td>
<td>Software asset license entitlements associated to the asset.</td>
</tr>
<tr>
<td><strong>Device Entitlements</strong> tab (available for software assets)</td>
<td></td>
</tr>
<tr>
<td>Allocated condition</td>
<td>Condition that a configuration item must satisfy to be granted entitlement for this license (available for software entitlements).</td>
</tr>
<tr>
<td>Device Entitlements</td>
<td>Software license entitlements associated to the asset.</td>
</tr>
<tr>
<td>User Entitlements (available for software assets)</td>
<td></td>
</tr>
<tr>
<td>Assigned condition</td>
<td>Condition that a user item must satisfy to be granted entitlement for this license (available for software entitlements).</td>
</tr>
<tr>
<td>User Entitlements</td>
<td>User license entitlements associated to the asset.</td>
</tr>
<tr>
<td>Activities</td>
<td>Work notes are updated for the following cases:</td>
</tr>
<tr>
<td></td>
<td>· Updates to <strong>Assigned To, Managed To State, Substate, and Reserved</strong> fields of asset. The columns for these fields are audited by default and any update is recorded in the work notes.</td>
</tr>
<tr>
<td></td>
<td>· Work notes for hardware and software assets are updated when asset is received by a purchase order and transfer order. These work notes help in tracking life cycle of the asset.</td>
</tr>
<tr>
<td>Related links</td>
<td></td>
</tr>
<tr>
<td>Calculate Depreciation</td>
<td>Click to calculate the depreciation amount and residual value.</td>
</tr>
<tr>
<td>Delete Assets Only</td>
<td>Click to delete the assets and not the associated CI.</td>
</tr>
</tbody>
</table>

5. Click **Submit**.

**Create customer relationships**

The Customer Service Management application provides the ability to establish different types of relationships between partners, customers, and contacts.

These relationships make account and asset management easy and flexible. The following types of customer service relationships are available.
### Customer service relationships

<table>
<thead>
<tr>
<th>Relationship</th>
<th>Description</th>
<th>Benefit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bi-directional account relationship</td>
<td>Create a relationship between two customer accounts or between a partner account and a customer account.</td>
<td>An account relationship allows partner account contacts with the partner role or the partner administrator role to create and manage cases for their partner account.</td>
</tr>
<tr>
<td>Account hierarchy</td>
<td>Create a parent-child relationship between accounts.</td>
<td>An account hierarchy allows an account contact with the customer administrator role to manage the child accounts.</td>
</tr>
<tr>
<td>Contact relationship</td>
<td>Add a contact from a third account to either of the accounts in an account relationship.</td>
<td>A contact relationship allows a contact with the customer role or customer administrator role to manage the account for which the contact relationship has been established.</td>
</tr>
</tbody>
</table>

**Bi-directional account relationships**
Create account relationships between two customer accounts or between a partner account and a customer account.

The system administrator can create account relationships by:

- Defining the types of relationships that exist between your partners and customers.
- Using these defined relationship types to create relationship records between selected accounts.

Once an account relationship record is created, it can be viewed on the Account form for either account in the **Account Relationships** related list.

For relationships between a partner account and a customer account, partner account contacts with the partner role or the partner administrator role can create and manage cases for their customer accounts.

**Account relationship types**
An account relationship is based on a defined account relationship type. Users with the system administrator role can define two types of relationships: partner-to-account and account-to-account.

There is one default account relationship type provided for partner accounts. The system administrator can create additional account relationship types by defining the following information:

- A unique name that identifies the relationship type.
- The type of source account, either an account or a partner.
- The type of target account, either an account or a partner.
- The relationship name between the source account and the target account.
- The reverse relationship name between the target account and the source account.
The system administrator can also update and delete account relationship types.

Create an account relationship type

Create an account relationship type by defining the types of source and target accounts and providing a name for the relationship between these accounts.

Role required: admin

1. Navigate to **Customer Service > Administration > Account Relationship Types**.
2. Click **New**.
3. Fill in the fields on the Account Relationship Type form.

**Account Relationship Type form fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Relationship type</td>
<td>A unique name that identifies the type of relationship. For example, Service Provider.</td>
</tr>
<tr>
<td>From</td>
<td>The type of source account for this relationship type; can be either an account or a partner.</td>
</tr>
<tr>
<td>Relationship</td>
<td>A text field where you can name the relationship from the source account to the target account. For example, Service provider for.</td>
</tr>
<tr>
<td>To</td>
<td>The type of target account for this relationship type; can be either an account or a partner.</td>
</tr>
<tr>
<td>Reverse relationship</td>
<td>A text field where you can name the reverse relationship from the target account to the source account. For example, Customer of.</td>
</tr>
</tbody>
</table>
Field | Definition
--- | ---
Active | Sets the account relationship type as active or inactive. Active account relationship types can be used to create account relationship records. An account relationship type can be set to inactive at any time.

4. Click **Submit**.

The new account relationship type appears on the Account Relationship Types list.

**Edit an account relationship type**

Edit an existing account relationship type by changing the types of source and target accounts and the name of the relationship between these accounts.

Role required: admin

When updating an existing account relationship type, if that account relationship type is currently being used by any account relationship records, then the **Relationship** and **Reverse relationship** fields in those records are automatically updated.

1. Navigate to **Customer Service > Administration > Account Relationship Types**.
2. Select a relationship type from the Account Relationship Types list.
3. Make the desired changes to the fields on the Account Relationship Type form.

**Account Relationship Type form fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Relationship type</td>
<td>A unique name that identifies the type of relationship. For example, <em>Service Provider</em>.</td>
</tr>
<tr>
<td>From</td>
<td>The type of source account for this relationship type; can be either an account or a partner.</td>
</tr>
<tr>
<td>Relationship</td>
<td>A text field where you can name the relationship from the source account to the target account. For example, <em>Service provider for</em>.</td>
</tr>
<tr>
<td>To</td>
<td>The type of target account for this relationship type; can be either an account or a partner.</td>
</tr>
<tr>
<td>Reverse relationship</td>
<td>A text field where you can name the reverse relationship from the target account to the source account. For example, <em>Customer of</em>.</td>
</tr>
<tr>
<td>Active</td>
<td>Sets the account relationship type as active or inactive. Active account relationship types can be used to create account relationship records. An account relationship type can be set to inactive at any time.</td>
</tr>
</tbody>
</table>

4. Click **Update**.

**Delete an account relationship type**

Delete an account relationship type.
Role required: admin

If there are no account relationship records that use the account relationship type, then it is simply deleted.

If there are active account relationship records that use the account relationship type, an attempt to delete that relationship type results in a warning message. Deleting an account relationship type also deletes the relationship records based on that type.

**Note:** Account relationship types can be set to inactive at any time.

1. Navigate to Customer Service > Administration > Account Relationship Types.
2. Select a relationship type from the Account Relationship Types list.
3. Click Delete.
4. Click Delete again in the confirmation pop-up window.

Account relationship records

Once an account relationship type has been defined, users with the customer service manager role can use it to create relationship records between specific accounts or partners.

An account relationship record includes the following information:

- A source account, selected in the Account From field.
- A target account, selected in the Account To field.
- The account relationship type that this relationship record is based on.
- The relationship and the reverse relationship of the selected accounts.

Once a relationship record has been created, you can see the relationship from either account:

- The relationship (Account From > Account To) appears in the Account Relationships related list on the source account record.
- The reverse relationship (Account To > Account From) appears in the Account Relationships related list on the target account record.

Select the account relationship record from either account to see the Account Relationship form.
The system administrator and the customer service manager can create and delete account relationship records as well as view all relationship records based on a specific account relationship type.

When a relationship is deleted, the reverse relationship is also deleted.

**View account relationship records**

View the account relationship records that use a specific account relationship type.

Role required: sn_customerservice_agent, sn_customerservice_manager, or admin

This information appears as a related list on the Account Relationship Type form. This list shows the source account (Account From field) and the target account (Account To field) for each account relationship record.

1. Navigate to Customer Service > Administration > Account Relationship Types.
2. From the Account Relationship Types related list, select a relationship type.

The account relationship records that use the selected account relationship type appear in the Account Relationships related list.
Create an account relationship record

Create an account relationship record by selecting the account relationship type and then selecting the accounts.

Role required: sn_customerservice_manager or admin

The system administrator can create a relationship record for an account from the Account Relationships related list on the Account Relationship Type form.

The customer service manager and the system administrator can create a relationship record for an account from the Account Relationships related list on the account or partner record.

1. Navigate to Customer Service > Customer > Accounts or Partners.
2. Select an account.
3. From the Account Relationships related list, click New.
4. Fill in the fields on the Account Relationship form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Account From</td>
<td>The source account for this relationship. If you are creating the relationship from an account or partner record, this field is automatically filled in; otherwise, make a selection from the Accounts list.</td>
</tr>
<tr>
<td>Relationship Type</td>
<td>Select the account relationship type for this record. If you are creating the record from an Account Relationship Type form, this field is automatically filled in. Otherwise, make a selection from the Account Relationship Types list, which shows all active account relationship types.</td>
</tr>
<tr>
<td>Account To</td>
<td>The target account for this relationship.</td>
</tr>
</tbody>
</table>

5. Click Submit.

Once a relationship record has been created, it appears in two places:

- The relationship appears in the Account Relationships related list on the source account record.
- The reverse relationship appears in the Account Relationships related list on the target account record.

Delete an account relationship record

Deleting a relationship record for an account also deletes the reverse relationship record.

Role required: sn_customerservice_manager or admin

The system administrator can delete a relationship record for an account from the Account Relationships related list on the Account Relationship Type form.

The customer service manager and the system administrator can delete a relationship record for an account from the Account Relationships related list on the account or partner record.

Note: Deleting a relationship record does not have any impact on customer service cases that refer to the relationship record.

1. Navigate to Customer Service > Customer > Accounts or Partners.
2. Select an account.
3. From the **Account Relationships** related list, select the relationship record.
4. Click **Delete**.
5. Click **Delete** again in the confirmation pop-up window.

**Account hierarchy**

Use the account hierarchy feature to create a parent-child relationship between accounts.

An account hierarchy represents the legal entity structure of the accounts and their relationships. It also represents an account’s customers, assets, and service entitlements.

Customer administrators can do the following for all of the accounts in the hierarchy:

- View and create cases.
- View assets and users.
- View and manage contacts.

Contacts of the parent account can also access all of the child accounts.

The system administrator defines the hierarchy between accounts on the Account form. From the Account form for the child account, select the parent in the **Parent Account** field. If this field is not filled in, the account is a top-level account.

After the account hierarchy has been defined, it is displayed on the Account form for the parent account. If a parent account is updated or deleted, the hierarchy for any child accounts is also updated.

**View the account hierarchy**

The account hierarchy uses a tree structure to show the parent, child, and sibling accounts. Two different views of the account hierarchy are available. In both views, the current account is highlighted in the account structure.

- The parent view displays the current account, the parent account (if applicable), and any child or sibling accounts.
- The full view displays the entire structure of the organization from the root account.

Customer service agents can:

- Expand and collapse the tree structure.
- Switch between the parent view and the full view.
- Click an account to open the related Account form.

**Account hierarchy in Agent Workspace for CSM**

From the Account form, customer service agents can click the open hierarchy icon (🔍) in the **Name** field to see the parent-child account relationships in the Account Hierarchy pop-up window. The account hierarchy is available for accounts that have a parent or child account.
Account hierarchy in the platform interface

Customer service agents can view account information in the Account Hierarchy section on the Account form.
Create an account hierarchy
Create a parent-child relationship between two accounts.

Role required: admin

2. Select the desired child account.
3. Select the parent for this account in the Parent Account field.
4. Click Update.

The account hierarchy is displayed in a tree map on the Account form for the parent account.

Contact relationships
Use a contact relationship to add a contact from a different account to either of the accounts in an established account relationship.

A contact relationship allows a contact with the customer role or customer administrator role to manage the account for which the contact relationship has been established. These contacts can view information and perform actions on behalf of the accounts, such as creating or updating cases from the customer portal.

When you create a contact relationship, you select a user from the Contact field. This field displays the contacts from:
- Both accounts in the account relationship
- All accounts in the account hierarchy

When creating a contact relationship, the responsibilities available for selection are those responsibility definitions created with a type of Contact. An account can have one unique combination of a contact and a responsibility.

Customer service managers can create and delete contact relationships for accounts. Managers and agents can view a list of contact relationships for an account.

Contacts appear in the Contact Relationships related list on the Account form.

Create a contact relationship for an account
Create a contact relationship for an account by selecting a contact and then assigning a responsibility to that contact.

Role required: sn_customerservice_manager or admin

1. Navigate to Customer Service > Customer > Accounts or Partners.
2. Select an account.
3. In the Contact Relationships related list, click New.
4. Fill in the fields on the Contact Relationship form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Account</td>
<td>The account to which the contact is assigned. This field is automatically filled in.</td>
</tr>
<tr>
<td>Contact</td>
<td>The customer contact selected to fulfill the role or responsibility. The Contacts list includes contacts from any related partner or account as well as contacts from the account hierarchy.</td>
</tr>
<tr>
<td>Field</td>
<td>Definition</td>
</tr>
<tr>
<td>--------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Responsibility</td>
<td>The role or responsibility selected for this customer contact.</td>
</tr>
</tbody>
</table>

**Note:** As part of creating a responsibility definition, the admin can specify if the responsibility is unique. If so, the responsibility can only be assigned to one contact per account. For more information, see *Set up account teams*.

5. Click **Submit**.
The contact name, account, and responsibility are added to the **Contact Relationships** related list.

Delete a contact relationship for an account
Delete a contact relationship for an account if the relationship is no longer necessary or valid.

Role required: sn_customerservice_manager or admin
1. Navigate to **Customer Service > Customer > Accounts** or **Partners**.
2. Select an account.
3. Select the tab for the **Contact Relationships** related list.
4. Select the check box to the left of the contact relationship.
5. Select **Delete** from the Actions dropdown list.
6. Click **Delete** on the confirmation pop-up window.

View contact relationships for an account
View a list of the contact relationships that have been created for an account.

Role required: sn_customerservice_agent, sn_customerservice_manager, or admin
1. Navigate to **Customer Service > Customer > Accounts** or **Partners**.
2. Select an account.
3. Select the tab for the **Contact Relationships** related list.

Create asset contact relationships
Assign an asset to a customer contact who is responsible for managing that asset.

Account and partner contacts can see all of the assets related to an account. To limit access to an asset, you can create an asset contact relationship and assign the asset to one or more contacts. Then you can enable the associated property to restrict access to the asset information to the assigned contacts.

The system administrator can add a primary contact to an asset by selecting a user in the **Primary Contact** field on the Asset form. This field references the Contacts table and is filtered by the asset’s account.

The system administrator can also create relationships with additional contacts from the **Asset Contacts** related list on the Asset form. When you create an asset contact relationship, you can select contacts from:
- The account that the asset belongs to.
- The partner of the account that the asset belongs to.
- Any contacts added to these accounts using contact relationships.
After adding contacts to an asset, enable the related property to limit access. When enabled, the following access is limited from the customer portal:

- When a user clicks **My Assets**, the list shows only those assets for which the user is a contact.
- When a user clicks **Create Case**, the **Asset** field on the Create Case form shows only those assets for which the user is a contact.

**Assign a primary contact to an asset**

Users with the system administrator role can assign a primary contact to an asset.

Role required: admin

1. Navigate to **Customer Service > Products > Assets**.
2. Click the desired asset.
3. Select a **Primary Contact**.
   - This field references the Contacts (customer_contact) table and is filtered by the account selected in the **Account** field.
4. Click **Update**.
   - The contact is added to the **Asset Contacts** related list on the asset form.

**Assign a contact to an asset**

Users with the system administrator role can assign a contact to an asset.

Role required: admin

Users with the sn_customerservice.customer_admin can also assign a contact to an asset from the Customer Service Portal.

1. Navigate to **Customer Service > Products > Assets**.
2. Click the desired asset.
3. Click **New** in the **Asset Contacts** related list.
   - This displays a new Asset Contact form. The **Asset** field displays the selected asset and is read-only.
4. Select a **Contact**.
   - The contacts available for selection are the contacts from the asset’s account.
5. Click **Submit**.
   - The contact is added to the **Asset Contacts** related list.

**Enable the asset contact relationship property**

Limit access to asset information to the assigned contacts by enabling the associated property.

Role required: admin

1. Navigate to **Customer Service > Administration > Properties**.
2. Enable the **Restrict Assets based on Contacts assigned to the assets** property.
3. Click **Save**.

**Create account teams**

Account teams are made up of both employees and customer contacts who fulfill specific jobs or roles for a particular account.

The system administrator creates the responsibility definitions, or roles, as needed and can delete definitions that are no longer used.

The customer service manager assigns these roles to employees and to contacts to fulfill specific jobs for an account.
Responsibility definitions
A responsibility definition describes a role or a function that is needed to support a customer account.

The system administrator can create two types of responsibility definitions: one for an employee and one for a contact. Once these definitions, or roles, are created, the customer service manager can use these roles to:

- Build an account team by selecting an account and then selecting roles and assigning them to employees.
- Add contact relationships to an account by selecting an account and then selecting roles and assigning them to contacts.

Create a responsibility definition
Define a role or responsibility needed to support an account.

Role required: admin
2. Click New.
3. Fill in the fields on the Responsibility Definition form.

Responsibility Definition form fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the role or responsibility.</td>
</tr>
<tr>
<td>Unique</td>
<td>Select this check box if this role should only be assigned to one employee or contact. Enabling this check box prevents the creation of duplicate entries for a role.</td>
</tr>
</tbody>
</table>
| Type  | The type of role:  
- Select User if this role should be performed by an employee. When assigning this role, the list of available users comes from the Users [sys_users] table.  
- Select Contact if this role should be performed by a customer contact. When assigning this role, the list of available users comes from the Contacts [customer_contact] table. |

4. Click Submit.

Delete a responsibility definition
Delete a role or responsibility from the Responsibility Definitions list.

Role required: admin
The system administrator can delete a role only if there are no entries for that role.
2. Select the desired role from the Responsibility Definitions list.
3. Click Delete.
4. Click Delete on the confirmation pop-up window.
View users assigned to a specific role
View a list of users who have been assigned to account teams to fulfill a specific role.

Role required: admin

2. Select the desired role from the Responsibility Definitions list.

The users who have been assigned to this role are displayed in the Account Team Members related list on the Responsibility Definition form.

Set up install base

Track which products and services have been purchased by a customer, how they have been installed or provisioned, along with the detailed configuration for each installed item.

Install base requires the Customer Service Install Base Management plugin (com.snc.install_base).

---

**Note:** Customer Service Install Base Management is only available for customers who are licensed for the Customer Service Management application.

Capture the install base for a customer by creating sold products, install base items, and installed products to enable customer service agents to easily trace issues back to the right product, instances of that product, and other entities that might impact their functioning.

Before setting up your install base, create your product data by creating or importing product models. For more information, see [Create product data](#).

There are three parts to setting up your install base.

<table>
<thead>
<tr>
<th>Sold Products</th>
<th>Create a sold product to provide customers, consumers, and customer service agents with a view into the products and services that have been sold to an account or a consumer.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Install Base Items</td>
<td>Create an install base item to track instances that have been provisioned for an account or consumer. An install base item can be any configuration item that has been made accessible to customers. For Software as a Service (SaaS) products, an install base item refers to an application service configuration item.</td>
</tr>
<tr>
<td>Installed Products</td>
<td>Create an installed product to track information on the instances that a sold product is deployed on at an account or consumer. A sold product can have multiple installed product records depending on the number of instances of the product in use.</td>
</tr>
</tbody>
</table>

You can create sold products, install base items, and installed products as individual records, import them in bulk, or create them from an Account or Consumer record.

**Create a sold product**

Create a sold product to track the products or services sold to an account or consumer.

Ensure that the Customer Service Install Base Management plugin (com.snc.install_base) is installed.

Role required: sn_customerservice_manager or admin
Sold products are products and components that have been sold to an account or a consumer. It provides an overview of the complete product sold to an account or consumer. A sold product can have child and parent sold products in a hierarchical structure. If issues arise with a configuration item, customer service agents can trace which sold product is affected on the Case form.

From the Sold Products form, you can edit install base items and create entitlements and cases.

1. Navigate to **Customer Service > Products > Sold Products**.
2. Click **New**.
3. Fill out the fields on the form.

### Sold product form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the product or service sold.</td>
</tr>
<tr>
<td>Parent Sold Product</td>
<td>Parent sold product, if applicable.</td>
</tr>
<tr>
<td>Account</td>
<td>Account associated with the sold product.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> If you enter an account, the <strong>Consumer</strong> field is hidden.</td>
</tr>
<tr>
<td>Consumer</td>
<td>Consumer associated with the sold product.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> If you enter a consumer, the <strong>Account</strong> field is hidden.</td>
</tr>
<tr>
<td>Product</td>
<td>Product model the sold product belongs to.</td>
</tr>
</tbody>
</table>

4. Right-click the form header and select **Save**. The **Child Sold Products**, **Install Base Items**, **Cases**, and **Entitlements** related lists are displayed.
5. Fill out the related lists as required.

### Sold product related lists

<table>
<thead>
<tr>
<th>Related list</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Child Sold Products</td>
<td>Click <strong>New</strong> to create a child sold product.</td>
</tr>
<tr>
<td>Install Base Items</td>
<td>Click <strong>Edit</strong> to edit an install base item.</td>
</tr>
<tr>
<td>Cases</td>
<td>Click <strong>New</strong> to add a case to the sold product. Any cases that are opened and are related to the sold product are displayed automatically.</td>
</tr>
<tr>
<td>Entitlements</td>
<td>Click <strong>New</strong> to add an entitlement for the sold product.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Customer service managers can create entitlements. Customer service agents can view entitlements.</td>
</tr>
</tbody>
</table>

6. Click **Update**.

The sold product is added to the account or consumer selected. Click an account or consumer to see a list of all sold products related to the account or consumer. You can also view a list of sold products per product model.
Note: You can also create sold products directly from an account or a consumer.

2. Click an account or a consumer.
3. Click the Sold Products related list.
4. Click New.

---

Create an install base item

Create an install base item that represents the instance of the product that has been configured for a customer.

Ensure that the Customer Service Install Base Management plugin (com.snc.install_base) is installed.

Role required: sn_customerservice_manager or admin

An install base item can be any configuration item that has been made accessible to customers. For Software as a Service (SaaS) products, an install base item refers to an application service configuration item. Each install base item references the configuration item record for the customer. If issues arise with a configuration item, customer service agents can trace which install base items are affected by the case.

1. Navigate to Customer Service > Products > Install Base Items.
2. Click New.
3. Fill out the fields on the form.

---

Install Base Item form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>Unique Id of the install base item. This field is automatically filled out, but can be changed.</td>
</tr>
<tr>
<td>Name</td>
<td>Name of the install base item.</td>
</tr>
<tr>
<td>Configuration Item</td>
<td>Configuration item associated with the install base item.</td>
</tr>
</tbody>
</table>

Note: sn_customerservice_manager must have the app_service_user role in order to create install base items for the Application Service CI class. For more information, see Application services.

Service models have a specific model category called Application Service, which links a service model to the Application Service CI class. For more information, see Create a service model.
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Account</td>
<td>Account associated with the install base item.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> If you enter an account, the Consumer field is hidden.</td>
</tr>
<tr>
<td>Contact</td>
<td>Account contact primarily responsible for the install base item.</td>
</tr>
<tr>
<td>Consumer</td>
<td>Consumer associated with the install base item.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> If you enter a consumer, the Account field is hidden.</td>
</tr>
<tr>
<td>Owned by</td>
<td>Business manager of the install base item.</td>
</tr>
<tr>
<td></td>
<td>If the business manager is entered in the configuration item, this field is</td>
</tr>
<tr>
<td></td>
<td>automatically entered with information from the configuration item.</td>
</tr>
<tr>
<td>Supported by</td>
<td>If this information is given in the configuration item, this field is</td>
</tr>
<tr>
<td></td>
<td>automatically entered with the information from the configuration item.</td>
</tr>
</tbody>
</table>

4. Right-click the form header and select **Save**.
   The Sold Products, Entitlements, and Cases related lists are displayed.

5. Fill out the related lists as required.

#### Install base item related lists

<table>
<thead>
<tr>
<th>Related list</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sold Products</td>
<td>Click <strong>Edit</strong> to edit a sold product.</td>
</tr>
<tr>
<td>Entitlements</td>
<td>Click <strong>New</strong> to add an entitlement for the install base item.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Customer service managers can create entitlements.</td>
</tr>
<tr>
<td></td>
<td>Customer service agents can view entitlements.</td>
</tr>
<tr>
<td>Cases</td>
<td>Click <strong>Edit</strong> to edit a case related to the install base item.</td>
</tr>
<tr>
<td></td>
<td>Any cases that are opened and are related to the install base item are</td>
</tr>
<tr>
<td></td>
<td>displayed automatically.</td>
</tr>
</tbody>
</table>

6. Click **Update**.
   The install base item is added to the account or consumer selected. Click an account or consumer to see a list of all install base items related to the account or consumer.

**Note:** You can also create install base items directly from an account or a consumer.

2. Click an account or a consumer.
3. Click the Install Base Items related list.

4. Click New.

---

Create an installed product

Create an installed product to create an association between sold products and install base items. Installed products provide information on the instances that a sold product is deployed on.

Ensure that the Customer Service Install Base Management plugin (com.snc.install_base) is installed.

Role required: sn_customerservice_manager or admin

1. Navigate to Customer Service > Products > Installed Products.

2. Click New.

3. Fill out the fields on the form.

   **Installed Product form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Install Base Item</td>
<td>Instance the sold item is deployed on.</td>
</tr>
<tr>
<td>Sold Product</td>
<td>Sold product deployed to the customer.</td>
</tr>
</tbody>
</table>

4. Click Submit.

---

Case management

Configure the Customer Service Management features and components that agents and managers use to create and resolve cases.

The customer service case is the primary entity of the customer service application. An agent creates a new case to identify a customer’s question or issue and to track the activities related to resolving the issue. An agent also uses a case to track all of the communication to and from the customer, including the communication channels being used.

Case activities include any action that is taken to resolve an issue. This can include phone calls or emails, knowledge base research, conversations with subject matter experts, and dispatch requests to field service agents, as well as other activities.

From the Case form, an agent can associate and store the related information, such as the customer’s name, phone number, and company; account information; product and asset information; service contract and entitlement details, and any associated service level agreements (SLAs).

Configure the Case form

Configure a Case form view to display the fields you require.

Role required: admin


2. Configure the form layout to add the fields you require.

   **Note:** If you are using Customer Service Install Base Management and Proactive Customer Service Operations, add the Sold Product field.

3. Configure the form layout to add the related lists you require.
4. Click Submit.

Create rules to route and assign customer service cases

The case routing feature uses matching rules and assignment rules to identify customer service cases that meet certain conditions and then route those cases to customer service agents.

Create one or more matching rules that establish specific conditions that a case must meet before it can be routed to an agent. Then use an assignment rule to route those cases to agents based on product knowledge and availability. You can also invoke the MatchingRuleProcessor API to execute the matching rules and return a list of users (sys_ids).

Watch this five-minute video to learn about creating an assignment rule, the assignment workbench, and advanced work assignment.

Matching Rules

Matching rules are based on two defined sets of conditions, one that identifies specific case attributes and another that identifies the agent resources best suited to handle cases with these attributes. Matching rules are created using the Matching Rule form.

To identify case attributes, select a table that stores the task type (for example, the Case table) and then use a condition builder to create one or more conditions that a case must meet before being routed. For example, you can build conditions for a specific account and product or for a specific product and priority level.

To identify an agent resource, use one of the following resource matching methods:

- **Simple**: select the resource name from a list of users.
- **Advanced**: build conditions that filter the available agent resources. These conditions can be based on user role, agent group, specific skills, work load, or agent availability.
- **Scripted**: create a customized script to identify agent resources.

Another resource matching method, Selection Criteria, can be used to create a matching rule with selected matching criteria for use with the assignment workbench.

Assignment Rules

Use assignment rules to automatically assign task to users and groups. Create an assignment rule for a matching rule by clicking the Create assignment rule related link on the Matching Rule form. When the matching rule conditions are met, a case can be routed to a user or a group using the assignment rule. The assignment rule is applied only if the task is not already assigned to another user or group.

Note: Matching rules and assignment rules are independent records with no synchronization. If you make a change in the Applies to component of the matching rule, it is not reflected in the assignment rule.

When you create an assignment rule, you select the following:

- The table for the task type and the conditions that must be met before the task is assigned.
- The user or the group to which the task is assigned.
Alternately, you can create a script to further customize the assignment rule.

Create a matching rule for case routing
Create a matching rule for a customer service case that identifies the case attributes as well as the agent resources.

Role required: admin

1. Navigate to Routing and Assignment > Matching Rules.
2. Click New.
3. Fill in the fields on the Matching Rule form.

   This form contains the following sections:
   - Basic rule information
   - Applies to: use this section to create rule conditions
   - Resource: use this section to create agent and agent group conditions

Matching Rule form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the matching rule.</td>
</tr>
<tr>
<td>Execution order</td>
<td>The order in which this matching rule is to be executed. Similar to business rules, matching rules are processed based on execution order, from the lowest to the highest.</td>
</tr>
<tr>
<td>Active</td>
<td>Enable this check box to activate the matching rule.</td>
</tr>
<tr>
<td>Applies To</td>
<td>The table that stores the task for which the matching rule is being created. The default is the Case (sn_customerservice_case) table.</td>
</tr>
<tr>
<td>Table</td>
<td>Use the buttons in this field to build one or more conditions on the selected table. A condition is made up of a selected field, an operator, and a value. Add conditions using the AND and OR buttons. Delete conditions by clicking the X to the right of a condition.</td>
</tr>
<tr>
<td>Conditions</td>
<td></td>
</tr>
<tr>
<td>Resource</td>
<td></td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Matching</td>
<td>The type of resource matching method to use for this rule: Simple, Advanced, Scripted, Selection Criteria. Select <strong>Simple</strong> to assign a task to a specific user.</td>
</tr>
</tbody>
</table>
|                               | Select **Simple** to assign a task to a specific user.  
1. Click the lookup icon next to the **Resource** field.  
2. Select a **Table name**.  
3. Select a **Document** from the table.  
4. Click **OK**.  
Select **Advanced** to create a specific set of resource conditions. Then use the condition builder in the **Resource** field to identify these conditions.  
Select **Scripted** to create a customized script for identifying resources, with the goal of returning a list of users that have the same skills as the task. The task under consideration is set in the context of the script. For example:  

```
//current has the task record for which the rule is being executed.  
var task = current;  
var skills = task.getValue("skills");  
var skillUtil = new global.SkillsUtils();  
var skilledUsers = skillUtil.getAllSkilledUserIds(skills);  
return skilledUsers;
```
Select **Selection Criteria** to create a matching rule for use with the assignment workbench. Create then rule and then add matching criteria using the **Select Criteria** related list on the Matching Rule form.  

| Resource                      | This field changes depending on the resource matching type selected in the **Matching** field.  
For **Simple** matching, use this field to select a table and a user.  
For **Advanced** matching, use the condition builder in this field to build one or more conditions to identify a resource. These conditions can be based on user role, agent group, specific skills, work load, or agent availability. |
<p>| Schedule based filtering      | This field applies to <strong>Advanced</strong> matching. Enable this check box to filter resources that are in schedule (work hours) at the time of routing. |</p>
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Script</td>
<td>For <strong>Scripted</strong> matching, use this field to create a customized script for identifying resources. An example script is included. The expected return from a customized script is an array of resource sys_ids.</td>
</tr>
</tbody>
</table>

4. **Click Submit.**
The rule appears in the Matching Rules list.

5. **Open the newly created rule from the Matching Rules list and add the desired matching criteria.**

6. **From the **Select Criteria** related list, click **New.****

7. **Select a **Criterion.****

8. **In the **Use for** field, specify how you want the matching criterion to be used.**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Ranking and display</strong></td>
<td>Use the criterion to determine agent ranking and displays it in a column on the workbench.</td>
</tr>
<tr>
<td><strong>Display only</strong></td>
<td>Displays the criterion in a column on the workbench but does not use it to determine agent ranking.</td>
</tr>
<tr>
<td><strong>Ranking only</strong></td>
<td>Uses the criterion to determine agent ranking but does not display it on the workbench.</td>
</tr>
</tbody>
</table>

9. **Select a **Ranking Method.**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>More is better</strong></td>
<td>For example, more availability is better when determining the agent ranking.</td>
</tr>
<tr>
<td><strong>Less is better</strong></td>
<td>For example, fewer assigned cases are better when determining agent ranking.</td>
</tr>
</tbody>
</table>

10. **Click Submit.**
The criterion appears on the Matching Rule form in the **Select Criteria** related list.

11. **Optional: From the **Select Criteria** related list, set a **Threshold** for the criterion.**

   A threshold sets a minimum requirement for a criterion. If necessary, personalize the list and add the **Threshold** field.

### Create an assignment rule for case routing
Create a rule that assigns those cases that meet the matching rule criteria to a customer service agent.

**Role required:** admin

1. **Open the desired matching rule.**

2. **Click the **Create assignment rule** related link.**

   You can also create an assignment rule by navigating to **Routing and Assignment > Assignment Rule** and clicking **New.**

3. **Fill in the fields on the Assignment Rule form.**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the assignment rule.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------</td>
<td>-------------</td>
</tr>
<tr>
<td>Application</td>
<td>The name of the application to which this assignment rule belongs. The default application is <strong>Global</strong>.</td>
</tr>
<tr>
<td>Order</td>
<td>The order in which this assignment rule is executed. Similar to business rules, assignment rules are processed based on execution order, from the lowest to the highest.</td>
</tr>
<tr>
<td>Active</td>
<td>Enable this check box to activate the matching rule. Only active assignment rules take effect.</td>
</tr>
<tr>
<td>Applies To</td>
<td>The table that stores the task for which the assignment rule is being created. This list shows only those tables and database views that are in the same scope as the assignment rule. If you select a custom table that extends the task table, you must clear the instance cache by navigating to https://&lt;instance_name&gt;.service-now.com/cache.do in order for the assignment rule to work.</td>
</tr>
<tr>
<td>Conditions</td>
<td>The conditions in which the assignment rule will apply. Use the buttons in this field to build one or more conditions on the selected table. A condition is made up of a selected field, an operator, and a value. Add conditions using the <strong>AND</strong> and <strong>OR</strong> buttons. Delete conditions by clicking the <strong>X</strong> to the right of a condition.</td>
</tr>
<tr>
<td>Assign To</td>
<td>The user to be assigned to the task.</td>
</tr>
<tr>
<td>User</td>
<td>The user to be assigned to the task.</td>
</tr>
<tr>
<td>Group</td>
<td>The assignment group to be assigned to the task.</td>
</tr>
<tr>
<td>Script</td>
<td>A script to determine advanced assignment rule functionality. Scripts provide access to current.variable_pool variables.</td>
</tr>
</tbody>
</table>

4. Click **Update**.

*Invoke the MatchingRuleProcessor API*

After you create one or more matching rules, you can invoke the MatchingRuleProcessor API and run the rules.
Role required: sn_customerservice_agent, sn_customerservice_manager, admin

The matching engine can be invoked using the `processAndGetCandidates` method of the `matchingRuleProcessor` class. Pass in the task record and the number of resources. The result is an array of resource sys_ids.

The matching rules are processed based on the number stored in the `Execution Order` field for each rule.

The result is a list of users (sys_ids), which you can use for case routing and assignment.

**Reverse matching**
Reverse matching uses the same matching rules to match tasks to a resource rather than resources to a task.

Role required: sn_customerservice_agent, sn_customerservice_manager, admin

The resource matching engine can match resources and tasks in two ways:
- Forward: matches resources for a task
- Reverse: matches tasks for a resource

The same matching rule can be used for both forward and reverse matching. In the customer service application, you can use reverse matching to determine which call the next available agent should take. Reverse matching returns a list of case sys_ids instead of user sys_ids. When using reverse matching, you can also limit the cases returned to a specific set.

The following example shows how to use reverse matching.

```
MatchingRuleProcessor.processAndGetCandidates(resource, taskLimit, "sn_customerservice_case", "reverse", false, [<array of cases to consider>])
```

Limit the number of task sys_ids returned for reverse matching rules
Reverse matching rules return a list of case sys_ids. Limit the number of cases returned by configuring the number in the `reverse.matchingrule.entity.limit` system property.

Role required: admin
1. In the navigation filter, type `sys_properties.list`.
2. Search for the `reverse.matchingrule.entity.limit` system property.
3. In the number field, change the number of cases returned. The default number is 30.

If the number of cases returned is more than the value listed in the system property, the reverse matching rule does not run for Scripted and Selection Criteria matching rules.

**Assignment workbench**

The assignment workbench enables customer service managers to assign tasks to agents efficiently and intelligently. The workbench uses configurable criteria, such as skills and availability, to evaluate the agents in a selected group and provide an overall ranking. Managers can view these results and click one button to assign a task.

The assignment workbench displays all the relevant information for task assignment, including:
- A list of the agents in the task assignment group.
- The matching criteria used to evaluate the agents.
- An overall ranking for each agent in the assignment group.
- A filter with the current assignment group and the skills identified for the task, including any mandatory skills.
Case - CS0000005 Urgent issue, need help ...

**Suggested Team Members**

<table>
<thead>
<tr>
<th>Rank</th>
<th>Agent</th>
<th>Matching Skills</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Bae Kim</td>
<td>4 / 5</td>
</tr>
<tr>
<td>2</td>
<td>Brandon Beckman</td>
<td>4 / 5</td>
</tr>
<tr>
<td>3</td>
<td>Baker Huges</td>
<td>4 / 5</td>
</tr>
<tr>
<td>3</td>
<td>Brian Samul</td>
<td>4 / 5</td>
</tr>
</tbody>
</table>
Agents are ranked from 1 to any number based on the criteria configured for the workbench. The more criteria that matches, the higher an agent’s rank. When the criteria for two agents is the same, the agents have the same rank. Point to an agent’s rank to display the details.

Use the filter to change the assignment group and to add or remove skills. Changes to the assignment group or to the skills lists are reflected immediately in the workbench:
- Changing the assignment group displays a different list of agents.
- Adding or removing skills can change the agent ranking.

If you are using the mandatory skills feature, the agents displayed in the assignment workbench are filtered by the skills in the Mandatory Skills Added list and then ranked by the other matching criteria.

**Note:** Agents cannot add or remove mandatory skills or make a skill not mandatory.

**Configuring the assignment workbench**

The assignment workbench configuration is stored in a matching rule that is based on the Selection criteria matching type. The default configuration uses the Recommendation for Case Assignment matching rule, which includes three of the four default matching criteria:
- Availability Today
- Matching Skills
- Assigned Cases

Based on these matching criteria, the workbench calculates and displays an overall rank for each agent in the group. You can modify or create matching criteria and the Recommendation for Case Assignment matching rule as needed or you can create your own configuration following these steps:
1. Create one or more matching criteria.
2. Create a matching rule with the Selection criteria matching type.
3. Open the matching rule and add the desired matching criteria.

If you are using mandatory skills, you must replace the Matching Skills criterion in this matching rule with the Matching Skills - Mandatory Skills Support criterion to match agents with mandatory skills required for a case.

**Using the assignment workbench**

Access the assignment workbench by clicking the Find Agents icon (🔍) next to the Assigned to field on the task form.

**Note:** The state of the current record determines the availability of the Find Agents icon. The icon is available for records in the Open, Awaiting, and Cancelled states, and if the user has write access for the Assigned to field. The icon is not available for records in the New or Closed states or when the Assigned to field is read-only for the current user.

Sort the list of agents by any of the matching criteria by clicking the desired column header, which reorders the suggested agents based on the selected criteria.
Select a different assignment group from the **Group** list in the filter. The list of agents is updated based on the selection. If the selected group does not contain any agents, a message is displayed to select another group.

Add or remove skills from the **Skills** list in the filter. These selections are reflected in the **Matching Skills** column.

Skills that have been identified as mandatory for a task are displayed in the **Mandatory Skills Added** list. These selections are also reflected in the **Matching Skills** column. You cannot add or remove skills from this list.

Select an agent and click **Assign** to assign the task. The workbench closes and returns to the Case form. The **Assigned to** field is updated with the selected agent. Click **Save** on Case form to save this assignment.

### Plugins

The Assignment Workbench plugin (com.snc.assignment_workbench) is activated as part of Customer Service Management.

The Case Assignment Workbench Demo plugin (com.snc.case_assignment_workbench_demo) provides demo data for the workbench.

### Tables

Assignment Workbench adds the following tables.

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Matching Criteria</td>
<td>Stores the matching criteria that can be used to create a configuration for the assignment workbench.</td>
</tr>
<tr>
<td>(matching_dimension)</td>
<td></td>
</tr>
<tr>
<td>Select Criteria</td>
<td>Stores the matching criteria for an assignment workbench configuration matching rules.</td>
</tr>
<tr>
<td>(matching_dimension_for_assignment)</td>
<td></td>
</tr>
<tr>
<td>Matching Rule</td>
<td>Stores matching rules, including the matching rules that configurations for the assignment workbench.</td>
</tr>
<tr>
<td>(matching_rule)</td>
<td></td>
</tr>
</tbody>
</table>

### User Roles

Assignment Workbench adds the following roles.

<table>
<thead>
<tr>
<th>Role title (name)</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assignment workbench</td>
<td>Provides access to the assignment workbench for customer service agents and consumer service agents.</td>
<td>• skill_user</td>
</tr>
<tr>
<td>(assignment_workbench)</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Properties

Assignment Workbench adds the following properties.
<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>assignment_workbench.find.agents.title</td>
<td>Title for the macro button.</td>
</tr>
<tr>
<td></td>
<td>· <strong>Type</strong>: string</td>
</tr>
<tr>
<td></td>
<td>· <strong>Default value</strong>: Find Agents</td>
</tr>
<tr>
<td></td>
<td>· <strong>Location</strong>: Routing and Assignment &gt; Properties</td>
</tr>
<tr>
<td>assignment_workbench.new.window</td>
<td>When enabled, opens the assignment workbench in a new window.</td>
</tr>
<tr>
<td></td>
<td>· <strong>Type</strong>: true</td>
</tr>
<tr>
<td></td>
<td>· <strong>Default value</strong>: false</td>
</tr>
<tr>
<td></td>
<td>· <strong>Location</strong>: Routing and Assignment &gt; Properties</td>
</tr>
<tr>
<td>assignment_workbench_no_of_agents</td>
<td>Number of agents per page. (To get better performance, do not use more than 50 agents per page.)</td>
</tr>
<tr>
<td></td>
<td>· <strong>Type</strong>: choice list</td>
</tr>
<tr>
<td></td>
<td>· <strong>Default value</strong>: 30</td>
</tr>
<tr>
<td></td>
<td>· <strong>Location</strong>: Routing and Assignment &gt; Properties</td>
</tr>
</tbody>
</table>

**Matching criteria for case assignment**

The assignment workbench uses configurable matching criteria, such as skills and availability, to evaluate the agents in a selected group and provide an overall ranking.

There are three types of matching criteria:

- **Simple Match**: creates one-to-one matching, such as matching the time zone of an agent with the time zone of a task location.
- **Aggregate**: uses a simple query and returns an aggregate result. For an aggregate type, select a table and create a filter, and then select an aggregate field such as the **Assigned to** field. This type of query returns a set of users.
- **Scripted**: uses a scripted query which returns a list of users.

Several matching criteria are provided with the assignment workbench:

- **Availability Today**: Availability is calculated based on the agent's work schedule, assigned work, and personal time off. The more availability an agent has, the higher the contribution to the agent's overall rank.
- **Matching Skills**: The number of agent skills that match the skills required for the case. The more skills that match, the higher the contribution to the agent's overall rank.
- **Matching Skills - Mandatory Skills Support**: Calculates the number of agent skills that match the mandatory skills. It does this by filtering out all agents who do not have the mandatory skills and ranks the remaining agents. The more skills that match, the higher the contribution to the agent's overall rank.

  **Note**: If using the mandatory skills feature, use the **Matching Skills - Mandatory Skills Support** criterion to match agents with the mandatory skills identified for a case.

- **Assigned Cases**: The number of cases already assigned to this agent. The more cases assigned, the lower the contribution to the agent's overall rank.
- **Last Assigned**: For the sake of balancing assigned work, prioritized the agent based on the last assigned work.
To create matching criteria, select the type and use the fields related to that type to build the query. After creating matching criteria, you can create a configuration for the assignment workbench by creating a matching rule of the type **Selection criteria** and selecting the desired matching criteria.

As part of selecting the matching criteria for the workbench configuration, you can specify the following settings for each individual criterion:

- ranking and display usage
- ranking method
- ranking weight
- threshold
- active/inactive

### Ranking and display usage

In the **Use for** field, specify how you want that matching criterion to be used:

- Ranking and display: uses the criterion to determine agent ranking and displays it in a column on the workbench.
- Display only: displays the criterion in a column on the workbench but does not use it to determine agent ranking.
- Ranking only: uses the criterion to determine agent ranking but does not display it on the workbench.

### Ranking method

There are two ranking methods:

- More is better: for example, more availability is better when determining the agent ranking.
- Less is better: for example, fewer assigned cases are better when determining agent ranking.

### Weight

Each matching criterion has an assigned weight. By default, the matching criteria in the **Recommendation for Case Assignment** matching rule have an assigned weight of 10. You can assign a higher weight to the criteria that are more important.

### Threshold

A threshold sets a minimum requirement for a criterion. For example, set the threshold of the Matching Skills criterion to 3 if you want to see only those agents who have at least three of the required skills for a task. For availability, set the threshold to the desired number of hours to display only those agents who have that minimum number of work hours available. You can set the threshold in the **Select Criteria** related list on the Matching Rule form. If necessary, personalize the list and add the **Threshold** column.
Active/Inactive

There can be several matching criteria associated with the matching rule that determines the assignment workbench configuration. Each individual criterion can be set to active or inactive. Changing this setting has an immediate impact on the agent ranking. You can make this change in the Select Criteria related list on the Matching Rule form. If necessary, personalize the list and add the Active column.

Calculating the agent ranking

The assignment workbench adds the values of the matching criteria and their respective weights and uses these values to determine the overall agent ranking.

1. Calculate a number for each criterion.
2. Multiply that number by the criterion weight.
3. Divide the result by the total of all criterion.
4. Repeat for each criterion and add the results.

The following example shows how the ranking is determined for an agent with these matching criteria values:

- Matching Skills with Mandatory Skills Support: 5/6
- Availability Today: 7 hours
- Assigned Cases: 2

Calculations:

- Matching Skills - Mandatory Skills Support: $5 / 6 = 0.833$ (with 5 being the maximum number of skills that includes mandatory and rest of the skills)
- Availability Today: $7 / 8 = 0.875$ (with 8 being the maximum number of hours)
- Assigned Cases: $2 / 26 = 0.0769$ (with 26 being the total number of tasks in the table)
- Weight: each matching criteria has an equal weight of 10

\[
\frac{(0.833 \times 10)}{\text{Total of criterion weight (10+10+10)}} + \frac{(0.875 \times 10)}{\text{Total of criterion weight (10+10+10)}} + \frac{(0.0769 \times 10)}{\text{Total of criterion weight (10+10+10)}}
\]

\[
(8.33 / 30) + (8.75 / 30) + (0.769 / 30)
\]

\[
0.222 + 0.291 + 0.0256 = 0.5386
\]

This calculation is performed for each agent in the assignment group. Agents are ranked based on the value of this calculation, with the highest number earning the highest ranking.

Matching rules for case assignment

Use a matching rule to create a configuration for the assignment workbench.

The assignment workbench configuration is stored in a matching rule that is based on the Selection criteria matching type.

The default configuration uses the Recommendation for Case Assignment matching rule, which uses three of the four default matching criteria:

- Availability Today
- Matching Skills
- Assigned Cases

**Note:** If using the mandatory skills feature, use the Matching Skills - Mandatory Skills Support criterion to match agents with the mandatory skills identified for a case.

You can customize this matching rule to meet your specific need for calculating agent recommendations. This matching rule can also be used for auto assignment if you create an assignment rule.

**Create assignment workbench matching criteria**
Create one or more matching criteria that can be used in an assignment workbench configuration.

**Role required:** admin

The assignment workbench uses configurable matching criteria, such as skills and availability, to evaluate agents in a selected group and provide an overall ranking. The Matching Criteria (matching_dimension) table stores the individual criterion that can be added to a matching rule to create an assignment workbench configuration.

1. Navigate to **Routing and Assignment > Criteria**.
2. Click **New**.
3. Enter a **Name** and a **Description** for the criterion.
4. Select the **Type** of matching criterion.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Simple Match</td>
<td>Creates a one-to-one match. For example, match the time zone of an agent with the time zone of a task location.</td>
</tr>
<tr>
<td>Aggregate</td>
<td>Takes a simple query as an input and provides aggregate results. The query returns a set of users.</td>
</tr>
<tr>
<td>Scripted</td>
<td>Includes a scripted query which returns a list of users.</td>
</tr>
</tbody>
</table>

5. To create a **Simple Match** criterion, fill in the following fields.

**Simple match criterion fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Applies to</td>
<td>The type of task that this criterion applies to.</td>
</tr>
<tr>
<td>Field</td>
<td>The field from the selected task table that you want to match.</td>
</tr>
<tr>
<td>Resource Table</td>
<td>The table that stores the resource to use for this matching criterion.</td>
</tr>
<tr>
<td>Resource Matching Field</td>
<td>The field from the resource table that you want to match.</td>
</tr>
<tr>
<td>Resource Field</td>
<td>The resource field to be displayed for the task records that match the resource records.</td>
</tr>
</tbody>
</table>

6. To create an **Aggregate** criterion, fill in the following fields.
## Aggregate criterion fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Aggregate Table</td>
<td>The type of task that this criterion applies to.</td>
</tr>
<tr>
<td>Aggregate Filter</td>
<td>Use the condition builder to create a query that returns a set of users from the selected task table. For example, create a query that returns customer service cases with the following states: New, Open, Awaiting info.</td>
</tr>
<tr>
<td>Aggregate Field</td>
<td>The field from the selected task table to be displayed for the task records that match the query conditions.</td>
</tr>
</tbody>
</table>

7. To create a **Scripted** criterion, fill in the following fields.

### Scripted criterion fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Script</td>
<td>Create a customized script which returns a list of users. An example script is included. The expected return from a customized script is an array of resource sys_ids.</td>
</tr>
<tr>
<td>Aggregate Field</td>
<td>The field from the selected task table to be displayed for the task records that match the query conditions.</td>
</tr>
</tbody>
</table>

8. Optional: Enter a **Display Name**.

9. Optional: Enable the **Use Reference** field.
   - If you use a reference field, fill in the following fields.

### Reference fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reference Table</td>
<td>The table that stores the referenced information.</td>
</tr>
<tr>
<td>Reference Filter</td>
<td>Add filter conditions to return the desired reference information.</td>
</tr>
<tr>
<td>Reference Field</td>
<td>The field from the selected reference table to be displayed for the records that match the filter conditions.</td>
</tr>
<tr>
<td>UI Filter Label</td>
<td>The label for this field that appears on the assignment workbench</td>
</tr>
</tbody>
</table>

10. Click **Submit**.

*Create an assignment workbench configuration*

Use a matching rule to create a configuration for the assignment workbench.

Role required: admin
The assignment workbench configuration is stored in a matching rule that is based on the Selection criteria matching type. The default configuration uses the Recommendation for Case Assignment matching rule, which includes three of the four default matching criteria:

- Availability Today
- Matching Skills
- Assigned Cases

You can modify or create matching criteria and then modify the Recommendation for Case Assignment matching rule as needed or you can create your own configuration.

1. Navigate to Routing and Assignment > Matching Rules to access the Matching Rules list.
2. Click New.
3. Enter a Name for the matching rule.
4. If desired, enter an Execution Order for the matching rule.
   This is the order in which this matching rule is to be executed. Similar to business rules, matching rules are processed based on execution order, from the lowest to the highest.
5. In the Applies To tab, select the Table that stores the task for which the matching rule is being created.
6. Use the Conditions field to build one or more conditions on the selected table.
   A condition is made up of a selected field, an operator, and a value. Add conditions using the AND and OR buttons. Delete conditions by clicking the X to the right of a condition.
8. Click Submit.
9. From the Matching Rules list, open the matching rule that you just created.
10. In the Select Criteria related list, click New.
    This opens the Select Criterion form.
11. Select a Criterion from the Matching Criteria list.
12. Select how the criterion is to be used in the Use for field.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ranking and Display</td>
<td>Uses the criterion to determine agent ranking and displays it in a column on the workbench.</td>
</tr>
<tr>
<td>Display Only</td>
<td>Displays the criterion in a column on the workbench but does not use it to determine agent ranking.</td>
</tr>
<tr>
<td>Ranking and No Display</td>
<td>Uses the criterion to determine agent ranking but does not display it on the workbench.</td>
</tr>
</tbody>
</table>

13. Select a Ranking Method.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>More is better</td>
<td>A higher value is better. For example, more availability is better when determining the agent ranking.</td>
</tr>
<tr>
<td>Less is better</td>
<td>A lower value is better. For example, fewer cases are better when determining the agent ranking.</td>
</tr>
</tbody>
</table>

14. Click Submit.
15. Repeat steps 10 through 14 for each criterion to add to the matching rule.
16. If desired, change the weight of a criterion by double-clicking the Weight field in the Select Criteria related list and entering a new weight.

Each matching criterion has an assigned weight. By default, the matching criteria in the Recommendation for Case Assignment matching rule have an assigned weight of 10. You can assign a higher weight to the criteria that are more important.
17. If desired, set the threshold for a criterion by double-clicking the **Threshold** field in the **Select Criteria** related list and entering a threshold number.

A threshold sets a minimum requirement for a criterion. It may be necessary to personalize the list and add the **Threshold** column.

18. If desired, set a criterion active or inactive by double-clicking the **Active** field in the **Select Criteria** related list and selecting **true** or **false**.

Changing this setting has an immediate impact on the agent ranking. It may be necessary to personalize the list and add the **Active** column.

---

### Set assignment workbench properties

Set the properties related to the assignment workbench display.

**Role required:** admin

1. Navigate to **Routing and Assignment > Properties**.
2. Set the following properties, as needed.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Title for the macro button</strong></td>
<td>Creates the title for the macro button on the task form. The default is <strong>Find Agents</strong>.</td>
</tr>
<tr>
<td><code>(assignment_workbench.find.agents.title)</code></td>
<td>-------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>When enabled opens the assignment workbench in a new window</strong></td>
<td>Opens the assignment workbench in a new window. The default is <strong>False</strong>.</td>
</tr>
<tr>
<td><code>(assignment_workbench.new.window)</code></td>
<td>-------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Number of agents per page</strong></td>
<td>Set this property to 20, 30, or 50 agents. To get better performance, do not use more than 50 agents per page. The default is <strong>30</strong>.</td>
</tr>
<tr>
<td><code>(assignment_workbench_no_of_agents)</code></td>
<td>-------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>

3. Click **Save**.

### Special handling notes

Use the Special Handling Notes application to create notes that bring important information about individual records to the user's attention.

Create special handling notes for specific records or for a set of records that meet one or more conditions. You can also configure the Special Handling Notes application to display any special handling notes from related records, such as the account or the product associated with a customer service case.

Users with the sn_shn.admin role can configure the desired entity tables to use special handling notes and then configure the corresponding forms to display either the list or pop-up window. Users with the sn_shn.admin role can create, view, update, and delete notes. Users with the sn_shn.editor role can view and update notes and users with the sn_shn.user role can view notes.

Once created, special handling notes can be displayed in different ways: in an embedded list or a related list on a record form or in a pop-up window that displays when you access a form.

In addition to a message, a special handling note also has a status, an assigned priority, and an expiration date. The status of a note can be one of the following:

<table>
<thead>
<tr>
<th>Status</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Active</strong></td>
<td>The note is active.</td>
</tr>
<tr>
<td></td>
<td>Active notes appear on the Special Handling Notes list or pop-up window.</td>
</tr>
<tr>
<td></td>
<td>Active notes remain on the list until they are set to <strong>Inactive</strong> or <strong>Expired</strong>.</td>
</tr>
</tbody>
</table>
### Status | Definition
--- | ---
Active | Notes remain on the pop-up window until dismissed or until they are set to Inactive or Expired.
Inactive | The note is no longer active. Users with the sn_shn.admin or sn_shn.editor role can set a note to Inactive if the information in the note is no longer useful. When a note is set to Inactive, it is removed from the Special Handling Notes list or pop-up window. Inactive notes can be viewed by navigating to Special Handling Notes > Special Handling Notes.
Expired | The note has reached its expiration date or it has been expired manually. If a note is expired, the form becomes read-only for all user roles other than the system administrator. A note is expired automatically by a scheduled job when it reaches its expiration date. The scheduled job also sets any inactive notes to expired if the inactive notes have reached their expiration date.

When creating a special handling note, you can make it effective right away or you can select a date when it becomes effective. You can also select an expiration date. The Deactivate Special Handling Notes scheduled job, which runs daily at midnight, checks the dates in the Effective on and Expires on fields for each note.

- If a special handling note has reached its Effective on date, the scheduled job sets the status of the note to Active.
- If a special handling note has reached its Expires on date, the scheduled job sets the status of the note to Expired.

A note can be assigned one of the following priorities:

- 1 - Critical (red)
- 2 - High (orange)
- 3 - Moderate (light green)
- 4 - Low (light blue)

The associated priority color is displayed as a colored bar to the left of the note in the pop-up window and as a colored circle to the left of the priority field in the embedded list.

### Special handling notes list

Special handling notes can be displayed on a form in an embedded or related list. Users with the sn_shn.admin role can configure a form to display the Special Handling Notes list. This list appears on a form when there are one or more active notes for a record. The Special Handling Notes list displays the following information for a note:

- Message
- Expiration date
- Priority
- Table

Special handling notes are displayed on the list unless you configure additional properties to display notes in a pop-up window.
Special handling notes pop-up window

Special handling notes can be displayed on a form in a pop-up window. Users with the sn_shn.admin role can configure a form to display the Special Handling Notes pop-up window. This window appears when you access a record that has one or more active notes. The pop-up window displays the following information for each note:

- Message
- Priority

To dismiss a note, click OK. Once you dismiss a note, it no longer appears in the pop-up window. To close the Special Handling Notes pop-up window, click X.

To display special handling notes in a pop-up window, navigate to Special Handling Notes > Properties and set the related properties.

Configure special handling notes

Configure the desired entity tables to use special handling notes and then configure the corresponding forms to display either the Special Handling Notes list or pop-up window.

Role required: sn_shn.admin

1. If necessary, activate the Customer Service Management plugin (com.sn_customerservice).
2. Configure the desired entity tables to use special handling notes.
3. Configure the corresponding form to display special handling notes.
   - You can display notes in an embedded or related list on a form with no additional configuration. To display notes in a pop-up window, you must also enable the related properties.
4. If desired, enable the properties necessary to display special handling notes in a pop-up window.

Configure an entity table to use special handling notes

Configure an entity table to use special handling notes.

Role required: sn_shn.admin

Configuring an entity to use special handling notes adds the Create Special Handling Notes related link to the corresponding form.

1. Navigate to Special Handling Notes > Configuration.
2. Click New.
3. Select a table in the Table name field.
4. If desired, select one or more Related Fields.
   - You can also display notes from related entities by including those fields in the configuration. For example, you can display notes for the account and contact associated with a customer service case by selecting the Account and Contact fields on the Case form.
5. Click Submit.
   - The configuration is added to the Special Handling Configuration list.

Configure a form to show special handling notes

Display special handling notes on a form in a list or pop-up window.

Role required: sn_shn.admin

1. Navigate to a form.
2. Right-click the form header and select Configure > Form Layout.
3. Select one of the following from the Available column and move it to the Selected column.
- Special Handling Notes List
- Special Handling Notes Pop Up

4. Click **Save**.

Configure special handling notes properties
Configure the necessary properties to display special handling notes.

Role required: sn_shn.admin

1. Navigate to **Special Handling Notes > Properties**.
2. Configure the following properties.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display special handling notes only once per session</td>
<td>Special handling notes are displayed each time you access a record. Enable this property to display special handling notes only once per session.</td>
</tr>
<tr>
<td>Maximum number of notes displayed in the Special Handling Notes pop-up window</td>
<td>Increase or decrease this number as desired. The default is 20 alerts.</td>
</tr>
<tr>
<td>Width of the Special Handling Notes pop-up window in pixels</td>
<td>The width of the pop-up window in pixels. The default width is 500. If you specify less than 300, the window automatically uses the default width.</td>
</tr>
</tbody>
</table>

3. Click **Save**.

**Case and account escalation**

Use the escalation feature to highlight specific cases or accounts and raise awareness of important customer issues.

Escalating cases or accounts facilitates communication about an issue and enables users to track progress toward a resolution. An escalation provides increased attention to a customer issue and provides a way to track the progress made in resolving the issue. Escalation is an internal process that is not exposed to customers.

Users with the escalation requester role can escalate cases or accounts on behalf of customers or for internal purposes. The escalation process can include an optional approval step where approvers review the request and either approve or reject the escalation.

When an escalation is approved, an escalation record is created and is associated with the case or account. Agents and escalation managers can manage the case or account through the escalation process using the escalation record. Escalated cases and accounts are identified on lists and forms with color indicators that correspond to the escalation severity.

Users with the de-escalation requester role can de-escalate cases or accounts when the cause of the escalation is resolved.

While the escalation process is similar for cases and accounts, there are some important differences to note between case escalations and account escalations. A customer service agent typically manages a case escalation and works directly with the escalated case to resolve the issue. An escalation manager typically manages an account escalation, which can include multiple associated cases, and records details in the escalation record. See **Case and account escalation differences** for more information.

**Case and account escalation differences**
An overview of the differences between case escalations and account escalations.

- **Case escalations**: A customer service agent typically manages a case escalation and performs most of the problem resolution work, which is recorded in the case record. For case
escalations, the escalation record is used primarily for status reporting purposes. The escalation SLA is also associated with the case record rather than the escalation record because that is where the agent provides regular updates.

- **Account escalations**: An account escalation manager typically manages an account escalation because it is associated with multiple underlying cases. An account manager works with multiple case owners to resolve the customer escalation and uses the escalation record to consolidate the status of the associated cases and provide regular updates. Therefore, the SLA is associated with the escalation record.

### Case and Account Escalation Process

<table>
<thead>
<tr>
<th>Feature</th>
<th>Case Escalation</th>
<th>Account Escalation</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Relationships</strong></td>
<td>Corresponds one-to-one to a case.</td>
<td>Corresponds one-to-one to an account. Users can link specific cases to the escalation record to indicate which cases are causing the escalation.</td>
</tr>
<tr>
<td><strong>Templates</strong></td>
<td>Uses case escalation templates.</td>
<td>Uses account escalation templates.</td>
</tr>
<tr>
<td><strong>Approval workflow</strong></td>
<td>Includes an option to automatically add the manager of the case assignment group to the approver list when using the default approval workflow.</td>
<td>Does not include an option to automatically add the manager of the case assignment group to the approver list because an account escalation can be associated with multiple cases.</td>
</tr>
<tr>
<td><strong>Escalation assignment</strong></td>
<td>Does not include a separate assignment. A case escalation corresponds to an individual case and the customer service agent manages the escalation.</td>
<td>Includes a separate assignment. An account escalation can have multiple associated cases that are assigned to different agents so the escalation record includes an <strong>Assigned to</strong> field. An account escalation is typically assigned to an escalation manager because account escalations are typically more serious than case escalations.</td>
</tr>
<tr>
<td><strong>Watch list</strong></td>
<td>Does not include an option to automatically add an account team to the escalation watch list.</td>
<td>Includes an option to automatically add an account team to the escalation watch list.</td>
</tr>
<tr>
<td><strong>Escalation updates added to case</strong></td>
<td>Updates to the escalation record are also added to the <strong>Work notes</strong> field on the corresponding case record.</td>
<td>Updates to the escalation record are not added to the account record.</td>
</tr>
<tr>
<td><strong>SLAs</strong></td>
<td>The case escalation SLAs provided with the escalation feature are attached to the case.</td>
<td>The account escalation SLAs provided with the escalation feature are attached to the account.</td>
</tr>
</tbody>
</table>

**Case and account escalation process**

The case and account escalation process follows several steps from request to completion.

1. A user with the escalation requester role requests an escalation for a case or account. As part of the request, the user provides the following information:
   - The reason for the request
   - Justification for the escalation
• The escalation severity
• The escalation template
• The watch list for the escalation

2. If approval is required, the approval workflow or approvers identified in the escalation template review the request and accept or reject the escalation.

3. Following approval, the agent manages the escalation as it progresses using the escalation form. For example, the agent can add users to the watch list and update the escalation trend.

   **Note:** Updates to the escalation form send email notifications to the current user and to users on the watch list.

4. When the issue has been resolved, a user with the de-escalation requester role can de-escalate a case or an account.

*Case and account escalation components*

The roles, modules, and tables installed with the case and account escalation feature.

**Roles**

Roles included with the case and account escalation feature.

<table>
<thead>
<tr>
<th>Role</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Escalation requester</td>
<td>Can request an escalation for a case or account.</td>
</tr>
<tr>
<td>(sn_customerservice.escalation_requester)</td>
<td></td>
</tr>
<tr>
<td>De-escalation requester</td>
<td>Can de-escalate a case or account. This role contains the</td>
</tr>
<tr>
<td>(sn_customerservice.deescalation_requester)</td>
<td>sn_customerservice.escalation_requester role.</td>
</tr>
</tbody>
</table>

**Escalation modules**

The case and account escalation feature adds the Escalations module to the Customer Service menu:

- **All**: lists all escalation records for cases and accounts.
- **Escalation Templates**: lists the case and account escalation templates.
- **Escalation Severity**: lists the types of escalation severity.

This feature also adds a list of escalated cases to the Customer Service menu: **Customer Service > Cases > Escalated**

**Tables**

Tables included with the case and account escalation feature:

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Escalation Templates</td>
<td>Stores escalation template records.</td>
</tr>
<tr>
<td>(sn_customerservice_escalation_template)</td>
<td></td>
</tr>
</tbody>
</table>
### Case and account escalation form

Customer service agents use the Escalation form to manage escalations for cases and accounts.

The Escalation form includes information about the escalation, such as the associated case or account, and the reason and justification for the escalation. It also includes information about the escalation as it progresses, including the trend and notes about the work being done to resolve the issue.

An escalation record can contain one or more associated cases. When updating escalation records, customer service agents can enter comments or work notes. For case escalations, updates are replicated to the case activity history as work notes so they are not visible to the customer.

The Escalation form has a **Related Cases** related list that includes the related cases for account escalations. The user can associate specific cases using this related list to indicate which cases are causing the escalation. The Escalation form also includes has **Task SLAs** and **Approvers** related lists.

### Escalation form fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>The number automatically assigned to the escalation request.</td>
</tr>
<tr>
<td>Source Record</td>
<td>The case or account for which escalation is requested.</td>
</tr>
<tr>
<td><strong>Note:</strong> The case or account form for the source record includes an <strong>Escalations</strong> related list.</td>
<td></td>
</tr>
<tr>
<td>State</td>
<td>The current state of the escalation:</td>
</tr>
<tr>
<td><strong>Requested:</strong></td>
<td>an agent with the escalation requester role has requested an escalation for the case or account.</td>
</tr>
<tr>
<td><strong>Escalated:</strong></td>
<td>the escalation request has been approved.</td>
</tr>
<tr>
<td><strong>Declined:</strong></td>
<td>the escalation request has been not approved.</td>
</tr>
<tr>
<td><strong>Closed:</strong></td>
<td>the reason for the escalation has been resolved and the escalation has been closed.</td>
</tr>
<tr>
<td><strong>De-escalation Requested:</strong></td>
<td>an agent with the de-escalation requester role has requested that an escalation request be removed from the case or account.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Request Source</td>
<td>The source of the case escalation request:</td>
</tr>
<tr>
<td></td>
<td>· Customer requested</td>
</tr>
<tr>
<td></td>
<td>· Internally requested</td>
</tr>
<tr>
<td>Reason</td>
<td>The reason for requesting the case escalation:</td>
</tr>
<tr>
<td></td>
<td>· Inactivity</td>
</tr>
<tr>
<td></td>
<td>· Lack of Progress</td>
</tr>
<tr>
<td></td>
<td>· Customer Imposed Deadline</td>
</tr>
<tr>
<td>Watch List</td>
<td>The watch list for this particular escalation record. For account escalations, you can Add account team members to watch list.</td>
</tr>
<tr>
<td></td>
<td>Users added to the watch list for a case, account, or escalation record receive email notification when the case or account has been escalated and when updates are made to the escalation record.</td>
</tr>
<tr>
<td>Assignment group</td>
<td>For account escalations, the assignment group for this account.</td>
</tr>
<tr>
<td>Assigned to</td>
<td>For account escalations, the customer service agent assigned to this account.</td>
</tr>
<tr>
<td>Request By</td>
<td>The user who requested the escalation.</td>
</tr>
<tr>
<td>Approved By</td>
<td>If approved, the user who approved the escalation request.</td>
</tr>
<tr>
<td>Declined By</td>
<td>If declined, the user who declined the escalation request.</td>
</tr>
<tr>
<td>De-escalated By</td>
<td>The user who de-escalated the case or account escalation.</td>
</tr>
<tr>
<td>Escalation Type</td>
<td>The escalation type selected by the user who requested the escalation.</td>
</tr>
<tr>
<td>Escalation Severity</td>
<td>The escalation severity associated with this escalation, which defines the severity level for the escalation and the color used to highlighted the escalated record in the user interface.</td>
</tr>
<tr>
<td></td>
<td>· <strong>High Severity</strong>: escalated records are highlighted in red.</td>
</tr>
<tr>
<td></td>
<td>· <strong>Medium Severity</strong>: escalated records are highlighted in orange.</td>
</tr>
<tr>
<td>Escalation Trend</td>
<td>The current state of the escalation:</td>
</tr>
<tr>
<td></td>
<td>· Improving</td>
</tr>
<tr>
<td></td>
<td>· Same</td>
</tr>
<tr>
<td></td>
<td>· Declining</td>
</tr>
<tr>
<td>Escalation Justification</td>
<td>Additional information that explains why this escalation is needed.</td>
</tr>
</tbody>
</table>
Administer case and account escalation
The system administrator creates escalation templates and escalation severity definitions that control the escalation process.

Escalation templates
An escalation template determines how an escalation request is processed. The escalation feature provides two standard escalation templates, one for case escalation and one for account escalation. If needed, the system administrator can modify these templates or create new templates.

An escalation template defines the following information:
- The type of escalation (case or account)
- If approval is required
  - If no, the escalation request is automatically approved.
  - If yes, provide the approver list required by the default approval workflow or provide a different approval workflow.
- The escalation watch list. Users added to the watch list receive email notifications when an escalation record is updated.

Escalation severity
An escalation severity record defines the severity level for the escalation and the color that is used to highlight the escalated case or account record in the user interface. This assigned severity allows agents to easily identify escalated cases and accounts on lists and forms. Escalated case and account numbers are indicated with a colored dot on a list and a colored background on a form.

The escalation feature provides two escalation severity definitions:
- **High Severity**: escalated records are highlighted in red
- **Medium Severity**: escalated records are highlighted in orange

In addition to defining the field style of an escalated case or account, the severity can be used when configuring SLAs. To configure additional escalation severity definitions, the system administrator must configure a new style with the desired color. For more information, see *Define field styles*.

Escalation SLAs
Escalation SLAs are typically used to govern the frequency of updates required for different types and severities of escalations. An escalation SLA is associated with an escalation severity in the SLA definition. When a user creates an escalation request, the selection in the *Escalation Severity* field determines the SLA for the escalation record.

The escalation feature provides the following case escalation SLAs. On case escalations, because the escalation corresponds one-to-one with a case, the default SLAs are associated with the case:
- **Escalated case response - 4 hours**: de-escalate the case within four hours.
- **Escalated case response - 8 hours**: de-escalate the case within eight hours.
The escalation feature provides the following account escalation SLAs. On account escalations, because the escalation corresponds to an account which typically does not support SLAs, the SLAs are associated with the escalation.

- Escalated account response - 4 hours: de-escalate the account within four hours.
- Escalated account response - 8 hours: de-escalate the account within eight hours.

The system administrator can configure case and account escalation SLAs that are based on escalation attributes such as the escalation type, severity, and trend.

You can find escalation SLAs in these locations:
- For account records, on the Escalation form in the Task SLAs related list.
- For case records, on the Case form in the Task SLAs related list.

Create a case or account escalation severity

Defines the type of escalation and the color used to represent the cases and accounts of this escalation severity in the user interface.

Role required: admin

2. Click New.
3. Enter a Name for the severity.
4. In the Style field, enter a color.
   
To configure additional escalation severity records, the system administrator must configure a new style with the desired color. For more information, see Define field styles.
5. Click Submit.

Create a case or account escalation template

Create a template for each type of case or account escalation.

Role required: admin

2. Click New.
3. Fill in the fields on the Escalation Template form, as needed.

<table>
<thead>
<tr>
<th>Escalation Template form fields</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the escalation template.</td>
</tr>
<tr>
<td>Skip Escalation Approval</td>
<td>Enable this check box to skip the need for approval. If skipped, escalations are automatically approved.</td>
</tr>
<tr>
<td>Use Default Approval Workflow</td>
<td>Enable this check box to use the default approval workflow (Escalation - Approval) provided with the escalation feature. If using the default approval workflow, select an Approval Group.</td>
</tr>
<tr>
<td>Add Case Assignment Group Manager to Approvers</td>
<td>For case escalation, enable this check box to add the manager of the case assignment group to the list of approvers.</td>
</tr>
</tbody>
</table>
### Field | Description
--- | ---
Approval Group | If the **Use Default Approval Workflow** check box is enabled:
· For the **Case Escalation** type, you can select an additional approval group.
· For the **Account Escalation** type, you must select an approval group.

**Note:** If there are no approvers, escalation requests are automatically approved.

Escalation Approval Workflow | The workflow used to approve escalation requests. Use the default **Escalation-Approval** workflow or select a different workflow.

Type | The type of escalation:
· Case Escalation
· Account Escalation

Escalation Watch List | Add users to the escalation template watch list. These users receive notifications for all escalations that use this escalation template. For an account escalation, the account team is automatically added to the watch list.

**Note:** Users can also be added to the watch list on the escalation record.

4. Click **Submit**.

### Case action status

Use the case action status feature to indicate the status of cases in the Case list. With this feature, customer service agents can easily identify cases that need attention and quickly prioritize their work.

Visual indicators in the **Action Status** column on the Case list highlight case status:
· A blue indicator highlights cases that need attention, such as cases that have been updated by customers or internal users and are waiting for input or review.
· A red indicator highlights cases that are blocked, such as cases that have open related task records or are waiting for customer feedback. Blocked cases can have the following status:
  · Blocked by task
  · Blocked by customer
  · Blocked internally and by customer

In addition to the colored indicators, the **Action Status** column also displays a brief status message.

The case action status feature uses actionable case flows to automatically determine the action status for customer service cases. These flows create and resolve blocking tasks for different case-
related actions and update the action status indicators. Certain agent actions trigger these case flows, which in turn create and resolve the blocking tasks.

Customer service agents and managers can also manually set the action status for cases by enabling the Needs Attention field on the Case form.

Plugin information

Users with the admin role can activate the Case Action Status plugin (com.snc.csm_action_status). This plugin provides a Customer Service-specific application of the Action Status Automation plugin (com.sn_action_status), which tracks blocking tasks created for customer service cases and updates the action status indicators.

The Case Action Status plugin provides several actionable case flows that create and resolve blocking tasks for different case-related actions. These flows are enabled by default. If you do not want to create blocking tasks for a specific action, disable the associated flow.

Note: The Case Action Status plugin provides case flows that create and resolve blocking tasks for problems associated with cases. To get complete functionality, you must also activate the Customer Service with Service Management plugin (com.sn_cs_sm). For more information, see Customer Service integration with Service Management.

Actionable case flows

Actionable case flows contain predefined user actions that automatically create and resolve blocking tasks for customer service cases.

The Case Action Status plugin provides several actionable case flows that create and resolve blocking tasks for different case-related actions. These flows are enabled by default. If you do not want to create blocking tasks for a specific action, you need to disable the associated flow.

To view these flows, navigate to Customer Service > Administration > Actionable Case Flows.

Flow Designer actions

Case flows use the following predefined Flow Designer actions:

- Add Blocking Task
- Inactivate Blocking Task
- Set Needs Attention Flag

Flows for customer service cases

The case action status feature provides the following flows for customer service cases.

- Create blocked by record if case needs customer information
- Create blocked by record if Case Task is associated with case
- Create blocked by record if Change Request is associated with case
- Create blocked by record if SC Request is associated with case
- Create blocked by record if Work Order is associated with case
- Create blocked by record if Incident is associated with case
- Create blocked by record if Problem is associated with case
- Resolve blocked by record if Case Task is closed
- Resolve blocked by record if Change Request is closed
- Resolve blocked by record if Incident is closed
• Resolve blocked by record if Problem is closed or Fix is communicated
• Resolve blocked by record if Problem is closed or Fix/Workaround is communicated
• Resolve blocked by record if SC Request is closed
• Resolve blocked by record if user information is provided for case
• Resolve blocked by record if Work Order is closed or cancelled
• Set Needs Attention if additional comments are added by others
• Set Needs Attention when case is commented by others
• Update case when blocked by record is created
• Update case when Needs attention field is toggled

Flows for customer service orders

The case action status feature provides the following flows for customer service orders.
• Create blocked by record if order case needs customer information
• Resolve blocked by record if user information is provided for order case
• Set Needs Attention if additional comments are added by others on order case
• Update order case when Needs attention field is toggled

Flows for problem records associated to a case

If a problem is associated to a case with the Need task resolution blocking reason, a case flow is provided that resolves the blocking task when a fix is communicated or the problem record is closed or cancelled.

If a problem is associated to a case with the Need PRB workaround blocking reason, a case flow is provided that resolves the blocking task when a workaround is provided or the problem record is closed or cancelled.

Blocking tasks
Certain agent actions trigger case flows which create and resolve blocking tasks for customer service cases. These tasks determine the case action status.

When an agent performs certain actions, such as asking a customer for more information or associating a problem with a case, the system:
• Adds a blocking task to the case. This task appears on the Case form in the Blocked by form section.
• Updates the Action Status field on the Case form and Case list.

Additionally, there are actions that resolve these blocking tasks, such as the customer responding to an agent’s question or an internal user resolving a problem task. When one of these actions occur, the system:
• Updates the status of the blocking task on the Case form.
• Updates the Action Status field on the Case form and Case list.
• Enables the Needs Attention field on the Case form.

Actions that create blocking tasks

The following actions create blocking task for customer service cases:
• The agent sets the state of the case to Needs More Information.
The agent associates one of the following to the case:

- Problem
- Request
- Change
- Incident
- Case task
- Work order

**Actions that resolve blocking tasks**

The following actions resolve blocking tasks for customer service cases:

- A customer provides the requested information.
- A fix or a workaround is associated with a related problem record.
- A related problem, request, change, or incident record is resolved.
- A related case task or work order is closed or cancelled.

**Needs attention field**

When the **Needs attention** field on the Case form is enabled, the **Action Status** column on the Case list displays a blue indicator.

The **Needs attention** field is enabled automatically when:

- A blocking task for a case is resolved.
- A customer or someone other than the case owner comments on a case.
- A work note is added to a case that is a child of a major case.

Customer service agents and managers can manually enable the **Needs attention** field if information is required from customers or internal users. This field can be disabled only by the agent assigned to the case or by the customer service manager or admin.

**Case action status and major issue management**

When using the case action status feature with major issue management, the following actions enable the **Needs attention** field for a major case:

- A customer provides comments for a case that is a child of a major case.
- An agent adds a work note to a case that is a child of a major case.

**Blocked by related list**

Blocking tasks that are created for a case are added to the **Blocked by** related list. Each blocking task is assigned one of the following blocking reasons:

- Need information from the customer
- Need task resolution
- Need PRB workaround
- Other
Note: When a problem is associated with a case and a blocking task is created, the blocking reason is set to **Need task resolution**. If necessary, the agent can change this reason to **Need PRB workaround**.

When a blocking task is resolved:

- The **Unblocked By** field displays the user who performed the unblocking action.
- The **Unblocked On** field displays the date that the blocking task was resolved.

**Blocking Tasks table**

Records that have blocking tasks are stored in the Blocked By table (sn_action_status_blocked_by). Records are periodically removed from this table. Six months after a blocked record is closed, the entries in the Blocked By table related to the blocked record are removed.

*Case action status analytics*

The Customer Service Manager dashboard displays the percentage of the case backlog that is waiting for an agent response, customer input, or a response for other users.

The dashboard includes the **Blocked open cases** widget which breaks down the remaining work to show cases that are with the following users:

- Agent
- Customer
- Other Internal Stakeholder

As blocking tasks for a case get created and resolved, this dashboard widget tracks the case time spent with each of these users. The breakdown is set for:

- Blocked internally
- Blocked by customer
- Blocked internally and by customer

*Case action status logging*

Logging for the case action status feature uses a metric definition to view information about blocking tasks associated with customer service cases.

Defined metrics can track how long a specific field holds a certain value. The **Case Actor Duration** metric definition logs the events related to case blocking tasks.

When a case blocking task is created or resolved, the system logs the information. This information can be used to report on the duration of the case with the customer, the agent, or other internal stakeholders.

As a case gets blocked and unblocked by a customer or an internal user, the metric definition tracks the duration of the case with each of these actors.

The metrics include:

- Case number
- Metric definition
- Value
  - Needs attention
  - Blocked by customer
  - Blocked internally and by customer
• Start and end times
• Duration

Automatically close customer service cases

Customer service cases in the Resolved state can be closed automatically if customers do not take any action.

This feature uses the Auto Close Resolved Cases Flow Designer flow.

Note: This flow is not active by default.

The Auto Close Resolved Cases Flow Designer Flow identifies cases in the Resolved state that are waiting for a customer response and takes the following actions:
• Sends a reminder notification to the customer after 5 days with no response that the case is pending solution acceptance.
• Closes the case and sends a reminder notification to the customer after 10 days that the case has been auto closed.

The notifications are added to the Additional comments field on the Case form.

The system administrator can enable the Auto Close Resolved Cases flow and configure the timing of the reminder notifications. The default settings include two notifications that are sent at 5 days and 10 days after a case has been resolved. The system administrator can also create additional notifications to the flow.

The system administrator can also create a configuration that enables both the system and agents to exclude cases from auto closure.

Using the Auto Close field on the Case form

Customer service agents can use the Auto Close field on the Case form to exclude cases from auto closure. This field is hidden by default. To use this field, configure the Case form to display the Auto Close field.

Configuring business rules for auto closure

The system administrator can configure business rules to enable or disable the Auto Close field on the Case form.

<table>
<thead>
<tr>
<th>Business Rule</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mark for Auto Close</td>
<td>Use this business rule to configure when the system sets the Auto Close field to true. The default configuration is as follows:</td>
</tr>
<tr>
<td></td>
<td>• The case status is Resolved.</td>
</tr>
<tr>
<td></td>
<td>• The Needs attention field on the Case form is false.</td>
</tr>
<tr>
<td></td>
<td>• The case is not escalated.</td>
</tr>
<tr>
<td></td>
<td>• The account is not escalated.</td>
</tr>
<tr>
<td>Business Rule</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Clear Auto Close    | Use this business rule to configure when the system automatically sets the **Auto Close** field to false. The default configuration is as follows:  
  - If the solution is rejected and the case status returns to Open. |

**Notifications for resolved cases**

Customers receive notifications about resolved cases that will be automatically closed if no action is taken.

When an agent proposes a solution for a customer service case, the customer has a certain number of days in which to accept or reject the solution. If the customer does not take action within this window, the case is automatically closed.

The customer receives a reminder message about the resolved case on the Customer Service Portal: **This case is pending solution acceptance. It will be auto closed if you do not take action.**

If the customer does not take any action, the system automatically closes the case and adds the following message to the case: **This case was auto closed.**

**Proactive Customer Service Operations**

You can proactively trigger case workflows and notify affected customers to improve customer experience, solve issues faster, and lower inbound call volume.

Customer Service Management provides an integration with ITOM Event Management. This integration enables customers to create cases proactively from alerts either manually or through automation and track the accounts and the corresponding install base items affected by the alert.

Customers expect quick resolutions when they approach support with an issue. What creates an exceptional customer experience is when you go out of their way to find potential problems and are transparent about the status of the resolution. By monitoring issues and creating proactive cases, you can be one step ahead of your customers and solve issues faster.

Proactive Customer Service Operations enables you to improve the customer experience by breaking down the silos that exist between the processes and systems used by front line customer service and back-office operations teams.

When Network Operations Center engineers are alerted to a service disruption, they can identify customers affected and create a case for customer service to review.

Customer service agents resolve and close proactive cases in the same way as other customer service management cases, using the major issue management process when multiple customers are affected.

Your customers use the Customer Service Management Service Portal to view their install base information and create their own cases.

Activate the Proactive Customer Service Operations plugin (com.snc.proactive_cs_ops) to enable this feature.

Learn about Proactive Customer Service Operations with Event Management from the following video tutorial.
Activate Proactive Customer Service Operations

Activate the Proactive Customer Services plugin to use Proactive Customer Service Operations.

Role required: admin

Proactive Customer Service Operations is only available for customers who are licensed for the Customer Service Management application. To activate Proactive Customer Service Operations, activate the Proactive Operations Management plugin (com.snc.proactive_cs_ops). This plugin is not active by default.

1. Navigate to System Definition > Plugins.
2. Search for the plugin com.snc.proactive_cs_ops.
3. Click Activate.

Activate an alert rule to automatically create a proactive case from an alert

Configure an alert rule to automatically create a proactive case when an incident is created from an alert that has one or more affected install base items.

Ensure that the Proactive Customer Service Operations plugin (com.snc.proactive_cs_ops) is installed.

Note: Proactive Customer Service Operations is only available for customers who are licensed for the Customer Service Management application and the Event Management application.

Role required: evt_mgmt_admin

2. Click Create Proactive Case.
3. Select the Active check box.
4. Click Update.

When an incident is created from an alert that contains affected install base items, a case is automatically created. The case number is added to the Case field on the Alert form.

Manually create a proactive case from an alert

Create a case for customer install base affected by an alert to anticipate customer issues and address them proactively.

Ensure that the Proactive Customer Service Operations plugin (com.snc.proactive_cs_ops) is installed.

Note: Proactive Customer Service Operations is only available for customers who are licensed for the Customer Service Management application and the Event Management application.

Role required: evt_mgmt_admin, evt_mgmt_operator

Conventionally, when customers have issues they contact customer service and the issues are taken care of. By creating proactive cases from alerts, you can identify and resolve customer issues before the customer has to take action.

A proactive case is a case created on behalf of customers whose install base is directly affected by an alert. You can open a proactive case manually or through automation. Cases are then worked on by customer service agents. From the Alert form, you can also track the install base items affected by the alert.
If the **Create Proactive Case** rule is enabled, a case is automatically created when an incident is created from an alert and the system has determined that there are external customer install base items affected. For more information, see *Activate an alert rule to automatically create a proactive case from an alert*.

---

**Note:** You can also manually create a case from an alert using the Event Management application in the Now Platform interface.

---

1. Navigate to **Agent Workspace > Agent Workspace Home > Lists > All Alerts**.
2. Click an alert that you want to create a case for.
3. Click **Refresh Install Base Items** to trace the install base items affected by the alert.
   These items are listed in the **Affected Install Base Items** related list on the Alert form. The **Affected Install Base Items** list is not updated automatically, so refresh the install base items each time you open an alert.
4. Click **Create Case**.
   **Note:** If you don't see the **Create Case** option, click ....
5. Fill out the **Work Notes** and other fields, as required.
6. Click **Submit**.
   A proactive case is created and the case number is added to the **Case** field on the Alert form.

---

**Service Management integration**

Customer Service Management provides an integration with the Request, Incident, Problem, and Change Management applications. This integration enables users to create request, incident, problem, and change records from a customer service case.

To configure the integration with Service Management:

- **Activate the plugins:**
  - Customer Service with Service Management
  - Customer Service with Request Management
- **Assign required roles to the customer service agents and managers who will be creating the request, incident, problem, and change records from customer service cases.** For more information, see *CSM/ITSM integration roles*.

---

**CSM/ITSM integration roles**

The Incident Management application includes roles that the system administrator can assign to customer service agents. These roles enable agents to view and create incident, problem, change, and request records for customer service cases.

**Note:** If you are upgrading from the Madrid release, contact ServiceNow Technical Support for access to these roles.
<table>
<thead>
<tr>
<th>Role title (name)</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
</table>
| sn_incident_read        | Customer service agents with this role can view information about an incident record associated with a customer service case. | - dependency_views 
                          - workspace_agent 
                          - view_changer 
                          - sn_comm_management.comm_plan_viewer_read 
                          - cmdb_read 
                          - cmdb_query_builder_read |
| sn_incident_write       | Customer service agents with this role can:                                | - sn_incident_read                                                             |
|                         |   - Create an incident record for a customer services case.                |                                                                                  |
|                         |   - Associate an existing incident record with a customer service case.    |                                                                                  |
|                         |   - Remove an incident record associated with a customer service case.     |                                                                                  |
| sn_problem_read         | Customer service agents with this role can view information about a problem record associated with a customer service case. | - dependency_views 
                          - workspace_agent 
                          - view_changer 
                          - cmdb_read 
                          - cmdb_query_builder_read |
| sn_problem_write        | Customer service agents with this role can:                                | - sn_problem_read                                                              |
|                         |   - Create a problem record for a customer services case.                 |                                                                                  |
|                         |   - Associate an existing problem record with a customer service case.     |                                                                                  |
|                         |   - Remove a problem record associated with a customer service case.       |                                                                                  |
| sn_change_read          | Customer service agents with this role can view information about a change record associated with a customer service case. | - dependency_views 
                          - workspace_agent 
                          - view_changer 
                          - cmdb_read 
                          - app_service_user 
                          - cmdb_query_builder_read |
| Role title (name)     | Description                                                                                                                                                                                                 | Contains roles                                                                 |
|----------------------|-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------|--------------------------------------------------------------------------------|---|
| sn_change_write      | Customer service agents with this role can:                                                                                                           | sn_change_read, template_editor, cmdb_query_builder                                |
|                      | • Create a change record for a customer services case.                                                                                               |                                                                                 |---|
|                      | • Associate an existing change record with a customer service case.                                                                                   |                                                                                 |---|
|                      | • Remove a change record associated with a customer service case.                                                                                   |                                                                                 |---|
| sn_request_read      | Customer service agents with this role can view information about request records associated with a customer service case in the Requests related list.                                                   | None                                                                            |---|
| sn_request_write     | Customer service agents with this role can:                                                                                                           | sn_request_read, task_editor, dependency_views, workspace_agent, view_changer, cmdb_read, cmdb_query_builder_read |---|
|                      | • Create request records for a customer services case.                                                                                               |                                                                                 |---|

**Manage skills**

Manage skill data in a central location for customer service agents and work items.

- Create and update skills.
- Assign skills to agents and groups.
- Assign skills to work items.
  - Create rules to identify skills and automatically associate them with work items.

**Communication channels**

Customers interact with customer service agents using several different communication channels, including email, phone, and chat.

With this omni-channel communication capability, customers can reach out to agents through their preferred channels. Agents can use all of these channels to communicate with customers. Customers can also use the self-service options available with the Customer Service Portal and the Consumer Service Portal.

Set up these communication channels as needed for your business requirements. See Communication channel setup overview for a high-level description of the channel setup tasks.

**Communication channel setup overview**

An overview of the tasks involved in setting up communication channels.

Role required: admin
Customers interact with customer service agents using several different communication channels, including web, email, chat, phone, and social media. Each channel requires some setup and configuration.

Watch this five-minute video to learn more about Omni-Chanel support capabilities.

1. Set up the **Customer Service email channel**.
   Customers can send emails to create new cases and update current cases as well as receive email updates from agents as cases progress. Customer Service Management uses the ServiceNow email accounts feature to create and maintain email accounts.
   - Configure one or more email addresses.
   - Configure an email address for a product.
   - Configure an email subject line prefix.
   - Set email communication channel properties.
   - Create an email client template.
   - Create quick messages.
   - Configure signatures in quick messages and email client templates.
   - Create rules for incoming emails and create and assign cases.

2. Set up the **Customer Service phone channel**.
   External customers can reach out to customer service agents using the phone communication channel. Customer Service Management uses both Computer Telephony Integration (CTI) and OpenFrame to provide phone support for customers, as well as the Notify application and the Twilio Voice product.

   OpenFrame is included with Customer Service Management. The CTI Softphone plugin (com.snc.cti) and the Customer Service CTI Demo Data (com.snc.customerservice_cti_demo) plugin must be activated separately. The Notify plugin (com.snc.notify) is activated as part of the CTI Softphone plugin.
   - Set up the phone communication channel.
   - Associate a phone number with a workflow.
   - Create an OpenFrame configuration.

3. Set up the **Customer Service chat channel**.
   The chat communication channel uses the Connect Support feature to provide chat capability from the Customer Service Portal and Consumer Service Portal. You can also enable Virtual Agent to create or use predefined chatbot topics (conversations) for your users.
   - Configure the customer service chat queue.
   - Add an agent to the chat support assignment group.
   - Activate Virtual Agent for CSM.
   - Activate Customer Service Virtual Agent conversations.
   - Integrate Customer Service Virtual Agent with Facebook Messenger.

4. Set up the **social media integration** feature to support case resolution through social media channels.
   - Create a social media profile for an account, contact, or consumer.
   - Create a social media log entry for a case.

**Customer service email channel**

Customers can send emails to create new cases and update current cases. They can also receive email updates from customer service agents as cases progress.
Setting up the email channel

Customer Service Management uses the Email Accounts application to create and maintain email accounts. The system administrator can create multiple incoming email addresses that customers can use to communicate with customer service agents. The system administrator can also create one outgoing email address.

After the incoming and outgoing email addresses are created, the system administrator can set these properties for the email communication channel:

- Establish one of the incoming email addresses to automatically create a case.
- Enable a prefix to include in the subject line of an email to any of the incoming email addresses that automatically creates a case.
- Create cases for customers who are not currently in the system.

The system administrator can also create a channel configuration to associate any of the incoming email addresses with specific products.

Creating, viewing, and updating cases

Customers can create a new case by sending an email to a designated address. They can also create a new case for a specific product by sending an email to a designated address and including the product name in the subject line. Or, if a channel configuration has been created, customers can send an email to a designated address regardless of the information included in the subject line.

After submitting a case, the customer receives a confirmation email with the assigned case number and a link to the Case form. When an agent updates a case, the customer receives an email with the details.

Customers can update an existing case in the following ways:

- By replying directly to an email from a customer service agent.
- By creating an email and including the Case: prefix followed by the case number in the subject line. For example, Case:CS0000011.

Note: If the case number in the subject line is incorrect, a new case is created.

Accepting and rejecting solutions

When an agent proposes a solution to a case, the customer receives an email with instructions for accepting or rejecting the solution. The customer can reply and include Accept or Reject in the first line of the email, or the customer can click the Accept or Reject link in the email.

When an agent closes a case, two emails are sent to the customer: the first states that the case has been closed and the second provides a link to a customer satisfaction survey.

Note: If a customer accepts a solution or closes a case from the Customer Service Portal, they are automatically routed to the survey. They do not receive the survey email.

Configure an email address for a product

Users with the system administrator role can configure an email address that creates a case for a specific product.

Role required: admin
Create a configuration that links a product to a specific email address. This configuration is created in the Channel Configuration (sn_customer_service_channel_config) table.

1. Navigate to **Customer Service > Administration > Channels**.
2. Click **New**.
3. Fill in the fields, as appropriate.

**Channel Configurations form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the email configuration.</td>
</tr>
<tr>
<td>Channel Type</td>
<td>This field displays the <strong>Email</strong> configuration type.</td>
</tr>
<tr>
<td>Product</td>
<td>The product model associated with this email configuration.</td>
</tr>
<tr>
<td>Active</td>
<td>The check box to activate the email configuration.</td>
</tr>
<tr>
<td>Email address</td>
<td>The email address for this configuration. Enter one of the incoming email addresses that the system administrator created using the Email Accounts application.</td>
</tr>
</tbody>
</table>

4. Click **Submit**.

**Configure an email subject line prefix**

Users with the system administrator role can configure a prefix to include in an email subject line that creates a case.

Role required: admin

1. Navigate to **Customer Service > Administration > Properties**.
2. In the **Email subject prefix format for new case** field, enter the prefix.
   - The default prefix is **Case:**.
3. Click **Save**.

**Customer service email properties**

Users with the system administrator role can set several properties for the Customer Service Management email communication channel.

After creating the incoming and outgoing email addresses that customers use to communicate with customer service agents, the system administrator can set the following email-specific properties. Navigate to **Customer Service > Administration > Properties** to access these properties.

**Customer Service Management email properties**

<table>
<thead>
<tr>
<th>Property</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Case email address (glide.cs.email.case_queue_address)</td>
<td>One of the incoming email addresses that automatically creates a customer service case. For incoming email, the system checks the address to see if it matches the address in the <strong>Case email address</strong> property. If yes, the system creates a customer service case. If it does not match, or if this property is not set, the system then checks the <strong>Email subject prefix format for new case</strong> property.</td>
</tr>
<tr>
<td>Property</td>
<td>Definition</td>
</tr>
<tr>
<td>---------------------------------------------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Email subject prefix format for new case</td>
<td>The prefix included in the subject line of an email to any of the incoming email addresses that automatically creates a customer service case. <strong>Case</strong> is the default prefix.</td>
</tr>
<tr>
<td>(glide.cs.email.new_case_prefix)</td>
<td></td>
</tr>
<tr>
<td>Create case for non matched user</td>
<td>Enable the creation of new customer service cases when emails are received from users with email addresses that do not currently exist in the system.</td>
</tr>
<tr>
<td>(sn_customerservice.email.create_case_for_non_matched_user)</td>
<td></td>
</tr>
</tbody>
</table>

**Configure signatures in quick messages and email client templates**

Configure signatures in quick messages and email client templates to include attributes of the logged-in user such as name, phone number, designation, or punch-line. Ensuring that customers receive emails with uniform signatures enhances the user experience.

While creating predefined content in quick messages or email client templates, including \${current_user} and \${current_user.title} in the message body substitutes the agent name and designation when an agent replies to a customer. The agent saves time when the signature is automatically appended. Following is an example of the message body text template.

```
Hi ${consumer.name}${contact.name},

Thank you for writing to us.

<<<Please type your response here before sending this email>>>

We hope this information was helpful.
For any further information, please reply to this email.

Regards,

${current_user}
${current_user.title}
```

When an agent replies to the customer with the template that you have predefined, the following message is automatically filled. The \${current user} is replaced by John Jason, which is the agent name and \${current_user.title} is replaced by the agent designation.

```
Hi Amy Chen,

Thank you for writing to us.

<<<Please type your response here before sending this email>>>

We hope this information was helpful.
For any further information, please reply to this email.

Regards,

John Jason
Customer Service Representative
```

Similarly, you can refer to the attributes in the sys_user table such as the address or phone number.

The following video provides an overview of configuring signatures in quick messages and email client templates.

**Creating rules for incoming emails that create and assign cases**

Create your email-related business processes using Inbound Email Flows. Once you receive an email on a specified support email address, you can define rules to create cases and assign the cases to specific teams.
In previous releases, incoming emails were processed through inbound email actions. Admins created separate email actions to support different business flows using scripts.

**Inbound Email Flows** provide powerful configuration capabilities to manage emails along with your customer service processes through a visual **Flow Designer** interface. Business managers can define inbound email flows without having to depend on admins or developers to write complex scripts. Email flows use conditional logic to incorporate multiple business processes in one flow.

The following email flows are available by default once you activate the Customer Service Management plugin. Enable the email flows for activating the email processing rules to automatically create and update cases.

- Create case from email
- Update case using Reply

---

**Note:**
- The execution order of the inbound email flows take a higher precedence than inbound actions (that is if an email flow executes, it prevents execution of inbound actions).
- The user who sends an email should have the necessary roles to perform operations specified in the flow, else the operation stops while executing.

---

The following email flows are shipped as a part of the platform. These flows are not required for any of the CSM email to case processing rules:

- Handle email replies.
- Logging a problem.

Define rules to process incoming emails and to create and assign cases.

Define your email-related business processes using Inbound Email Flows, which enables you to manage emails along with your customer service processes through a visual **Flow Designer** interface without having to design or request complex scripts.

Role required: admin, sn_customerservice_manager

Email flows use conditional logic to incorporate multiple business processes in one flow. When designing inbound email flows, note the following:

- The execution order of the inbound email flows take a higher precedence than inbound actions (that is if an email flow executes, it prevents execution of inbound actions).
- The user who sends an email should have the necessary roles to perform operations specified in the flow or the operation will stop.

1. **Navigate to Customer Service > Flow Designer > Inbound Email Flows.**
2. **Select a default flow.**
   - The available flows are:
     - Create case from email - (explanation)
     - Update case using Reply - (explanation)
3. **Click the Inbound Email trigger.**
4. **Modify the default email filter conditions or select New Criteria to add conditions.**
5. **Select a table in the Reply Record Type field.**
6. **Click Done.**
7. **Click an existing action and expand it.**
8. **Provide information for the action or click + to add a new action, flow logic, or subflow.**
9. Click Done.
10. Verify the email flow and modify it if necessary.
11. Click Save.
12. Click Activate.
   The defined inbound email flow is activated.

Customer service phone channel

External customers can reach out to customer service agents by phone.

The Customer Service Management application uses both Computer Telephony Integration (CTI) and OpenFrame to provide phone support for customers.

CTI provides a way to integrate the Now Platform with telephony providers to support inbound and outbound calls. With this integration, customer service agents can place and accept calls from customers, quickly identify customers and account information, and capture case-related information.

Note: The CTI integration with the Twilio Voice product requires activation of the Notify plugin.

OpenFrame is a tool that enables CTI capability with telephony service providers. OpenFrame provides a communication frame that agents use to place and receive customer calls.

Create an OpenFrame configuration

This configuration specifies the OpenFrame window settings as well as the URL to be launched within OpenFrame.

Role required: admin

As part of the OpenFrame configuration, users with the admin role can select one or more user groups. Access to the configuration is limited to the users that have the openframe user role and that belong to the selected groups.

1. Navigate to OpenFrame > Configurations to display the OpenFrame Configurations list.
2. Click New.
3. Fill in the fields, as appropriate.

OpenFrame Configuration form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the OpenFrame configuration.</td>
</tr>
<tr>
<td>Title</td>
<td>The title that appears in the OpenFrame window header.</td>
</tr>
<tr>
<td>Subtitle</td>
<td>The subtitle that appears in the OpenFrame window header.</td>
</tr>
<tr>
<td>Order</td>
<td>The order number for the configuration. If users have multiple OpenFrame configurations, they can only access the configuration with the lowest order number.</td>
</tr>
</tbody>
</table>

Note: When upgrading, the Order field for the existing default OpenFrame configuration is set to 1.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable collapsed view</td>
<td>Enables the expand and collapse capability for the OpenFrame window. When collapsed, users can still access call control actions. The default setting is <strong>False</strong>.</td>
</tr>
<tr>
<td>Show presence indicator</td>
<td>Enables the indicator that displays agent availability.</td>
</tr>
<tr>
<td>User Group</td>
<td>The user groups selected for this configuration. Access to this configuration is limited to the users that have the openframe user role and that belong to the selected groups.</td>
</tr>
<tr>
<td><strong>Note:</strong> If you do not select any groups, the configuration is available to all users with the openframe user role.</td>
<td></td>
</tr>
<tr>
<td>URL</td>
<td>The URL to be launched within OpenFrame. This URL can be an absolute path or a path that is relative to the ServiceNow instance.</td>
</tr>
<tr>
<td>Active</td>
<td>Denotes this configuration as active.</td>
</tr>
<tr>
<td>Width</td>
<td>The width of the OpenFrame window.</td>
</tr>
<tr>
<td>Height</td>
<td>The height of the OpenFrame window, not including the OpenFrame header height.</td>
</tr>
<tr>
<td>Icon Class</td>
<td>The class of icons used for the OpenFrame window (retina-icons.css). Only supports icon-phone and icon-video values.</td>
</tr>
<tr>
<td>Title Icon</td>
<td>The icon displayed on the OpenFrame window header.</td>
</tr>
<tr>
<td>Configuration</td>
<td>Can be used to store any JSON encoded string.</td>
</tr>
</tbody>
</table>

**Note:**
Several fields on the OpenFrame Configuration form can also be set by using the OpenFrame API. These fields include: **Title**, **Subtitle**, **Width**, **Height**, and **Title Icon**.

4. **Click Submit.**

**Customer service chat channel**

Customers can use the chat channel to communicate with a customer service agent.

The chat communication channel uses the ServiceNow Connect Support feature to provide chat capability. You can also enable Virtual Agent to create or use predefined chatbot topics (conversations) for your users. The user always has the option of switching to a live agent.

The Customer Service Portal and Consumer Service Portal include a chat icon that customers can click to open a chat window and start a discussion with a customer service agent.

The chat request from the customer is either routed to a virtual agent or to an available agent with the required skill set. The agent can respond to the customer and, if necessary, create a new case or link the discussion to an existing case.
Agents must be added to the Customer Service chat support assignment group before they can receive chat requests. This assignment group is used by the Customer Service chat queue to route the chat requests.

If a case is created as the result of a chat, the customer can find the case by clicking My Cases on the customer service portal and viewing the case list. The customer service agent can also link a chat discussion to an existing case. Details from the chat discussion are copied to the case form and appear in the Activity field.

For more information, see Connect Support and Activate Virtual Agent for CSM.

Configure the customer service chat queue
Define the customer service agents, default chat messages, schedule, and escalation path for the customer service chat queue.

Role required: admin

The Customer Service Management chat communication channel uses the ServiceNow Connect Support feature.

Set up chat queue

1. Navigate to Collaborate > Administration > Queues.
2. Select Customer Service from the Chat Queues list.
3. Fill in the fields, as appropriate.

Chat Queue form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the queue.</td>
</tr>
<tr>
<td>Active</td>
<td>Not used in Connect.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Assignment group</td>
<td>User group that contains the support staff for the queue. Any user in the group can view the queue in the Connect sidebar and accept chats. No other users can access the queue. This field must be populated.</td>
</tr>
<tr>
<td>Average wait time</td>
<td>Average time it takes for an agent to accept a chat in the queue. This value is automatically calculated. Do not manually edit.</td>
</tr>
<tr>
<td>Confirm problem</td>
<td>Not used in Connect.</td>
</tr>
<tr>
<td>Escalate to</td>
<td>Different queue to which an agent can escalate a chat. For example, there is a queue for high priority support chats. When a queue is defined in this field, agents can access the Escalate option in conversations.</td>
</tr>
<tr>
<td>Initial agent response</td>
<td>Message that users see when an agent accepts their chat. For example, Thank you for contacting support. We are looking into your question now and will be with you shortly.</td>
</tr>
<tr>
<td>Not available</td>
<td>Message that users see when they attempt to start a chat outside the defined queue Schedule. You can use HTML to format the message and include links or media.</td>
</tr>
<tr>
<td>Question</td>
<td>Initial phrase that users see when they start a new chat in the queue. For example, How can I help you?</td>
</tr>
<tr>
<td>Schedule</td>
<td>Schedule that defines when the queue is available. Leave the field blank to make the queue available all the time. Users cannot start a new conversation in the queue outside the schedule hours.</td>
</tr>
</tbody>
</table>

4. Click **Submit**.

**Activate Virtual Agent for CSM**

Activate Virtual Agent for CSM to use the predefined Customer Service Virtual Agent topics (chatbot conversations) designed to help your customers complete common self-service tasks.

The Virtual Agent plugin (com.glide.cs.chatbot) must be activated. If Virtual Agent is not currently activated, contact ServiceNow to activate it.

Role required: admin

Activate the Customer Service Virtual Agent Conversations plugin (com.sn_csm.virtualagent) to access the predefined Customer Service topics.

**Customer Service Virtual Agent conversations**

The pre-built Customer Service Virtual Agent chatbot conversations are designed for your customers to get help with the product. A conversation topic defines the dialog between the Virtual Agent (chat support bot) and the user to accomplish a specific goal. When Natural Language Understanding (NLU) models are integrated with your virtual agent chatbot topics, it enables chatbots to analyze, understand, and navigate the user to the right topic based on the inferred intent.
Activating Virtual Agent conversations

The system administrator or a virtual agent admin must do the following to enable the chatbot conversations:

- Enable the Glide Virtual Agent plugin (com.glide.cs.chatbot).
- Enable the Customer Service Virtual Agent Conversations plugin (com.sn_csm.virtualagent).
- Publish a Virtual Agent topic the following read-only pre-defined virtual agent chatbot topics:

  **Note:** You can duplicate a topic and then customize it.

- Check Case Status
  Users can search cases and check the status of an existing case.
- Get Help with a Product
  Users can get help on an issue with a product, search relevant knowledge articles, or create a case for the issue.
- Get Help
  This topic is for users who are not logged in and want to chat anonymously. Users can use keywords and search relevant knowledge articles or choose to be transferred to a live agent. You can integrate this topic with the Virtual agent - Facebook messaging integration to enable chat using your messaging application.
- Get Help with an Order
  Users can get help on an issue with an existing order, search relevant knowledge articles, or create a case for the issue.

Your users can run the published topics in your chat support client.

Activating Virtual Agent conversations with NLU

- The Customer Service NLU Model for Virtual Agent Conversations (com.sn_csm.nlu) plugin is automatically enabled when you enable the Customer Service Virtual Agent Conversations plugin (com.sn_csm.virtualagent).

  After you enable the plugin, you can view the following read-only intents for the Customer Service NLU for VA models in Studio:

  - CheckCaseStatus
  - GetHelp
  - GetHelpWithProduct
  - GetHelpWithOrder

  Each intent corresponds to a chatbot topic. To customize an intent, you can import an existing intent from the Customer Service NLU for VA model and then link the NLU model with the associated intent for the topic.

- Enable ServiceNow NLU in the general settings.

Integrate Customer Service Virtual Agent with Facebook Messenger

Integrate the Customer Service Virtual Agent with Facebook Messenger to enable bot conversations in the messenger.

- Install the Customer Service (com.sn_customerservice) plugin.
- Install the Customer Service Virtual Agent Conversations plugin (com.sn_csm.virtualagent).
- Make sure Virtual Agent is integrated with Facebook Messenger.
- Make sure you have the token and secret for the messenger.

For information on integrating the Virtual Agent with Facebook Messenger and for retrieving the messenger token and secret, see [Set up Virtual Agent integration for consumer messaging apps](#).

Role required: virtual_agent_admin or admin

With this integration, you can get help using Virtual Agent chatbot conversations. For more information on getting help, see [Customer Service Virtual Agent conversations](#).

1. In the application navigator, enter
   `sys_cs_adapter_configuration_page_messenger_list.do`
2. Select sample-fb-messenger-app.
   You have to be in the Customer Service Virtual Agent Conversations application to edit the record.
3. In the Messenger Page ID field, enter your company's Facebook page ID.
4. Right-click and select Save.
5. In the Provider Auth field, click the information icon and open the Message Auth record:
   - Go to the Outbound message creation field, click the information icon and open the Token Verification record.
   - In the Token field, enter the token for the messenger application.
   - Click Update.
6. In the Message Auth record:
   - Go to the Inbound message verification field, click the information icon, and open the Hash Message Verification record.
   - In the Secret field, enter the app secret for the messenger application.
   - Click Update.

Social media integration

Support case resolution through social media communication channels.

When working with customers or consumers to create and resolve cases, agents can select Social as the communication channel and add a social profile to the Case form. Any communication with customers or consumers that takes place through social media is recorded on the Case form in the Social Logs related list.

Customer service managers can create one or more social profiles for a user by recording a user's social profile information on a specific social media channel such as Twitter or Facebook. Managers can create social profiles for accounts, contacts, and consumers from the Social Profiles related list on the entity form. Agents have read-only access to these profiles.

Integration with Customer Service Management

The social media communication channel is integrated with the following Customer Service Management forms: Case, Account, Contact, and Consumer.

On the Case form, the Channel field includes the Social option. Selecting this option adds the Social Profile field to the Case form, in which you can select a specific social media channel. The Social Logs related list captures the details of social media conversations.

The Account, Contact, and Consumer forms include the Social Profiles related list. Customer service managers can create one or more profiles for each of these entities.
Plugins

The Customer Service Social Integration plugin (com.sn_cs_social) is activated as part of the Customer Service Management plugin.

Tables

The Customer Service Social Media plugin adds the following tables.

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Social Channels&lt;br&gt;(sn_app_cs_social_social_channel)</td>
<td>Stores the social channels, which are brought in by the social integration tool.</td>
</tr>
<tr>
<td>Social Profiles&lt;br&gt;(sn_app_cs_social_social_profile)</td>
<td>Stores the social profiles created for each customer contact or consumer.</td>
</tr>
<tr>
<td>Social Logs&lt;br&gt;(sn_app_cs_social_social_log)</td>
<td>Stores the details of social media conversations related to cases.</td>
</tr>
</tbody>
</table>

Customer Service Portal

Customize the Customer Service Portal to support your business-to-business (B2B) customers. The Customer Service Portal is a self-service web portal based on the ServiceNow Service Portal application. Use the Customer Service Portal to provide information and support for your customers. The Customer Service Portal portal provides a basic format that customers can use to search for information or request assistance from a customer service agent. It includes the following features:

- A header with links for different customer activities.
- A search feature that customers can use to search for information from several repositories.
- Links to information sources such as the knowledge base, the user community, and customer support.

Activate the plugin and then customize the Customer Service Portal to employ the components that meet your customer needs. Some of the components that you can customize include:

- **Branding**: Configure the portal branding to give your Customer Service Portal its own look and feel.
- **Menus**: Configure the portal header menu to set up the main menu, one of the main navigation controls for your users.
- **Homepage**: Assign a homepage to the portal.
- **Widgets**: Use Service Portal widgets to define the content in your portal.
- **Roles**: Configure page security by role to either set up pages to be public (no login required) or to filter them by user role.

Consumer Service Portal

Customize the Consumer Service Portal to support your business-to-consumer (B2C) customers. The Consumer Service Portal is a self-service web portal based on the ServiceNow Service Portal application. Use the Consumer Service Portal to provide information and support for
your consumers. The Consumer Service Portal provides a basic format that customers can use to search for information or request assistance from a customer service agent. It includes the following features:

- A header with links for different consumer activities.
- A search feature that consumers can use to search for information from several repositories.
- Links to information sources such as the knowledge base, the user community, and customer support.

Activate the plugin and then customize the Consumer Service Portal to employ the components that meet your customer needs. Some of the components that you can customize include:

- **Branding**: Configure the portal branding to give your Customer Service Portal its own look and feel.
- **Menus**: Configure the portal header menu to set up the main menu, one of the main navigation controls for your users.
- **Homepage**: Assign a homepage to the portal.
- **Widgets**: Use Service Portal widgets to define the content in your portal.
- **Roles**: Configure page security by role to either set up pages to be public (no login required) or to filter them by user role.

### Consumer Service Portal properties

Properties that the system administrator can set to limit the number of registered products per consumer, the number of open cases per consumer, and the number of attachments per consumer record.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>consumer_max_attachments_per_record</td>
<td>Maximum consumer attachable items per record.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Type</strong>: integer</td>
</tr>
<tr>
<td></td>
<td>- <strong>Default value</strong>: 5</td>
</tr>
<tr>
<td></td>
<td>- <strong>Location</strong>: Customer Service &gt; Administration &gt; Properties</td>
</tr>
<tr>
<td>consumer_max_new_cases_daily</td>
<td>Maximum new cases that a consumer can create per day.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Type</strong>: integer</td>
</tr>
<tr>
<td></td>
<td>- <strong>Default value</strong>: 10</td>
</tr>
<tr>
<td></td>
<td>- <strong>Location</strong>: Customer Service &gt; Administration &gt; Properties</td>
</tr>
<tr>
<td>consumer_max_comments_per_case_daily</td>
<td>Maximum comments that a consumer can post per day on a case.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Type</strong>: integer</td>
</tr>
<tr>
<td></td>
<td>- <strong>Default value</strong>: 25</td>
</tr>
<tr>
<td></td>
<td>- <strong>Location</strong>: Customer Service &gt; Administration &gt; Properties</td>
</tr>
</tbody>
</table>
### View the number of bot-based sessions

CSM portal usage sessions are billable to customers, but sometimes customers are unnecessarily charged for sessions generated due to bots, crawlers, and DDOS attacks. You can view the number of bot-based sessions to ensure that customers are not incorrectly billed.

Role required: admin, usage_admin

For all new portals you create, bot sessions are captured in the Service Portal Bot Sessions (ua_sp_bot_session) table and all session types are captured in the Service Portal Usage (ua_sp_usage) table.

1. Navigate to Reports > View/Run.
2. Search for customer portal usage.
3. Click the Customer Portal Usage report.
   The report shows the session count for all sessions and a separate count of sessions generated due to bots, crawlers, and DDoS attacks.

### Multi-factor authentication for Customer and Consumer Service Portals

Multi-factor authentication, also known as two-step verification, is a security requirement that asserts a user enter more than one set of credentials.

Enable multi-factor authentication for Customer and Consumer Service Portal users so that access to the self-service web portals is more secure from potential vulnerabilities. For more information, see [Multifactor authentication (MFA)](https:// servicenow.com).

### Multi-factor authentication properties

Use properties to enable role-based multi-factor authentication criteria and configure the behavior.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
</table>
| Enable Multi-factor authentication (glide.authenticate.multifactor) | Select this check box to allow users and administrators to use this feature.  
  - **Type**: enabled | disabled  
  - **Default value**: enabled  
  - **Location**: Multi-factor Authentication > Properties |
<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of times a user can bypass setting up multi-factor authentication</td>
<td>Enter a number that represents how many times a user can choose to skip the additional passcode requirement. This gives your users the ability to still log in the instance if they do not have their mobile device with them. If you disable this feature and then re-enable it, the counter starts over again.</td>
</tr>
<tr>
<td>(glide.authenticate.multifactor.setup.bypass.count)</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Type:</strong> string&lt;br&gt;<strong>Default value:</strong> 3&lt;br&gt;<strong>Location:</strong> Multi-factor Authentication &gt; Properties</td>
</tr>
<tr>
<td></td>
<td><strong>The time in minutes, the one time code sent to user's email address is valid for</strong>&lt;br&gt; (glide.multifactor.onetime.code.validity)</td>
</tr>
<tr>
<td></td>
<td><strong>Type:</strong> string&lt;br&gt;<strong>Default value:</strong> 10&lt;br&gt;<strong>Location:</strong> Multi-factor Authentication &gt; Properties</td>
</tr>
<tr>
<td></td>
<td><strong>Additional time in seconds for which the code will be valid to accommodate for the clock skew. Max value is 60 seconds.</strong>&lt;br&gt; (glide.authenticate.multifactor.clock_skew)</td>
</tr>
<tr>
<td></td>
<td><strong>Type:</strong> string&lt;br&gt;<strong>Location:</strong> Multi-factor Authentication &gt; Properties</td>
</tr>
</tbody>
</table>

**Configure roles for multi-factor authentication**

Add the following external roles to the multi-factor roles:

- sn_customerservice.customer
- sn_customerservice.consumer

Users with these roles will be required to use multi-factor authentication. For more information, see Require MFA for a role.
Customer Service properties

Use system properties to customize the Customer Service Management application. These properties control settings for several different features, including email communication, asset contact relationships, and the Consumer Service Portal.

To access these properties, navigate to Customer Service > Administration > Properties.

Integrate Customer Service Management with other applications


Integration with Field Service Management


Users can view account and contact information on work orders and work order tasks in the Field Service Management application. Customers and consumers can view case-related work orders from the Customer Service and Consumer Service Portals.

When an agent creates a work order from a customer service case, the work order and task forms include case-related information such as the account and contact.

When a customer or a consumer views a case from either the Customer or Consumer Service Portals, they can view the details of any work orders and tasks related to the case.

Changes to the Field Service Management application

In the Field Service Management application, this integration adds the following fields to the Work Order form. These fields are visible in the Case view. To display these fields, right-click the Work Order form header and select View > Case.

- Account
- Consumer
- Contact
- Asset
- Partner
- Partner Contact

Updating the Account field on the Work order form also updates the Company field. Updating the Contact field on the Work Order form updates the Caller field.

Changes to the Customer Service Management application

In the Customer Service Management application, this integration adds the Work Orders link to the Customer Service Portal and Consumer Service Portal headers. Click this link to view a list of work orders, including the work order number, priority, state, and short description. The work orders displayed in this list on the Customer Service Portal depend on the customer role: customer, customer admin, partner, or partner admin.

Click a work order in this list to display the work order details.
Known Limitations

There is no synchronization between the Work Order form and the associated Case form. If information changes on the Case form, it does not get updated on the Work Order form.

CSM integration with Service Management

Customer Service Management provides an integration with the Incident, Problem, Change, and Request Management applications. This integration enables users to create request, incident, problem, and change records from a customer service case.

The Customer Service Management integration with the Service Management applications provides the following functionality:

- Agents can create incident, problem, change, and request records from open cases.
- Agents can associate existing incident, problem, change, and request records with cases or remove associated records from cases.
- Customers can submit requests from the Customer Service Portal. A case is created for each request.
- Updates to records associated with a case automatically update the case work notes.
- Updates to cases with associated records can be used for customer communication.
- Agents and managers can view cases with Service Management-related indicators on the Customer Service dashboards.

Plugins

Customer service integration with Service Management requires the following plugins:

- Customer Service with Service Management plugin (com.sn_cs_sm) for integration with the Incident, Problem, and Change Management applications.
- Customer Service with Request Management plugin (com.sn_cs_sm_request) for integration with the Request Management application.

For new Madrid instances, the following plugins are automatically activated. For upgraded instances, the system administrator must activate these plugins:

- Problem Management Best Practice – Madrid (com.snc.best_practice.problem.madrid)
- Problem Management Best Practice – Madrid – State Model (com.snc.best_practice.problem.madrid.state_model)

For both new and upgraded instances, the system administrator must activate the following plugin:

- Problem Management Best Practice – Madrid – Knowledge Integration (com.snc.best_practice.problem.madrid.knowledge)

These plugins provide additional synchronization between case and problem records and are necessary to fully utilize the integration with Problem Management and the case action status feature.

Roles

The Service Management integration plugins do not add any roles to the customer service agent (sn_customerservice_agent) role. To enable the Service Management integration features, you
must assign the CSM/ITSM integration roles included with the Incident Management application to the agents who need this capability.

**Additional Actions menu options**

The Service Management integration plugins add the following options to the Additional Actions menu on the Case form. Agents can use these menu options to create records for a case.

- Create Incident
- Create Problem
- Create Request
- Create Normal Change
- Create Standard Change

**Note:** Agents can create or associate one incident, problem, or change record with a case. After a record is created or associated with a case, the corresponding options are no longer available on the Additional Actions menu.

**Related Records form section**

The Service Management integration plugins add the Related Records form section to the Case form. This section includes the following fields:

- Incident
- Problem
- Change Request
- Caused by Change

When an incident, problem, or change record is created from a case, or an existing record is associated with a case, the record number is added to the corresponding field.

**Requests related list**

Requests are added to the Requests related list on the Case form. Agents can create multiple requests for a case.

**Resolution codes**

The Service Management integration plugins provide the following case resolution codes:

- Solved – Fixed by closing related PRB
- Solved – Workaround provided based on open PRB
- Solved – Fixed by closing related Change Request
- Solved – Fixed by closing related Incident
- Solved – Related Request is Closed Complete
**Major issue management**

The major issue management feature works with the CSM integration with Service Management as follows:

- A major issue manager with the ITIL role can create incident, problem, change, and request records from a major case.
- When a major case candidate with an associated record is accepted as a major case:
  - A new major case is created and the candidate becomes a child of the major case.
  - The related record information is copied from the child case to the major case.
  - For the child case, the options to create related records are removed from the Additional Actions menu.
  - For the child case, the fields in the Related Records form section are read-only.
  - Updates to the related records appear in the work notes of the major case. These updates are added to the child case when fields are synchronized from the major case to the child case.

- A major case and child cases can have different types of related records. This can happen when an existing case with a related incident, problem, change, or request record is added as a child of a major case. When updates are made to the record related to the child case, information about the update is added to the child case work notes.
- If a major case and child cases have the same related record, updates to that record are added to the major case work notes. These notes are copied from the major case to the child cases if:
  - The `sn_customerservice.case_fields_to_sync` property is enabled.
  - The field in the Related Records form section is added to the `sn_customerservice.case_fields_to_sync` property.

- If a major case and child cases have different related records of the same type, updates to the records are copied only to the respective cases.

**CSM integration with Incident Management**

Integration with the Incident Management application enables customer service agents to create incident records from cases or associate existing incident records to cases.

Integration with Incident Management requires the Customer Service with Service Management plugin (com.sn_cs_sm). It also requires the system administrator to assign the following roles to customer service agents:

<table>
<thead>
<tr>
<th>Role title (name)</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_incident_read</td>
<td>Customer service agents with this role can view information about an incident record associated with a customer service case.</td>
<td>dependency_views, workspace_agent, view_changer, sn_comm_management.comm_plan_viewer, cmdb_read, cmdb_query_builder_read</td>
</tr>
<tr>
<td>Role title (name)</td>
<td>Description</td>
<td>Contains roles</td>
</tr>
<tr>
<td>------------------</td>
<td>-------------</td>
<td>----------------</td>
</tr>
</tbody>
</table>
| sn_incident_write | Customer service agents with this role can:  
· Create an incident record for a customer services case.  
· Associate an existing incident record with a customer service case.  
· Remove an incident record associated with a customer service case. | · sn_incident_read |

With this plugin and role assignment, customer service agents can:

· Create an incident from a case.  
· Associate an existing open incident to a case.  
· Remove an associated incident from a case.  
· View the following in the case work notes:
  · Incident state changes.  
  · Additional comments added to the incident record.

**Note:** A case can be associated with one incident. If a case is already associated with an incident, the **Create Incident** option does not appear on the Additional Actions menu.

**How it works**

An agent can create an incident from a case by selecting the **Create Incident** option from the Additional Actions menu. When the incident is created:

· The incident state is **New**.  
· The incident is associated with the case and the incident number is added to the **Incident** field.  
· A work note for the incident association with the case is added to the **Work notes** field.  
· The domain of the incident is mapped to the domain of the case.  
· The following information is copied from the case to the incident record.

<table>
<thead>
<tr>
<th>Case fields</th>
<th>Incident fields</th>
</tr>
</thead>
<tbody>
<tr>
<td>Short description</td>
<td>Short description</td>
</tr>
<tr>
<td>Default impact</td>
<td>Impact</td>
</tr>
<tr>
<td>Urgency</td>
<td>Urgency</td>
</tr>
<tr>
<td>Contact</td>
<td>Caller</td>
</tr>
<tr>
<td>Configuration item (if available)</td>
<td>Configuration item</td>
</tr>
</tbody>
</table>

**Note:** The agent can manually change the incident impact and urgency to different values on the incident record as needed.
If the case has an associated Problem, Change Request, or Caused by Change record, this information is also copied to the incident record.

Work notes are synchronized from the incident to the case when:

- The incident state changes. If the incident state changes to On Hold, the hold reason is copied to the case work notes.
- The incident is resolved or closed. The incident resolution notes and resolution code are copied to the case work notes.
- Additional comments are added to the incident.

When an incident is created or an existing incident is associated with a case, notification from the incident is suppressed if the caller is an external user (contact or consumer).

**Extension points**

Customers can create the logic for mapping the **Incident** field by using the `sn_cs_sm.CSMIncidentIntegrations` extension point.

**CSM integration with Problem Management**

Integration with the Problem Management application enables customer service agents to create problem records from cases or associate existing problem records to cases.

Integration with Problem Management requires the Customer Service with Service Management plugin (com.sn_cs_sm). It also requires the system administrator to assign the following roles to customer service agents:

<table>
<thead>
<tr>
<th>Role title (name)</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_problem_read</td>
<td>Customer service agents with this role can view information about a problem record associated with a customer service case.</td>
<td>dependency_views, workspace_agent, view_changer, cmdb_read, cmdb_query_builder_read</td>
</tr>
<tr>
<td>sn_problem_write</td>
<td>Customer service agents with this role can:</td>
<td>sn_problem_read</td>
</tr>
<tr>
<td></td>
<td>- Create a problem record for a customer services case.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Associate an existing problem record with a customer service case.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Remove a problem record associated with a customer service case.</td>
<td></td>
</tr>
</tbody>
</table>

With this plugin and role assignment, customer service agents can:

- Create a problem from a case.
- Associate an existing open problem to a case.
- Remove an associated problem from a case.
- View the following in the case work notes:
  - Problem state changes.
- Additional comments added to the problem record.

**Note:** A case can be associated with one problem. If a case is already associated with a problem, the **Create Problem** option does not appear on the Additional Actions menu.

**How it works**

An agent can create a problem from a case by selecting the **Create Problem** option from the Additional Actions menu. When the problem is created:

- The problem state is **New**.
- The problem is associated with the case and the problem number is added to the **Problem** field.
- A work note for the problem association with the case is added to the **Work notes** field.
- The domain of the problem is mapped to the domain of the case.
- The following information is copied from the case to the problem record:

<table>
<thead>
<tr>
<th>Case fields</th>
<th>Problem fields</th>
</tr>
</thead>
<tbody>
<tr>
<td>Short description</td>
<td>Short description</td>
</tr>
<tr>
<td>Default impact</td>
<td>Impact</td>
</tr>
<tr>
<td>Urgency</td>
<td>Urgency</td>
</tr>
<tr>
<td>Priority</td>
<td>Priority</td>
</tr>
<tr>
<td>Company</td>
<td>Company</td>
</tr>
<tr>
<td>Configuration item (if available)</td>
<td>Configuration item (if blank on case, agent can manually update on problem record)</td>
</tr>
<tr>
<td>Case sys_id (if the com.snc.best_practice.problem.madrid plugin is activated)</td>
<td>First reported by</td>
</tr>
</tbody>
</table>

**Note:** The agent can manually change the problem impact and urgency to different values on the problem record as needed.

- If the Problem Management Best Practice – Madrid plugin is activated, the case sys_id is added to the **First reported by** field on the problem record.

**Extension points**

Customers can create the logic for mapping the **Problem** field by using the **sn_cs_sm.CaseProblemIntegrations** extension point.

**Additional plugins**

With the Problem Management Best Practice – Madrid plugin activated, customer service agents can view the following information in the case work notes:

- When the state of a related problem is updated, the text of the work note includes a link to the problem.
- When **Communicate Workaround** is clicked from the related problem, the workaround text is copied to the case work notes.
- When **Communicate Fix** is clicked from the related problem, the fix text is copied to the case work notes.
- When the problem is resolved or closed with a specific resolution code:
  - State is Closed and Resolution Code is Cancelled, the Cancelled Reason text is copied to the case work notes.
  - State is Closed and Resolution Code is Risk Accepted, the Cause notes, Risk accepted reason, and Fix notes are copied to the case work notes.
  - State is Resolved and Resolution Code is Fix Applied, the Cause notes and Fix notes are copied to the case work notes.
  - State is Closed and Resolution Code is Fix Applied, the Cause notes and Fix notes are copied to the case work notes.

With the Problem Management Best Practice - Madrid - Knowledge Integration plugin activated, the customer service agent can view information in the case work notes when a Known Error Article is created for or associated to a related problem. The work note includes a link to the article.

**CSM integration with Change Management**

Integration with the Change Management application enables customer service agents to create change records from cases or associate existing change records to cases.

Integration with Change Management requires the Customer Service with Service Management plugin (com.sn_cs_sm). It also requires the system administrator to assign the following roles to customer service agents:

<table>
<thead>
<tr>
<th>Role title (name)</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_change_read</td>
<td>Customer service agents with this role can view information about a change record associated with a customer service case.</td>
<td>dependency_views, workspace_agent, view_changer, cmdb_read, app_service_user, cmdb_query_builder_read</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>sn_change_write</td>
<td>Customer service agents with this role can:</td>
<td>sn_change_read, template_editor, cmdb_query_builder</td>
</tr>
<tr>
<td></td>
<td>- Create a change record for a customer services case.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Associate an existing change record with a customer service case.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Remove a change record associated with a customer service case.</td>
<td></td>
</tr>
</tbody>
</table>

With this plugin and role assignment, customer service agents can:

- Create a change from a case.
- Associate an existing open change to a case.
- Remove an associated change from a case.
- View the following in the case work notes:
• State changes for the change record.
• Additional comments added to the change record.

**Note:** A case can be associated with one change. If a case is already associated with a change, the Create Normal Change and Create Standard Change options do not appear on the Additional Actions menu.

### How it works

An agent can create a change from a case by selecting one of the following from the Additional Actions menu:

- Create Normal Change
- Create Standard Change

When the agent selects the Create Normal Change menu option and the change is created:

- The change state is **New**.
- The change is associated with the case and the change number appears in the Change Request field.
- A work note for the change association with the case is added to the Work notes field.
- The Requested by field on the change record is updated with the case agent.
- The domain of the change is mapped to the domain of the case.
- The following information is copied from the case to the change record:

<table>
<thead>
<tr>
<th>Case fields</th>
<th>Change fields</th>
</tr>
</thead>
<tbody>
<tr>
<td>Short description</td>
<td>Short description</td>
</tr>
<tr>
<td>Description</td>
<td>Description</td>
</tr>
<tr>
<td>Impact</td>
<td>Impact</td>
</tr>
<tr>
<td>Urgency</td>
<td>Urgency</td>
</tr>
<tr>
<td>Priority</td>
<td>Priority</td>
</tr>
<tr>
<td>Company</td>
<td>Company</td>
</tr>
<tr>
<td>Contact</td>
<td>Caller</td>
</tr>
<tr>
<td>Configuration item (if available)</td>
<td>Configuration item</td>
</tr>
</tbody>
</table>

**Note:** The change manager can update the configuration item on the change record. If the configuration item is not available, the agent can also manually update this information.

- Default values are added to the following fields on the change record:
  - Type = Normal
  - State = New
  - Category = Other
  - Risk = Moderate
When an agent creates a change by selecting the **Create Standard Change** menu option, a change record is created using the Standard Change template (which is defined in the Standard Change catalog). The data mapping is created from the template; no data is copied from the case to the change record.

Work notes are synchronized from the change to the case when:

- The change state or change type is updated.
- Additional comments are added to the change record.
- When the change associated with a case is put on hold, the work notes are updated with the hold reason.
- When a hold on the change associated with a case is removed, the work notes on the case are updated.
- When the change is resolved or closed.

**Extension points**

Customers can create the logic for mapping the **Change Request** field by using the `sn_cs_sm.CaseChangeIntegrations` extension point.

**Change form related lists**

The Customer Service Management with Change Management adds the following related lists to the Change form:

- Cases Fixed by Change
- Cases Caused by Change

**Standard Change record producer behavior**

When a record producer for a Standard Change or Normal Change is created and exposed to customer service agents from the Customer or Consumer Service Portals:

- The record producer only appears in the portal after clicking the **Create Request** UI action.
- The record producer does not appear as part of Standard Change catalog items.
- If the agent chooses to create a Standard Change from the normal record producer, the Standard Change is created but the change record is not linked with the case.

**CSM integration with Request Management**

Integration with the Request Management application enables customers to create requests from the Customer Service Portal. Agents can also create request records from cases.

Integration with Request Management requires the Customer Service with Request Management plugin (com.sn_cs_sm_request). It also requires the system administrator to assign the following roles to customer service agents:
<table>
<thead>
<tr>
<th>Role title (name)</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_request_read</td>
<td>Customer service agents with this role can view information about request records associated with a customer service case in the Requests related list.</td>
<td>None</td>
</tr>
</tbody>
</table>
| sn_request_write | Customer service agents with this role can:  
• Create request records for a customer service case. | sn_request_read  
• task_editor  
• dependency_views  
• workspace_agent  
• view_changer  
• cmdb_read  
• cmdb_query_builder_read |

With this plugin and role assignment, customer service agents can:
• Create one or more requests on behalf of a customer from an existing customer service case.
• Associate an existing request to a case.
• Remove an associated request from a case.
• View a list of requests associated with a case in the Requests related list.
• View the following in the case work notes:
  • Request state changes.
  • Additional comments added to the request record.

**Note:** When creating a request from a case, if the agent chooses a catalog item that is using cart v1 (the use_sc_layout field is not checked), the case is not set as the parent of the request.

### Implementation

Integration with Request Management is available for customer service agents and external customers.

**Note:** Integration with Request Management is not supported for the partner and partner administrator flows. The ability to select accounts and contacts for the partner and partner administrator flows is not available.

### How it works for a customer

Customers can submit requests for themselves from the Customer Service Portal. The request process is integrated with Service Catalog.

**Note:** Partners and customer administrators cannot submit requests on behalf of other accounts or contacts.

• The customer selects a catalog item and submits a request.
- A new case is created, which becomes the parent of the request. One request is associated with a case and a request contains one item.
- The case is used as the reference for the customer, who can see the request status and updates from the case on the Customer Service Portal.
- All cases associated with a request appear on the request record in the Cases related list.
- The following information is copied from the request to the case:

<table>
<thead>
<tr>
<th>Request fields</th>
<th>Case fields</th>
</tr>
</thead>
<tbody>
<tr>
<td>Short description</td>
<td>Short description</td>
</tr>
<tr>
<td>Requested for</td>
<td>Contact</td>
</tr>
<tr>
<td>Account</td>
<td>Account</td>
</tr>
</tbody>
</table>

**How it works for an agent**

An agent can create a request from a case by selecting the Create Request option from the Additional Actions menu. When the request is created:

- The request state is **New**.
- The case becomes the parent of the request. The case number is added to the Parent field on the request form.
- The request is associated with the case and is added to the Requests related list.
- A work note for the request association with the case is added to the Work notes field.
- The domain of the request is mapped to the domain of the case.
- The following information is copied from the case to the request record:

<table>
<thead>
<tr>
<th>Case fields</th>
<th>Request fields</th>
</tr>
</thead>
<tbody>
<tr>
<td>Short description</td>
<td>Short description</td>
</tr>
<tr>
<td>Contact</td>
<td>Contact</td>
</tr>
</tbody>
</table>

Work notes are synchronized from the request to the case when:

- The request state changes.
- The request is closed.
- Additional comments are added to the request.

**Note:** When a request is closed, the case does not automatically move to solution proposed.

**Extension points**

Customers can create the logic for mapping the Request field by using the sn_cs_sm.CaseRequestIntegrations extension point.

**Communicating with the requester**

The task fullfiller can communicate with the requester if additional information is needed. Use the Additional comments field on the request to communicate with the requester through the case.
Information added to the **Additional comments** on the request are synchronized to the casework notes.

If the case is the parent of the request, notifications to the requester are suppressed when additional comments are added to the request by the fulfiller.

**Service catalog integration with the Customer and Consumer Service Portals**

The customer administrator (sn_customerservice.customer_admin) can [associate a portal with a catalog](#).

This section describes the catalog pages and widgets provided as part of the Customer Service integration with Request Management.

**CSM Catalog page**

The display page for catalog items on the Customer and Consumer Service Portals. This page serves as the landing page for any service catalog item exposed on a CSM portal. All request items exposed on the CSM portals are either service catalog items or service catalog record producers. Navigate to [Service Portal > Pages](#) to view this page.

- **Page ID:** csm_sc_cat_item
- **Update name:** sp_page_7ea80b123bb31300bfe04d72f3efc4b7
- **Available to roles:** snc_internal, snc_external

**CSM Catalog Item widget**

This widget handles the redirection logic on submission of the catalog item and embeds the default catalog item widget. This widget listens to event `$sp.sc_cat_item.submitted`; on submission of a catalog item, it handles the portal redirection logic based on the page_id and the catalog portal URL. When there is no parent set in the Requests (sc_request) table, the URL is redirected to the default service portal ticket page. If a record producer has a redirect URL, this widget uses the redirect URL from the record producer instead of redirecting to the ticket page.

- **Widget ID:** csm-sc-cat-item
- **Update name:** sp_widget_ec837c713bbb1300bfe04d72f3efc4d1
- **Available to roles:** snc_internal, snc_external

**Page route map**

It is important to set up a page route map for any new Service Portals to handle the redirection to the Case ticket page. The redirection is based on the logic described in the CSM Catalog Item widget.

- **CSM Catalog item page route map:** for the Customer Service Portal, this page route map routes the URL redirect from the sc_cat_item page to the csm_sc_cat_item page.
- **CSP Catalog item page route map:** for the Consumer Service Portal, this page route map routes the URL redirect from the sc_cat_item page to the csm_sc_cat_item page.

**Portal settings for catalog items**

Once the catalog items are defined, visibility of the **Submit / Add to Cart** button can be controlled by navigating to [Service Catalog > Catalog Definitions > Maintain Items](#), selecting the desired item, and enabling or disabling the fields in the Portal Settings form section.

- **Request method:** select Order, Request, or Submit as the type of catalog item.
- **Hide ‘Add to Cart’:** enable if the **Add to Cart** button should be disabled for the catalog item.
Note: The Add to Cart button is not currently supported on the Customer Service Portal or the Consumer Service Portal.

- **Hide Quantity**: enable if the **Quantity** of the catalog item should be hidden.
- **Hide Delivery Time**: enable if the **Delivery Time** of the catalog item should be hidden.
- **Hide ‘Add to Wish List’**: enable if the **Add to Wish List** button for the catalog item should be hidden.
- **Hide Attachment**: enable if the attachment of the catalog item should be hidden.

**Provide external customers with access to problem, change, and request records**

External customers can view the problem, change, and request records associated with their customer service cases from the Customer and Consumer Service Portals.

Customers interact with customer service agents to create and update customer service cases. As they work to resolve cases, agents sometimes need to create problem, change, or request records or associate existing records.

With this feature, you can provide read-only access to external users to the problem, change, and request records that are related to cases. After logging in to the Customer or Consumer Service Portal, users can view a list of their cases, select a case, and view the Related Records list for the case. They can also click a record in this list opens a read-only view of the record form in a pop-up window.

Note: The Related Records list shows data only if the logged in user has access to view the related records.

Customers, customer partners, and internal users with the proxy contact role (sn_customerservice.proxy_contact) can also create requests from the Customer and Consumer Service Portals. For more information about this feature, see [Create cases as a proxy contact](#).

**Required roles**

Users with the snc_internal or snc_external role and with read access to the related records can see the problem, change, and request records related to a case.

The system administrator can assign roles to customer service agents that enable the enable agents to view and create incident, problem, change, and request records for customer service cases. For more information, see [CSM/ITSM integration roles](#).

**Viewing problem, change, and request records**

From the Customer or Consumer Service Portal, customers can see problem, change, and request records associated with their cases. These records appear in the Related Records widget on the case view page. Clicking a record in this list displays information from the record in a pop-up window. Agents and customers can use the **Additional comments** field on the case to communicate about these records.

Customers can also view Known Error articles for a problem related to a case. These articles are displayed:

- If there is a KE article present for the problem record. If there are multiple articles associated with the problem, the customer has access to the primary article. If there are no articles, the customer does not see the link.
• If the customer has access to the KE article.

Configuration

To configure this feature, the system administrator can:

• Assign the required roles to the customer service agents and managers who will be creating the request, problem, and change records from customer service cases.
• Provide access to problem, change, and request records by configuring ACLs for the snc_external role. This access is not provided out of box. The admin must add these ACLs to the snc_external user role based on case access.

Note: Existing ACLs on the problem, change, and request records may impact the visibility for external users.

• Configure the Case Related Records widget. By default, this widget is displayed for users with the snc_internal and snc_eternal roles.
• Define the views for the problem, change, and request records and select the fields that are visible to external customers. For more information, see Create and delete views.

Enable users to create requests from the Customer and Consumer Service Portals

Enable your contacts and consumers to create and track requests from the Customer and Consumer Service Portals.

Contacts and consumers can request items from the Customer and Consumer Service Portals. Each submitted request generates a case, with the request associated to that case.

This feature requires activation of the Customer Service with Request Management plugin (com.sn_cs_sm_request).

External user roles that can create requests

<table>
<thead>
<tr>
<th>Role</th>
<th>Actions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Customer administrator</td>
<td>Users with this role can:</td>
</tr>
<tr>
<td>(sn_customerservice.customer_admin)</td>
<td>• Browse the service catalog and catalog items and make a selection.</td>
</tr>
<tr>
<td></td>
<td>• Create requests for themselves, for other contacts from the same account, or for child accounts.</td>
</tr>
<tr>
<td></td>
<td>• View the request details.</td>
</tr>
<tr>
<td>Partner</td>
<td>Users with this role can:</td>
</tr>
<tr>
<td>(sn_customerservice.partner)</td>
<td>• Browse the service catalog and catalog items and make a selection.</td>
</tr>
<tr>
<td></td>
<td>• Create requests for themselves (if they also have the customer role).</td>
</tr>
<tr>
<td></td>
<td>• Create requests on behalf of the accounts with which they have established relationships.</td>
</tr>
<tr>
<td></td>
<td>• View cases and requests.</td>
</tr>
</tbody>
</table>
### Role and Actions

<table>
<thead>
<tr>
<th>Role</th>
<th>Actions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Customer case manager</td>
<td>Users with this role can:</td>
</tr>
<tr>
<td>(sn_customerservice.customer_case_manager)</td>
<td>· Browse the service catalog and catalog items and make a selection.</td>
</tr>
<tr>
<td></td>
<td>· Create requests for themselves or for other contacts from the same account.</td>
</tr>
<tr>
<td></td>
<td>· View the request details.</td>
</tr>
<tr>
<td>Customer</td>
<td>Users with this role can:</td>
</tr>
<tr>
<td>(sn_customerservice.customer)</td>
<td>· Create a request.</td>
</tr>
<tr>
<td></td>
<td>· View the request details.</td>
</tr>
<tr>
<td>Proxy contact</td>
<td>Users with this role can:</td>
</tr>
<tr>
<td>(sn_customerservice.proxy_contact)</td>
<td>· Browse the service catalog and catalog items and make a selection.</td>
</tr>
<tr>
<td></td>
<td>· Create requests on behalf of customers.</td>
</tr>
<tr>
<td></td>
<td>· Add the account and contact information of the customers.</td>
</tr>
<tr>
<td></td>
<td>· View the details of the case and the related request.</td>
</tr>
</tbody>
</table>

#### Agents can create requests on behalf of contacts and consumers

Customer service agents can browse the catalog and make a selection to create a request on behalf of a customer.

- From Agent Workspace, agents can create requests from case and interaction records.
- From the platform interface, agents can create requests from case records.

#### Changes to the Case form

The system administrator can configure the Case form to display the `Initiated as request` field. When a request is created from the portal, the system creates a case for the request and sets the `Initiated as request` field to true. This field is read-only for all users.

#### Related Records list widget

When viewing a case on the Customer or Consumer Service Portal, users can see other records that are associated with the case in the Related Records widget. These records can include problems, changes, and requests. Users can click a record in the Related Records widget to view record details in a pop-up window.

**Note:** If a case does not have any related records, the Related Records widget does not appear on the case view page.

For requests, the `Stage` field displays the current stage of the request. This field can be expanded to show more detail about the request process.
Record list filter

From the Customer and Consumer Service Portals, users can view lists of cases and requests by doing one of the following:

- Clicking **My Lists** in the portal menu header.
- Clicking **Requests > All Requests** in the portal menu header.

The list view page includes a **My Lists** filter with the following options:

- **All**: displays all case and request records.
- **Action Needed**: displays cases in the **Resolved** state that are waiting for a customer response.
- **My Issues**: displays the cases that were not initiated as a request.
- **My Requests**: displays the cases that were created as a request.

Integration with Financial Management

Plugins for Customer Service Management and Field Service Management provide an integration with the Financial Management application as well as dashboards and reports.

The Financial Management application enables you to allocate, track, and report on expenses in your organization. When the Financial Management application allocates an expense, it breaks down the expense into detailed amounts of money called allocations. These allocations can be associated with specific segments and accounts for a specific cost model. The integration with Financial Management provides cost allocations for Customer Service Management and Field Service Management.

Use these cost allocations on the Financial Management workbench, which provides financial administrators with a graphical interface to allocate expenses. Access the workbench through the **Cost Transparency > Workbench** module.

Plugins

Two different plugins, one for Customer Service Management and one for Field Service Management, enable the integration with Financial Management. These plugins also add dashboards based on cost allocations.

- **Performance Analytics - Content Pack - Financial Management for Field Service Management plugin** (com.snc.pa.fm.fsm)

The Performance Analytics - Content Pack - Financial Management for Customer Service plugin includes demo data for FY16: Q1 through FY17: Q2. The demo data includes records with the CSFM prefix, which indicates that the records are for the Customer Service Management integration with Financial Management. Activating the plugin adds these records to the Case (sn_customerservice_case) table.

**Note:** The Performance Analytics - Content Pack - Financial Management for Field Service Management plugin does not include demo data.
Cost models

A cost model is a set of rules, methods, and metrics that determines the allocation of expenses. Select cost models on the Data Definitions tab of the Financial Management workbench.

For Customer Service Management, the integration with Financial Management provides these cost models:

- **CSM Allocation Model for Cust Account**: allocates expenses for individual B2B customer accounts.
- **CSM Allocation Model for Channels**: allocates expenses for communication channels.

For Field Service Management, the integration with Financial Management provides this cost model:

- **FSM Allocation Model for Company**: allocates expenses for companies.

Segment hierarchy

All accounts in the chart of accounts belong to segments which are structured in a hierarchy. This hierarchy enables the roll-up of expenses from lower-level accounts and segments to higher-level accounts and segments.

- **CSM Allocation Model for Cust Account** uses this segment hierarchy: Assignment Group > Product > Customer Account.
- **CSM Allocation Model for Channels** uses this segment hierarchy: Assignment Group > Product > Channels.
- **FSM Allocation Model for Company** uses this segment hierarchy: Assignment Group > Product > Company.

Account buckets

Use account buckets to categorize cleansed expenses before assigning them to accounts and segments. Account buckets can be organized in parent-child relationships so that several child buckets can refer to a single parent bucket.

The Customer Support and Field Service Support account buckets include:

- Facilities
- IT Chargeback
- Payroll and Labor Expenses
- Professional Fees & Services
- Supplies
- Training
- Other expenses

Allocation metrics

Allocation metrics are rules that you can create and use to split an allocation based on dimensions such as:
• Number of Customer Service cases: allocate expenses to a product based on the number of cases closed in a fiscal period.
• Total Customer Service case resolution time: allocate expenses to a product based on the total hours worked on cases closed in a fiscal period.
• Number of Field Service work order tasks: allocates expenses to a product based on the number of work order tasks completed in a fiscal period.
• Total work order completion time: allocates expenses to a product based on the total hours worked on tasks completed in a fiscal period.

For Customer Service Management, the integration with Financial Management provides these allocation metrics:
• CSM Allocate to Assignment Groups by Headcount
• CSM Allocate to Product by # Cases
• CSM Allocate to Product by Case Time Worked Duration
• CSM Rollup from AssgGrp to Product by # Cases
• CSM Rollup from AssgGrp to Product by Case Time Worked Duration
• CSM Rollup from Product to Account by # Cases
• CSM Rollup from Product to Account by Case Time Worked Duration

For Field Service Management, the integration with Financial Management provides these allocation metrics:
• FSM Allocate to Assignment Groups by Headcount
• FSM Allocate to Product by # Work Orders
• FSM Rollup from Product to Company by # Work Orders

User roles

These roles can access the Financial Management workbench (Cost Transparency > Workbench):
• cost_transparency_analyst
• cost_transparency_admin
• financial_mgmt_user
• financial_mgmt_admin

Dashboards and reports

The Performance Analytics - Content Pack - Financial Management for Customer Service and Performance Analytics - Content Pack - Financial Management for Field Service Management plugins provide the following dashboards:
• CSM Financials Dashboard
• FSM Financials Dashboard

Navigate to Performance Analytics > Dashboards and select the desired dashboard from the Dashboard menu.

Integration with Event Management

This integration enables customers to create cases proactively from alerts either manually or through automation and track the accounts and the corresponding install base items affected by the alert.

For more information, see Proactive Customer Service Operations.

Continual Improvement Management with CSM

Use the Continual Improvement Management (CIM) application with Customer Service Management (CSM) to request improvement opportunities and to implement phases and tasks to meet performance goals, track progress, and measure success.

You can use CIM for improvements to Performance Analytics (PA) indicators and to service operations. For example, create a new improvement initiative to:

- Reduce the open case backlog.
- Improve the average case response time.

See Continual Improvement Management for more information about how CIM can help you with setting goals, organizing effort, and completing tasks.

Use CIM with Customer Service Management

To use CIM with Customer Service Management, you must request the Continual Improvement Management (com.sn_cim) plugin. For more information, see Request Continual Improvement Management.

Administer Customer Service Management

Use a number of features and tools to administer the Customer Service Management application.

Anonymous chat

Consumers can chat with a consumer service agent without logging in to the Consumer Service Portal.

From the Consumer Service Portal, guest users can click the Live Chat link in the portal header to initiate a chat session with a consumer service agent. Clicking this link opens a form that requests some basic information, including the user's name, email address, and type of issue. Completing and submitting the form creates a chat request that is routed to the appropriate agent queue based on the selected issue type. Once the assigned agent accepts the request, a chat session is established. If necessary, the agent can create a consumer record or a case for the guest user, or transfer the chat to another agent.

Setting up anonymous chat

Setting up the anonymous chat feature involves the following steps.

2. Modify the default anonymous chat record producer or create a new record producer.
3. Create one matching rule for each agent queue.
4. Configure anonymous chat properties.
5. If necessary, modify the Connect actions to provide the desired functionality for consumer service agents in chat conversations. The anonymous chat feature includes these actions: Create Case for Guest and Create Consumer and Case for Guest. For more information, see Administer Connect Actions.

Anonymous chat plugins

The anonymous chat feature requires two plugins which are activated as part of the Consumer Service Portal plugin:

- Anonymous Connect Support (com.glide.connect.anonymous_support): enables the anonymous chat feature for Connect.
- Connect Support Routing (com.glide.connect.support.routing): routes Connect Support requests to the appropriate chat queue.

Anonymous chat record producer

The form used to request information from a guest user is a configurable record producer based on the Consumer Interaction table (sn_customerservice_customer_interaction), which is a new table in the Istanbul release. When a guest user submits the form, the information provided is stored as a record in the Customer Interaction table. This record is used for routing the chat request.

The default anonymous chat record producer, What can we help you with?, is located at Service Catalog > Catalog Definition > Record Producers. This is a public record producer. You can modify this record producer or create your own. If you choose to create your own, see Section 3 in the Making a record producer and catalog item public on a CMS page (KB0551300) article. You must also set the glide.sc.use_user_criteria property to false.

For more information, see Record Producer.

Anonymous chat routing

Information provided by the guest user assists with routing and also provides the context of the request to the consumer service agent. The chat request is routed to the appropriate agent queue based on the type of issue selected. The routing for anonymous chat requests uses matching rules. Create one matching rule for each queue and tie a chat request to a chat queue based on the selected issue type. Matching rules for anonymous chat are based on the Customer Interaction table.

The following matching rules are provided:

- Anonymous Connect - Billing Support
- Anonymous Connect - Order Support
- Anonymous Connect - Product Support

These rules are based on the selections in the Issue Type field on the default anonymous chat record producer.
Anonymous chat properties

There are two properties related to the anonymous chat feature. Set these properties to limit the number of chat requests created by guest users.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>connect.support.max_guest_sessions_per_hour</td>
<td>Limit maximum number of guest conversations created in the last hour.</td>
</tr>
</tbody>
</table>
| | - **Type**: integer  
| | - **Default value**: 200  
| | - **Location**: Collaborate > Connect Support > Support Administration > Properties |
| connect.support.guest_sessions_rate_limit_reached_message | Message shown to user when rate limit for guest conversations is breached. |
| | - **Type**: string  
| | - **Default value**: Guest Chat is currently not available, please retry later.  
| | - **Location**: Collaborate > Connect Support > Support Administration > Properties |

Modify the anonymous chat record producer

Modify the default anonymous chat record producer to gather the desired information from guest users.

Role required: admin

This record producer requests information from a guest user on the Consumer Service Portal and stores the information as a record in the Consumer Interaction table (sn_customerservice_customer_interaction). The record is then used for routing the chat request.

1. Navigate to Service Catalog > Catalog Definition > Record Producers.
2. Click What can we help you with?.
3. Modify the record producer as necessary, including the variables in the Variables related list.
   For more information, see [Create a record producer](#).
4. Click Update.

Create a matching rule for anonymous chat

Create one matching rule for each agent queue.

Role required: admin

A chat request is tied to a chat queue based on the selected issue type.

1. Navigate to Routing and Assignment > Matching Rules.
2. Click New.
3. Enter a Name for the matching rule.
4. In the Table field, select Customer Interaction.
5. In the Conditions field, use the condition builder to create the following conditions.

<table>
<thead>
<tr>
<th>Field</th>
<th>Operator</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Channel</td>
<td>is</td>
<td>Chat</td>
</tr>
</tbody>
</table>
### Configure anonymous chat properties

Users with the system administrator role can set properties to limit the number of chat requests created by guest users.

**Role required:** admin

1. Navigate to **Collaborate > Connect Support > Support Administration > Properties**.
2. Set the following properties.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Limit maximum number of guest conversations created in the last hour. (connect.support.max_guest_sessions_per_hour)</td>
<td>Limits the number of guest chat requests that can be created in a one-hour timeframe. The default value is 200.</td>
</tr>
<tr>
<td>Message shown to user when rate limit for guest conversations is breached. (connect.support.guest_sessions_rate_limit_reached_message)</td>
<td>The message that is displayed on the Consumer Service Portal when the limit on the number of guest chat requests has been reached.</td>
</tr>
</tbody>
</table>

3. **Click Save.**

### Respond to an anonymous chat request

Select a chat request from the chat queue and respond to a guest user's question or comment.

**Role required:** sn_customerservice.consumer_agent, sn_customerservice_manager, or admin

1. Navigate to **Collaborate > Connect Chat**.
   The Connect workspace opens in a new tab.
2. Click the support tab of the Connect sidebar, indicated by a headset icon.
   The support tab displays **_queues** to which you belong. It also displays your open support conversations under **Cases**. When a consumer starts a support conversation or an agent transfers a conversation to a queue, any agent who belongs to the associated queue has the option to accept the conversation. An agent can also request to transfer a conversation directly to you.
3. Accept a conversation in one of the following ways.
   - Accept a conversation from a queue
   - Accept a transfer request
4. Respond to the guest user and help resolve the issue.
   By default, your messages are added to the conversation record as comments and are visible to the user.
If necessary, you can create a consumer record for a guest user and create a consumer service case from the conversation to track the issue. You can also transfer the conversation to a different agent or queue, or escalate the conversation to a higher priority queue. For more information, see Connect Support.

**Customer Service Management Flow Designer actions**

Use Flow Designer actions as building blocks to create Customer Service Management business processes.

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Get Case</td>
<td>Retrieve a case record using the case number. If multiple records are found, only the first record is returned.</td>
</tr>
<tr>
<td>Create Case</td>
<td>Create a case using one or more attributes. This action mimics the structure of the Case table (sn_customerservice_case) and exposes all of the fields present on the Case table.</td>
</tr>
<tr>
<td>Create Quick Case</td>
<td>Create a case using the customer, description, channel, priority, and category attributes.</td>
</tr>
<tr>
<td>Create Task on Case</td>
<td>Create a case task and optionally associate it with a case.</td>
</tr>
<tr>
<td>Update Case</td>
<td>Update a case by providing the case reference and the fields that you want to update.</td>
</tr>
<tr>
<td>Assign Case</td>
<td>Assign a case using matching rules. To use this action, you must first define the matching rules that match cases with resources (assignment groups, agents).</td>
</tr>
<tr>
<td>Escalate Case</td>
<td>Request case escalation. This action does not automatically approve escalation. Approval is based on the selected escalation template.</td>
</tr>
<tr>
<td>Escalate Account</td>
<td>Request account escalation. This action does not automatically approve escalation. Approval is based on the selected escalation template.</td>
</tr>
<tr>
<td>Add Work Note to Task</td>
<td>Add a work note to a task or to task extended objects (for example, a case or case task).</td>
</tr>
<tr>
<td>Add Comment to Task</td>
<td>Add a comment to a task or to task extended objects (for example, a case or case task).</td>
</tr>
</tbody>
</table>

**Domain separation in Customer Service Management**

This is an overview of domain separation and Customer Service Management. Domain separation enables you to separate data, processes, and administrative tasks into logical groupings called domains. You can then control several aspects of this separation, including which users can see and access data.

**Overview**

**Support: Level 1**
Domain separation is supported in this application. Not all ServiceNow applications support domain separation; some include limitations on the data and administrative settings that can be domain separated. To learn more, see Application support for domain separation.

Domain separation for Customer Service Management is designed for:

- **Customers using the application in a domain-separated environment or in a hybrid environment.** With domain separation, a customer can grant access to end users (contacts or consumers) to other entities in addition to customer service cases. For example, contacts or consumers can access problems, changes, or projects. System administrators can synchronize the CSM account model with the domain structure and maintain data separation for entities that do not have account-based data separation enabled.

- **Managed service providers (MSPs) using the application to provide customer support.** In this scenario, an MSP can provide support to multiple customers, where domains are necessary to contain all relevant customer data and processes. For example, an MSP providing support to customers related to billing questions, contract renewals, or other non-service operations.

- **Managed service providers offering the application as a service that customers can provide to their customers.** In this scenario, an MSP can offer Customer Service Management as a service to customers who, in turn, use the application to support their end customers. This scenario requires additional configuration due to domain support for some of the core entities in the platform such as Product Model.

### How domain separation works in Customer Service Management

Domain separation for Customer Service Management aligns each customer account to one domain. To use domain separation with the application, all customer accounts must be assigned to a domain.

The customer account is the main entity within Customer Service Management. All entities related to the account, such as contacts and cases, are created in the same domain as the account. This rule also applies for all entities on customer service cases, including addresses, assets, and contacts.

When a new account is created, a domain of the same name is also created and assigned to the account. All related entities for an account, such as contacts and cases, must reside in the same domain. When a related entity for a domain separated account is created, the entity is assigned to the account domain.

### Setting up domain separation for Customer Service Management

Domain separation for Customer Service Management requires the domain separation plugin. Contact ServiceNow to activate domain separation.

Activating this plugin enables the `csm_auto_account_domain_generation` property, which automates domain separation. This property is installed with Customer Service Management and is available only after the domain separation plugin is active.

When the `csm_auto_account_domain_generation` property is enabled, the Customer Service Management application automatically creates a domain of the same name when a new account is created.

---

**Note:** Enabling the `csm_auto_account_domain_generation` property does not add domains for existing accounts. It only creates domains for newly created accounts. Adding domains for existing accounts requires a migration script.
Changes to Customer Service Management tables

Domain separation for Customer Service Management adds the **Domain** and **Domain Path** fields to the Account (customer_account) table. These fields are not exposed by default. Customers can customize lists and forms to view these fields.

Account domains and related entities

When creating related entities for an account, the domain for the related entities is set to the account domain. Related entities include:

- Contacts
- Cases
- Assets
- Contracts
- Entitlements
- Addresses
- Social profiles
- Escalations
- Sold Products
- Installed Products
- Install Base Items
- Affected Install Base Items

Changing the domain for an account also changes the domain for all the account’s related entities.

Domain visibility for customer service agents and managers

Users with the customer service agent (sn_customerservice_agent) and customer service manager (sn_customerservice_manager) roles must be manually assigned to the **TOP/MSP/Default** domain. Agents and managers cannot see case or account details until they are assigned to the **TOP** domain.

Domain separation for case and account escalation

Escalation template records and escalation severity records are domain separated. By default, these records reside in the global domain. Users can configure the Escalation Template and Escalation Severity forms to display the **Domain** field and set the domain as needed.

When an escalation record is created from a case or account, it is created in the account domain.

Domain separation and entity relationships

With domain separation in Customer Service Management, you can further control visibility and access to data by using contact, partner, and parent-child relationships.
Partner-customer account relationships

In partner-customer account relationships, the partner account can see data in the customer account’s domain. When setting up an account relationship, the domain visibility direction is **From > To**. The account in the **From** field contains the domain of the account in the **To** field.

When a partner admin creates a case for a customer account, the case is created in the customer account’s domain so that all relevant parties can access the case.

In partner-customer account relationships where the customer account has child relationships, the partner admin can create a case for the customer account but not for the child accounts. The partner admin can only create cases for the account with which the relationship has been established.

Contact relationships

In contact relationships, the contact included in the relationship can see data for the specified account domain.

Parent-child relationships

The account hierarchy feature creates a parent-child relationship between accounts. This relationship is defined by selecting the parent in the **Parent Account** field on the Account form for the child account. Domain hierarchy is also achieved using the **Parent Account** field. In parent-child account relationships, parent domains can see data in child domains.

To provide access from the child account to the parent account, you need to set domain visibility. Navigate to the child account and set visibility in the Visibility Domains related list (sys_user_visibility) by connecting the user to the domain.

Extension points in Customer Service Management

Use extension points to call custom scripts in the Customer Service Management application.

To access the available extension points, type `sys_extension_point.list` in the application navigator and press **Enter**. Click the desired extension point to view the record details.

You can create multiple implementations for each extension point and provide an order number for each implementation. The implementation that has the lowest order number is the implementation that is executed.

<table>
<thead>
<tr>
<th>Extension point</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_customerservice.CSMService</td>
<td>Defines the default value logic for case objects. Available with the Customer Service (com.sn_customerservice) plugin.</td>
</tr>
<tr>
<td>Extension point</td>
<td>Description</td>
</tr>
<tr>
<td>----------------</td>
<td>-------------</td>
</tr>
</tbody>
</table>
| sn_customerservice.CSMCaseSync | Use this extension point to customize the logic for parent-child case synchronization. This extension point can be used in one of two ways:  
  - Define the conditions for parent case records that can be considered for synchronization to child cases. The default functionality is based on the `sn_customerservice.parent_child_case_sync` system property. Customers can add additional conditions using this extension point.  
  - Customize the logic for parent-child case synchronization based on the state of the child case. By default, if the child case is in the `Resolved`, `Closed`, or `Cancelled` state, there is no sync from the parent case.  
  
  This extension point is used by the `CSCaseSyncHelper` script include.  
  Available with the Customer Service (com.sn_customerservice) plugin. |
| sn_majorissue_mgt.MajorCase | Available with the Major Issue Management (com.sn_majorissue_mgt) plugin. |
| sn_action_status.NeedsAttentionAccessUtil | Enables each application to choose the user roles that can enable and disable the `Needs Attention` field on a case form.  
  Available with the Customer Service Case Action Status plugin (com.snc.csmactionstatus). |
| sn_cs_sm.CSMChangeIntegrations | Creates the logic for mapping the `Change Request` field on the case record.  
  Available with the Customer Service with Service Management (com.sn_cs_sm) plugin. |
| sn_cs_sm.CSMIncidentIntegrations | Creates the logic for mapping the `Incident` field on the case record.  
  Available with the Customer Service with Service Management (com.sn_cs_sm) plugin. |
| sn_cs_sm.CSMProblemIntegrations | Creates the logic for mapping the `Problem` field on the case record.  
  Available with the Customer Service with Service Management (com.sn_cs_sm) plugin. |
| sn_cs_sm_request.CSMRequestIntegrations | Creates the logic for mapping the `Request` field on the case record.  
  Available with the Customer Service with Request Management (com.sn_cs_sm_request) plugin. |

**Knowledge product entitlements**

The Knowledge Product Entitlements application enables administrators to designate the knowledge bases and knowledge articles that customers can view from the Customer Service Portal.
Limit access on the Customer Service Portal to the following:

- The knowledge bases and articles for the products that a customer’s company has purchased.
- The knowledge bases and articles for which a customer’s company has entitlements.

The Knowledge Product Entitlements plugin (com.snc.kb_product_entitlements) must be activated to use this application. Installing this plugin adds the Related Products field to the Knowledge Base form and to the Knowledge form. The knowledge information available on the customer portal is limited to the products selected in this field.

Additional controls are available by enabling properties that allow you to:

- Limit access to knowledge bases based on product entitlements.
- Enable access if no products are specified in the Related Products fields.

Add a related product to a knowledge base or knowledge article

Add a product to a knowledge base or knowledge article using the Related Products field on the corresponding form.

Role required: admin

1. Navigate to one of the following:
   - Knowledge > Administration > Knowledge Bases
   - Knowledge > Articles > All

2. Select the desired knowledge base or knowledge article.
3. Add one or more products in the Related Products field.
4. Click Update.

Set knowledge product entitlement properties

Set various properties to allow customers to access knowledge bases and knowledge articles on the Customer Service Portal.

Role required: admin

1. Navigate to Knowledge Product Enhancements > Properties.
2. Set the following properties, as needed.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable access control of Knowledge Bases based on product entitlements</td>
<td>If enabled, customers can access all of the knowledge bases related to the products for which they have entitlements.</td>
</tr>
<tr>
<td>Allow access to Knowledge Bases with empty related_products</td>
<td>If enabled, customers can access all knowledge bases even if no products have been specified in the Related Products field on the Knowledge Base form.</td>
</tr>
<tr>
<td>Enable access control of Knowledge Articles based on product entitlements</td>
<td>If enabled, customers can access all of the knowledge articles related to the products for which they have entitlements.</td>
</tr>
<tr>
<td>Allow access to Knowledge Articles with empty related_products</td>
<td>If enabled, customers can access all knowledge articles even if no products have been specified in the Related Products field on the Knowledge form.</td>
</tr>
</tbody>
</table>

3. Click Save.
Limit knowledge base access to internal users

Limit access to the information in a knowledge base to internal users.

Role required: admin

The articles in a knowledge base are available to both internal users, such as customer service agents, and to external users (customers and partners). If the articles in a knowledge base are intended for internal users only, the system administrator can restrict access by customizing the knowledge base form.

1. Navigate to Knowledge > Administration > Knowledge Bases.
2. Click the desired knowledge base.
3. Right-click the form header and select Configure > Related Lists.
4. Select Cannot Contribute from the Available column and move it to the Selected column.
5. Click Save.
6. On the selected knowledge base form, click the Cannot Contribute related list.
7. Click Edit.
8. Click All Customer Contacts in the left column and move it to the right column.
9. Click Save.

Mandatory skills

Use the mandatory skills feature to identify any skills that are required for agents and technicians to work on customer service cases and field service work orders and tasks. Then assign cases and tasks to agents and technicians who have those required skills.

When assigning cases, work orders, and work order tasks, the assignment tools consider the mandatory skills, filter out agents and technicians who do not have these skills, and then rank the remaining agents.

- If agents with the mandatory skills are available, the cases and tasks are assigned to these agents.
- If agents with the mandatory skills are not available, then agents with any other, non-mandatory skills identified in the cases and tasks are ranked and assigned.

Field service dispatchers (wm_dispatcher), field service technicians (wm_agent), customer service managers (sn_customerservice_manager), and customer service agents (sn_customerservice_agent) can specify both skills and mandatory skills for cases and tasks.

Mandatory skills is an optional feature. Mandatory skills can be identified on the assignment workbench. In addition to the Skills list, the assignment workbench includes a Mandatory Skills Added list. Agents are ranked in the workbench based on the number of skills that match the skills identified in the Skills list. If the mandatory skills feature is being used, then the agents displayed are filtered by the skills listed in the Mandatory Skills Added list and then ranked by the other matching criteria.

Configuring the mandatory skills feature

Configure the mandatory skills feature for use with the Customer Service Management and Field Service Management applications.

Mandatory skills is an optional feature included with the Customer Service Management and Field Service Management plugins. Use the steps below to configure this feature with the desired application.
Customer Service Management configuration

To configure the mandatory skills feature for use with Customer Service Management:

- In the Case form:
  - Configure the form layout to use the Task Skills (task_m2m_skill) table.
  - In the Task Skills table, set the **Mandatory** field to **True** to identify skills that are mandatory to complete a task.

  **Note:** The Case form should use either the **Skills** field or the Task Skills table, but not both.

- (Optional) For existing cases that have data populated in the **Skills** field on the Case form, run the **Migrate Skills to Task Skill M2M** script to move this data to the Task Skills table. By default, this fix script migrates the skills from existing entries in the Case, Work Order, and Work Order Task tables to the Task Skills table. For more information, see **Migrate skills to the Task Skill table**.

- If you are using the assignment workbench, replace the **Matching Skills** matching criteria with the **Matching Skills - Mandatory Skills Support** matching criteria. For more information, see **Matching rules for case assignment**.

Field Service Management configuration

To configure the mandatory skills feature for use with Field Service Management:

- Enable the **work.management.use.mandatory.skills** system property.
- Configure the Work Order form and the Work Order Task form to use the Task Skills (task_m2m_skill) table.

  **Note:** The Work Order and Work Order Task forms should use either the **Skills** field or the Task Skills table, but not both.

- (Optional) For existing work orders and tasks that have data populated in the **Skills** field on the Work Order and Work Order Task forms, run the **Migrate Skills to Task Skill M2M** script to move this data to the Task Skills table. By default, this fix script migrates the skills from existing entries in the Case, Work Order, and Work Order Task tables to the Task Skills table. For more information, see **Migrate skills to the Task Skill table**.

- If you are using dynamic scheduling, update the task filter for the dynamic scheduling configuration and replace the **Matching Skills for Dynamic Scheduling** matching criteria with the **Matching Mandatory Skills for Dynamic Scheduling** matching criteria. For more information, see **Create a task filter**.

Mandatory Skills system properties

The **Migrate Skills to Task Skill M2M** script migrates skills from existing tasks to the Task Skills (task_m2m_skill) table. Configure the task tables included in the migration using the **skills_management.migration** system property.

The mandatory skills feature adds the following system properties.

  **Note:** To open the System Property (sys_properties) table, enter `sys_properties.list` in the navigation filter.
<table>
<thead>
<tr>
<th>System parameter</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>work.management.use.mandatory.skills</td>
<td>Enables the mandatory skills feature and indicates that the Task Skills (task_m2m_skill) table is being used for work orders and work order tasks.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Type</strong>: true/false</td>
</tr>
<tr>
<td></td>
<td>- <strong>Default value</strong>: false</td>
</tr>
<tr>
<td>skills_management.migration</td>
<td>Lists the task tables to migrate to the Task Skills (task_m2m_skill) table when an admin runs the Migrate Skills to Task Skill M2M script.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Type</strong>: choice list</td>
</tr>
<tr>
<td></td>
<td>- <strong>Default value</strong>: <code>wm_task,customerservice_case,wm_order</code></td>
</tr>
<tr>
<td>com.snc.skills_management.task_skill_migrated_tables</td>
<td>Contains a list of tables for which the Skills field has already been migrated to the Task Skills (task_m2m_skill) table. If the table name is listed in this property, the data has been migrated and will not be migrated again.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Type</strong>: choice list</td>
</tr>
<tr>
<td></td>
<td>- <strong>Default value</strong>: none</td>
</tr>
</tbody>
</table>

**Migrate skills to the Task Skill table**

Migrate data from the **Skills** field to the Task Skills table to utilize mandatory skills support for executing tasks in a case or work order.

**Role required**: `wm_admin`, `admin`

The Task Skills (task_m2m_skill) table stores skills and mandatory skills.

In the Customer Service Management application, the assignment workbench uses the Task Skills table instead of the **Skills** field in the Case table to display agents based on the evaluation criteria for task assignments.

In the Field Service Management application, the work order task assignments done using auto-assignment, dynamic scheduling, and central dispatch use the Task Skills table instead of the **Skills** field in the Work Order and Work Order Task tables to assign agents for task assignments.

1. **Add a system property** with the following settings:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create a system property for a table in the Customer Service Management application.</td>
<td>Make sure that you are logged in to the Customer Service Management application.</td>
</tr>
</tbody>
</table>

**Note**: Configure the System Properties form to display the **Suffix** field.

In the **Suffix** field, enter the name of the system property as follows:

`com.snc.skills_management.<table_name>_migrate_skills`,

where `<table_name>` is the name of a case task table from which the skills need to be copied.
**Option**                  | **Description**                  |
|-------------------------|----------------------------------|
| Create a system property for a table in the Field Service Management application. | Make sure that you are logged in to the Global application. In the **Name** field, enter the name of the system property in the following format: `com.snc.skills_management.<table_name>_migrate_skills`, where `<table_name>` is the name of a work order or work order task table from which the skills need to be copied.  

2. In the **Type** field, set the value to **true**.  
3. Click **Update**.  
4. Navigate to **System Definition > Fix Scripts** and run the **Migrate Skills to Task Skill M2M** fix script. The skills are copied to the `task_m2m_skill` table. The name of the table from which the skills are copied gets appended to the `com.snc.skills_management.task_skill_migrated_tables` system property. When the script is run again, it ignores all tables from which skills have already been migrated.

### Quick start tests for Customer Service Management

Validate that the Customer Service Management application still works after you make any configuration change such as apply an upgrade or develop an application. Copy and customize these quick start tests to pass when using your instance-specific data.


### Quick start tests added in the New York release

- CSM: Agent Creating Request for Customer  
- CSM: Manager creating request OBO customer from CSM portal  
- CSM: Employee creating case OBO customer  
- CSM: Create Major Case and it’s Child Case  
- CSM: Lookup Type Skill Determination Rule Test  
- CSM: Simple Type Skill Determination Rule Test  
- CSM - Update Support Profile  
- CSP - Update Support Profile  
- CSM - Provide Feedback on Survey  
- CSP - Provide Feedback on Survey  
- CSM: Search On Homepage  
- CSP: Search On Homepage  
- CSM- Accept Proposed Solution On Case  
- CSP- Accept Proposed Solution On Case  
- CSM- Provide requested info on case  
- CSP- Provide requested info on case  
- CSP: Register Your Product
### CSM: Case Management Test Suite

<table>
<thead>
<tr>
<th>Test</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CSM - Accept Proposed Solution On Case</td>
<td>Accept a proposed solution for a case from the Customer Service Portal.</td>
</tr>
<tr>
<td>CSP - Accept Proposed Solution On Case</td>
<td>Accept a proposed solution for a case from the Consumer Service Portal.</td>
</tr>
<tr>
<td>CSM: Agent Creating Request for Customer</td>
<td>As a customer service agent, create a request for a customer.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Requires Customer Service Request Integration.</td>
</tr>
<tr>
<td>CSM: Assign Asset on Case</td>
<td>Assign an asset to a case.</td>
</tr>
<tr>
<td>CSM: Assign Case to an Agent</td>
<td>Create a case and assign it to a customer service agent.</td>
</tr>
<tr>
<td>CSM: Assign Entitlement</td>
<td>Assign an entitlement to a case.</td>
</tr>
<tr>
<td>CSM: Close a Case</td>
<td>Close a case.</td>
</tr>
<tr>
<td>CSM: Create CHG from Case</td>
<td>Create a change record from a case.</td>
</tr>
<tr>
<td>CSM: Create Incident from Case</td>
<td>Create an incident record from a case.</td>
</tr>
<tr>
<td>CSM: Create Major Case and its Child Cases</td>
<td>Create a major case and the associated child cases for the customer accounts in the recipient list.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Requires Major Issue Management.</td>
</tr>
<tr>
<td>CSM: Create Order Case</td>
<td>Create a case for an order.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Requires Customer Service Management for Orders.</td>
</tr>
<tr>
<td>CSM: Create Order Case as Customer from CSM Portal</td>
<td>Create an order case as a customer from the Customer Service Portal.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Requires Customer Service Portal. Also requires that the test be run as admin.</td>
</tr>
<tr>
<td>CSM: Create Problem from Case</td>
<td>Create a problem record from a case.</td>
</tr>
<tr>
<td>CSM: Create Product Case</td>
<td>Create a case for a product.</td>
</tr>
<tr>
<td>CSP: Create Product Case as Consumer from CSP Portal</td>
<td>Create a product case as a consumer from the Consumer Service Portal.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Requires Consumer Service Portal. Also requires that the test be run as admin.</td>
</tr>
<tr>
<td>Test</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>CSM: Create Product Case as Customer from CSM Portal</td>
<td>Create a product case as a customer from the Customer Service Portal.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Requires Customer Service Portal. Also requires that the test be run as admin.</td>
</tr>
<tr>
<td>CSM: Create Proactive Case by NOC Operator</td>
<td>Verify if a proactive case is created.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Requires Proactive Customer Service Operations.</td>
</tr>
<tr>
<td>CSM: Create Product Case as Partner from CSM Portal</td>
<td>Create a product case as a partner from the Customer Service Portal.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Requires Customer Service Portal. Also requires that the test be run as admin.</td>
</tr>
<tr>
<td>CSM: Create Special Handling Notes</td>
<td>Create special handling notes for a case.</td>
</tr>
<tr>
<td>CSM: Employee creating case OBO customer</td>
<td>As an employee with the proxy contact role (sn_customerservice_proxy_contact), create a case from the self-service portal on behalf of a customer.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Requires the CSM Extension for Proxy Contacts.</td>
</tr>
<tr>
<td>CSM: Escalate an Account</td>
<td>Escalate an account.</td>
</tr>
<tr>
<td>CSM: Escalate a Case</td>
<td>Escalate a case.</td>
</tr>
<tr>
<td>CSM: Lookup Type Skill Determination Rule Test</td>
<td>Create a lookup type skill determination rule.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Requires Skill Determination.</td>
</tr>
<tr>
<td>CSM: Manager creating request OBO customer from CSM portal</td>
<td>As a user with the case manager role, create a case on behalf of a customer from the Customer Service Portal.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Requires Customer Service Request Integration.</td>
</tr>
<tr>
<td>CSP- Provide Feedback on Survey</td>
<td>Provide feedback on a survey after a case is closed from the Consumer Service Portal.</td>
</tr>
<tr>
<td>CSM- Provide Feedback on Survey</td>
<td>Provide feedback on a survey after a case is closed from the Customer Service Portal.</td>
</tr>
<tr>
<td>CSM - Provide requested info on case</td>
<td>From the Customer Service Portal, the contact can provide information for a case that was requested by the agent.</td>
</tr>
<tr>
<td>CSP - Provide requested info on case</td>
<td>From the Consumer Service Portal, the consumer can provide information for a case that was requested by the agent.</td>
</tr>
<tr>
<td>CSP: Register Your Product</td>
<td>Register a product from the Consumer Service Portal.</td>
</tr>
<tr>
<td>Test</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>CSM: Search on Homepage</td>
<td>Search for information from the Customer Service Portal. The search includes cases, Knowledge articles, and Community threads.</td>
</tr>
<tr>
<td>CSP: Search on Homepage</td>
<td>Search for information from the Consumer Service Portal. The search includes cases, Knowledge articles, and Community threads.</td>
</tr>
<tr>
<td>CSM: Simple Type Skill Determination Rule Test</td>
<td>Create a simple type skill determination rule.</td>
</tr>
<tr>
<td>Note: Requires Skill Determination.</td>
<td></td>
</tr>
<tr>
<td>CSM: Time Recording</td>
<td>Record the time worked on a case.</td>
</tr>
<tr>
<td>CSM - Update Support Profile</td>
<td>Update a contact's profile from the Customer Service Portal.</td>
</tr>
<tr>
<td>CSP - Update Support Profile</td>
<td>Update a consumer's profile from the Consumer Service Portal.</td>
</tr>
<tr>
<td>ITAM: Create Service Model</td>
<td>Verify that you can create a service model, which is a type of product model.</td>
</tr>
<tr>
<td>ITAM: Create Service Model copy</td>
<td>Verify that you can create a copy of a service model, which is a type of product model.</td>
</tr>
</tbody>
</table>

**Agent Workspace for CSM**

Agent Workspace for Customer Service Management integrates the platform functionality specific to tier 1 customer service agents and puts these features into an easy-to-navigate interface.

Agent Workspace for CSM supports the needs of agents handling customer inquiries, issues, and cases from multiple sources, including:

- Case agents, who handle cases created from the Customer or Consumer Service Portals or from inbound emails.
- Phone agents, who handle customer phone inquiries.
- Chat agents, who handle customer chat requests.

Agent Workspace for CSM makes it easy for agents to efficiently manage multiple cases, accounts, customers, and consumers.

- The multi-tab interface improves agent productivity by enabling agents to easily navigate between records.
- The ribbon provides overview information in a way that quickly orients an agent to case details.
- The intuitive Case form layout minimizes scrolling by displaying case details side-by-side with the activity stream.
- Agent Assist enables agents to quickly search for information across multiple sources such as knowledge bases and community sites.
- Predictive Intelligence can provide agents with a list of similar cases and can also provide recommendations about major issues and major cases. For more information, see [Similar case/recommendation](#).
Browser support for workspaces

Do not use Internet Explorer 11 to access any workspaces. If you are on the New York release and you are using Internet Explorer 11 with any workspace, such as Service Owner Workspace, Vendor Manager Workspace, or any other type workspace, you must migrate to a modern browser before you upgrade to future releases. Internet Explorer 11 will not be supported for workspaces after the New York release. See KB0683275 for more information on Internet Explorer 11, and see Generally supported browsers for more information about browsers and what you can use across the platform.

Plugins

The Customer Service plugin (com.sn_customerservice) activates the CSM Workspace plugin (com.snc.agent_workspace.csm) and provides the functionality of CSM Agent Workspace.

Additional plugins are required for phone integration. For details, see Agent Workspace phone integration with OpenFrame and computer telephony integration (CTI).

Agent Workspace for CSM landing pages

Landing pages provide customer service agents with an overview of their new, assigned, and high priority cases plus the cases assigned to their groups. Landing pages can also include analytics. Customer service agents can use these pages to quickly scan and access cases.

The CSM Landing Page is available for Agent Workspace for CSM. This landing page is included with the CSM Workspace plugin (com.snc.agent_workspace.csm). It includes components that display case information, plus visualizations that further break down the component data. Each visualization is connected to a data source. For example, the My High Priority Cases component includes visualizations for P1 and escalated cases. This landing page does not require a Performance Analytics license.

To add Performance Analytics information to the CSM Landing Page landing page, activate the Performance Analytics - Content Pack - Customer Service Management - Advanced plugin (com.snc.pa.customer_service_advanced). This plugin adds a section for My Organization's Performance, which includes analytics for CSAT and New vs Closed Cases.
My Workspace

My High Priority Cases

<table>
<thead>
<tr>
<th>Priority</th>
<th>Escalated</th>
<th>SLA Breached</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>0</td>
<td>2</td>
</tr>
</tbody>
</table>

My Cases

<table>
<thead>
<tr>
<th>Needs Attention</th>
<th>Not Updated in 5d</th>
<th>Open</th>
<th>All</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>8</td>
<td>3</td>
<td>14</td>
</tr>
</tbody>
</table>

My Teams' Cases

<table>
<thead>
<tr>
<th>Unassigned</th>
<th>PI</th>
<th>Escalated</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>13</td>
<td>2</td>
</tr>
</tbody>
</table>

My Organization's Performance

| CSAT  | 66.67% |

Show all

CSM Landing page (PA version)
Configuring landing pages

With the CSM Agent Workspace administrator role (workspace_admin) or the admin role, you can create landing pages for different agents and teams:

- Clone the existing CSM Landing Page.

  **Note:** The application scope must be set to CSM Workspace. The **Clone Page** action is not available in the Global scope.

- Add or edit containers in the page.
- Add or edit visualizations for each container.
- Edit the layout of a page or container.

The following types of visualizations are available:

- Reports
  - Single score
  - Trend by
  - List
- Performance Analytics
  - Single score
  - Time series

Multiple landing pages

You can create multiple landing pages. However, only a single landing page is displayed for a user. The landing page that is displayed for a user depends on the following settings:

- The setting of the **Active** field. This field must be set to true for a landing page to be displayed.
- The **Order** of the landing page. Pages with a lower order value take precedence over pages with a higher order value.
- If permissions are defined, users can see a landing page if they have the required role or are a member of the required assignment group. Multiple roles and assignment group conditions are treated as OR conditions.

Using landing pages

From the CSM Landing Page, customer service agents can:

- View the case information presented in each component.
- Drill into each component to see the case list behind the single score.
- Navigate to individual records from the case lists.

From the CSM Landing Page (PA version), which includes analytics, agents can also:

- View a single score component.
- View a time series component.

  **Note:** There are no interactions for a time series component.
Create an Agent Workspace for CSM landing page

Create landing pages for different agents and teams by cloning the **CSM Landing Page** and adding or modifying components and visualizations.

Role required: admin

The **CSM Landing Page** is included with the CSM Workspace plugin (com.snc.agent_workspace.csm). You can add Performance Analytics information to this landing page by activating the Performance Analytics - Content Pack - Customer Service Management - Advanced plugin (com.snc.pa.customer_service_advanced). This plugin adds a section for **My Organization’s Performance**, which includes analytics for **CSAT** and **New vs Closed Cases**.

1. Navigate to **Agent Workspace > Landing Pages**.
2. Click the **CSM Landing Page**.
3. Click **Clone Page**.

   **Note:** The **Clone Page** action is available when the application scope is CSM workspace.

4. Fill out the form.

   The settings in the **Layout** and **Available Child Slots** fields determine how the content renders on the page.

   **Landing page attributes and layout**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of your landing page.</td>
</tr>
<tr>
<td>Component</td>
<td>The component defaults to sn-page and is read-only.</td>
</tr>
<tr>
<td>Page</td>
<td></td>
</tr>
<tr>
<td>Order</td>
<td>The order for the landing page. If you have multiple landing pages, the order determines the landing page precedence. Pages with a lower order value take precedence over pages with a higher order value.</td>
</tr>
<tr>
<td>Active</td>
<td>Determines whether the landing page is active. This field must be enabled for a landing page to be displayed.</td>
</tr>
<tr>
<td>Optional Page Title</td>
<td>A title to display on the page.</td>
</tr>
<tr>
<td>Available Child Slots</td>
<td>A predefined style of child slots.</td>
</tr>
<tr>
<td>Layout</td>
<td>The layout of the columns on the page.</td>
</tr>
</tbody>
</table>

5. Click **Update** to save your landing page.
6. Optional: Configure permissions for users to access the landing page.
   a) Click the **UX Page Element Permissions** related list.
   b) Click **New**.
   c) Select the role or group for the landing page to be visible.
   d) Click **Submit** to save your permissions.

Any page element (including sub elements) can have a restriction to a given set of roles or groups. If there are no element permissions set on roles or groups, then all users see the
element. If there are some element permissions set, then a user needs just one role or group assignment to see the element.

7. Configure a container:
   a) Click the **UX Page Elements** related list.
   b) Click **New Container** or select an existing container.
   c) Fill out the form.

### Container attributes and layout

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of your container.</td>
</tr>
<tr>
<td>Component</td>
<td>The component defaults to sn-page-container and is read-only.</td>
</tr>
<tr>
<td>Parent element</td>
<td>The landing page your container resides.</td>
</tr>
<tr>
<td>Slot</td>
<td>The component placement within the parent element's slot configuration.</td>
</tr>
<tr>
<td>Order</td>
<td>The order the page shows.</td>
</tr>
<tr>
<td>Border</td>
<td>Enable if you want a border around your container.</td>
</tr>
<tr>
<td>Optional Container Title</td>
<td>A title to display on the container.</td>
</tr>
<tr>
<td>Type</td>
<td>Select a type of styling for your visualization.</td>
</tr>
<tr>
<td>Available Child Slots</td>
<td>A predefined style of child slots.</td>
</tr>
<tr>
<td>Layout</td>
<td>The layout of the columns on the page.</td>
</tr>
</tbody>
</table>

8. Configure a widget:
   a) Click **New Visualization** or select an existing widget.
   b) Fill out the form.

### Widget attributes and layout

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of your widget.</td>
</tr>
<tr>
<td>Component</td>
<td>The component defaults to sn-page-widget-visualization and is read-only.</td>
</tr>
<tr>
<td>Parent element</td>
<td>The container that your widget resides in.</td>
</tr>
<tr>
<td>Slot</td>
<td>The component placement within the parent element's slot configuration.</td>
</tr>
<tr>
<td>Order</td>
<td>The order the component shows.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Report</td>
<td>Select the report you want to render:</td>
</tr>
<tr>
<td></td>
<td>- Single score</td>
</tr>
<tr>
<td></td>
<td>- Trend by</td>
</tr>
<tr>
<td></td>
<td>- List</td>
</tr>
<tr>
<td>Note:</td>
<td>Choose and populate either Report or PA Widget, but you cannot display both.</td>
</tr>
<tr>
<td>PA Widget</td>
<td>Select the PA widget you want to render:</td>
</tr>
<tr>
<td></td>
<td>- Single score</td>
</tr>
<tr>
<td></td>
<td>- Time series</td>
</tr>
<tr>
<td>Note:</td>
<td>Choose and populate either Report or PA Widget, but you cannot display both.</td>
</tr>
<tr>
<td>Optional Widget Label</td>
<td>A label to display on the widget.</td>
</tr>
<tr>
<td>Size Variant</td>
<td>Select the size of the widget. Choices include:</td>
</tr>
<tr>
<td></td>
<td>- Small</td>
</tr>
<tr>
<td></td>
<td>- Medium</td>
</tr>
<tr>
<td></td>
<td>- Large</td>
</tr>
<tr>
<td></td>
<td>- Extra Large</td>
</tr>
<tr>
<td>Note:</td>
<td>Not all size variants apply to all widgets.</td>
</tr>
<tr>
<td>Border</td>
<td>Check if you want a border around your widget.</td>
</tr>
<tr>
<td>Refresh Interval</td>
<td>Determines the number of minutes before a widget refreshes with new data.</td>
</tr>
<tr>
<td></td>
<td>The interval begins when a user navigates away from a landing page, and ends</td>
</tr>
<tr>
<td></td>
<td>when the user comes back to the landing page.</td>
</tr>
<tr>
<td>Note:</td>
<td>There is no auto-refresh, but a user can click a refresh button at any time.</td>
</tr>
<tr>
<td>Additional Details</td>
<td>Any additional information to note about the widget.</td>
</tr>
<tr>
<td>Visualization SysID (Read Only)</td>
<td>Designated ID for the widget.</td>
</tr>
<tr>
<td>Report Type (Read Only)</td>
<td>The type of report that renders.</td>
</tr>
</tbody>
</table>

9. Click **Update** or **Submit** to save changes to the page element.
10. Click **Update** to save changes to the landing page.
AWA for CSM overview

Use the ServiceNow® Advanced Work Assignment (AWA) for Customer Service Management feature to automatically assign work items to agents based on their availability, capacity, and skills. AWA for CSM pushes work to qualified agents using work item queues, routing conditions, and assignment criteria that you define. Agents see their assignments in their Agent Workspace inbox.

Plugins

You can activate the Advanced Work Assignment for CSM plugin (com.snc_csm.awa) if you have the admin role. Activating this plugin also activates the following plugins:

- Customer Service (com.sn_customerservice), which activates the CSM Workspace, Agent Chat, and Interactions plugins
- Advanced Work Assignment (com.glide.awa)

To use the chat feature with Advanced Work Assignment for CSM, you must also activate the Agent Chat plugin (com.glide.interaction.awa).

For more information, see Activate related plugins for Advanced Work Assignment.

Inbox layouts

Three chat inbox layouts are included with the Chat service channel.

<table>
<thead>
<tr>
<th>Chat Layout</th>
<th>Included Fields</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default Chat Layout</td>
<td>Short description</td>
</tr>
<tr>
<td>Contact Chat Layout</td>
<td>Short description, Contact, Account</td>
</tr>
<tr>
<td>Consumer Chat Layout</td>
<td>Short description, Consumer</td>
</tr>
</tbody>
</table>

Two case inbox layouts are included with the Case service channel.

<table>
<thead>
<tr>
<th>Case Layout</th>
<th>Included Fields</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default Case Layout</td>
<td>Short description, Contact, Account, Priority, Category</td>
</tr>
<tr>
<td>Consumer Case Layout</td>
<td>Short description, Consumer, Priority, Category</td>
</tr>
</tbody>
</table>

Form ribbon and components

The form ribbon provides agents with a quick overview of the case or incident details. The form ribbon includes components that display relevant information about the record, such as a contact or consumer summary, a timeline, and SLAs.

In addition to viewing case information, agents can use links in the ribbon components to place phone calls or create email messages. Agents can also show or hide the ribbon as needed.

With the workspace administrator role (workspace_admin), you can configure the ribbon layout, including the components to display in the ribbon, the order in which the components appear, and the component width. You can also configure display attributes for some of the components.
Customer Service Management ribbon components

For Customer Service Management, you can configure the ribbon for the Case form to include one or more of the available ribbon components:

- Customer 360
- Timeline
- Active SLAs

For more information about ribbon configuration, see Configure Agent Workspace ribbon settings.

For some of the components, you can also configure attributes, such as the fields to include in the Customer 360 component. For more information about configuring component attributes, see Configure ribbon component attributes.

Customer 360 ribbon component

The Customer 360 component displays customer information such as the contact or consumer name, email address, and phone numbers.

You can configure the Customer 360 component to display the following fields:

- Header:
  - For B2B customers: displays either the Primary Contact or Contact.
  - For B2C customers: displays the Consumer.
  - For internal contacts with the sn_customerservice.proxy_contact role: displays the Internal contact.

  Note: Requires the CSM Extension for Proxy Contacts (com.snc.csm_proxy_contacts) plugin.

- Photo
- Name
- Title
- Account (B2B customers)
- Phone numbers
For contacts: Mobile phone and Business phone
For consumers: Mobile phone and Home phone
Email address

Note: For B2B customers, the Customer 360 component can also include colored tags that indicate Very Important Person (VIP) accounts and escalated accounts.

From the Customer 360 ribbon component, agents can perform the following actions.

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Email a contact or consumer</td>
<td>Agents click the address in the Email field to send an email to the contact or consumer. This action opens a new email in the email editor with the following fields auto-populated:</td>
</tr>
<tr>
<td></td>
<td>• To: the contact or consumer email address</td>
</tr>
<tr>
<td></td>
<td>• Subject: the case number and short description</td>
</tr>
<tr>
<td>Call a contact or consumer</td>
<td>If phone integration is enabled, agents click a number in one of the phone number fields to call the contact or consumer. The OpenFrame window displays information about the contact or consumer name and the account.</td>
</tr>
<tr>
<td>View the account record</td>
<td>Agents click the Account link to open the account record.</td>
</tr>
</tbody>
</table>

Timeline ribbon component

The timeline component displays a summary of case activities, including case state changes and interactions between the fulfiller, typically the agent, and the requester. It also shows how much time that the fulfiller and requester spent on the case. The workspace administrator can select the fulfiller role when configuring the timeline component attributes.

Circles represent state changes and vertical bars represent agent and customer comments. The timeline shows how much time that the agent and customer spent on the case and uses color to show if the case is with the agent or the customer. Agents can point to activities in the timeline to display tooltips with additional information.
Active SLA component

The Active SLA component displays active SLAs for the case, including time remaining, the SLA state, and any breaches. If a case has multiple SLAs, the SLA with the most imminent deadline is shown first. Pointing to the SLA component displays left and right navigation arrows that agents can use to view the other SLAs.

SLA ribbon component

Color coding within the component indicates the time remaining for the SLA:

- Green: 0–50%
- Yellow: 50–75%
- Orange: 75–99%
- Red: 100% or breached

Configure ribbon component attributes

Configure attributes for the Customer 360 and timeline ribbon components.

Role required: workspace_admin

You can configure attributes for the following Customer Service Management ribbon components:

- **Customer 360**: displays customer information such as the contact or consumer name, email address, and phone numbers. This component includes fields for both a primary user and a secondary user. If the system does not find a valid primary user in the configured table, it then queries for the secondary user.

Note: With the CSM Extension for Proxy Contacts (com.snc.csm_proxy_contacts) plugin, a tertiary user, the internal contact, is also available.
- **Timeline**: displays a summary of case activities, including case state changes and interactions between the agent and the customer. It also shows how much time that the agent and customer, or requester, spent on the case. The timeline ribbon component uses the resolution shaper configuration for the selected entity table, for example, the Case table.

**Note**: If the Resolution Shaper Configs table (sys_resolutionshaper_config) does not have a record for the selected entity table, the timeline component displays a message that a configuration is not available.

1. Navigate to **Agent Workspace > Ribbon Settings** and then click the desired component.
2. To configure the Customer 360 component, click **Customer 360**, fill in the fields in the Ribbon Component Attributes section of the form, and click **Update**.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Primary user</td>
<td>The reference field from the table selected in the Table field that provides customer information for the primary user. For example, Contact.</td>
</tr>
<tr>
<td>Primary reference table</td>
<td>The table that stores information for the Primary user field.</td>
</tr>
<tr>
<td>Primary fields</td>
<td>The reference fields from the Primary reference table that provide additional information for the Primary user.</td>
</tr>
<tr>
<td>Secondary user</td>
<td>The reference field from the table selected in the Table field that provides customer information for the secondary user. For example, Consumer.</td>
</tr>
<tr>
<td>Secondary reference table</td>
<td>The table that stores information for the Secondary user field.</td>
</tr>
<tr>
<td>Secondary fields</td>
<td>The reference fields from the Secondary reference table that provide additional information for the Secondary user.</td>
</tr>
<tr>
<td>Tertiary user</td>
<td>The reference field from the table selected in the Table field that provides customer information for the tertiary user. For example, Internal contact.</td>
</tr>
<tr>
<td>Tertiary reference table</td>
<td>The table that stores information for the Tertiary user field.</td>
</tr>
<tr>
<td>Tertiary fields</td>
<td>The reference fields from the Tertiary reference table that provide additional information for the Tertiary user.</td>
</tr>
</tbody>
</table>

**Note**: The fields for the tertiary user are available with the CSM Extension for Proxy Contacts (com.snc.csm_proxy_contacts) plugin.

3. To configure the timeline component:
   a) Click **Timeline**.
   b) In the Ribbon Component Attributes section of the form, select a role in the **Fulfiller role** field.
All of the case activities that are performed by the user with the selected fulfiller role are displayed in the timeline component as from the fulfiller. The other case activities are displayed as from customers. For CSM, the default fulfiller role is sn_esm_agent.

The timeline ribbon component uses the resolution shaper configuration for the selected entity table. In this configuration, you can set the labels for the fulfiller and requester fields that appear in the timeline.

The **Fulfiller Label** on the Resolution Shaper Config form should match the timeline component **Fulfiller role** attribute. For example, if the **Fulfiller role** is set to **sn_esm_agent**, which is an agent role, the **Fulfiller Label** should refer to an agent.

For more information about the resolution shaper configuration, see [Customer service case timeline](#).

---

**Note:**
Changes that you make to the resolution shaper configuration affect both Agent Workspace and the platform interface.

---

**c) Click Update.**

### Agent Workspace for CSM form features

CSM Agent Workspace form features include form headers, agent actions by form, related lists, account hierarchy, and special handling notes.

#### Form headers

Form headers provide a quick glance of case, account, or contact information. Form headers include a primary header and several secondary or subheaders.

![Agent Workspace for CSM Case form header](image)

The workspace administrator can configure the information included in the header for the Case, Account, and Contact forms. For more information, see [Configure the form header for Agent Workspace](#).
<table>
<thead>
<tr>
<th>Form</th>
<th>Primary Header</th>
<th>Secondary Headers</th>
</tr>
</thead>
</table>
| Case   | Short description | • Account and contact (B2B)  
|        |                 | • Consumer (B2C)  
|        |                 | • Priority  
|        |                 | • State  
| Account| Account         | Primary contact  
| Contact| Contact         | Account  

**Agent actions by form**

Actions available to customer service agents appear in the form header as buttons or menu items. The CSM Workspace plugin (com.snc.agent_workspace.csm) provides the following actions for customer service agents.

**Note:** Actions must be enabled for each form in Agent Workspace by the workspace administrator. For more information, see [Enable UI actions for Agent Workspace](#).

<table>
<thead>
<tr>
<th>Form</th>
<th>Actions</th>
</tr>
</thead>
</table>
| Interaction| • Verify Contact  
|            | • Verify Consumer  
|            | • Create a case  
|            | • Create a consumer  

© 2019 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Form</th>
<th>Actions</th>
</tr>
</thead>
</table>
| Case        | • Assign to me  
              • Accept  
              • Update or Save  
              • Request Info  
              • Propose Solution  
              • Propose Major Case  
              • Escalate Case: available to agents with the sn_customerservice.escalation_requester role  
              • De-escalate Case: available to agents with the sn_customerservice.deescalation_requester role  
              • Create Incident: Requires the Customer Service with Service Management plugin (com.sn_cs_sm), available to agents with the itil role  
              • Create Normal Change: Requires the Customer Service with Service Management plugin (com.sn_cs_sm), available to agents with the itil role  
              • Create Problem: Requires the Customer Service with Service Management plugin (com.sn_cs_sm), available to agents with the itil role  
              • Create Request: Requires the Customer Service with Request Management plugin (com.sn_cs_sm_request), available to agents with the itil role  
              • Create Knowledge: This UI action requires the following actions:  
                  • Activate the Knowledge Management Advanced Installer plugin (com.snc.knowledge_advanced.installer)  
                  • Set the sn_customerservice.enable_knowledge_kcs property to true  
                  • Set the KCS Article template to true (navigate to Knowledge > Administration > Article Templates)  
              • Report Knowledge Gap  
              • Close Case, including:  
                  • Select a resolution code.  
                  • Enable a check box to automatically copy the resolution notes to the additional comments. |
| Account     | • Update account information  
              • Account Hierarchy  
              • Create Case |
| Contact     | • Update contact information  
              • Create Case |
| Consumer    | • Update consumer information  
              • Create a case for the consumer |
| Asset       | • Update asset information  
              • Create a case for the asset |
<p>| Product Model | • Create a case for the product model |</p>
<table>
<thead>
<tr>
<th>Form</th>
<th>Actions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Order</td>
<td>• Create a case for the order</td>
</tr>
<tr>
<td>Service Contract</td>
<td>• Create a case for the account</td>
</tr>
<tr>
<td>Entitlement</td>
<td>• Create a case for the account</td>
</tr>
</tbody>
</table>

**Related lists**

The following related lists are included on the Case form in CSM Agent Workspace. Clicking a record in a related list opens that record in a subtab.

- Details
- SLAs
- Tasks
- Interactions: stores the channel and direction of each interaction associated with the case, either inbound or outbound. This related list also appears on the Account, Contact, and Consumer entity records.
- Emails
- Task Skills
- Attached Knowledge
- Escalations
- Special Handling Notes List
- Requests
- Appointments
- Social Logs
- Blocked by

**Account Hierarchy**

From the Account form, customer service agents can click the open hierarchy icon ( ) in the Name field to see the parent-child account relationships in the Account Hierarchy pop-up window. The account hierarchy is available for accounts that have a parent or child account.
Agent Workspace for CSM Account Hierarchy pop-up window

The account hierarchy uses a tree structure to show the parent, child, and sibling accounts. The parent view displays the current account, the parent account (if applicable), and any child or sibling accounts. The full view displays the entire structure of the organization from the root account. The current account is highlighted in the account structure.

Customer service agents can:

- Expand and collapse the tree structure.
- Switch between the parent view and the full view of the account hierarchy.
- Click an account to open the Account form in a sub tab.

For information about creating an account hierarchy, see Account hierarchy.

Special handling notes

Special handling notes bring important information about individual records to the attention of the customer service agent. If special handling notes are available for a record, these notes are displayed in a pop-up window when the record is opened in CSM Agent Workspace.
Special Handling Notes

Notes are also available in the Special Handling Notes related list. Agents can see a priority, short description, and message for each note. Notes are ordered by priority and use different styles based on priority and type:

- Priority 1 — red
- Priority 2 — yellow
- Priority 3 — green
- Priority 4 — blue

Agents can:
- Dismiss individual notes. When all notes are dismissed, the pop-up window closes.
- Close the window.

In the Special Handling Notes module on the platform:
- Users with the sn_shn.admin role can configure special handling notes and specify properties.
- Users with the sn_shn.admin or sn_customerservice_manager roles can create special handling notes.
Configure service catalogs for Agent Workspace for CSM

Customer service agents use service catalogs to fulfill catalog item requests. You can configure the Service Workspace Portal to use the catalogs that contain the desired items.

Role required: sp_admin, admin

1. Navigate to Service Portal > Portals.
2. Click Service Workspace Portal.
3. Click the Catalogs related list and then click Edit.

   Note: If you are not able to edit the Catalogs related list, make sure you are in the Service Catalog - Service Workspace application.

4. Add the desired catalogs to the Catalogs list (for example, Customer Service).
5. Click Save.

   The catalog items belonging to the configured service catalogs are shown in Agent Workspace.

Using lookup and verify

The lookup and verify feature enables customer service agents to quickly look up contacts or consumers using information such as the name, phone number, or record number.

This feature simplifies the process of looking up and verifying contact or consumer information. Agents can use it as follows:

- If an interaction record is already populated with contact or consumer information from a chat or phone call, the agent can review the information and confirm that it is correct.
- If no customer or consumer information is available, the agent can search for this information, select and confirm the information, and populate the interaction record.

   Note: If this information has already been verified, such as through a customer portal login or authentication by Virtual Agent or by an IVR, the Verified check box on the interaction record is enabled.

Agents can use the Lookup Contact and Lookup Consumer buttons on the interaction record to access the search window. Agents can perform a type-ahead search across multiple configurable fields such as name, phone number, email address, and record number. From the search results list, agents can select a result to display detailed information for the contact or consumer in a verification card. Once verified, the system adds the information to the interaction record and enables the Verified check box.

Lookup and Verify plugin

Activate the CSM Lookup and Verify (com.snc.sn_csm_lookup_verify) plugin to enable the lookup and verify feature. This plugin provides the configuration for contact and consumer lookup as well as Lookup Contact and Lookup Consumer UI actions that can be added to the interaction record.

   Note: These actions are not enabled by default. The workspace admin can enable these actions as part of the lookup and verify feature configuration.
Contact and consumer configurations

Two lookup and verify configurations are provided with the feature, one for contacts and one for consumers. Navigate to Agent Workspace > Lookup and Verify > Configuration to access the Lookup and Verify Configurations list.

For each configuration, the workspace administrator can:
- Enable the configuration and display the related UI action on the interaction record.
- Enter the minimum number of characters to start the type-ahead search.
- Enter the maximum number of search results returned.
- Select the primary and secondary fields to include in the search results.
- Select the fields to display on the verification card.
- View the lookup tables.

Note: Customers can contact ServiceNow to make changes to the search fields.

Verify Contact and Verify Consumer pop-up windows

Agents search for contact or consumer information using the Verify Contact or Verify Consumer pop-up windows on the Interaction form. The search field provides type ahead search that displays results in a list and narrows the results as more characters are entered. Selecting a result from the list displays more detailed information about the contact or consumer in a verification card.

The search feature searches multiple configured fields such as name, account, phone number, and record number.
- For phone numbers and record numbers, it uses an "exact match" search.
- For other fields, it uses a "starts with" search.

Verification cards

After selecting a search result, detailed information about the contact or consumer is displayed in a verification card. From this card, the customer service agent can review and confirm the information by clicking Verified.

Tables

The CSM Lookup and Verify plugin adds the following tables:
- Lookup and Verify Configurations (sn_lookup_verify_config)
- Lookup Tables (sn_lookup_verify_search_on_table)

Look up and verify a contact or consumer

An agent can look up contact or consumer information from an interaction record, review and confirm the information, and then populate the information on the interaction record.

Role required: sn_customerservice_agent, sn_customerservice.consumer_agent, workspace_admin, admin
Agents can search for information such as name, phone number, email address, case number, or order number.

1. From the interaction record, click **Verify Contact** or **Verify Consumer**.
   This action brings up the corresponding Verify Contact or Verify Consumer pop-up window.

2. In the **Look up** field, enter information such as the first few letters of a first or last name or the first few digits of a phone or case number.
   This field uses a type-ahead search feature that displays results in a list and narrows the results as more characters are entered. Multiple display fields in the search results help to differentiate contacts. When searching for a record number, the contact or consumer associated with the record is returned in the search results.

   **Note:** Delete characters from the **Look up** field to clear the search results.

3. Select the desired result from the list.
   This action displays information about the selected contact or consumer in a verification card.

4. Select one of the following actions:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Click Verified.</strong></td>
<td>If the information is correct, click <strong>Verified</strong>. Selecting this option populates the following fields on the interaction record:</td>
</tr>
<tr>
<td></td>
<td>· For a contact, the <strong>Account</strong> and <strong>Contact</strong> fields are populated.</td>
</tr>
<tr>
<td></td>
<td>· For a consumer, the <strong>Consumer</strong> field is populated. Selecting this option also enables the <strong>Verified</strong> check box.</td>
</tr>
<tr>
<td><strong>Repeat the search.</strong></td>
<td>If the contact or consumer information is not correct, repeat steps 2 and 3 of this procedure.</td>
</tr>
<tr>
<td><strong>Click Cancel.</strong></td>
<td>Clicking <strong>Cancel</strong> closes the pop-up window. The information on the interaction record remains unchanged.</td>
</tr>
</tbody>
</table>

5. Optional: If necessary, click **Lookup Contact** or **Lookup Consumer** again and repeat the search by entering different search information in the **Look up** field.

6. **Click Save.**
   The system saves the interaction record and refreshes the related lists.

---

**Integration with Service Management applications**

Provides an integration between Customer Service Management and the Incident, Problem, Change, and Request Management applications.

Customer service agents with the itil role can create incident, problem, change, and request records from open cases in Agent Workspace.

**Create a request**

Agents can create one or more requests from a case. To create a request from a case in Agent Workspace:

1. **Select Create Request** from the Additional Actions menu to open a New Catalog Item tab.
2. Select the desired item from the catalog and click **Order now**.

3. Click **Checkout** on the Order Confirmation pop-up window.

The request number and some request information is displayed, with the option to view additional details or close the window. Clicking **View details** opens the request record.

Information about the request is added as follows:

- An update with the request number is added to the case work notes.
- The request record is added to the **Requests** related list.
- Updates to the **Additional comments** on the request record are copied to the case work notes.

**Create an incident**

Agents can create one incident from a case or associate one existing incident to a case. To create an incident from a case in Agent Workspace, select **Create Incident** from the Additional Actions menu to open an Incident record in a new tab.

The following information is copied from the case to the incident record:

<table>
<thead>
<tr>
<th>Case fields</th>
<th>Incident fields</th>
</tr>
</thead>
<tbody>
<tr>
<td>Short description</td>
<td>Short description</td>
</tr>
<tr>
<td>Default impact</td>
<td>Impact</td>
</tr>
<tr>
<td>Urgency</td>
<td>Urgency</td>
</tr>
<tr>
<td>Contact</td>
<td>Caller</td>
</tr>
<tr>
<td>Configuration item (if available)</td>
<td>Configuration item</td>
</tr>
</tbody>
</table>

Information about the incident is added as follows:

- An update with the incident number is added to the case work notes.
- The incident is added to the **Incident** field in the **Related Records** form section on the case form.
- Updates to the work notes on the incident are copied to the case work notes.

**Create a change**

Agents can create one change from a case or associate one existing change to a case. To create a change from a case in Agent Workspace, select **Create Normal Change** from the Additional Actions menu to open a Change record in a new tab.

The following information is copied from the case to the change record:

<table>
<thead>
<tr>
<th>Case fields</th>
<th>Change fields</th>
</tr>
</thead>
<tbody>
<tr>
<td>Short description</td>
<td>Short description</td>
</tr>
<tr>
<td>Description</td>
<td>Description</td>
</tr>
<tr>
<td>Impact</td>
<td>Impact</td>
</tr>
<tr>
<td>Urgency</td>
<td>Urgency</td>
</tr>
<tr>
<td>Priority</td>
<td>Priority</td>
</tr>
</tbody>
</table>
### Case fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Company</td>
<td>Company</td>
</tr>
<tr>
<td>Contact</td>
<td>Caller</td>
</tr>
<tr>
<td>Configuration item (if available)</td>
<td>Configuration item</td>
</tr>
</tbody>
</table>

**Note:** The change manager can update the configuration item on the change record. If the configuration item is not available, the agent can also manually update this information.

### Change fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Company</td>
<td>Company</td>
</tr>
<tr>
<td>Configuration item</td>
<td>Configuration item</td>
</tr>
</tbody>
</table>

### Information about the incident is added as follows:

- An update with the change number is added to the case work notes.
- The change is added to the **Change Request** field in the **Related Records** form section on the case form.
- Updates to the work notes on the change are copied to the case work notes.
- If a change is put on hold, the hold reason is also copied to the case work notes.

### Create a problem

Agents can create one problem from a case or associate one existing problem to a case. To create a problem from a case in Agent Workspace, select **Create Problem** from the Additional Actions menu to open a Problem record in a new tab.

The following information is copied from the case to the problem record:

<table>
<thead>
<tr>
<th>Case fields</th>
<th>Incident fields</th>
</tr>
</thead>
<tbody>
<tr>
<td>Short description</td>
<td>Problem statement</td>
</tr>
<tr>
<td>Impact</td>
<td>Impact</td>
</tr>
<tr>
<td>Urgency</td>
<td>Urgency</td>
</tr>
<tr>
<td>Priority</td>
<td>Priority</td>
</tr>
<tr>
<td>Company</td>
<td>Company</td>
</tr>
<tr>
<td>Configuration item (if available)</td>
<td>Configuration item (if blank on case, agent can manually update on problem record)</td>
</tr>
<tr>
<td>Case sys_id (if the com.snc.best_practice.problem.madrid plugin is activated)</td>
<td>First reported by</td>
</tr>
</tbody>
</table>

Information about the problem is added as follows:

- An update with the problem number is added to the case work notes.
- The problem is added to the **Problem** field in the **Related Records** form section on the case form.
- Updates to the work notes on the problem are copied to the case work notes.
Case action status in Agent Workspace for CSM

In Agent Workspace, customer service agents can use the case action status feature to easily identify cases that need attention.

Action Status column

This feature enables customer service agents to easily identify cases that need attention and quickly prioritize their work. Visual indicators in the Action Status column on the My Cases and My Open lists highlight case status:

- A blue indicator highlights cases that need attention, such as cases that have been updated by customers or internal users and are waiting for input or review.
- A red indicator highlights cases that are blocked, such as cases that have open related task records or are waiting for customer feedback. Blocked cases can have the following status:
  - Blocked by task
  - Blocked by customer
  - Blocked internally and by customer

In addition to the colored indicators, the Action Status column also displays a brief status message.

Blocked by related list

The case action status feature adds the Blocked by related list to the workspace view of the Case form. Blocking tasks for a case appear in this list. When the system adds a blocking task to a case, it also adds one of the following blocking reasons:

- Need information from the customer
- Need task resolution
- Need PRB workaround
- Other

**Note:** When a problem is associated with a case, the blocking reason is set to Needs task resolution. The agent can update this reason to Need PRB workaround if necessary.

When a blocking task is resolved:

- The Unblocked By field displays the user who performed the unblocking action.
- The Unblocked On field displays the date that the blocking task was resolved.
- The Needs Attention field for the case is enabled.

Notifications

Agents can receive notifications on their preferred channel when a blocking task for an assigned case is resolved. Agents can also receive notifications when the Needs Attention field for an assigned case is enabled.

**Note:** Notifications are not sent to the user who updated the record.
Users with the admin role can configure notification triggers by navigating to **Agent Workspace > Notification Triggers > Case Action Status Trigger.**

**Report a knowledge gap**

If you cannot find relevant knowledge articles that could help resolve a case, you can report a knowledge gap.

Role required: sn_customerservice_agent, sn_customerservice.consumer_agent, workspace_admin, admin

You can search for and attach knowledge articles to a case. If you cannot find any relevant articles, you can either create a knowledge article (if you have permission) or report a knowledge gap.

1. From the Case form, click the More UI Actions icon (***).
2. Click **Report Knowledge Gap.**
   This creates a new knowledge feedback task in a sub-tab. The short description from the case is copied to the **Description** field on the task.
3. Optional: Edit the task description.
4. Click **Save.**
   The knowledge feedback task is saved and added to the **Knowledge Gaps** related list.

**Respond to a community thread from a case**

For cases that are created from a community discussion, customer service agents can view and respond to the discussion in a new browser tab.

Role required: sn_customerservice_agent, sn_customerservice.consumer_agent, workspace_admin, admin

Cases that have been created from a community discussion have the **Channel** field set to Community.

1. Open a case that was created from a community discussion.
2. Click the More UI Actions icon (*** ) and select **Show Community Thread.**
   This UI action is only available if the **Channel** is Community.
3. View the community discussion in a new browser window and respond as necessary.

**Create a knowledge article from a customer service case**

Reuse information from a customer service case by creating knowledge articles from cases.

Role required: sn_customerservice_agent, sn_customerservice.consumer_agent, workspace_admin, admin

Your administrator must **enable creation of articles from customer service cases.**

1. From the Case form, click the More UI Actions icon (***).
2. Click **Create Knowledge Article.**
   This creates a new knowledge article in a sub-tab. By default, the new article is created from the KCS Article template. The following information is copied from the case to the knowledge article:
   - Short description
• Source
• Cause
• Close notes

3. In the **Knowledge base** field, enter the name of the knowledge base in which you want this article to display.
4. Optional: Edit the knowledge article.
5. Click **Save**.

### Open a knowledge article in a sub-tab

Search for a knowledge article in Agent Assist and then open the article in a sub-tab.

Role required: sn_customerservice_agent, sn_customerservice.consumer_agent, workspace_admin, admin

1. Open a customer service case.
2. In the Agent Assist panel, select an article from the default search or search for something specific using the search bar.
3. Click the article link to open the article in a new sub-tab of the parent case.

### Manage skills for a customer service case

Add or remove optional and mandatory skills for a customer service case.

Role required: sn_customerservice_agent, sn_customerservice.consumer_agent, workspace_admin, admin

Agents can also change a skill between mandatory and optional.

1. Open the desired case.
2. Click the **Task Skills** related list.
3. To create a new skill:
   a) Click **New**.
   b) Select a skill in the **Skill** field.
   c) If mandatory, click the **Mandatory** check box.
   d) Click **Save**.

4. To switch a skill between optional and mandatory:
   a) Click the desired skill.
   b) Enable or disable the **Mandatory** check box.
   c) Click **Save**.

### Components installed with Agent Workspace for CSM

Several types of components are installed with the Agent Workspace for CSM application.
Roles

The Workspace agent role (workspace_agent) is added to the Service Management agent (sn_esm_agent) role. The role is required to access Agent Workspace for CSM.

Form views

Customer service agents see forms in the CSM Workspace form view (workspace_csm), if they exist for certain record types. Otherwise, agents see forms in the Workspace form view.

Tables

In Agent Workspace for CSM, a number of Customer Service Management tables are provided with the Workspace and CSM Workspace view layouts.

Tables in Workspace view

Agent Workspace for CSM provides the Workspace view for the following tables:

- Case (sn_customerservice_case)
- Consumer (csm_consumer)
- Account (customer_account)
- Contact (customer_contact)
- Account Relationship (account_relationship)
- Asset (alm_asset)
- Contract (ast_contract)
- Product Model (cmdb_model)
- Entitlement (service_entitlement)
- Task (sn_customerservice_task)
- Appointments (sn_customerservice_appointment)
- Contact Relationship (sn_customerservice_contact_relationship)
- Escalation (sn_customerservice_escalation)
- Order (csm_order)
- Order Case (csm_order_case)
- Special Handling Notes (sn_shn_notes)
- Order Line Item (csm_order_line_item)
- Asset Contact (sn_customerservice_m2m_asset_contact)
- Account Team Member (sn_customerservice_team_member)
- Social Profiles table (sn_app_cs_social_social_profile)
- Social Logs table (sn_app_cs_social_social_log)
- Knowledge Applied to Tasks table (m2m_kb_task)

Tables in CSM Workspace view

Agent Workspace for CSM provides the CSM Workspace view (workspace_csm) for the following tables:

- Interaction (interaction)
- Location (cmn_location)
The CSM Workspace view for these tables is similar to the respective default platform interface view.

**Lists**

The list categories and filtered lists that have been configured for customer service agents in Agent Workspace for CSM.

<table>
<thead>
<tr>
<th>List Category</th>
<th>Filtered Lists</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cases</td>
<td>My Cases</td>
<td>Cases assigned to the customer service agent.</td>
</tr>
<tr>
<td></td>
<td>My Open</td>
<td>Open cases assigned to the customer service agent.</td>
</tr>
<tr>
<td></td>
<td>Unassigned for my groups</td>
<td>Cases that belong to any of the customer service agent's groups but have not been assigned to an agent.</td>
</tr>
<tr>
<td></td>
<td>All</td>
<td>All customer service cases.</td>
</tr>
<tr>
<td>Major Issue Management</td>
<td>Major Cases</td>
<td>Major cases that have been accepted.</td>
</tr>
<tr>
<td>Customer</td>
<td>Accounts</td>
<td>A list of customer accounts.</td>
</tr>
<tr>
<td></td>
<td>Partners</td>
<td>A list of partner accounts.</td>
</tr>
<tr>
<td></td>
<td>Contacts</td>
<td>A list of customer contacts.</td>
</tr>
<tr>
<td></td>
<td>Consumers</td>
<td>A list of consumers.</td>
</tr>
<tr>
<td>Interactions</td>
<td>My Interactions</td>
<td>Interactions that are assigned to the customer service agent (agent’s name appears in the Assigned to field on the interaction record).</td>
</tr>
<tr>
<td>Knowledge</td>
<td>My Knowledge Articles</td>
<td>Knowledge articles authored by the customer service agent (agent’s name appears in the Author field).</td>
</tr>
</tbody>
</table>

**Note:** This list appears in the list panel when the Knowledge Management Advanced Installer plugin (com.snc.knowledge_advanced.installer) is activated.

| Catalog Tasks          | Assigned to my groups   | Catalog tasks assigned to the current agent's groups.                       |

**Note:** Additional filtered lists appear in the list panel when a customer service agent also has the ITIL role.

**Mobile experience for Customer Service Management**

Manage customer service cases from a mobile device with the Customer Service Management mobile application. Stay connected and access information in real time to complete tasks quickly.

Customer service agents can use the Customer Service Management mobile application to review case details and quickly complete case tasks.
Note: The Customer Service Management mobile application supports product cases.

With the customer service agent role (sn_customerservice_agent), you can:
• Get a quick overview of your case load, including new cases, critical cases, and those that need attention.
• Accept and reassign cases.
• Add comments or work notes to cases.
• Review case details, activity stream, and related information such as SLAs, case tasks, and child cases.
• Edit case information such as priority.
• Propose major cases.
• Receive push notifications for assigned or updated cases.

With the system administrator role, you can configure the Customer Service Management mobile application in the following ways:

• Configure pages to display the desired data.
• Configure the functions associated with swipe actions and top menu actions.
• Configure and create push notifications.

**Activate the Customer Service Mobile plugin**

The Customer Service Management mobile application runs on the ServiceNow® mobile platform.

To use the Customer Service Management mobile application, activate the Customer Service Mobile plugin (com.sn_csm_mobile). This plugin activates the following plugins:

• Mobile Agent Native Client plugin (com.glide.sg.agent_native_client)
• Customer Service (com.sn_customerservice)
• Customer Service Case Action Status (com.sn.csm_action_status)

To provide support for major cases, you can activate the optional Major Issue Management plugin (com.sn_majorissue_mgt).

Once the Customer Service Management mobile application is activated and configured, agents can download the ServiceNow Agent mobile app on their mobile devices and access ServiceNow instances.

**Note:** You can activate the Customer Service Mobile plugin (com.sn_csm_mobile) from the Customer Service Management guided setup.

For more information, see [Activate a plugin](#).

**Customer Service mobile application overview**

Customer service agents can use the applet launcher and applets in the Customer Service mobile application to view notifications and manage customer service cases.

**Applet launchers**

Applet launchers serve as landing pages or home pages. When you log in to your instance, you see an applet launcher and the applets configured to display on that launcher. The system administrator configures the applet launcher and applets for the Customer Service Management mobile application.
Navigation bar

The navigation bar appears at the bottom of the mobile application screen. This bar includes the following tabs that you can use to access different applets and application launch pages:

- **Cases**: displays the main case page. Use this applet launcher to access case management functionality.
- **Notifications**: view a list of the notifications that have been pushed to the agent. Tap a notification in the list to see the details, then tap the details open the case.
- **Settings**: manage settings for the mobile application.

Applets and cards

Select an applet from the applet launcher screen. Each applet contains one or more screens used to display records that correspond to the applet function. The Active Cases applet, for example, displays a list of all active case records.

The cases in the list are displayed as cards, with the case status displayed at the top of the card. To use the cards:

- Swipe a card left or right to see the available actions, then tap the desired action.
- Tap a card to see the record details.
- In the detail view:
  - Tap the top menu to see additional actions, then tap the desired action.
  - Select the back button to return to the list.

Applets provide a filter option if there is more than one case in the list. When you tap the applet, you see a list of filters that you can use to narrow down the list of cases.

Agent applets

Customer service agents have access to the following set of applets.

<table>
<thead>
<tr>
<th>Applet</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>My Cases</td>
<td></td>
</tr>
<tr>
<td>Needs Attention Cases</td>
<td>Cases that are waiting for the agent to take action. Includes cases in the Open, Awaiting Info, and Resolved states.</td>
</tr>
<tr>
<td>Active Cases</td>
<td>Cases that are assigned to the agent. Includes cases Open, Awaiting Info, and Resolved states.</td>
</tr>
<tr>
<td>New Cases</td>
<td>Cases in the New state.</td>
</tr>
<tr>
<td>Active Critical Cases</td>
<td>Priority 1 cases in the Open, Awaiting Info, and Resolved states.</td>
</tr>
</tbody>
</table>

**Note**: Cases in these lists are sorted by the last updated date in descending order, with the most recent updated case displayed first.
Customer service card layout

In a list view, case cards display the following information:

- Case state
- Case number
- Short description
- Contact
- Account

In the major case list view, case cards display the following information:

- Major case state
- Case number
- Short description
- Account

Case form related lists

Customer service agents can access the following Case form related lists.

<table>
<thead>
<tr>
<th>Related list</th>
<th>Description</th>
</tr>
</thead>
</table>
| SLAs         | Displays a list of SLAs for a case. View the following information for SLAs included in this list:  
- Task  
- SLA Stage  
- SLA Definition  
- Actual Elapsed Percentage  
- Actual Elapsed Time  
  Note: Detail view is not available from the SLAs related list. |
| Child Cases  | Displays a list of child cases for a case. View the following information for child cases included in this list:  
- State  
- Case number  
- Short description  
- Account  
- Contact  
  Click a child case to view additional details on the Case form. |
<table>
<thead>
<tr>
<th>Related list</th>
<th>Description</th>
</tr>
</thead>
</table>
| Tasks        | Displays a list of case tasks. View the following information for case tasks included in this list:  
  - Number  
  - State  
  - Priority  
  - Subject  
  - Assigned to  

  **Note:** Detail view is not available from the Tasks related list.

---

**Notifications**

Agents can receive notifications in the Customer Service mobile application when cases are assigned, are commented, or need attention. The following notifications are available:

<table>
<thead>
<tr>
<th>Notification</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Case assignment</td>
<td>When a case is assigned to an agent by someone else, a notification is sent to the agent selected in the <strong>Assigned to</strong> field. The notification includes the case number, state, priority, and short description.</td>
</tr>
<tr>
<td>Case comments</td>
<td>When information is added to a case in the <strong>Additional comments</strong> or <strong>Work notes</strong> fields by someone other than the assigned agent, a notification is sent to the user selected in the <strong>Assigned to</strong> field. The notification includes the case number, priority, and short description.</td>
</tr>
<tr>
<td>Needs attention flag is checked</td>
<td>When the <strong>Needs attention</strong> flag is checked on the Case form, a notification is sent to the agent in the <strong>Assigned to</strong> field. The notification includes the case number, state, priority, and short description.</td>
</tr>
</tbody>
</table>

---

**Configure the Customer Service mobile application**

Configure the Customer Service mobile application and customize it for agents who use the application instance on their mobile devices.

Role required: admin

The Customer Service Mobile plugin (com.sn_csm_mobile) enables the Customer Service mobile application.

1. Navigate to **System Applications > Studio**.
2. In the **Select Application** pop-up window, click **Customer Service Mobile**.
   
   The Customer Service mobile application opens in the Studio, which is a guided app creator. For more information about using the Studio, see [Getting started with mobile app creation using the guided app creator](#).

3. Customize the application to display the desired applets and data and configure agent actions and notifications.
# Get started with the Customer Service mobile application

Use the ServiceNow Agent mobile app to access the Customer Service mobile application. Then log in to an instance and work on your customer service cases.

**Role required:** sn_customerservice_agent

1. Depending on your device, go to the Apple App Store or the Google Play Store and download the ServiceNow Agent mobile app.
2. **Log in to an instance.**
3. Tap **Customer Service** to open the application and display the applet launcher.
4. Use the following actions to manage your customer service cases.

<table>
<thead>
<tr>
<th>Agent task</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accept a case</td>
<td>Swipe left and tap <strong>Accept</strong>.</td>
<td>Accept a case that has been assigned to you.</td>
</tr>
<tr>
<td>Add comments to a case</td>
<td>• Swipe right and tap <strong>Add Comments</strong>.</td>
<td>Add information to the case <strong>Work Notes</strong> or <strong>Additional Comments</strong> fields.</td>
</tr>
<tr>
<td></td>
<td>• Tap the top menu and select <strong>Add Comments</strong>.</td>
<td></td>
</tr>
<tr>
<td>Assign a case to another agent</td>
<td>• Swipe left and tap <strong>Assign</strong>.</td>
<td>This action is available for unassigned cases. Select to display the <strong>Assignment Group</strong> and <strong>Assigned To</strong> fields and make the assignments.</td>
</tr>
<tr>
<td></td>
<td>• Tap the top menu and select <strong>Assign</strong>.</td>
<td></td>
</tr>
<tr>
<td>Assign a case to yourself</td>
<td>• Swipe left and tap <strong>Assign to me</strong>.</td>
<td>Assign an unassigned case to yourself.</td>
</tr>
<tr>
<td></td>
<td>• Tap the top menu and select <strong>Assign to me</strong>.</td>
<td></td>
</tr>
<tr>
<td>Close a case</td>
<td>Tap the top menu and select <strong>Close Case</strong>.</td>
<td>Select to display the <strong>Resolution Code</strong> and <strong>Resolution Notes</strong> fields, which are mandatory fields for completing this action. Enable the check box to add the resolution code to the <strong>Additional Comments</strong> field.</td>
</tr>
<tr>
<td>Agent task</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------</td>
<td>-----------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Edit a case                      | Tap the top menu and select **Edit Case**. | You can edit the following fields in the Case form:  
  - Short description  
  - Account  
  - Contact  
  - Needs attention  
  - Priority  
  - Product  
  - Asset  
  - Assignment group: selecting an assignment group clears the value in the **Assigned to** field.  
  - Assigned to: if a group is selected in the **Assignment group** field, the list of available users belong to that group. |
| Open a case                      | Tap the top menu and select **Open Case**. | Open a case and change the state from **Awaiting info** or **Resolved** to **Open**.                                                                                                                                                                                                                                                                                                     |
| Propose a case as a major case   | Tap the top menu and select **Propose Major Case**. | Propose a case as a major case candidate.  
  **Note:** This action is available if the Major Issue Management plugin is activated.                                                                                                                                                                                                                                                                               |
| Propose a solution for a case    | Tap the top menu and select **Propose Solution**. | Select to display the **Resolution Code** and **Resolution Notes** fields, which are mandatory fields for completing this action. Enable the check box to add the resolution code to the **Additional Comments** field.                                                                                                           |
| Reassign a case to another agent | Swipe left and tap **Reassign**.         | Available for assigned cases. Select to display the **Assignment Group** and **Assigned To** fields and change the assignments.                                                                                                                                                                                                                                       |
| Request more information         | • Swipe left and tap **Request Info**.  
  • Tap the top menu and select **Request Info**. | Add the request to the **Additional Comments** field.                                                                                                                                                                                                                                                                                                                                            |
Manage customer service cases

Customers service agents and managers can create and route cases; manage customer information and interactions; monitor case activity, including case status and SLAs; and work to resolve customer issues.

Manager tasks

Customer service managers oversee agents and agent groups, assign cases, maintain special handling notes, and manage customer account teams.

Assign a case from the workbench

Users with the customer service manager role can assign a case to an agent from the assignment workbench.

Role required: sn_customerservice_manager

1. Open a customer service case.
2. Click the Find Agents icon ( ) next to the Assigned to field to open the assignment workbench.
   
   If the case has an Assignment group, the agents from that group are listed on the workbench. If the case does not have an assigned group, no agents are displayed.

   **Note:** The state of the current record determines the availability of the Find Agents icon. The icon is available for records in the Open, Awaiting, and Cancelled states, and if the user has write access for the Assigned to field. The icon is not available for records in the New or Closed states or when the Assigned to field is read-only for the current user.

3. Optional: Select an assignment group from the Group list.

   The list of agents updates based on the selected group.

4. Optional: Add or remove skills from the Skills list.

   The selected skills appear in a list below this field. The Matching Skills column updates to reflect the selected skills.

   **Note:** Mandatory skills cannot be changed.

5. Optional: Sort the agents by clicking the column header for the desired matching criteria.
6. Select an agent by enabling the check box by the agent's name and then click Assign.
   
   The assignment workbench closes and the name of the selected agent appears in the Assigned to field on the Case form.

7. Click Update to save the agent assignment.

Create a special handling note

Create a special handling note for a record.

Role required: sn_shn.admin or sn_customerservice_manager

If users have the sn_customerservice_manager role, they can create a special handling note for a record.

1. Perform one of the following actions.
   - Navigate to the desired form and click the Create Special Handling Note related link.
   - Navigate to Special Handling Notes > Special Handling Notes and click New.
2. Fill in the fields, as necessary.

**Special Handling Notes form fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Short Description</td>
<td>A brief description of the note which is displayed in the Special Handling Notes list.</td>
</tr>
<tr>
<td>Message</td>
<td>The detailed content of the note.</td>
</tr>
<tr>
<td>Display as pop-up alert</td>
<td>Displays this note in the Special Handling Notes pop-up window.</td>
</tr>
<tr>
<td>Type</td>
<td>The type of special handling note:</td>
</tr>
<tr>
<td></td>
<td>- <strong>Standard</strong>: Create a note for a specific record, which you select in the Related record field.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Conditional</strong>: Create a note for multiple records which meet certain conditions. Select a Table name and then create Conditions.</td>
</tr>
<tr>
<td>Priority</td>
<td>The priority of the note:</td>
</tr>
<tr>
<td></td>
<td>- 1-Critical</td>
</tr>
<tr>
<td></td>
<td>- 2-High</td>
</tr>
<tr>
<td></td>
<td>- 3-Moderate</td>
</tr>
<tr>
<td></td>
<td>- 4-Low</td>
</tr>
<tr>
<td>Status</td>
<td>The status of the special handling note:</td>
</tr>
<tr>
<td></td>
<td>- <strong>1-Active</strong>: The note is active and appears in the Notes list or pop-up window.</td>
</tr>
<tr>
<td></td>
<td>- <strong>2-Inactive</strong>: The note is inactive and does not appear in the Notes list or pop-up window. Inactive notes are removed from the Notes list but can be seen by navigating to Special Handling Notes &gt; Special Handling Notes.</td>
</tr>
<tr>
<td></td>
<td>- <strong>3-Expired</strong>: The note has reached its expiration date.</td>
</tr>
<tr>
<td>Effective immediately</td>
<td>Check box to make the special notes effective immediately. The status is set to 1 - Active. Deselect this check box to display the Effective on field.</td>
</tr>
<tr>
<td>Effective on</td>
<td>The date on which the special notes become effective. Enter a date for the special notes to become effective and click Update. The status is set to 2 - Inactive until the date is reached.</td>
</tr>
</tbody>
</table>
**Expires on**
The date on which the note expires. Select a date from the calendar and click **Save**.

The **Deactivate Special Handling notes** scheduled job runs daily at midnight and checks all active alerts. If the notes have reached their expiration date, it sets the status to **Expired**.

The **Deactivate Special Handling notes** scheduled job also checks the **Effective on** field. If the status is active or inactive and the expiry date has been reached, it sets the status to **Expired**. If the status is inactive and the effective on date has been reached, it sets the status to **Active**.

**Related record**
The record for which this note is created. This field appears when you select **Standard** in the **Type** field.

If you access this form from the **Create Special Handling Notes** related link, the record number is automatically filled in.

To select a record, select a **Table name** and a **Document** from the pop-up window. The tables available for selection have been configured to use special handling notes.

**Table name**
The table that stores the entity for which the note is being created. This field appears when you select **Conditional** in the **Type** field.

The default is the first table which has been configured to use special handling notes.

After you select a table, a link is displayed with the number of matching records. This link is updated after you select one or more conditions. Click the link to display these records in a list.

**Conditions**
This field appears when you select **Conditional** in the **Type** field.

Use the buttons in this field to build one or more conditions on the selected table. A condition is made up of a selected field, an operator, and a value. Add conditions using the **AND** and **OR** buttons. Delete conditions by clicking the **Delete** button to the right of a condition.

3. Click **Submit**.

**Delete a special handling note**
Delete a special handling note for a record.

Role required: sn_customerservice_manager or sn_shn.admin
Users with the sn_customerservice_manager role can delete a special handling note for a record if they can delete a record for the underlying table.

1. **Navigate to Special Handling Notes > Special Handling Notes.**
   - You can also delete a note from the Special Handling Notes list on a form.
2. In the Special Handling Notes list, click the note to be deleted.
3. Click **Delete.**

---

### Delete a special handling note from a form

Delete a special handling note for a record from the Special Handling Notes list on the form.

Role required: sn_customerservice_manager or sn_shn.admin

Users with the sn_customerservice_manager role can delete a special handling note for a record if they can delete a record for the underlying table.

1. Navigate to an entity form.
2. In the Special Handling Notes list, click the red X to the left of the desired note.
   - Initially, the note remains in the Special Handling Notes list and the text of the note is crossed out. The note is removed from the list after the form is saved.
3. Click **Update.**

---

### Create a social media profile

Users with the customer service manager role can create a social media profile for an account, contact, or consumer.

Role required: sn_customerservice_manager or admin

1. Navigate to the **Social Profiles** related list on the desired entity form: Account, Contact, or Consumer.
2. Click **New.**
3. Fill in the fields on the Social Profile form, as appropriate.

<table>
<thead>
<tr>
<th>Field</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Channel</td>
<td>The social media channel for this profile. For example, Twitter or Facebook.</td>
</tr>
<tr>
<td>Social ID</td>
<td>The user’s name or handle for the selected social media channel.</td>
</tr>
<tr>
<td>Contact</td>
<td>If created from the Contact form, this field displays the name of the contact.</td>
</tr>
<tr>
<td>Consumer</td>
<td>If created from the Consumer form, this field displays the name of the consumer.</td>
</tr>
<tr>
<td>Account</td>
<td>If created from the Account form, this field displays the name of the account.</td>
</tr>
<tr>
<td>Profile URL</td>
<td>The link to the user’s social media account.</td>
</tr>
</tbody>
</table>

4. Click **Submit.**

---

### Create a social media log entry

Users with the customer service manager role can create a social media log entry for a case.

Role required: sn_customerservice_manager or admin
Only a manager or administrator can create an entry on the Social Logs related list, if necessary. The entries on this list are typically populated by the social integration tool.

1. Navigate to the desired Case form.
2. From the Social Logs related list, click New.
3. Fill in the fields on the Social Log form, as appropriate.

<table>
<thead>
<tr>
<th>Field</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Social Profile</td>
<td>The social profile for the customer contact or consumer.</td>
</tr>
<tr>
<td>Agent</td>
<td>The agent participating in the conversation.</td>
</tr>
<tr>
<td>Social URL</td>
<td>The URL for the social conversation. Clicking this URL opens the conversation in a new tab.</td>
</tr>
<tr>
<td>Document</td>
<td>The related case number.</td>
</tr>
<tr>
<td>Message</td>
<td>The details of the conversation.</td>
</tr>
</tbody>
</table>

4. Click Submit.

**Assign a team member to an account**

Assign a team member to an account by selecting the employee and the employee's role or responsibility.

Role required: sn_customerservice_manager or admin

The system administrator can assign a team member to an account from the Account Team Members related list on the Responsibility Definition form.

The customer service manager can assign a team member to an account from the Account Team Members related list on the account or partner record.

1. Navigate to Customer Service > Customer > Accounts or Partners.
2. Select an account.
3. From the Account Team Members related list, click New.
4. Fill in the fields on the Account Team Member form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Account</td>
<td>The account to which the user is assigned. If you are assigning a user from an account or partner record, this field is automatically filled in; otherwise, make a selection from the Accounts list.</td>
</tr>
<tr>
<td>Responsibility</td>
<td>The role or responsibility selected for this employee.</td>
</tr>
<tr>
<td>User</td>
<td>The employee selected to fulfill the role or responsibility.</td>
</tr>
</tbody>
</table>

5. Click Submit.

**View team members assigned to an account**

View the team members for a specific account.
Role required: sn_customerservice_agent, sn_customerservice_manager, or admin

1. Navigate to Customer Service > Customer > Accounts or Partners.
2. Select an account.
3. Select the Account Team Members related list.
   This list displays the employees who have been assigned to the team as well as their responsibilities.

**Add an agent to the chat support assignment group**

Agents must be added to the chat support assignment group before they can receive chat requests. This assignment group is used by the Customer Service Management chat communication channel to route chat requests.

Role required: sn_customerservice_manager or admin

1. Navigate to User Administration > Groups.
2. Select Customer Service Support.
3. In the Group Members related list, click Edit.
4. Select the agents that you want to receive chat requests, and move them to the Customer Service Support group members list.
5. Click Save.

**Agent tasks**

Customer service agents create cases, interact with customers, and work to resolve questions and issues. Agents have a number of tools that they can use to resolve and close cases.

**Create a customer service case**

Customer service agents and agent managers can create a case from the Customer Service Management application.

Role required: sn_customerservice_agent, sn_customerservice_manager, or admin

   You can also click New from the Customer Service Cases list or click the Create New Case related link on several of the entity forms.
2. Fill in as many fields on the Create Case form as you can.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>The automatically assigned case number.</td>
</tr>
<tr>
<td>Channel</td>
<td>The method by which the customer initiated contact and the case was opened.</td>
</tr>
<tr>
<td></td>
<td>• Web (default)</td>
</tr>
<tr>
<td></td>
<td>• Phone</td>
</tr>
<tr>
<td></td>
<td>• Email</td>
</tr>
<tr>
<td></td>
<td>• Chat</td>
</tr>
<tr>
<td></td>
<td>• Social</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Contact Local Time</td>
<td>The local time of the contact assigned to the case.</td>
</tr>
<tr>
<td></td>
<td>It is automatically filled according to the time zone set on the Contact form. If no time zone is set on the Contact form, it is filled according to the <strong>Contact Timezone</strong> set on the case itself.</td>
</tr>
<tr>
<td></td>
<td>If no time zone is set on the Contact form or in the case, the field is left blank and is read-only.</td>
</tr>
<tr>
<td></td>
<td>If a case is closed or canceled, the <strong>Contact Local Time</strong> field is hidden.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>Configure the form layout to add this field to the Case form.</td>
</tr>
<tr>
<td>Contact time zone</td>
<td>The contact time zone if the customer is working in a different time zone for the case. It overrides the Contact form time zone.</td>
</tr>
<tr>
<td></td>
<td>If no contact local time or contact time zone is set, the instance time zone is displayed.</td>
</tr>
<tr>
<td></td>
<td>Once the case is created, the field is read-only.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>Configure the form layout to add this field to the Case form.</td>
</tr>
<tr>
<td>Account</td>
<td>The name of the company associated with this case.</td>
</tr>
<tr>
<td></td>
<td>If you select a contact in the <strong>Contact</strong> field, this field is auto-filled if the account information is available in the contact record.</td>
</tr>
<tr>
<td>Contact</td>
<td>The name of the customer contact for this case.</td>
</tr>
<tr>
<td>Product</td>
<td>The product model of the asset. A model is a specific version or configuration of an asset (for example, Apple Mac Book Pro).</td>
</tr>
<tr>
<td></td>
<td>If you select an asset in the <strong>Asset</strong> field, this field is auto-filled if the associated product information is available in the asset record. A product may be associated with multiple assets.</td>
</tr>
<tr>
<td>Asset</td>
<td>The asset tag number or the serial number of the asset associated with this case.</td>
</tr>
<tr>
<td>Partner Contact</td>
<td>The name of the partner contact for this case.</td>
</tr>
<tr>
<td></td>
<td>If you select a partner in the <strong>Partner</strong> field, the list of available partner contacts is based on this selection.</td>
</tr>
</tbody>
</table>

© 2019 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Follow the sun</td>
<td>A check box to indicate that a case should be handed-off for global follow-up. If a customer enters additional comments on a <strong>Priority 1 - Critical</strong> or a <strong>Priority 2 - High</strong> case, or if the case is escalated, the flag is automatically selected. You can also manually select the check box. The activity stream on the case form is updated with any changes. <strong>Note:</strong> Enable the <strong>Follow the sun</strong> check box on the Customer Service case form by setting the value of the property <strong>sn_customerservice.FTS_flag_enabled</strong> to <strong>true</strong>. Configure the form layout to add this field to the Case form.</td>
</tr>
<tr>
<td>Short description</td>
<td>A brief description of the customer question, issue, or problem.</td>
</tr>
<tr>
<td>Opened</td>
<td>The date and time that the case was opened.</td>
</tr>
<tr>
<td>Priority</td>
<td>The assigned priority:&lt;br&gt;• 1 - Critical&lt;br&gt;• 2 - High&lt;br&gt;• 3 - Moderate&lt;br&gt;• 4 - Low (default)</td>
</tr>
<tr>
<td>Assignment group</td>
<td>The assigned customer service agent group.</td>
</tr>
<tr>
<td>Assigned to</td>
<td>The assigned agent. This field displays all users with the <strong>sn_customerservice_manager</strong> and <strong>sn_customerservice_agent</strong> roles. If a group is selected in the <strong>Assignment group</strong> field, the assigned agent must belong to this group.</td>
</tr>
<tr>
<td>Assigned on</td>
<td>The data and time when the case is assigned. This field is updated when a user is added or changed in the <strong>Assigned to</strong> field.</td>
</tr>
<tr>
<td>Contract</td>
<td>The contract number associated with this case. If you selected an asset in the <strong>Asset</strong> field, the <strong>Contract</strong> field displays those contracts that include a line item for that asset.</td>
</tr>
</tbody>
</table>
### Assign a customer service case

Assign a case to yourself or to another customer service agent.

Role required: sn_customerservice_agent, sn_customerservice_manager, or admin

The **Assign to me** button is only visible if the current user has the customer service agent role and is not already assigned to the case.

1. Open the desired case.
2. Assign the case to an agent.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assign the case to yourself.</td>
<td>Click <strong>Assign to me.</strong></td>
</tr>
<tr>
<td>Assign the case to another agent.</td>
<td>Select an agent in the <strong>Assigned to</strong> field.</td>
</tr>
</tbody>
</table>

The agent’s name appears in the **Assigned to** field. If the agent also belongs to an agent group, the group name appears in the **Assignment group** field.

### Respond to a customer chat request

Select a chat request from the chat queue and respond to a customer’s question or comment.

Role required: sn_customerservice_agent, sn_customerservice_manager, or admin

1. Navigate to **Connect > Connect Support**.
   The Connect workspace opens in a new tab.
2. Click the support tab of the Connect sidebar, indicated by a headset icon (_CODEC_). The support tab displays **Queues** to which you belong. It also displays your open support conversations under **Cases**. When a user starts a support conversation or an agent transfers a conversation to a queue, any agent who belongs to the associated queue can accept the conversation. An agent can also request to transfer a conversation directly to you.
3. Accept a conversation in one of the following ways.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Accept a conversation from a queue</strong></td>
<td>Under Queues, click <strong>Accept</strong> by the queue.</td>
</tr>
<tr>
<td></td>
<td>The conversation opens in the conversation pane and an entry appears in the <strong>Cases</strong> section of the sidebar.</td>
</tr>
</tbody>
</table>
Option | Description
--- | ---
Accept a transfer request | Under Cases, click Accept by a transfer request.

**Transfer request**

The conversation opens in the conversation pane. The agent who transferred the conversation can stay in the conversation.

4. **Respond to the user and help resolve the issue.**

   By default, your messages are added to the conversation record as comments and are visible to the user.

   If necessary, you can open a new customer service case or incident from the conversation to track the issue. You can also transfer the conversation to a different agent or queue, escalate the conversation to a higher priority queue.

**Respond to a consumer chat request**

Select a chat request from the chat queue and respond to a customer’s question or comment.

Role required: sn_customerservice_agent or sn_customerservice_manager

1. Navigate to **Collaborate > Connect Support**.
   The Connect workspace opens in a new tab.

2. Click the support tab of the Connect sidebar, indicated by a headset icon.
   The support tab displays Queues to which you belong. It also displays your open support conversations under Cases. When a consumer starts a support conversation or an agent transfers a conversation to a queue, any agent who belongs to the associated queue has the option to accept the conversation. An agent can also request to transfer a conversation directly to you.

3. Accept a conversation in one of the following ways.
   - Accept a conversation from a queue
   - Accept a transfer request

4. **Respond to the consumer and help resolve the issue.**

   By default, your messages are added to the conversation record as comments and are visible to the user.

   If necessary, you can open a new customer service case or incident from the conversation to track the issue. You can also transfer the conversation to a different agent or queue, escalate the conversation to a higher priority queue.
If necessary, you can open a new customer service case or incident from the conversation to track the issue. You can also transfer the conversation to a different agent or queue, or escalate the conversation to a higher priority queue. For more information, see Connect Support.

Create a customer service case from a chat

If a customer chat results in the need to open a case, create the case directly from the conversation.

Role required: sn_customerservice_agent or sn_customerservice_manager

When you create a customer service case from a support conversation, the system copies the conversation history to the case activity stream as comments and work notes. Future messages are tracked in the case as well.

1. Navigate to Connect > Connect Support.
   The Connect workspace opens in a new tab.
2. Click the support tab of the Connect sidebar, indicated by a headset icon.
3. Under Cases, open a customer service conversation.
4. At the bottom of the conversation, click the menu icon to open the Connect actions menu.
5. In the Connect actions menu, select Create Case.
   In the conversation tools area to the right of the conversation, a new case form opens in a record tab. The system automatically sets certain fields based on conversation details.
6. Complete the form as necessary and click Submit.
   Any comments or work notes in the record conversation appear as comments on the incident form. Work notes do not appear in the chat for the ESS user. The chat agent can select whether a message is a Comment or Work Note in the conversation.
   a) In the record conversation, by the text entry field, click the message type icon.

            ( ).

   b) Select Comment or Work Note.
   c) Enter a message.

   By default, record conversation messages are added as comments.

   Note: If you add an attachment to a record conversation, it is attached to the underlying record as well.

   The system automatically shares the record in the conversation, copies the conversation to the record activity stream, and references the record on the Chat Queue Entry (chat_queue_entry) table. Any new journal fields added to the record do not appear in the chat. The system also changes the document ID for the conversation to reference the incident number instead of the entry in the Chat Queue Entry table.

Create a consumer case from an anonymous chat

If an anonymous chat results in the need to create a consumer case, create the case directly from the conversation.

Role required: sn_customerservice.consumer_agent, sn_customerservice_manager, or admin
When you create a case from a support conversation, the system copies the conversation history to the case activity stream as comments and work notes. Future messages are tracked in the case as well.

1. Respond to an anonymous chat request.
2. Chat with the user to determine the issue.
3. At the bottom of the conversation, click the menu icon to open the Connect actions menu.
4. In the Connect actions menu, select Create Case for Guest.
   In the conversation tools area to the right of the conversation, a new case form opens in a record tab. The system automatically sets certain fields based on conversation details. For a case created from a guest user chat, the Short description field displays the initial chat request from the user.
5. Complete the form as necessary and click Submit.
   The system automatically shares the record in the conversation, copies the conversation to the record activity stream, and references the record on the Chat Queue Entry (chat_queue_entry) table.

Create a consumer record from an anonymous chat

If an anonymous chat results in the need to create a consumer record, create the record directly from the conversation.

Role required: sn_customerservice.consumer_agent, sn_customerservice_manager, or admin

1. Respond to an anonymous chat request.
2. Chat with the user to determine the issue.
3. At the bottom of the conversation, click the menu icon to open the Connect actions menu.
4. In the Connect actions menu, select Create Consumer and Case for Guest.
   In the conversation tools area to the right of the conversation, a new consumer form opens in a record tab. The system automatically sets certain fields based on conversation details. For a consumer record created from a guest user chat, the First name, Last name, and Email fields display information from the initial chat request.
   Selecting this option creates a consumer record using the information provided on the record producer and then associates the case with the newly created consumer. The Case form is also populated with the information provided on the record producer.
5. Complete the form as necessary and click Submit.

Create a work order for a customer service case

Create a work order as part of the case resolution process.

sn_customerservice_agent, sn_customerservice_manager, or admin

After a work order is created, it appears in the Work Orders related list on the case form. The case number is also referenced on the work order.

1. Open the desired case.
2. From the Work Orders related list, click New.
3. Fill in the fields on the Work Order form.
4. Click Update.

Create a consumer case from a chat

If a consumer chat results in the need to open a case, create the case directly from the conversation.
Role required: sn_customerservice.agent

When you create a case from a support conversation, the system copies the conversation history to the case activity stream as comments and work notes. Future messages are tracked in the case as well.

1. Navigate to Collaborate > Connect Support.
The Connect workspace opens in a new tab.

2. Click the support tab of the Connect sidebar, indicated by a headset icon.
The support tab displays Queues to which you belong. It also displays your open support conversations under Cases. When a consumer starts a support conversation or an agent transfers a conversation to a queue, any agent who belongs to the associated queue has the option to accept the conversation. An agent can also request to transfer a conversation directly to you.

3. Under Cases, open a consumer conversation.

4. At the bottom of the conversation, click the menu icon to open the Connect actions menu.

5. In the Connect actions menu, select Create Case.
   In the conversation tools area to the right of the conversation, a new case form opens in a record tab. The system automatically sets certain fields based on conversation details. (For a case created from a consumer chat, the Consumer field is filled in and the Short description field displays the initial chat request from the consumer.)

6. Complete the form as necessary and click Submit.
The system automatically shares the record in the conversation, copies the conversation to the record activity stream, and references the record on the Chat Queue Entry (chat_queue_entry) table.

Create a consumer record

Consumer service agents and managers can create a consumer record from the Customer Service Management application.

Role required: sn_customerservice.consumer_agent, sn_customerservice.manager or admin

1. Navigate to Customer Service > Customer > Consumers

2. Click New.

3. Fill in the fields on the Consumer form as necessary.

4. Fill in the fields on the Primary Address tab.
   A consumer can have multiple addresses but only one primary address. The primary address is stored in the Primary Address tab on the Consumer form and in the Addresses related list.

5. If desired, set any of the fields on the Preferences tab.

6. Click Submit.
   The record is added to the Consumers table (csm_consumer). The primary address is added to the Addresses related list and the Primary field is set to true.

Create additional consumer addresses

Consumers can have multiple addresses, including one primary address.

Role required: sn_customerservice.consumer_agent, sn_customerservice.manager, or admin

The primary address is stored in the Primary Address tab on the Consumer form and in the Addresses related list. When you fill in the fields in the Primary Address tab and click Submit, this information is added to the Addresses related list as the primary address, with the Primary field set to true. Any changes made to the Primary Address fields are also updated in the related list.

Note: A consumer can have only one primary address.
Other addresses, such as billing or shipping addresses, can be created and stored in the **Addresses** related list. For these other addresses, the **Primary** field is set to **false**.

1. Navigate to **Customer Service > Customer > Consumers**.
2. Click the number of the desired consumer.
3. In the **Addresses** related list, click **New**.
4. Fill in the fields on the Location form.
5. To denote this address as the primary address for the consumer, enable the **Primary** check box.
   - A consumer can have multiple addresses but only one primary address.
6. Click **Submit**.

### Manage a proactive case created from an alert

Identify customers and their corresponding install base items affected by the issue causing the alert. Resolve the proactive case as you would other customer service cases and use the major issue management process when multiple customers are affected.

**Role required:**
- sn_customerservice_agent
- sn_customerservice_manager can accept a case as a major case and creates child cases
- evt_mgmt_admin and evt_mgmt_operator have read-only access to a case created from an alert and can add work notes, as required.

This task describes how to manage a proactive case using Agent Workspace. You can also manage a proactive case using the Customer Service application in the Now Platform interface.

1. Navigate to **Agent Workspace > Agent Workspace Home > Lists > Cases**. Alternatively, accept a proactive case from your Agent Workspace inbox.
2. Click the case you want to work on.
3. You can perform the following actions from the Case form.

#### Case form

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Click <strong>Affected Install Base Items</strong>.</td>
<td>View accounts and their corresponding install base items affected by the alert.</td>
</tr>
<tr>
<td>Click <strong>Add or Remove</strong>.</td>
<td>Add or remove an affected install base item.</td>
</tr>
<tr>
<td>Click <strong>Details</strong>.</td>
<td>View the sold product associated to the case as well as the alert that the case was created from.</td>
</tr>
<tr>
<td>Click <strong>Propose Major Case</strong>.</td>
<td>Propose a major case when multiple customers are affected.</td>
</tr>
</tbody>
</table>

**Note:** If you don't see this option, click the More UI Actions icon (***).

---

© 2019 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
4. Resolve and close proactive cases in the same way as other customer service management cases.

Note: If an alert is closed, a case is not automatically closed.

Send email responses directly from cases

Respond to cases using options within a customer email thread instead of having to use an email client. This capability helps you save time and effort instead of having to address and send a separate email message.

Role required: sn_customerservice_agent

When you respond to a customer's email from within a case using the reply, reply all, and forward options, the content from previous conversation thread is included in the response. These options are available by default.

Note: Admins might have disabled this option if the business manager does not want you to interact with your customers directly.

1. Navigate to Customer Service > Cases > My Cases.
2. Select and open the case for which you want to send a response.
3. Click Reply to write a response to the customer.
4. Click the icon to Reply to All the customer email ids mentioned in the original email or Forward the email to any other email id not mentioned earlier.
5. Compose your email and click Send.

Responding to cases using predefined email quick messages

Predefined quick email messages help agents draft replies to a case quickly without having to enter most of the required information to save time and be more productive.

Business managers and admins: You can set up quick messages to predefine the content for replying to cases. For example, you can predefine personal greetings, disclaimers, providing more information, and signatures. You can also incorporate icons, business logos, pictures, HTML layout, and rich text format.

Note: You can configure quick messages so that only a certain user or a group can view them.

Agents: You can select predefined quick messages to quickly draft an email with relevant details auto-filled. The following example shows a sample agent email to a customer.
Sample customer email created with quick message

To compose emails with quick messages, see [Composing emails with quick messages](#).

**Create a request on behalf of a customer or consumer**

Customer service agents can create requests on behalf of customers from Agent Workspace or from the platform interface.

Role required: sn_customerservice_agent, sn_customerservice.consumer_agent

Customer service agents can browse the catalog and make a selection to create a request on behalf of a customer.
- From Agent Workspace, agents can create requests from case and interaction records.
- From the platform interface, agents can create requests from case records.

1. Open a customer service case.
2. To create a request, do one of the following:
   - Agent Workspace: Click the More UI Actions icon (three dots) and select Create Request.
   - Platform interface: Click the form context menu icon and select Create Request.
3. Select an item or a service from the catalog to display the item page.
4. Optional: Select the quantity.
5. To complete the request, do one of the following:

<table>
<thead>
<tr>
<th>Interface</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Agent Workspace</td>
<td>Complete these steps:</td>
</tr>
<tr>
<td></td>
<td>1. Click Order Now.</td>
</tr>
<tr>
<td></td>
<td>2. Add or change the information in these fields on the Order Confirmation pop-up window: Request for, Delivery information, Special instructions.</td>
</tr>
<tr>
<td></td>
<td>3. Click Checkout.</td>
</tr>
</tbody>
</table>

The system creates the request and displays the request number. Click View Details to open the request record.

<table>
<thead>
<tr>
<th>Platform interface</th>
<th>Click Order Now.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>The system creates the request and displays the request number. An information message provides a link to the case associated with the request.</td>
</tr>
</tbody>
</table>

6. From the Case form, click the Requests related list to see the requests associated with the case.

**Initiate a conference call from a case**

As part of resolving a customer service case, you can initiate a conference call between involved users.

Role required: sn_customerservice_agent, sn_customerservice_manager, admin

Customer service agents can initiate a conference call from a case and add participants, including on-call members of shift groups.

**Note:**

Notify must be set up before you can use Notify on task. Ensure there are Notify phone numbers (E.164 or short code) in number groups with phone call workflows. Also ensure the property glide.notify.task.phone_number is set to one of these Notify phone numbers.

1. Open the desired case.
2. Click the Start Conference Call related link. You can add individual participants, groups, or individual phone numbers.
Resolve cases with knowledge and community content

Enable agents to resolve a case more quickly by searching for information from the knowledge base and community and, if helpful, associating it to the case.

Role required: sn_customerservice_agent

The Case form displays contextual search results based on text entered in the Short Description field. These search results provide targeted knowledge articles, pinned articles, and community content to customer service agents.

Customer service agents can search for information that is related to a case when opening a case or in a case that is already open. If the search results in any related content, the agent can preview the content. If the information is relevant, the agent can mark it as helpful. Knowledge articles can be also attached to the case.

Note: By default, search results include knowledge articles, solved community questions and blogs, and pinned articles.

1. Navigate to Customer Service > Cases.
2. Perform one of the following actions.
   * Open a new case and start typing in the Short description field.
   * Open an existing case and click Related Search Results.

Any matching search results are displayed in the Related Search Results section. The content displayed depends on the permissions assigned to the agent in Knowledge and Communities.

3. Click one of the results to open the content in a pop-up window.
4. Perform any of the following optional steps.

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
</table>
| Attach a knowledge article to the case | 1. Click Attach next to the knowledge article you want to attach to the case.  
2. If you opened the knowledge article, click Attach to Case.  
The knowledge article is displayed in Activities as a work note and is visible only to customer service agents. A link to the article is also entered in the Additional comments field.  
3. To make the article visible to customers, click Post.  
Note: You cannot attach Social Q&A or Communities content to the Case form. |
| Mark the content as helpful for resolving the associated case | Click This helped. |
| Scroll to previous or next result | Use the arrow keys to scroll up to the previous or down to the next result. |

5. Perform one of the following actions.
   * If you opened a case, click Submit.  
   * If you updated an existing case, click Update.
Report a knowledge gap

If you cannot find relevant articles that could help resolve a case, you can report a knowledge gap.

Role required: sn_customerservice_agent, sn_customerservice_manager, or admin

You can search for and attach knowledge articles related to a case in a Case form. If you cannot find the relevant articles, you can create a knowledge article that could help resolve the case. If you do not have permissions to create an article, report a knowledge gap.

1. Navigate to Customer Service > Cases.
2. Open a case.
   You can search for existing knowledge articles or create a knowledge article to help resolve a case.
4. Provide details about the knowledge gap in the Description field.
5. Click Submit.
   A knowledge feedback task is created and is added to the Knowledge Gaps related list.

Work on a feedback task

Update a special handling note

Update a special handling note for a record.

Role required: sn_customerservice_agent, sn_customerservice_manager, sn_shn.editor, or sn_shn.admin

Users with the sn_customerservice_manager role can update a special handling note for a record if they can update a record for the underlying table.

1. Navigate to Special Handling Notes > Special Handling Notes.
   You can also update a note from the Special Handling Notes list on a form.
2. In the Special Handling Notes list, click the note to be updated.
3. Make any necessary changes to the fields on the Special Handling Notes form.
4. Click Update.

Close a customer service case

Close a case at any time, except when it is in the Resolved state.

Role required: sn_customerservice_agent, sn_customerservice_manager, or admin

After an agent proposes a solution for a case, the state changes to Resolved and the customer can either choose to accept or reject the solution. If accepted, the case is closed. If rejected, the state reverts to Open.

An agent or agent manager can close a case at any time, except when it is in the Resolved state, when only a customer can accept or reject the proposed solution. When an agent or agent manager closes a case, details must be included in the Resolution notes field.

1. Open the desired case.
2. Click the Resolution Information tab.
3. From the Resolution Code drop-down list, select the code that indicates the resolution state of the case.
4. Enter any information related to the closure in the Resolution notes field.
5. Click Close Case.
**Customer service satisfaction surveys**

Customers can complete a satisfaction survey when they accept a case solution or close a case from the Customer Service Portal.

When a customer accepts a proposed solution for a case by clicking **Accept Solution** on the case record or closes a case by clicking **Close Case**, they can access a satisfaction survey in the Customer Service Portal. Customers have the option of completing or skipping the survey.

If a customer is using the email communication channel, the system sends an email with a link to a customer satisfaction survey when an agent closes a case. The customer can click on this link to complete the survey.

**Note:** One survey can be generated per case. If a survey has already been generated for a case, a second survey cannot be generated even if a case is reopened and closed again.

The Customer Service application includes a default survey that you can customize as needed. To customize the default survey, navigate to **Survey > View Surveys** and select **Customer Service Satisfaction Survey** from the list of assessment metric types. To edit the default survey, open the survey and click the **Survey Designer** button.

You can also design your own survey using the survey designer tool. After designing a survey, be sure to select a condition for triggering the survey.

The Customer Service dashboard includes a Customer Satisfaction report that displays the survey results. You can also access the Customer Satisfaction report by navigating to **Reports > View/Run > Customer Satisfaction**.

**List and form views by agent role**

Users with either the customer agent role or the consumer agent role can see attributes specific to the end user on these Customer Service Management lists.

**List view**

<table>
<thead>
<tr>
<th>List</th>
<th>Columns displayed for customer agent</th>
<th>Columns displayed for consumer agent</th>
<th>Columns displayed for agent with both roles</th>
</tr>
</thead>
</table>
| Customer | • Number  
• Name  
• Phone  
• Primary Contact  
• City  
• Zip / Postal code  
• Updated |                                      |                                          |
| Consumer |                                      | • Number  
• Name  
• Mobile phone  
• City  
• Zip / Postal code  
• Updated |                                          |
<table>
<thead>
<tr>
<th>List</th>
<th>Columns displayed for customer agent</th>
<th>Columns displayed for consumer agent</th>
<th>Columns displayed for agent with both roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Case</td>
<td>• Number&lt;br&gt;• Short description&lt;br&gt;• Contact&lt;br&gt;• Account&lt;br&gt;• Channel&lt;br&gt;• State&lt;br&gt;• Priority&lt;br&gt;• Assigned to&lt;br&gt;• Updated</td>
<td>• Number&lt;br&gt;• Short description&lt;br&gt;• Consumer&lt;br&gt;• Channel&lt;br&gt;• State&lt;br&gt;• Priority&lt;br&gt;• Assigned to&lt;br&gt;• Updated</td>
<td>• Number&lt;br&gt;• Short description&lt;br&gt;• Contact&lt;br&gt;• Account&lt;br&gt;• Consumer&lt;br&gt;• Channel&lt;br&gt;• State&lt;br&gt;• Priority&lt;br&gt;• Assigned to&lt;br&gt;• Updated</td>
</tr>
<tr>
<td>Entitlement</td>
<td>• Name&lt;br&gt;• Contract&lt;br&gt;• Product&lt;br&gt;• Account&lt;br&gt;• Business Hours&lt;br&gt;• Remaining Units&lt;br&gt;• Start Date&lt;br&gt;• End Date</td>
<td>• Name&lt;br&gt;• Contract&lt;br&gt;• Product&lt;br&gt;• Consumer&lt;br&gt;• Business Hours&lt;br&gt;• Remaining Units&lt;br&gt;• Start Date&lt;br&gt;• End Date</td>
<td>• Name&lt;br&gt;• Contract&lt;br&gt;• Product&lt;br&gt;• Consumer&lt;br&gt;• Business Hours&lt;br&gt;• Remaining Units&lt;br&gt;• Start Date&lt;br&gt;• End Date</td>
</tr>
<tr>
<td>Asset</td>
<td>• Display name&lt;br&gt;• Account&lt;br&gt;• Primary Contact&lt;br&gt;• Serial number&lt;br&gt;• Model category</td>
<td>• Display name&lt;br&gt;• Consumer&lt;br&gt;• Serial number&lt;br&gt;• Model category</td>
<td>• Display name&lt;br&gt;• Account&lt;br&gt;• Primary Contact&lt;br&gt;• Serial number&lt;br&gt;• Model category</td>
</tr>
</tbody>
</table>

**Form view**

A user with either the customer agent role or the consumer agent role can see fields specific to the end user on these forms. If an agent has both roles, all of the fields are shown.

<table>
<thead>
<tr>
<th>Form</th>
<th>Fields displayed for customer agent</th>
<th>Displayed for consumer agent</th>
</tr>
</thead>
<tbody>
<tr>
<td>Case</td>
<td>Account&lt;br&gt;Contact</td>
<td>Consumer</td>
</tr>
<tr>
<td>Entitlement</td>
<td>Account&lt;br&gt;Contact</td>
<td>Consumer</td>
</tr>
<tr>
<td>Asset</td>
<td>Account&lt;br&gt;Primary Contact</td>
<td>Consumer</td>
</tr>
<tr>
<td>Service Contract</td>
<td>Account</td>
<td>Consumer</td>
</tr>
</tbody>
</table>
Additional Customer Service Management features

The Customer Service Management application has a number of additional features that you can use to manage customer service cases. Some of these features require plugin activation.

Predictive Intelligence for case management

Assist agents with case creation by requiring a minimum of information, such as the short description, and predicting values for the category, priority, and assignment group.

From either Agent Workspace or the platform interface, agents can use this feature when creating cases by providing the short description. Based on the information entered in the Short description field, the Predictive Intelligence feature predicts the category, priority, and assignment group, and routes the case to the correct queue.

Solution definitions

Predictive Intelligence includes solution definitions for Customer Service Management:

- CSM Case Categorization
- CSM Case Assignment
- CSM Case Prioritization

A solution definition predicts one or more output fields based on a configured input field. At least one solution definition must be active to use Predictive Intelligence with Customer Service Management.

Business rules

Predictive Intelligence also includes business rules for Customer Service Management:

- Default Case Based Prediction
- Update Prediction Results

Extension points

The Predictive Intelligence feature for Customer Service Management includes the CSMPredictionService extension point. This extension point contains a method that returns the following information:

- The list of solution definitions that are used to predict field values during case creation.
- The treatment of the predicted fields based on the values of the input fields.

The system administrator can use this extension point to customize the solution definitions.

Configure Predictive Intelligence for case management

Activate the Predictive Intelligence plugin and enable the related system property and client script to use Predictive Intelligence with Customer Service Management.

Role required: admin

1. Activate the Predictive Intelligence plugin (com.glide.platform_ml).
2. Enable the Enable/Disable the prediction for case property (\texttt{sn_customerservice.case.mlpredictor.enable}).
   a) Navigate to Customer Service > Administration > Properties.
   b) Enable the Enable/Disable the prediction for case check box.
   c) Click Save.

3. Enable the Predict Case Values client script.
   a) Navigate to System Definition > Client Scripts.
   b) Click Predict Case Values in the Client Scripts list.
   c) Enable the Active check box.
   d) Click Update.

Use Predictive Intelligence for case management

Agents can use Predictive Intelligence to predict values for configured fields when creating a customer service case.

Role required: sn_customerservice_agent, sn_customerservice_manager or admin

The Predictive Intelligence feature predicts values for the configured fields based on the short description when you create a case. If you update the case, the values for these fields are not predicted again.

1. Create a case.
2. Enter information in the Short description field and then tab to the next field.

   Based in this information, the system predicts the values for the Priority, Assignment group, and Category fields.

   

   \textbf{Note:} If the system cannot predict values based on the short description, these fields remain blank.

3. Optional: Change the values in the predicted fields if needed or enter values for fields where Predictive Intelligence has skipped prediction.

   The system does not overwrite user-entered values for the predicted fields.

Update cases with missing field predictions

View the list of open cases for which the prediction of category, priority, or assignment group was skipped by the Predictive Intelligence feature.

Role required: sn_customerservice_agent, sn_customerservice_manager or admin

In the event that Predictive Intelligence cannot predict one or more case attributes for a case, customer service agents and administrators can update this information after a case is created. For example, the short description might not include enough detail to make a prediction.

1. Navigate to Customer Service > Cases > Cases Skipped by Predictive Intelligence.
2. Select a case from the list.
3. Provide the missing information and click Update.
Customer Service case digests

Use the case digests feature to provide periodic updates and resolution information about high priority customer service cases to customers and internal stakeholders.

With this feature, you can send periodic case updates while a case is in progress using a case action summary. Once a case has been resolved, you can provide a post case review document that captures details about the issue, root cause, resolution, and preventive measures.

The case digests feature uses a configuration for case action summaries and post case reviews. The configuration determines the information from a customer service case that is captured as part of the case action summary or the post case review document. The configuration also identifies the template that is used to create the summaries and review documents.

Activate the Case Digests plugin

With the system administrator role, you can activate the Case Digests plugin (com.sn_csm_case_digest). This plugin activates the following plugins:

- Customer Service (com.sn_customerservice)
- Customer Service Document Template (com.sn_csm_doc_template)
- ServiceNow Document Viewer (com.snc.documentviewer)
- Targeted Communications (com.sn_publications)

For more information, see Activate a plugin.

Note: You can also activate the Case Digests plugin from the Customer Service Management guided setup.

Additional plugin information

The Case Digests feature uses the recipient lists feature from the Targeted Communications plugin (sn_publications).

When creating a case action summary record, users with the sn_esm_agent role can select a recipient list of the type Internal Users. Selecting the Publish to Case & Notify UI action on the Case Action Summary form sends an email notification to the users included in the selected recipient list.

Note: The Publish to Case & Notify UI action is available when a list has been selected in the Additional internal recipients field.

For more information, see Recipient lists.

Case action summaries

Use a case action summary to provide updates to customers and internal stakeholders while a case is in progress.

Customer service agents typically use case action summaries to communicate information about high priority cases and mass outage cases. Case action summaries can include both internal content and customer-visible information. The summaries available to customers include only the customer-visible information. The summaries available to internal users include both customer-visible information and internal content.

Customer service agents can:
• Create case action summaries for cases that are in progress.
• Preview summaries prior to publishing.
• Publish summaries to customers and internal stakeholders or publish to customers and send email notifications to internal stakeholders.
• Update and re-send summaries as needed.

Customer service agents use the **Send Case Action Summary** UI action to create a case action summary. This action creates a case action summary record and adds the record to the Related Records section on the Case form in the **Case Action Summary** field.

Customer service agents can preview a case action summary before publishing it to a case. In the preview, internal content appears after the customer-visible information and is identified with a message: **The following content is not visible to customers.**

When publishing a case action summary, agents have two options.

- **Publish to Case**: When an agent clicks the **Publish to Case** option, the system takes the following actions:
  - Adds the information from the customer-visible fields to the **Additional comments** field.
  - Adds the information from all fields to the **Work notes** field.

- **Publish to Case & Notify**: When an agent clicks the **Publish to Case & Notify** option, the system also sends an email notification with the case action summary to the internal users included in the recipient list selected in the **Additional internal recipients** field.

  **Note:** The **Publish to Case & Notify** UI action is available when a list has been selected in the **Additional internal recipients** field.

Closing a case automatically closes the corresponding case action summary.

**Post case reviews**

Use a post case review document to capture details about a resolved case, including a summary of the issue, affected assets, root cause, resolution, and any preventive measures.

Customer service agents use the **Create Post Case Review** UI action to create a post case review document. This action creates a case action summary record and adds the record to the Related Records section on the Case form in the **Post Case Review** field.

The configuration selected for post case review documents identifies the information from the customer service case that is captured and populated in post case review record. The configuration also specifies the template that the system uses to create the post case review document.

Before publishing a post case review document to a case, agents can preview the document and, if necessary, have it reviewed and approved. Agents can add an approval group or approval users to the Post Case Review record and then request approval. The system sends an email notification to the approvers with a link to the post case review document. The approvers can either approve the document or suggest changes by adding them to the **Work notes** field on the Post Case Review record.

When an agent publishes a post case review document, the system adds a link to a PDF of the document in the **Additional comments** field on the Case form. The system also adds the record to the Related Records section on the Case form in the **Post Case Review** field. If the document is available to customers, the link is visible from the Customer and Consumer Service Portals.

If a case is closed while the post case review document is in progress, agents can still update the **Additional comments** on the Case form with the post case review document link. Once a case is closed, the Post Case Review form displays a message that the associated case has been closed.

Customer service roles can perform the following actions for post case review documents.
<table>
<thead>
<tr>
<th>Role</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Customer service agent</td>
<td>• Create and preview one post case review document for a resolved case.</td>
</tr>
<tr>
<td></td>
<td>• Request approval using an optional approval workflow.</td>
</tr>
<tr>
<td></td>
<td>• Publish a post case review document to a case.</td>
</tr>
<tr>
<td></td>
<td>• Reopen and edit a published post case review document.</td>
</tr>
<tr>
<td>Customer service manager</td>
<td>Review, approve, and suggest changes to post case review documents.</td>
</tr>
<tr>
<td>Major issue manager</td>
<td>• Create and publish post case review documents for resolved major cases.</td>
</tr>
<tr>
<td></td>
<td>• Copy the documents to the associated child cases.</td>
</tr>
<tr>
<td>Customer</td>
<td>View post case review documents from the Customer and Consumer Service Portals.</td>
</tr>
</tbody>
</table>

**Post case reviews for major cases**

Customer service managers and major issue managers can create and publish post case review documents for resolved major cases. These documents capture the case data specified in the configuration but do not include account-specific information. The customer service manager can also copy a post case review document to the associated child cases. The system adds the account-specific information when it generates the document for each child case.

The system administrator can enable post case review documents for major cases by setting the `sn_customerservice.parent_child_case_sync` system property to true.

**Note:** Setting this property to true disables the Create Post Case Review UI action for child cases.

**Post case review record states**

Post case review records can be in a number of different states as they are created, approved, and published.

<table>
<thead>
<tr>
<th>State</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
<td>A case review record has been created but is not yet assigned to an agent.</td>
</tr>
<tr>
<td>In Progress</td>
<td>A case review record has been created and is assigned to an agent.</td>
</tr>
<tr>
<td>Awaiting Approval</td>
<td>An agent created a case review document from the case review record and sent it to one or more approvers.</td>
</tr>
<tr>
<td>Approved</td>
<td>The case review document has been approved by one or more approvers.</td>
</tr>
<tr>
<td>Closed</td>
<td>The case review record has been closed.</td>
</tr>
</tbody>
</table>
Post case review approvals
Enable an optional approval process for post case review documents.

In the case digest configuration, the system administrator can:

- Enable the approval process by selecting an approval workflow.
- Use a condition builder to define the conditions that determine the post case review documents that require approval.

One approval workflow, Post Case Review - Default Approval, is provided with the Case Digests plugin. This workflow reads the approvers from the Approval group and Approval Users fields on the Post Case Review form and sends an approval request notification to each user.

Approvers receive an email notification with a link to the post case review document. Approvers can either approve the document or suggest changes by adding them to the Work notes field on the Post Case Review form. The agent receives a notification when an approver approves the case review document or suggests changes.

- If the approver suggests changes, the agent can see the changes in the Work notes field.
- If the approver approves the document, the status of the post case review record changes to Approved.

Case action summary and post case review assignment rules

Use assignment rules to assign case action summaries and post case review documents to customer service agents.

The Case Digests plugin includes two assignment rules:

- Auto assign the CAS to case agent
- Auto assign the PCR to case agent

When an agent clicks either Send Case Action Summary or Create Post Case Review on a case record, the system creates the corresponding record and automatically assigns it to that agent.

The system administrator can modify these assignment rules or define different rules to assign case action summary and post case review records. The system populates the Assigned to field on the Case Action Summary or Post Case Review form with the user determined by the assignment rule. If there are no active assignment rules, the Assigned to field remains blank and the record can be assigned manually.

If using the provided assignment rules that auto assign the records to the same agent:

- The agent clicks Send Case Action Summary or Create Post Case Review on the Case form.
- The corresponding record opens with the agent's name in the Assigned to field.
- The record state is In Progress.

If using assignment rules that do not auto-assign the records to the same agent:

- The agent clicks Send Case Action Summary or Create Post Case Review on the Case form.
- The corresponding records are created but are not displayed.
- If assigned to another agent, the Assigned to field displays the agent's name and the state updates to In Progress.
- If unassigned, the record remains in the New state.

Create a document template

Create a template to use for generating case action summaries or post case review documents.

Role required: admin
Document templates identify the information to be included in case action summaries and post case review documents. Create a document template to select, organize, and format the content included in the generated documents. You can create a new template or modify an existing template. Two document templates, **CAS Template** and **PCR Template**, are included with the Case Digests plugin.

1. Navigate to **Case Digest > Administration > Document Templates**.
2. Click **New** to create a template.
   - You can also modify an existing template by clicking the template name and opening the template form.
3. Fill in the following fields on the CS Document Template form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The template name.</td>
</tr>
<tr>
<td>Table Name</td>
<td>The table that contains the fields to include in the document template.</td>
</tr>
<tr>
<td></td>
<td>- Case Action Summary (sn_csm_case_digest_cas)</td>
</tr>
<tr>
<td></td>
<td>- Post Case Review (sn_csm_case_digest_pcr)</td>
</tr>
<tr>
<td>Header Image</td>
<td>Click to add an image file to use in the document header.</td>
</tr>
<tr>
<td>Footer Text</td>
<td>Text to include in the document footer.</td>
</tr>
<tr>
<td>Header Position</td>
<td>The position of the image within the header:</td>
</tr>
<tr>
<td></td>
<td>- Left</td>
</tr>
<tr>
<td></td>
<td>- Center</td>
</tr>
<tr>
<td></td>
<td>- Right</td>
</tr>
<tr>
<td>Body</td>
<td>The content to include in the generated case action summary or post case review document. Add content by selecting fields from the table identified in the Table Name field. Selected fields are added to the text editor.</td>
</tr>
<tr>
<td>Internal content</td>
<td>The content in the case action summary that is for internal users only.</td>
</tr>
<tr>
<td></td>
<td>This field is available if the Case Action Summary table is selected in the Table name field.</td>
</tr>
</tbody>
</table>

4. Click **Submit** or **Update**.

**Create a case digest configuration**

Create case digest configurations to handle different types of case review processes.

Role required: admin

As part of creating a case digest configuration, you can define the specific information from a customer service case that needs to be captured as part of the review. Two configurations, **CAS Configuration** and **PCR Configuration**, are included with the Case Digests plugin.

1. Navigate to **Case Digest > Administration > Configuration**.
2. Click **New** to create a new configuration. You can also modify an existing configuration by clicking the configuration name and opening the configuration form.

3. Fill in the following fields on the Case Digest Configuration form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The configuration name.</td>
</tr>
<tr>
<td>Table name</td>
<td>The table that contains the fields to include in the configuration.</td>
</tr>
<tr>
<td></td>
<td>• Case Action Summary (sn_csm_case_digest_cas)</td>
</tr>
<tr>
<td></td>
<td>• Post Case Review (sn_csm_case_digest_pcr)</td>
</tr>
<tr>
<td>Order</td>
<td>Determine the order for the configuration. When multiple configurations match for a case, the configuration with the lowest order number is used.</td>
</tr>
<tr>
<td>Document template</td>
<td>Select a template to use when creating a case action summary from the Case Action Summary form or a post case review document from the Post Case Review form. You can select from a list of templates that have been defined for the table selected in the <strong>Table name</strong> field.</td>
</tr>
<tr>
<td>Case table</td>
<td>A read-only field that displays the Case (sn_customerservice_case) table.</td>
</tr>
<tr>
<td>Approval workflow</td>
<td>If using an optional approval workflow, select the workflow from the Workflow list.</td>
</tr>
<tr>
<td>Case condition</td>
<td>Use the condition builder to select the case conditions to which this configuration applies.</td>
</tr>
</tbody>
</table>

4. Click **Submit** or **Update**.

**Create a case digest table map**

Create a table map to configure the fields that are copied from the case record to the post case review or the case action summary records.

Role required: admin

Two table maps are included with the Case Digests plugin. The **PCR Map** uses the Case (sn_customerservice_case) table as the source table and the Post Case Review (sn_csm_case_digest_pcr) table as the target table. The **PCR Map** maps the following fields.

<table>
<thead>
<tr>
<th>Case field</th>
<th>Post Case Review field</th>
</tr>
</thead>
<tbody>
<tr>
<td>sys_id</td>
<td>Case number</td>
</tr>
<tr>
<td>Short description</td>
<td>Short description</td>
</tr>
<tr>
<td>Cause</td>
<td>Root Cause Analysis</td>
</tr>
<tr>
<td>Close notes</td>
<td>Solution provided</td>
</tr>
</tbody>
</table>
The **CAS Map** uses the Case (sn_customerservice_case) table as the source table and the Case Action Summary (sn_csm_case_digest_cas) table as the target table. The **CAS Map** maps the following fields:

<table>
<thead>
<tr>
<th>Case field</th>
<th>Case Action Summary field</th>
</tr>
</thead>
<tbody>
<tr>
<td>sys_id</td>
<td>Case number</td>
</tr>
<tr>
<td>Short description</td>
<td>Short description</td>
</tr>
</tbody>
</table>

1. To access the CSM Table Map list, navigate to `csm_table_map_list.do`.
2. Click **New** to create a new table map.
   You can also modify an existing table map by clicking the map name to open the map form.
3. Fill in the following fields on the CSM Table Map form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mapping name</td>
<td>The table map name.</td>
</tr>
<tr>
<td>Application</td>
<td>Read only. The application for this table map.</td>
</tr>
<tr>
<td>API Name</td>
<td>Read only. The API for this table map.</td>
</tr>
<tr>
<td>Advanced Field Mapping</td>
<td>Enables advanced field mapping.</td>
</tr>
<tr>
<td>Source Table</td>
<td>The source table for the map.</td>
</tr>
<tr>
<td>Target Table</td>
<td>The target table for the map.</td>
</tr>
<tr>
<td>Active</td>
<td>Enables the mapping from the source to the target tables.</td>
</tr>
<tr>
<td>Use Advanced Condition</td>
<td>Enables advanced condition mapping, which uses a script.</td>
</tr>
<tr>
<td>Advanced Condition</td>
<td>If enabled, add a script in the <strong>Advanced Condition</strong> field.</td>
</tr>
<tr>
<td>Conditions</td>
<td>The script to use if the <strong>Use Advanced Condition</strong> field is enabled.</td>
</tr>
<tr>
<td>Order</td>
<td>Order of priority for processing multiple matching map definitions simultaneously to resolve dependencies.</td>
</tr>
<tr>
<td></td>
<td>- If there is only one matching table map, the system uses that map.</td>
</tr>
<tr>
<td></td>
<td>- If there are multiple matching table maps with the same order, the system uses the map with the older created date.</td>
</tr>
<tr>
<td></td>
<td>- If there are multiple matching table maps with different orders, the system uses the map with the highest order.</td>
</tr>
</tbody>
</table>

4. Click **Submit**.
5. From the CSM Table Map list, select the table map created in step 2.
6. In the Basic Field Mapping form section, click **New**.
7. Select a **Source Field** and a **Target Field**.
8. Enable the **Active** check box.
9. Enter a number in the **Order** field.
10. Click **Submit**.
11. Repeat steps 7 through 10 for each field to be mapped.
12. Click **Update** on the CSM Table Map form.

### Create a case action summary

Create a case action summary for a customer service case.

**Role required:** sn_customerservice_agent, sn_customerservice_manager, or admin

You can send case action summaries for customer service cases that are in any states other than **New** or **Closed**.

After creating a case action summary, the record is added to the Case form in the Related Records form section. Closing a case automatically closes the corresponding case action summary.

1. Open a customer service case.
2. To create a case action summary, do one of the following:
   - Agent Workspace: Click the More UI Actions icon (*** ) and select **Send Case Action Summary**.
   - Platform interface: Click the form context menu icon and select **Send Case Action Summary**.

   This opens a new Case Action Summary form with a status of **In progress**. Depending on the table map configuration defined for the case action summary, some of the information from the case is copied to the Case Action Summary form. With the CAS Configuration, this includes the information from the **Short description** field.

   **Note:** The **Short description** field on the Case Action Summary form can be edited in the platform interface but cannot be edited in Agent Workspace.

3. In the Case Action Summary form, enter any necessary information in the following fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Additional internal recipients</td>
<td>Select a recipient list. When an agent clicks <strong>Publish to Case &amp; Notify</strong>, the system sends an email notification to the internal users in the selected list.</td>
</tr>
<tr>
<td>Short description</td>
<td>The short description from the case.</td>
</tr>
<tr>
<td>Case summary</td>
<td>A brief summary of the case.</td>
</tr>
<tr>
<td>Actions taken</td>
<td>Details about actions taken so far to resolve the case.</td>
</tr>
<tr>
<td>Next steps</td>
<td>The steps that the agent is planning to take in order to resolve the case. This field is not customer visible.</td>
</tr>
<tr>
<td>Internal notes</td>
<td>Other internal information that the agent wants to share regarding the case. This field is not customer visible.</td>
</tr>
</tbody>
</table>

4. Click **Preview** to generate the case action summary and view it in the Preview Document pop-up window.
5. Optional: Make any desired changes to the fields on the Case Action Summary form and click Preview again.

6. Click Update to save the changes to the case action summary.

7. Publish the case action summary using one of the following actions.

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Publish to Case</td>
<td>Updates the case with the case action summary.</td>
</tr>
<tr>
<td></td>
<td>• Information from the customer-visible fields on the case action summary is added to the Additional comments field on the Case form.</td>
</tr>
<tr>
<td></td>
<td>• Information from the case action summary is added to the Work notes field on the Case form.</td>
</tr>
<tr>
<td>Publish to Case &amp; Notify</td>
<td>Updates the case with the case action summary as described above and sends an email with the case action summary to the internal stakeholders in the recipient list selected in the Additional internal recipients field.</td>
</tr>
</tbody>
</table>

Note: The Publish to Case & Notify UI action is available when a list has been selected in the Additional internal recipients field.

Create a post case review

Create a post case review document for a resolved case that captures the configured case information.

Role required: sn_customerservice_agent, sn_customerservice_manager, or admin

You can create post case review documents for customer service product cases that are in the Resolved state. Creating a review document is a multi-step process that involves:

- Creating a post case review record from a case.
- Previewing the generated review document and making any corrections.
- Requesting approval, if necessary.
- Publishing the review document so that it is available to customers, internal stakeholders, or both.

You can create one post case review document per case. If this document has already been created, the Create Post Case Review menu option is not available. You can view and edit the post case review document from the Related Records form section.

If a case is closed while the post case review is in progress, you can still update the Additional comments field on the Case form with the Post Case Review document link. When the case is closed, the system displays a message about the case closure on the Post Case Review form.

1. Open a customer service case in the Resolved state.

2. To create a post case review record, do one of the following:

   - Agent Workspace: Click the More UI Actions icon (…) and select Create Post Case Review.
   
   - Platform interface: Click the form context menu icon and select Create Post Case Review.

3. In the Post Case Review form, enter any necessary information in the following fields.
Some information is copied from the Case form to the Post Case Review form, such as the short description and the resolution information.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>The automatically assigned post case review record number.</td>
</tr>
<tr>
<td>Case number</td>
<td>The case number from which this post case review record was created.</td>
</tr>
<tr>
<td>Assigned to</td>
<td>The agent assigned to the post case review record.</td>
</tr>
<tr>
<td>Commitment Date</td>
<td>The expected completion date of the post case review.</td>
</tr>
<tr>
<td>Assignment group</td>
<td>The group assigned to the post case review record.</td>
</tr>
<tr>
<td>Approval group</td>
<td>The group assigned to review and approve the post case review record.</td>
</tr>
<tr>
<td></td>
<td>This field is visible if an approval workflow is selected in the case digest configuration.</td>
</tr>
<tr>
<td>Approval users</td>
<td>The users assigned to review and approve the post case review record.</td>
</tr>
<tr>
<td></td>
<td>This field is visible if an approval workflow is selected in the case digest configuration.</td>
</tr>
<tr>
<td>Short description</td>
<td>Copied from the Short description field on the Case form.</td>
</tr>
<tr>
<td>Summary</td>
<td>A summary of the issue.</td>
</tr>
<tr>
<td>Symptoms</td>
<td>Specific symptoms or problems created by the issue.</td>
</tr>
<tr>
<td>Root Cause Analysis</td>
<td>Copied from the Cause field in the Resolution Information section on the Case form.</td>
</tr>
<tr>
<td>Solution Provided</td>
<td>Copied from the Resolution notes field in the Resolution Information section on the Case form.</td>
</tr>
<tr>
<td>Preventive Measures Taken</td>
<td>Any measures taken to prevent the issue from happening.</td>
</tr>
<tr>
<td>Work notes list</td>
<td>Internal users who receive a notification about this case when work notes are added.</td>
</tr>
<tr>
<td>Work notes</td>
<td>Information about how to resolve a customer service case, or steps taken to resolve it, if applicable.</td>
</tr>
<tr>
<td>Activities</td>
<td>Records all activity associated with this record.</td>
</tr>
</tbody>
</table>

4. Click **Preview** to generate the review document and view it in the Preview Document pop-up window.

5. Optional: Make any desired changes to the fields on the Post Case Review record and click **Preview** again.

You can edit the content in the Post Case Review record if the state is **New** or **In Progress**.

Clicking **Preview** creates a preview of the document with the latest record information.
6. Optional: If approval is required, complete the following steps:
   a) Add an Approval group.
   b) Add one or more Approval users.
   c) Click Request Approval.

You can request approval for a post case review document before sharing it with customers or internal stakeholders. When approval is requested, the status of the post case review moves to Awaiting Approval and the record is locked for edits.

An email is sent to the approvers with a link to the post case review document. The approvers can either approve the document or suggest changes by adding them to the Work notes field on the Post Case Review record. The agent receives a notification when an approver approves the case review document or suggests changes.

- If the approver suggests changes, the agent can see the changes in the Work notes field.
- If the approver approves the document, the status of the post case review record changes to Approved.

7. Click Save.
8. Click Publish to Case to update the case with the Post Case Review document.

The document is included as a link in the Additional comments field on the Case form. If the document is available to customers, the link is visible from the Customer and Consumer Service Portals.

---

Create a post case review for a major case

Create a post case review document for a resolved major case that captures the configured case information.

Role required: sn_customerservice_manager, sn_majorissue_mgt.major_issue_manager, or admin

You can create a post case review document for a resolved major case if the sn_customerservice.parent_child_case_sync is set to true.

---

**Note:** Setting this property to true disables the Create Post Case Review UI action for child cases.

---

1. Open a major case in the Resolved state.
2. Complete steps 2 through 7 in the Create a post case review topic.
3. Select one of the following options:
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Publish to Case</td>
<td>The system performs the following actions:</td>
</tr>
<tr>
<td></td>
<td>1. Syncs the child case PCR record with the parent case PCR record. (If the child case PCR record is not present, the system creates a new child case PCR record.) The following fields are synced:</td>
</tr>
<tr>
<td></td>
<td>• Assigned To</td>
</tr>
<tr>
<td></td>
<td>• Case Digest Configuration</td>
</tr>
<tr>
<td></td>
<td>• Short Description</td>
</tr>
<tr>
<td></td>
<td>• Root Cause Analysis</td>
</tr>
<tr>
<td></td>
<td>• Solution Provided</td>
</tr>
<tr>
<td></td>
<td>• Summary</td>
</tr>
<tr>
<td></td>
<td>• Symptoms</td>
</tr>
<tr>
<td></td>
<td>• Preventive Measures Taken</td>
</tr>
<tr>
<td></td>
<td>• Commitment Date</td>
</tr>
<tr>
<td></td>
<td>• Assignment Group</td>
</tr>
<tr>
<td></td>
<td>• State</td>
</tr>
<tr>
<td></td>
<td>• Approval Users</td>
</tr>
<tr>
<td></td>
<td>2. Generates a PDF document for all of the child case PCR records with customer-specific information.</td>
</tr>
<tr>
<td></td>
<td>3. Adds a link to the PCR document to the Additional Comments field on the child case form.</td>
</tr>
<tr>
<td>Copy to Child Cases</td>
<td>The system syncs the child case PCR record with the parent case PCR record. (If the child case PCR record is not present, the system creates a new child case PCR record.) The following fields are synced:</td>
</tr>
<tr>
<td></td>
<td>• Assigned To</td>
</tr>
<tr>
<td></td>
<td>• Case Digest Configuration</td>
</tr>
<tr>
<td></td>
<td>• Short Description</td>
</tr>
<tr>
<td></td>
<td>• Root Cause Analysis</td>
</tr>
<tr>
<td></td>
<td>• Solution Provided</td>
</tr>
<tr>
<td></td>
<td>• Summary</td>
</tr>
<tr>
<td></td>
<td>• Symptoms</td>
</tr>
<tr>
<td></td>
<td>• Preventive Measures Taken</td>
</tr>
<tr>
<td></td>
<td>• Commitment Date</td>
</tr>
<tr>
<td></td>
<td>• Assignment Group</td>
</tr>
<tr>
<td></td>
<td>• State</td>
</tr>
<tr>
<td></td>
<td>• Approval Users</td>
</tr>
</tbody>
</table>

Review and approve a post case review document

Review and approve a post case review document for a resolved case.

Role required: sn_customerservice_manager or admin

When a customer service agent creates a post case review document that requires an approval, the system sends an email notification to the list of approvers. This email contains the following information:
• A short description of the case and the agent assigned to the case.
• Links to the post case review and case records.
• A link to download the post case review document.
• Links to approve the document or suggest changes.

When a post case review record is in the **Awaiting Approval** state, approvers can access the **Approve** and **Suggest Changes** UI actions.

1. Click the link in the email to download the post case review document.
2. Review the document.
3. To suggest changes to the document:
   a) Click the link in the email to suggest changes. Alternately, click the link to open the post case review record and then click **Suggest Changes**.
   b) add the information in the **Work notes** field on the Post Case Review record.

4. To approve the document:
   • Click the link in the email to approve the document.
   • Click the link to open the post case review record and then click **Approve**.

The state of the post case review record changes to **Approved**.

**Re-open a post case review document**

Re-open an approved post case review document if you need to make changes or update information.

Role required: sn_customerservice_agent, sn_customerservice_manager, admin

1. Open a customer service case.
2. In the Related Records form section, access the record in the **Post Case Review** field.
3. Click **Re-open** on the Post Case Review form.
   The status of the record reverts to **In Progress**.
4. Make the necessary changes to the fields on the Post Case Review form.
5. Click **Preview** to generate the review document and view it in the Preview Document pop-up window.
6. Optional: Click **Request Approval**.
7. Click **Publish to Case**.

**Components installed with case digests**

Several types of components are installed with the Case Digests plugin.

**Tables**

The Case Digests plugin adds the following tables:

• Case Digest Configuration (sn_csm_case_digest_config)
• Case Digest (sn_csm_case_digest_task)
• Post Case Review (sn_csm_case_digest_pcr)
• Case Action Summary (sn_csm_case_digest_cas)

The Customer Service Document Template plugin adds the following table:
Extension points

The Case Digests plugin includes the following extension points. Customers can use these extension points to customize the publish action.

<table>
<thead>
<tr>
<th>Extension point</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_csm_case_digest.CASPublish</td>
<td>Use this extension point to alter the functionality of publishing a case action summary to a case.</td>
</tr>
<tr>
<td>sn_csm_case_digest.PCRPublish</td>
<td>Use this extension point to alter the functionality of publishing a post case review document to a case.</td>
</tr>
<tr>
<td>sn_csm_case_digest.MajorPCRPublish</td>
<td>Use this extension point to alter the functionality of publishing a post case review document to a major case.</td>
</tr>
</tbody>
</table>

Create cases as a proxy contact

The proxy contact role enables employees to create cases for customer accounts and contacts. Employees can also be proxy case contacts on behalf of customers.

Assign the proxy contact role (sn_customerservice.proxy_contact) to employees in your company who require access to CSM applications and functionality, but for whom the other CSM-specific roles are not a good fit.

**Note:** This role requires licensing for access to CSM applications.

Employees with the proxy contact role can do the following:

- Create cases on behalf of customers by email, phone, chat, Virtual Agent, and from the Customer Service Portal.
- Create requests on behalf of customers from the Customer Service Portal.

When creating a case, the employee can select a customer contact or a partner contact as the case contact. The employee is also added to the case as the internal contact.

From the Customer Service Portal, employees can do the following for the cases where they are the internal contact:

- View a list of cases.
- View case details.
- Add comments or attachments to a case.
- Accept or reject a case resolution.
- View a list of related work orders.
- Check the status of a case using Virtual Agent.

Customer service agents can create cases and designate an employee with the proxy contact role as the internal contact.

- From Agent Workspace, agents can create cases for employees from interaction records.
- From connect chat sessions with employees, agents can create cases that add the employee to the **internal contact** field on the Case form.
Plugin information

Activate the CSM Extension for Proxy Contacts (com.snc.csm_proxy_contacts) plugin to enable this feature. This plugin adds the following to Customer Service Management:

- The `sn_customerservice.proxy_contact` role.
- The `ProxyContactHelper` script include.
- The `Internal contact` field on the Case form.
- The `Opened for` field on the Interaction form.

**Note:** You need to configure the Interaction form to display the `Opened for` field and the Case form to display the `Internal contact` field.

Configure the Customer 360 ribbon component in Agent Workspace

With the workspace administrator role (workspace_admin), you can configure the Customer 360 ribbon component to display the internal contact for a case.

- If the `Contact` field (the primary field) is populated on the Case form, the Customer 360 component displays the contact information.
- If the `Consumer` field (the secondary field) is populated on the Case form, the Customer 360 component displays the consumer information.
- If the `Internal contact` field (the tertiary field) is populated on the Case form, and the `Contact` and `Consumer` fields do not contain any data, the Customer 360 component displays the internal contact (employee) information.

For more information about configuring the Customer 360 ribbon component, see [Configure ribbon component attributes](#).

Internal contact field on Case form

When an employee with the `sn_customerservice.proxy_contact` role creates a case for a customer account, the `Internal contact` field on the Case form is populated with the employee's name. This field determines case visibility for the employee. From the Customer Service Portal, employees can see cases that they have created and are identified as the internal contact.

**Note:** This field appears on the Case form in both the platform interface and Agent Workspace.

When an agent creates a case, they can select an employee with the `sn_customerservice.proxy_contact` role in the `Internal contact` field.

Creating a case from the Customer Service Portal

An employee with the proxy contact role can create a case for a customer from the Customer Service Portal. As part of creating a case, the employee:

- Selects an account.
- Selects a contact from the available contacts for the account.
- Selects an asset or product for the account.
- Enters a subject and description for the case.
When the case is created, the employee is added to the **Internal contact** on the Case form.

**Creating a case from an interaction record**

An agent can create a case for an employee by clicking **Create Case** on the Interaction form. On the resulting Case form, the **Internal contact** field:

- Is set to the value from the **Opened for** field if the employee has the proxy contact role.
- Remains blank if the user in the **Opened for** field does not have the proxy contact role.

**Creating a case via email**

Employees can create a case by sending an email to the inbound email address. When the email is received, the system checks to see if the user has the proxy contact role.

- If yes, the case is created and the employee is added to the **Internal contact** field. The content of the email is logged in the case activity stream.
- If no, the case is not created.

**Initiating a chat from the Customer Service Portal**

Employees with the proxy contact role can initiate a chat with an agent directly from the Customer Service Portal or using Virtual Agent. This creates a chat request card with the employee’s name in the agent’s inbox.

- **Agent Workspace**: when the agent accepts the chat, the interaction record displays the employee name in the **Opened for** field.
- **Platform**: when the agent accepts the chat and creates a case from the chat session, the employee name is added to the Case form in the **Internal contact** field.

**Check the status of a case using Virtual Agent**

Employees with the proxy contact role can use Virtual Agent to check the status of a case where they are the internal contact.

After logging in to the Customer Service Portal and initiating Virtual Agent, use the options available with the **Check Case Status** topic.

**Viewing work orders**

From the Customer Service Portal, employees with the sn_customerservice.proxy_contact role can see work orders for the cases where they are the internal contact. Employees can also add attachments to the work orders.

In the portal header, click **Support > Work Orders**.

**Employee notifications**

The system sends an email notification to the employee in the **Internal contact** field on the Case form when:
- The case is opened or closed.
- Comments are added to the case.

**Configure the AWA queues for the proxy contact role**

Modify the Advanced Work Assignment queues and add routing conditions that support the proxy contact role and the **internal contact** field on the Case form.

Role required: admin

Modify the following AWA queues:
- For the Case service channel: Customer Service Cases
- For the Chat service channel: Customer Service

1. Navigate to **Advanced Work Assignment > Queues**.
2. Select the **Customer Service Cases** queue.
3. In the **Work item routing condition** field, add the following OR condition: **Internal Contact is not empty**.
4. Click **Update**.
5. Select the **Customer Service** queue.
6. In the **Work item routing condition** field, add the following OR condition: **Roles is sn_customerservice.proxy_contact**.
7. Click **Update**.

**Case and account escalation**

Users with the escalation requester role can request and manage case and account escalations. Users with the de-escalator role can de-escalate cases and accounts.

You can use the escalation feature to highlight specific cases or accounts and raise awareness of important customer issues.

Escalating cases or accounts facilitates communication about an issue and enables users to track progress toward a resolution. An escalation provides increased attention to a customer issue and provides a way to track the progress made in resolving the issue. Escalation is an internal process that is not exposed to customers.

**Escalate a case or an account**

Users with the escalation requester role can escalate a case or account.

Role required: sn_customerservice.escalation_requester or sn_customerservice.deescalation_requester

1. Navigate to the desired case or account.
2. Click the **Escalate Case** or the **Escalate Account** related link.
3. Fill in the fields on the Escalation form, as needed.

**Escalation form fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>The number automatically assigned to the escalation request.</td>
</tr>
<tr>
<td>Source Record</td>
<td>The case or account for which escalation is requested.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Request Source</td>
<td>The source of the case escalation request:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Customer</strong></td>
</tr>
<tr>
<td></td>
<td>• <strong>Internal</strong></td>
</tr>
<tr>
<td>Reason</td>
<td>The reason for requesting the case escalation:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Inactivity</strong></td>
</tr>
<tr>
<td></td>
<td>• <strong>Lack of Progress</strong></td>
</tr>
<tr>
<td></td>
<td>• <strong>Customer Imposed Deadline</strong></td>
</tr>
<tr>
<td>Escalation Severity</td>
<td>The escalation severity associated with this escalation, which defines the severity level for the escalation and the color used to highlight the escalated record in the user interface.</td>
</tr>
<tr>
<td></td>
<td>• <strong>High Severity</strong>: escalated records are highlighted in red.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Medium Severity</strong>: escalated records are highlighted in orange.</td>
</tr>
<tr>
<td>Escalation Template</td>
<td>The escalation template selected by the user who requested the escalation.</td>
</tr>
<tr>
<td>Watch List</td>
<td>The watch list for this escalation record. The watch list includes users on the escalation template and any users that you add for this record. <strong>For account escalations, you can Add account team members to watch list.</strong></td>
</tr>
<tr>
<td>Assignment group</td>
<td>For account escalations, the assignment group for this account escalation.</td>
</tr>
<tr>
<td>Assigned to</td>
<td>For account escalations, the customer service agent assigned to this account.</td>
</tr>
<tr>
<td>Request By</td>
<td>The user who requested the escalation.</td>
</tr>
<tr>
<td>Escalation Justification</td>
<td>Additional information that explains why this escalation is needed.</td>
</tr>
</tbody>
</table>

4. **Click Submit.**

If the escalation template includes an approval workflow, the approvers review the escalation request and either approve or deny the request (provide a reason).

**Manage an escalated case or account**

Manage and document the progress for an escalation using the case or account escalation record.

Role required: sn_customerservice_agent or sn_customerservice.consumer_agent

Perform tasks such as changing the escalation severity (which may trigger a different SLA), update the escalation trend, add or remove users from the watch list, and add comments.

- **Case escalations**: When managing a case escalation, the customer service agent typically performs most of the problem resolution work directly in the case record and the escalation...
ServiceNow New York Customer Service Management

record is primarily used for status reporting purposes. For example, updating the escalation trend and comments to escalation stakeholders. All updates to the case escalation record are automatically replicated to the case record as work notes. The escalation SLA is also associated with the case record rather than the escalation record because that is where the agent provides regular updates.

- **Account escalations:** For account escalations, the escalation record takes on a more important role because account escalations are more serious and are often associated with multiple underlying cases. An account escalation is typically assigned to an account escalation manager who works closely with multiple case owners to resolve the customer escalation. The account escalation manager can consolidate the status across the underlying cases and provide regular updates using the escalation record. Therefore, the SLA is associated with the escalation record.

1. Navigate to the desired case or account escalation record.
2. Update the fields on the escalation form as needed.
3. Click **Update**.

### De-escalate a case or an account

Users with the de-escalation requester role can de-escalate cases or accounts when the cause of the escalation is resolved.

Role required: sn_customerservice.deescalation_requester

1. Navigate to the desired escalation record.
2. Click **De-escalate** in the form header. This opens the De-escalate Case pop-up window.
3. Enter the necessary information in the **De-escalation Justification** field.
4. Click **De-escalate** on the window. The state of the escalation record changes to Closed.

### Agent calendar

Customer service agents and field service technicians can use the agent calendar to see work schedules and assignments and also add personal events such as meetings or appointments.

The agent calendar provides a tool for maintaining different work schedules or shifts and assigning agents and technicians to shifts for specific time periods. The calendar has the flexibility to accommodate work schedules that are fixed or varied and shifts that rotate by week, month, or other patterns. The agent calendar administrator creates the calendar configuration, including a schedule configuration for each calendar user and the types of tasks to display on the calendar.

The schedule information stored in the agent calendar is used by other ServiceNow applications and features, such as the assignment workbench, central dispatch, and auto assignment. The assignment workbench uses agent availability, based on upcoming work schedules and personal time off, when evaluating predefined criteria and recommending agents for case assignment. Auto assignment in Service Management core applications, such as Field Service Management and Facilities Service Management, evaluate agent work schedules before assigning tasks.

The agent calendar administrator has access to the Agent Schedule menu in the application navigator. This menu includes the following modules:

- **Event Configuration:** create a configuration for each type of event or task displayed on the agent calendar.
- **Work Schedule:** create one or more work schedules for each calendar user.
- **Agent Personal Events**: create personal schedules for each agent and add events to those schedules.
- **Schedule**: create or modify schedules. For more information, see [Schedules](#).

### Viewing the calendar

Customer service agents and field service technicians with the agent_schedule_user role can access their personal calendars in the following ways:

- **Customer Service > My Schedule**
- **Field Service > Agent > My Schedule**

**Note:** The agent calendar is supported in the mobile application and the mobile web.
<table>
<thead>
<tr>
<th>Time</th>
<th>11 Sunday</th>
<th>12 Monday</th>
<th>13 Tuesday</th>
<th>14 Wednesday</th>
</tr>
</thead>
<tbody>
<tr>
<td>03:00</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>04:00</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>05:00</td>
<td></td>
<td></td>
<td></td>
<td>Inspect date</td>
</tr>
<tr>
<td>06:00</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>07:00</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>08:00</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>09:00</td>
<td>Meeting with team</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>10:00</td>
<td></td>
<td></td>
<td>Router replace</td>
<td></td>
</tr>
<tr>
<td>11:00</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>12:00</td>
<td></td>
<td></td>
<td>Demo dryrun</td>
<td></td>
</tr>
<tr>
<td>13:00</td>
<td>Inspect router</td>
<td></td>
<td></td>
<td>Failover config</td>
</tr>
<tr>
<td>14:00</td>
<td></td>
<td></td>
<td></td>
<td>Router cable check</td>
</tr>
<tr>
<td>15:00</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>16:00</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
The calendar can display a single day, a week, or a month. Buttons in the calendar header allow you to switch views as well as go backward or forward in time. An agent’s scheduled work hours are highlighted in gray and the current day is highlighted in blue. The agent calendar displays work or tasks assigned to the agent as well as personal events. Each type of event is displayed on the calendar using a different color.

Agents can add events to their calendars by double-clicking a specific time slot and entering the details in the New Event popup window or by clicking and dragging. Agents can also move events by dragging and dropping. Click an event to display a popup with event details and double-click an event to open the event record.

Plugins

The Agent Schedule plugin (com.snc.agent_schedule) is activated as part of the Customer Service Management and Field Service Management plugins.

Tables

The Agent Schedule plugin adds the following tables.

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Agent Work Schedule (agent_work_schedule)</td>
<td>Stores one or more work schedules for each agent, including the date range for the schedule and the schedule type.</td>
</tr>
<tr>
<td>Agent Personal Schedule (agent_events)</td>
<td>Stores personal calendar events for each agent, such as training, personal time off, or meetings.</td>
</tr>
<tr>
<td>Event Configuration (agent_schedule_task_config)</td>
<td>Stores a configuration for each type of task displayed on the agent calendar, such as case tasks or work order tasks.</td>
</tr>
<tr>
<td>Agent Schedule User Config (agent_schedule_user_pref)</td>
<td>Stores the agent’s personalization data for the calendar. A user configuration is created automatically when a user with the agent_schedule_user role accesses their personal calendar.</td>
</tr>
<tr>
<td>Agent Schedule Relationship (agent_schedule_task_config_rel_user_pref)</td>
<td>Stores the relationships between agent configurations and event configurations. Relationship entries are created automatically based on a user’s read access to the task tables selected in the event configurations.</td>
</tr>
<tr>
<td>Agent Schedule Definition Theme (agent_schedule_definition_theme)</td>
<td>Stores the colors used to display different types of tasks on the agent calendar.</td>
</tr>
</tbody>
</table>

User Roles

The Agent Schedule plugin adds the following user roles.
<table>
<thead>
<tr>
<th>Role</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Agent schedule administrator</td>
<td>Sets up the Agent Calendar configuration. Contains roles:</td>
</tr>
<tr>
<td>(agent_schedule_admin)</td>
<td>• agent_schedule_user</td>
</tr>
<tr>
<td></td>
<td>• schedule_admin</td>
</tr>
<tr>
<td>Agent schedule user</td>
<td>Allows customer service agents and field service technicians to access and</td>
</tr>
<tr>
<td>(agent_schedule_user)</td>
<td>update their personal calendars.</td>
</tr>
</tbody>
</table>

**Configure the agent calendar**

Users with the agent calendar administrator role can perform several calendar configuration tasks.

These tasks include:

- Creating one or more schedule configurations for each calendar user.
- Creating an event configuration for each type of event to display on the calendar.
- Creating a work schedule to assign to an agent.

If necessary, agent calendar administrators can create personal events for a calendar user although the users themselves typically perform these tasks.

*Create an event configuration for the agent calendar*

Create configurations for each type of entry displayed on the agent calendar. Entries could include case tasks, work order tasks, appointments, or schedule entries such as event types that you could track and manage on the team calendar.

Role required: agent_schedule_admin

The schedule entry uses the Schedule Span (cmn_schedule_span) table to store different types of events.

The following types of schedule entries for event type configurations are available by default:

- Event — Appointment
- Event — Excluded
- Event — Meeting
- Event — Phone
- Event — Time Off
- Event — Other

These configurations are inactive by default. You can activate a configuration by navigating to Agent Schedule > Event Configuration, selecting an event type configuration, and setting the Active field to true for one or more event configuration types you would like to activate. Each configuration displays as a separate event type on the team calendar.

1. Navigate to Agent Schedule > Event Configuration and perform one of the following actions:

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create a configuration from an existing</td>
<td>1. Select the desired configuration.</td>
</tr>
<tr>
<td>event configuration</td>
<td>2. Right-click the form header and click Insert and Stay.</td>
</tr>
<tr>
<td></td>
<td>A copy of the selected event type configuration is created.</td>
</tr>
</tbody>
</table>
To | Do this
---|---
Create a new event configuration | Click New.

2. Fill in the fields on the Event Configuration form, as necessary.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>A descriptive name for this configuration.</td>
</tr>
<tr>
<td>Config Label</td>
<td>Name displayed for this event in the agent calendar.</td>
</tr>
<tr>
<td>Color theme</td>
<td>Color used to display this type of schedule on the agent calendar.</td>
</tr>
</tbody>
</table>

Setup

- Setup method for this configuration.
  - Simple: use condition builder to set up this configuration.
  - Scripted: use advanced scripts to set up this configuration.

Table

The table where the tasks for this type of configuration are stored.

Filter

Use condition builder to create the desired conditions for the selected task type.

For example, the event configuration for Case Tasks includes a filter on the task State field to display only those tasks that are open.

User Field

A field from the Table that provides the user assigned to the task.

For example, the event configuration for Case Tasks uses the Assigned To field from the Task table (sn_customerservice_task). When a case task is assigned, it appears on the agent calendar for the user selected in this field.

Event type

Type of schedule entry.

Display Field

A field from the Table that provides the information to be displayed for this event type on the agent calendar.

For example, the event configuration for Case Tasks uses the Subject field from the Task table (sn_customerservice_task). When a case task is assigned, the subject of the task appears on the agent calendar.

Start Date Field

A field from Table that provides the start date for the task.

For example, the event configuration for Case Tasks uses the Expected start field from the Task table (sn_customerservice_task). When a case task is assigned, it appears on the agent calendar starting on the date and time specified in this field.

End Date Field

A field from the Table that provides the end date for the task.

For example, the event configuration for Case Tasks uses the Due date field from the Task table (sn_customerservice_task). When a case task is assigned, it appears on the agent calendar ending on the date and time specified in this field.

**Note:** Because the agent schedule administrator can select any fields from the Task Table for the Start Date Field and the End Date Field, it is possible that the end date may be earlier than the start date. In this event, the task is displayed on the agent calendar between the two points in time.
Create a work schedule for an agent or technician

Users with the agent schedule administrator role can create one or more work schedules for a customer service agent or a field service technician.

Role required: agent_schedule_admin

A work schedule includes a date range and a schedule type, such as day shift or evening shift. Agents and technicians can have multiple work schedules.

1. Navigate to Agent Schedule > Work Schedule.
2. Click New.
3. Fill in the fields on the Agent Work Schedule form, as necessary.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>From Date</td>
<td>The first day of the work schedule.</td>
</tr>
<tr>
<td>To Date</td>
<td>The last day of the work schedule.</td>
</tr>
<tr>
<td>User</td>
<td>The selected agent or technician.</td>
</tr>
<tr>
<td>Work Schedule</td>
<td>The selected schedule from the Schedules list.</td>
</tr>
</tbody>
</table>
| Type          | The type of work that the agent or technician is performing during this schedule:
   - Primary work
   - Other
   An agent can have only one primary schedule for a specific range of dates. Primary schedules cannot overlap. |

4. Click Submit.

Create a personal event for an agent or technician

Users with the agent schedule administrator role can create personal events that appear on an agent’s personal calendar.

Role required: agent_schedule_admin

Agents and technicians typically add personal events to their own calendars.

1. Navigate to Agent Schedule > Agent Personal Events.
2. Select the personal schedule for the desired agent.
3. In the Schedule Entries related list, click New.
4. Fill in the fields on the Schedule Entry form, as necessary.

**Schedule Entry form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the event.</td>
</tr>
</tbody>
</table>
| Type      | The type of event:  
  - Time off  
  - Appointment  
  - Meeting  
  - Phone call  
  - Excluded  
  - On call  
  - Time off - in approval  
  - Time off - rejected |
| Show as   | Show this event on the agent's personal calendar as one of the following:  
  - Busy  
  - Free  
  - Tentative  
  - On call  
  Select **Busy** to exclude the block of time from agent availability calculations for the auto assignment and the case assignment workbench. |
| When      | The start date and time of the personal event. |
| To        | The end date and time of the personal event. |
| All day   | Enable this check box if the event lasts all day. |
| Repeats   | Create a repeating event by selecting the frequency. Depending on the selection, other fields are required to complete the frequency information.  
  - Does not repeat  
  - Daily  
  - Every Weekday (Mon-Fri)  
  - Every Weekend (Sat, Sun)  
  - Every Mon, Wed, Fri  
  - Every Tue, Thu  
  - Weekly  
  - Monthly  
  - Yearly  
  Enter a number for the frequency of the repeated event.  
  For weekly events, select a day of the week. |
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Monthly type</td>
<td>For monthly events, select one of the following. These selections use the day and date in the When field as the basis for repetition.</td>
</tr>
<tr>
<td></td>
<td>• Day of the month</td>
</tr>
<tr>
<td></td>
<td>• Day of the week</td>
</tr>
<tr>
<td></td>
<td>• Last day of the month</td>
</tr>
<tr>
<td></td>
<td>• Last week of the month</td>
</tr>
<tr>
<td>Yearly type</td>
<td>For monthly events, select one of the following:</td>
</tr>
<tr>
<td></td>
<td>• Day of the year: this selection uses the day and date in the When field as the basis for repetition.</td>
</tr>
<tr>
<td></td>
<td>• Floating: for this selection, complete the Float week, Float day, and Float month fields.</td>
</tr>
<tr>
<td>Repeat until</td>
<td>Select a date for the end of the repeated event.</td>
</tr>
<tr>
<td>Float week</td>
<td>For a floating yearly repeating event, select the week.</td>
</tr>
<tr>
<td>Float day</td>
<td>For a floating yearly repeating event, select the day.</td>
</tr>
<tr>
<td>Float month</td>
<td>For a floating yearly repeating event, select the month.</td>
</tr>
</tbody>
</table>

5. Click Submit.

Create a schedule to use with the agent calendar
Users with the agent calendar administrator role can create a schedule to use with the agent calendar.

Role required: agent_schedule_admin
Creating a schedule for the agent calendar uses the schedule feature. For more information, see Schedules.
Schedules are configured with two types of records.

- Schedule records specify a time zone and a type of schedule and use one or more schedule entries. Schedule records are saved in the Schedule (cmn_schedule) table.
- Schedule entry records specify the time periods that are included or excluded from a schedule. Schedule entries are saved in the Schedule Entry (cmn_schedule_span) table.

1. Navigate to Agent Schedule > Schedule.
2. Click New.
3. Complete the fields on the Schedule form.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time Zone</td>
<td>Select the time zone for the schedule. If you select Floating, the time zone will be relative to whatever is accessing the item at any given time.</td>
</tr>
<tr>
<td>Parent</td>
<td>Select a parent schedule to constrain the new schedule.</td>
</tr>
<tr>
<td>Type</td>
<td>Enter a label that describes the purpose of the schedule. You can also use one of these system terms to determine how to process certain schedules:</td>
</tr>
<tr>
<td></td>
<td>• excluded: excludes time periods from SLA counts.</td>
</tr>
<tr>
<td></td>
<td>• maintenance: specifies time periods where change management activities are allowed. A schedule containing maintenance schedule entries cannot also contain blackout schedule entries.</td>
</tr>
<tr>
<td></td>
<td>• blackout: excludes time periods from change management schedules. A schedule containing blackout schedule entries cannot also contain maintenance schedule entries.</td>
</tr>
<tr>
<td>Description</td>
<td>(Optional) Describe the schedule.</td>
</tr>
</tbody>
</table>

**Note:** The Schedule form displays a warning message if there are no active entries defined for the current schedule. If your schedule is a child schedule that only contains exclusions, ignore the message because exclusions are non-active entries.

4. Right-click the header bar and click **Save**.

**Note:** If you create a schedule of type **maintenance** and save the record, a UI policy hides the **Type** field from the form. To view or change the value for the **Type** field, view the list of schedules rather than the schedule form and add the **Type** column if necessary. You can double-click the cell for the value in the **Type** column and modify from the list view.

5. Configure one or more schedule entries.

6. Click **Submit**.

**Use the agent calendar**

Users with the agent calendar user role can add events to their personal calendar and configure the calendar to show or hide different types of events.

**Add an event to the agent calendar**

Users with the agent schedule user role can add events to their personal calendar.

Role required: agent_schedule_user

1. Navigate to your calendar.
   - Customer Service > My Schedule
   - Field Service > Agent > My Schedule
2. Double-click a timeslot or click and drag over a timeslot on the calendar to open the New Event form.
3. Fill in the fields on the New Event form, as necessary.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the event.</td>
</tr>
<tr>
<td>Type</td>
<td>The type of event:</td>
</tr>
<tr>
<td></td>
<td>· Time off</td>
</tr>
<tr>
<td></td>
<td>· Appointment</td>
</tr>
<tr>
<td></td>
<td>· Meeting</td>
</tr>
<tr>
<td></td>
<td>· Phone call</td>
</tr>
<tr>
<td></td>
<td>· Excluded</td>
</tr>
<tr>
<td></td>
<td>· On call</td>
</tr>
<tr>
<td></td>
<td>· Time off - in approval</td>
</tr>
<tr>
<td></td>
<td>· Time off - rejected</td>
</tr>
<tr>
<td>Show as</td>
<td>Show this event on the agent’s personal calendar as one of the following:</td>
</tr>
<tr>
<td></td>
<td>· Busy</td>
</tr>
<tr>
<td></td>
<td>· Free</td>
</tr>
<tr>
<td></td>
<td>· Tentative</td>
</tr>
<tr>
<td></td>
<td>· On call</td>
</tr>
<tr>
<td></td>
<td>Select <strong>Busy</strong> to exclude the block of time from agent availability</td>
</tr>
<tr>
<td></td>
<td>calculations for the auto assignment and the case assignment workbench.</td>
</tr>
<tr>
<td>When</td>
<td>The start date and time of the personal event.</td>
</tr>
<tr>
<td>To</td>
<td>The end date and time of the personal event.</td>
</tr>
<tr>
<td>All day</td>
<td>Enable this check box if the event lasts all day.</td>
</tr>
<tr>
<td>Time zone</td>
<td><em>(Read only)</em> If an agent has selected a specific time zone in their user</td>
</tr>
<tr>
<td></td>
<td>profile, that time zone is displayed here and is used as the time zone</td>
</tr>
<tr>
<td></td>
<td>for this event. Subsequent changes to the <strong>Time zone</strong> field in the user</td>
</tr>
<tr>
<td></td>
<td>profile do not change the time zone designation for this event.</td>
</tr>
<tr>
<td></td>
<td><em>(Read only)</em> If an agent has selected a specific time zone in their user</td>
</tr>
<tr>
<td></td>
<td>profile, that time zone is displayed here and is used as the time zone</td>
</tr>
<tr>
<td></td>
<td>for this event. Subsequent changes to the <strong>Time zone</strong> field in the user</td>
</tr>
<tr>
<td></td>
<td>profile do not change the time zone designation for this event.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Repeats</td>
<td>Create a repeating event by selecting the frequency. Depending on the selection, other fields are required to complete the frequency information.</td>
</tr>
<tr>
<td></td>
<td>· Does not repeat</td>
</tr>
<tr>
<td></td>
<td>· Daily</td>
</tr>
<tr>
<td></td>
<td>· Every Weekday (Mon-Fri)</td>
</tr>
<tr>
<td></td>
<td>· Every Weekend (Sat, Sun)</td>
</tr>
<tr>
<td></td>
<td>· Every Mon, Wed, Fri</td>
</tr>
<tr>
<td></td>
<td>· Every Tue, Thu</td>
</tr>
<tr>
<td></td>
<td>· Weekly</td>
</tr>
<tr>
<td></td>
<td>· Monthly</td>
</tr>
<tr>
<td></td>
<td>· Yearly</td>
</tr>
<tr>
<td>Repeat every</td>
<td>Enter a number for the frequency of the repeated event.</td>
</tr>
<tr>
<td>Repeat on</td>
<td>For weekly events, select a day of the week.</td>
</tr>
<tr>
<td>Monthly type</td>
<td>For monthly events, select one of the following. These selections use the day and date in the When field as the basis for repetition.</td>
</tr>
<tr>
<td></td>
<td>· Day of the month</td>
</tr>
<tr>
<td></td>
<td>· Day of the week</td>
</tr>
<tr>
<td></td>
<td>· Last day of the month</td>
</tr>
<tr>
<td></td>
<td>· Last week of the month</td>
</tr>
<tr>
<td>Yearly type</td>
<td>For monthly events, select one of the following:</td>
</tr>
<tr>
<td></td>
<td>· Day of the year: this selection uses the day and date in the When field as the basis for repetition.</td>
</tr>
<tr>
<td></td>
<td>· Floating: for this selection, complete the Float week, Float day, and Float month fields.</td>
</tr>
<tr>
<td>Repeat until</td>
<td>Select a date for the end of the repeated event.</td>
</tr>
<tr>
<td>Float week</td>
<td>For a floating yearly repeating event, select the week.</td>
</tr>
<tr>
<td>Float day</td>
<td>For a floating yearly repeating event, select the day.</td>
</tr>
<tr>
<td>Float month</td>
<td>For a floating yearly repeating event, select the month.</td>
</tr>
</tbody>
</table>

4. **Click Submit.**
   The new event appears on the agent calendar and also in the Schedule Entries related list on the Agent Personal Schedule form.

*Move an event on the agent calendar*

Users with the agent schedule user role can move events on their personal calendar.
Role required: agent_schedule_user

1. Navigate to your calendar.
   - Customer Service > My Schedule
   - Field Service > Agent > My Schedule

2. Use one of the following methods to move an event.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Click an event and drag it to a new day or time</td>
<td>The When and To fields in the event record are updated with the new information.</td>
</tr>
<tr>
<td>Double-click an event to open the event record</td>
<td>Change the date and time information in the When and To fields and click Submit. The event appears on the calendar in the new location.</td>
</tr>
</tbody>
</table>

Show or hide event types on the agent calendar

Users with the agent schedule user role can personalize their calendar and show or hide different types of events.

Role required: agent_schedule_user

1. Navigate to your calendar.
   - Customer Service > My Schedule
   - Field Service > Agent > My Schedule

2. Click the configuration icon in the calendar header to display the Schedule Configuration menu.

3. Enable or disable the switches for the different types of events.
   An option is enabled when the switch is moved to the right and appears with a green background.

4. Click the configuration icon again to hide the Schedule Configuration menu.
   The calendar displays the enabled task types.

Similar case recommendations

The similar case recommendation feature enables customer service agents to easily find similar cases that can provide helpful information about a current case. This feature can also provide recommendations about cases that may be related to major issues.

The similar case recommendation feature uses the following components:

Additional search resources for contextual search

Additional search resources are provided for contextual search. These additional resources enable customer service agents to search open or resolved cases for information related to the current case.

Predictive Intelligence similarity solution definitions

Several of the additional search resources have an associated Machine Learning (ML) similarity solution definition. These additional resources perform a contextual search based on the case short description and return a list of similar records.

Predictive Intelligence in Agent Workspace

Predictive Intelligence can provide agents with a list of cases that are similar to the current case. These similar cases may provide helpful details or resolution information for the current case.
Predictive Intelligence can also provide recommendations about potential major issues and major cases.

With the similar case/recommendation feature, customer service agents can:
- Find cases that are similar to the current case.
- Copy resolution notes and codes from resolved cases to the current case.
- Link the current case to a similar case.
- View a list of open cases similar to the current case and submit the current case as a major case candidate.
- View one or more similar major cases and link the current case as a child to a major case.

Major issue managers can search for cases that are similar to a major case and add them as child cases.

Using the feature in Agent Workspace and in the platform interface

With Agent Workspace, agents can:
- Perform a search in Predictive Intelligence using the additional search resources.
- Create a link from the current case to a selected case in the search results.
- Copy resolution information from a selected case to the current case. This includes the resolution code and the resolution notes (the agent must then save the case).
- View a list of similar cases that do not include major cases. This is a way to see that the current case might be a major case candidate.
- View a list of similar cases that include one or more major cases. The major cases are displayed first in the list of results. Agents can use an available action to add the current case as a child of a major case.

With the platform interface, agents can:
- Perform a search in the Related Search Results section on the Case form using the additional search resources. Agents can select these additional resources from a list by the Related Search field.
- Create a link from the current case to a selected case in the search results.

Plugins

The configuration for the similar case/recommendation feature is included with the Customer Service plugin (com.sn_customerservice). Activating the Customer Service plugin also activates the CSM Workspace plugin (com.snc.agent_workspace.csm).

The similar case/recommendation feature has a dependency on the Contextual Search plugin (com.snc.contextual_search). Activate the Contextual Search plugin to use contextual search and the additional search resources.

To use similar case/recommendation with the following features, activate the associated plugins:
- Major Issue Management – activate the Major Issue Management plugin (com.sn_majorissue_mgt)
- Predictive Intelligence – activate the Predictive Intelligence plugin (com.glide.platform_ml)
- Problem Management – activate the Problem Management Best Practice – Madrid – State Model (com.snc.best_practice.problem.madrid.state_model)
Additional search resources

The similar case recommendation feature uses additional search resources, which are configured using the Contextual Search application.

Navigate to Contextual Search > Additional Resources to view the Search Resources (Additional Resources view) list. Two types of additional search resources are available: Table and Predictive Intelligence Similarity.

Table resources

Additional search resources of the type Table are based on a selected table and have specific conditions that must be met for a record to be included in the search results.

The following Table additional search resources are included with the Customer Service plugin:

- Open Cases
- Resolved Cases
- Open Major Issues

The following Table additional search resources are included with the Problem Management Best Practice - Madrid - State Model plugin:

- Open Problems
- Resolved Problems

<table>
<thead>
<tr>
<th>Table type additional search resources</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Additional Resource</strong></td>
</tr>
<tr>
<td>--------------------------</td>
</tr>
</tbody>
</table>
| Open Cases               | Case      | Returns a list of open cases created in the last three months that are not major cases or child cases of a major case. Actions available:
|                          |           | - Link to Case: the current case becomes a child of the case selected from the search results. |
| Resolved Cases           | Case      | Returns a list of cases created in the last six months that have a state of resolved or closed and the resolution code is one of the following:
|                          |           | - Solved - Fixed by support/Guidance provided
|                          |           | - Fixed by closing related PRB
|                          |           | - Workaround provided based on open PRB
|                          |           | Actions available:
|                          |           | - Link to Case: the current case becomes a child of the case selected from the search results.
|                          |           | - Copy Resolution Information: copies the resolution notes and resolution code from the selected case to the current case. |
### Additional Resource Table Description

<table>
<thead>
<tr>
<th>Additional Resource</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open Major Issues</td>
<td>Case</td>
<td>Returns a list of open major cases. Actions available:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <a href="#">Link to Case</a>: the current case becomes a child of the case selected from the search results.</td>
</tr>
<tr>
<td>Open Problems</td>
<td>Problem</td>
<td>Returns a list of open problems. Actions available:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <a href="#">Link to Case</a>: adds the selected record as the Problem reference on the current case.</td>
</tr>
<tr>
<td>Resolved Problems</td>
<td>Problem</td>
<td>Returns a list of problems that have a state of Resolved or Closed. Actions available:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <a href="#">Link to Case</a>: adds the selected record as the Problem reference on the current case.</td>
</tr>
</tbody>
</table>

### Predictive Intelligence Similarity resources

Additional search resources of the type Predictive Intelligence Similarity are associated with a Machine Learning (ML) similarity solution definition. Search resources of this type require the Predictive Intelligence plugin (`com.glide.platform_ml`). The resources listed in the following table are included with the Predictive Intelligence plugin.

In addition to the associated similarity solution definition, Predictive Intelligence Similarity resources can have configured properties. These properties identify conditions that must be met for cases to be included in the search results.

<table>
<thead>
<tr>
<th>Additional Resource</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Recommended Resolved Cases</td>
<td>Case</td>
<td>Returns a list of resolved similar cases created in the last six months.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Associated with the Recommended Resolved Cases similarity solution definition.</td>
</tr>
<tr>
<td>Recommended Open Cases</td>
<td>Case</td>
<td>Returns a list of open similar cases created in the last six months.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Associated with the Recommended Open Cases similarity solution definition.</td>
</tr>
<tr>
<td>Additional Resource</td>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------</td>
<td>---------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>All Similar Cases</td>
<td>Case</td>
<td>Returns a list of all similar cases created in the last six months.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Associated with the All Similar Cases similarity solution definition.</td>
</tr>
</tbody>
</table>

**Major case agent assist recommendations**

The Major Case agent assist recommendations is used for recommending major cases.

The agent assist provides a recommendation for each of the two major case scenarios:

- **Major case found**: returns a list with one or more major cases created in the time-frame indicated in the solution definition that are similar to the current case. Cases are listed by similarity score. The default time-frame is set to the start of yesterday.
- **No major case found**: returns a recommendation based on the number of cases created in the time-frame indicated in the solution definition that are similar to the current case (does not include any major cases). The default time-frame is set to the start of yesterday.

To configure the time-frame for the solution definition threshold, refer to *Update your similarity score threshold*

If the Major Case agent assist recommendations find one or more major cases similar to the current case, the Predictive Intelligence tab displays these cases ranked by similarity score. The case with the highest score is highlighted with a white box and the title **Major Case** and includes a user action to link the current case to the major case.
If the Major Case agent assist recommendations find cases similar to the current case, but no major cases, the Predictive Intelligence tab displays a recommendation highlighted with a blue box. It includes the option to propose the current case as a major case candidate.
The Major Case agent assist recommendations:

- Uses the Major Case agent assist recommendations ML solution definition.
- Includes some properties that provide customers with customization options, such as the recommendation title and message that appears in the Predictive Intelligence tab.
- Includes the Potential Major Case trend definition.

This definition sets the threshold for:

- Finding the number of distinct accounts that cases need to belong to for a major issue recommendation. The default value is 3.
- The number of similar cases that need to be returned by the solution definition for a major issue recommendation using a script. The default value is 10.

**Similarity solution definitions**

The similar case recommendation feature uses several Predictive Intelligence solution definitions for similarity models.
Navigate to **Predictive Intelligence > Similarity > Solution Definitions**. The following solution definitions are provided with the similar case/recommendation feature.

- All Similar Cases (ml_sn_global_all_similar_cases)
- Recommended Resolved Cases (ml_sn_global_recommended_resolved_cases)
- Recommended Open Cases (ml_sn_global_recommended_open_cases)
- Major Issue Detector (ml_sn_global_major_issue_detector)

Several of the additional contextual search resources used by the similar case/recommendation feature are associated with these solution definitions. Agents can select these search resources and access the cases returned by these similarity solution definitions.

**Similar case user actions**

Customer service agents and major issue managers can use the similar case recommendation feature to link cases, copy resolution information, propose major case candidates, and add cases to existing major cases.

<table>
<thead>
<tr>
<th>User Action</th>
<th>Description</th>
<th>UI Action</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Customer service agent can link the current case to a similar case</td>
<td><strong>Agent Workspace:</strong> the Predictive Intelligence tab shows a list of similar cases ordered by the similarity score. <strong>Platform:</strong> the Related Search Results section of the case form shows a list of similar cases ordered by the similarity score.</td>
<td><strong>Agent Workspace:</strong> click the More UI Actions menu and select <strong>Link to Case</strong>. <strong>Platform:</strong> click the desired case in the search results list, then click <strong>Link to Case</strong>.</td>
<td>The current case is linked as a child of the similar case.</td>
</tr>
<tr>
<td>Customer service agent can copy resolution information from a resolved case to the current case</td>
<td><strong>Agent Workspace:</strong> the Predictive Intelligence tab shows a list of resolved similar cases ordered by the similarity score.</td>
<td><strong>Agent Workspace:</strong> click the More UI Actions menu and select <strong>Copy Resolution</strong>.</td>
<td>Copies the resolution code and resolution notes from the similar case to the current case. <strong>Note:</strong> Be sure to save the current case record.</td>
</tr>
<tr>
<td>Customer service agent can propose a major case candidate</td>
<td><strong>Agent Workspace:</strong> the Predictive Intelligence tab shows a major issue recommendation with the following message: &quot;We noticed that (x) similar cases have been created for (y) different accounts in the last (z) hours. Propose this as a major issue?&quot;</td>
<td><strong>Agent Workspace:</strong> click the <strong>Propose Major Case</strong> link.</td>
<td>The current case is proposed as a major issue.</td>
</tr>
<tr>
<td>User Action</td>
<td>Description</td>
<td>UI Action</td>
<td>Result</td>
</tr>
<tr>
<td>---------------------------------------------------------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>--------------------------------------------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Major issue manager can associate the current case to a major case</td>
<td><strong>Agent Workspace</strong>: the Predictive Intelligence tab lists one or more major cases similar to the current case, ranked by similarity score.</td>
<td><strong>Agent Workspace</strong>: click the More UI Actions menu and select <strong>Link to this major issue</strong>.</td>
<td>The current case is added as a child to the major case.</td>
</tr>
<tr>
<td><strong>Note</strong>: The Major Issue Detector similarity solution definition must be active.</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Targeted communications**

The Targeted Communications application provides the ability to create and send articles and emails to internal and external customers.

Users with the publications author (sn_publications.author) and publications administrator (sn_publications.admin) roles can use the Targeted Communications application to author publication articles and emails for employees, customer contacts and accounts, and consumers. Articles are available for viewing from the self-service portals and can also be sent out as email notifications.

Each publication article includes content and a specified list of recipients and can also include optional email notification. Recipients lists can be created dynamically by using a condition builder to identify the desired conditions, by running scripts, or by manual file upload. Recipients can be added to or removed from a list manually and lists can have both dynamically generated and manually added records of the same type.

Publication authors specify a publish date and an expiration date when creating an article to handle time-sensitive information. Authors can also request a review prior to publishing an article.

The process of publishing articles is based on workflows and two default workflows are provided: one to publish articles instantly and one that requires approval prior to publishing. Publication administrators can update workflows and add users with the publications approver (sn_publications.approver) role to perform reviews. Both authors and administrators can monitor publications and see which users have received and viewed the information.

Customer contacts and consumers can view publications by logging in to the Customer Service Portal or the Consumer Service Portal and clicking the **Publications** link in the portal header. Employees can view these publications by navigating to **Targeted Communications > Publications** in the application navigator.

**Note**: If the optional email notification is selected, all users receive the publication in an email, including consumers who do not have a login ID for the Consumer Service Portal.

**Publication article stages**

Publication articles progress through several stages which are displayed in a process flow formatter on the Publication form.
Publication stages

<table>
<thead>
<tr>
<th>Stage</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Author</td>
<td>The initial state of the publication creation process.</td>
</tr>
<tr>
<td>Review</td>
<td>Publications that are waiting for review. A publication cannot be updated when it is in the <strong>Review</strong> stage.</td>
</tr>
<tr>
<td>Ready To Publish</td>
<td>Publications that have been reviewed and are ready to be published.</td>
</tr>
<tr>
<td>Published</td>
<td>Publications that have reached their <strong>Publish Date</strong>.</td>
</tr>
<tr>
<td>Expired</td>
<td>Publications that have reached their <strong>Expiry Date</strong> or that have been manually expired.</td>
</tr>
<tr>
<td>Cancelled</td>
<td>Pending publications that have been cancelled.</td>
</tr>
</tbody>
</table>

States are shown in a process flow formatter at the top of the Publication form. The current state is indicated by a blue underline. States that have been completed are indicated by a blue check mark.

Publication lists

The Targeted Communications application menu includes several views of publication records.

Publications lists

<table>
<thead>
<tr>
<th>State</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active Publications</td>
<td>Includes publications in the following stages:</td>
</tr>
<tr>
<td></td>
<td>• Author</td>
</tr>
<tr>
<td></td>
<td>• Review</td>
</tr>
<tr>
<td></td>
<td>• Ready to Publish</td>
</tr>
<tr>
<td></td>
<td>• Published</td>
</tr>
<tr>
<td>Draft Publications</td>
<td>Includes publications that have been created and sent for review.</td>
</tr>
<tr>
<td>Expired Publications</td>
<td>Includes publications that have reached their <strong>Expiry Date</strong> or have been set to <strong>Expired</strong>.</td>
</tr>
</tbody>
</table>

Recipients lists

Create recipients lists for active publications.

The list of recipients for an article can include internal users, accounts, contacts, and consumers. When an article is published, the recipients on this list can view the article on the Customer or Consumer Service Portal. Recipients can also receive optional email notifications.

Recipients lists are also used by the Major Issue Management application to create child cases for a major case.

Recipients lists are created in the following ways:

- By creating a list of imported users.
• By creating a dynamic list based on selected conditions.
• By creating a script.

Recipients lists can have both dynamically generated and manually added records of the same type.

The system administrator can manage a scheduled job to refresh recipient lists. This scheduled job, Targeted Communications Refresh recipient list, adds new recipients to each of the active published articles. The new recipients receive email notification of the article and are granted access to view the article on the portal.

Create a recipient list by importing contact information

Create a recipient list by importing contact information. For contacts, supported file types include xls and csv.

Multiple files can be imported into the same recipient list, with new recipients appended to the recipient list file. The system checks that the accounts and contacts exist in the system and only imports those that exist. Duplicate entries are not created. At the end of the import process, the system displays a status with the number of records imported and rejected.

The system uses the sys_id and the email address attributes to match contacts. It first looks for a matching sys_id match. If not found, it then looks for a matching email address. If neither are found, the record is rejected.

Create a recipient list by importing account, consumer, or internal user information

Create a recipient list by importing account, consumer, or internal user information. The supported file type is xls.

The system uses the following attributes to match the imported records:

• Account: Uses the sys_id and the account number. Attempts to match the sys_id. If not found, then attempts to match using the account number. If neither are found, the record is rejected.
• Consumer and User: Uses the sys_id or the email address. Attempts to match the sys_id. If not found, then attempts to match the email address. If neither are found, the record is rejected.

Create a recipient list using a script

Create a recipient list using a script with these supported entities: contact, company/account, consumer, and internal user. The output of the script is an array of sys_ids of the corresponding entity. After creating the recipient list, the system shows the total number of records identified, added to the list, and rejected.

To create a recipient list using a script, select Dynamic Condition in the Method field on the Recipients List form and enable the Show Script check box. Then create your script in the Script field.

Add or remove an approver

Add or remove an approver to a publication workflow.

Role required: sn_publications.admin

1. Navigate to Targeted Communications > Publication Workflow.
2. Select a workflow.
The approvers assigned to the workflow are displayed in the Approvers field.

3. To add an approver, click **Edit Approvers** next to the Approvers field and select an approver from the Users list.
   This list includes users with the sn_publications.approver role. The selected user is added to the Approvers field.

4. To remove an approver, click **Edit Approvers** next to the Approvers field and select the approver's name. Then click **Remove**.
   The approver's name is removed from the Approvers field.

5. Click **Update**.

**Create a recipients list**

Create and save a list of users to receive targeted communications.

Role required: sn_publications.author, sn_publications.admin, sn_customerservice_agent, sn_customerservice_manager, sn_majorissue_mgmt.major_issue_manager

A recipient list can include internal users, accounts, contacts, or consumers. Create a recipient list using any of the following methods:

- By importing a list of users.
- By creating a dynamic list based on selected conditions.
- By creating a script.

Recipients lists can have both dynamically generated and manually added records of the same type.

---

**Note:** You must create at least one recipient list before creating a publication.

1. Navigate to **Targeted Communications > Recipients Lists**.
2. Click **New**.
3. Fill in the fields on the Recipients List form.

**Recipients List form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the list.</td>
</tr>
<tr>
<td>Type</td>
<td>The type of recipients to include in the list.</td>
</tr>
<tr>
<td></td>
<td>- Contacts (customer_contacts)</td>
</tr>
<tr>
<td></td>
<td>- Internal Users (sys_user)</td>
</tr>
<tr>
<td></td>
<td>- Consumers (csm_consumer)</td>
</tr>
<tr>
<td></td>
<td>- Accounts (customer_account)</td>
</tr>
<tr>
<td>State</td>
<td>The state of the recipient list.</td>
</tr>
<tr>
<td></td>
<td>- <strong>New:</strong> the list has not yet been generated. Click <strong>Refresh Recipient List</strong>.</td>
</tr>
<tr>
<td></td>
<td>- <strong>In Progress:</strong> the list is currently being generated. (You may only see this state when generating a very large list of recipients.)</td>
</tr>
<tr>
<td></td>
<td>- <strong>Complete:</strong> the list has been generated.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Method</td>
<td>The method used to generate the recipient list.</td>
</tr>
<tr>
<td></td>
<td>· <strong>Upload File</strong>: create a list by uploading user information from a selected Excel .xlsx file.</td>
</tr>
<tr>
<td></td>
<td>· <strong>Dynamic Condition</strong>: create a list by selecting conditions in the condition builder or by adding a script.</td>
</tr>
<tr>
<td>Choose File</td>
<td>If the <strong>Method</strong> is <strong>Upload file</strong>, download an Excel template and then select an .xlsx file that contains the user information.</td>
</tr>
<tr>
<td></td>
<td>The templates vary based on the entity selected in the <strong>Type</strong> field. For accounts, the template includes columns for sys_id and account number values. For contacts, consumers, and internal users, the template includes columns for sys_id and email values.</td>
</tr>
<tr>
<td>Show Script</td>
<td>If the <strong>Method</strong> is <strong>Dynamic Condition</strong>, enable this check box to create a recipients list using a script. Enabling this check box displays the <strong>Script</strong> field.</td>
</tr>
<tr>
<td>Script</td>
<td>The script used to create a recipients list.</td>
</tr>
<tr>
<td>Table</td>
<td>The table that stores the user information.</td>
</tr>
<tr>
<td></td>
<td>Depending on the selection in the <strong>Type</strong> field, this field displays:</td>
</tr>
<tr>
<td></td>
<td>· Contact (customer_contact)</td>
</tr>
<tr>
<td></td>
<td>· User (sys_user)</td>
</tr>
<tr>
<td></td>
<td>· Consumer (csm_consumer)</td>
</tr>
<tr>
<td></td>
<td>· Account (customer_account)</td>
</tr>
<tr>
<td>User Field</td>
<td>The field in the selected table that stores the user information.</td>
</tr>
<tr>
<td></td>
<td>This field is displayed for the following types of recipients lists: <strong>Contacts</strong>, <strong>Internal Users</strong>, and <strong>Consumers</strong>.</td>
</tr>
<tr>
<td>Account Field</td>
<td>The field in the selected table that stores the account information.</td>
</tr>
<tr>
<td></td>
<td>This field is displayed for the following types of recipients lists: <strong>Accounts</strong>.</td>
</tr>
<tr>
<td>Conditions</td>
<td>Use the buttons in this field to build one or more conditions on the selected table. A condition is made up of a selected field, an operator, and a value. Add conditions using the AND and OR buttons. Delete conditions by clicking the Delete button to the right of a condition.</td>
</tr>
</tbody>
</table>
For recipients lists created by file upload, clicking **Submit** validates the records in the Excel file. Following validation, the system displays a pop-up window with the upload results, including valid and invalid user records.

**Edit a recipients list**

Edit a list of users to receive targeted communications.

Role required: sn_publications.author, sn_publications.admin, sn_customerservice_agent, sn_customerservice_manager, sn_majorissue_mgt.major_issue_manager

The **Recipients** related list includes the **Dynamically Added** column which displays either True or False, depending on how a record was added:

- True for records that are dynamically generated, either by using the condition builder or by running a script.
- False for records that are added manually, either by using the **Edit** button on the **Recipients** related list or by file upload.

The **Active Communication** column is set to True by default for both dynamically and manually added records. This field indicates whether or not the recipient requires active communication.

1. Navigate to **Targeted Communications > Recipients Lists**.
2. Select the desired list.
3. In the **Recipients** related list, click **Edit**.
4. Use the arrows to add or remove records.
5. Click **Save**.

**Create a publication**

Create a publication with optional email notification to send to customers.

Role required: sn_publications.author or sn_publications.admin

Two options to consider when creating a publication:

- Include the optional email notification (default)
- Select the type of content: HTML or Wiki

After creating an article, there are two publishing options:

- Submit: sets the stage to **Ready To Publish**
- Send for review: sends the publication to the approver and sets the stage to **Review**

1. Navigate to **Targeted Communications > Create New Publication**.
2. Fill in the fields on the Publication form.

**Publication form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>The automatically generated publication number.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Content Type</td>
<td>The type of data included in the publication. Select one of the following:</td>
</tr>
<tr>
<td></td>
<td>- HTML: this content can include Rich Text formatted (RTF) text, images,</td>
</tr>
<tr>
<td></td>
<td>attachments, and links. Enter the publication data in the Content field.</td>
</tr>
<tr>
<td></td>
<td>- Wiki: this content can include plain text. Enter the publication data in</td>
</tr>
<tr>
<td></td>
<td>the Wiki field.</td>
</tr>
<tr>
<td></td>
<td>The default selection is HTML.</td>
</tr>
<tr>
<td>Category</td>
<td>If desired, select a category for the publication. The following categories</td>
</tr>
<tr>
<td></td>
<td>are available:</td>
</tr>
<tr>
<td></td>
<td>- Defect</td>
</tr>
<tr>
<td></td>
<td>- Outage</td>
</tr>
<tr>
<td></td>
<td>- Information</td>
</tr>
<tr>
<td></td>
<td>- IT</td>
</tr>
<tr>
<td></td>
<td>- HR</td>
</tr>
<tr>
<td></td>
<td>- Finance</td>
</tr>
<tr>
<td>Recipient Lists</td>
<td>Select a predefined list to target specific customers. Recipient lists are</td>
</tr>
<tr>
<td></td>
<td>created by the publication author or administrator.</td>
</tr>
<tr>
<td>Short Description</td>
<td>A brief description or title of the publication.</td>
</tr>
<tr>
<td>Recurrence</td>
<td>This field is displayed for recurring publications and displays the short</td>
</tr>
<tr>
<td></td>
<td>description entered on the Recurrence form.</td>
</tr>
<tr>
<td>Publish Date</td>
<td>Select the publication date. This date can be the current date or any</td>
</tr>
<tr>
<td></td>
<td>future date. Publications are sent automatically when the publish</td>
</tr>
<tr>
<td></td>
<td>date and time are reached.</td>
</tr>
<tr>
<td>Expiry Date</td>
<td>Select the expiration date. This date must be at least one day after the</td>
</tr>
<tr>
<td></td>
<td>Publish Date. Publications are automatically expired when the expiry</td>
</tr>
<tr>
<td></td>
<td>date and time are reached.</td>
</tr>
<tr>
<td>Skip Notification</td>
<td>Enable this check box if you do not want to use email notification with</td>
</tr>
<tr>
<td></td>
<td>this publication. Enabling this check box disables the Email Template</td>
</tr>
<tr>
<td></td>
<td>field and hides the Include Attach Links field.</td>
</tr>
</tbody>
</table>

**Note:** If email notification is selected, all users receive the publication in an email, including consumers who do not have a login ID for the Consumer Service Portal.
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Email Template</td>
<td>Select a template to use for email notification.</td>
</tr>
<tr>
<td></td>
<td>The <strong>Publication Default</strong> email template is provided with the Targeted Communications application.</td>
</tr>
<tr>
<td></td>
<td>Users with the <code>sn_publications_admin</code> role can create additional email templates.</td>
</tr>
<tr>
<td>Include Attach Links</td>
<td>Include links to any attachments in the email notification preview.</td>
</tr>
<tr>
<td>Content</td>
<td>This field appears when you select HTML as the <strong>Content Type</strong>.</td>
</tr>
<tr>
<td></td>
<td>Enter the text of the publication in this field. HTML content can include Rich Text formatted (RTF) text, images, attachments, and links.</td>
</tr>
<tr>
<td>Wiki</td>
<td>This field appears when you select Wiki as the <strong>Content Type</strong>.</td>
</tr>
<tr>
<td></td>
<td>Click the Wikitext button and enter the text of the publication in this field. Wiki content can include plain text.</td>
</tr>
</tbody>
</table>

3. Click one of the following:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Submit</td>
<td>The stage is set to <strong>Ready To Publish</strong> and the publication is published on the <strong>Publish Date</strong>.</td>
</tr>
<tr>
<td>Send for Review</td>
<td>The stage is set to <strong>Review</strong> and the publication is sent to the approver for review. Approvers can navigate to <strong>Self-Service &gt; My Approvals</strong> to see a list of review requests.</td>
</tr>
</tbody>
</table>

### Publish a publication

Publish a publication with optional email notification to send to customers.

Role required: `sn_publications.author` or `sn_publications.admin`

When creating a publication, you can include an optional email notification that is sent to all recipients in the recipients list when the publication is published. In this email notification, all of the recipients are included in a **bcc** list to maintain privacy.

1. Navigate to **Targeted Communications > Active Publications**.
2. Select the desired publication.
3. Click **Publish**.
   *The publication is published an email notification is sent to the recipients in the the recipients list.*

### Create a recurring publication

Use an existing publication as a template to create multiple copies of a new publication.

Role required: `sn_publications.author` or `sn_publications.admin`
You can specify the recurrence interval and the recurrence start and end date. The number of copies that are created are based on these settings and appear in the **Publications** related list on the original publication form. Each copy has a different publish date, which is based on the interval. Each copy gets reset to the **Author** state and each one goes through its own workflow.

1. Do one of the following:
   - Navigate to **Targeted Communications > Active Publications**, open the desired publication, and click the **Setup Recurrence** related link.
   - Navigate to **Targeted Communications > Recurrences** and click **New**.

2. Fill in the fields on the Recurrence form.

   **Recurrence form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Short Description</td>
<td>A brief description or title of the publication.</td>
</tr>
<tr>
<td>Publication Template</td>
<td>The number of the publication being used as a template.</td>
</tr>
<tr>
<td></td>
<td>• If you clicked the <strong>Setup Recurrence</strong> related link, this field displays the original publication number.</td>
</tr>
<tr>
<td></td>
<td>• If you clicked <strong>Recurrences</strong> in the Targeted Communications menu, select a publication from the Publications list.</td>
</tr>
<tr>
<td>Recurrence Start</td>
<td>Select a date for the first occurrence of the recurring publications.</td>
</tr>
<tr>
<td>Recurrence End</td>
<td>Select a date for the last occurrence of the recurring publications.</td>
</tr>
<tr>
<td>Recurrence Interval</td>
<td>Select an interval for the recurring publications:</td>
</tr>
<tr>
<td></td>
<td>• Daily</td>
</tr>
<tr>
<td></td>
<td>• Weekly</td>
</tr>
<tr>
<td></td>
<td>• Biweekly</td>
</tr>
<tr>
<td></td>
<td>• Monthly</td>
</tr>
<tr>
<td></td>
<td>• Custom</td>
</tr>
<tr>
<td>Custom Interval in Days</td>
<td>This field appears when you select <strong>Custom</strong> as the <strong>Recurrence Interval</strong>. Enter the number of days for the interval.</td>
</tr>
</tbody>
</table>

3. Click **Submit**.
   The recurring publications are created based on the selected dates and the recurrence interval and the stage for each copy is set to **Author**. The copies appear on the **Publications** related list on the original publication form, as well as on the Active Publications and the Draft Publications lists. From any of these lists you can open each publication and change the information as necessary. Each copy lists the publication template number in the **Recurrence** field.
   A record of the recurrence appears on the Recurrences list.

**Preview an email notification**

Preview an email notification for a publication before it is sent to customers.
Role required: sn_publications.author or sn_publications.admin

Preview the following information for an email notification:

- The recipient list
- The subject of the publication
- The text of the publication and any attachments.

1. Navigate to one of the following:
   - Targeted Communications > Active Publications
   - Targeted Communications > Draft Publications

2. Select the desired publication.
3. Click the Preview Target Email related link.
4. View the email notification in the Notification Preview window.
5. If desired, view the publication on the customer portal by clicking the link in the body of the email.
6. Close the Notification Preview window.
   Once the publication has been published, the customers in the recipient list should receive the email.

Update a publication

You can make changes to a publication that is in the Author or Review stages.

Role required: sn_publications.author or sn_publications.admin

1. Navigate to one of the following:
   - Targeted Communications > Active Publications
   - Targeted Communications > Draft Publications

2. Open the desired publication.
   The stage of the publication must be either Author or Review.
3. Make the desired changes.
4. Click Update.

Send a publication for review

You can send a publication for review if it is in the Author stage.

Role required: sn_publications.author or sn_publications.admin

1. Navigate to one of the following:
   - Targeted Communications > Active Publications
   - Targeted Communications > Draft Publications

2. Select a publication in the Author stage.
3. Click Send For Review.
   The publication stage is set to Review and the approvers are added to the Approvers related list on the Publication form.
   Approvers can navigate to Self-Service > My Approvals to see a list of review requests.
   Approvers also receive an email notification about the review request.
Review a publication

Users with the publications approver role that have been added as approvers to the publication workflow can review a publication.

Role required: sn_publications.approver or sn_customerservice_manager

After reviewing, an approver can either accept or reject a publication. If an approver does not review a publication before the Publish Date, the publication cannot be approved. The Approve button is not displayed and the approver sees a message that the publish date and time has passed. The approver can only reject the publication, which returns it to the Author stage.

The Approvers related list displays a list of approval tasks and includes most recent comment from each approver.

1. Navigate to Self-Service > My Approvals.
2. Select a publication for review from the Approvals list that has a state of Requested.
3. Review the publication summary at the bottom of the approval form.
4. Add review comments to the Comments field.
5. Click one of the following:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Approve</td>
<td>The review state changes to Approved on the Approvals list and the publication stage is set to Ready To Publish. For other approvers of this article, the review state changes to No Longer Required.</td>
</tr>
<tr>
<td>Reject</td>
<td>The review state changes to Rejected on the Approvals list and the publication stage is set to Author.</td>
</tr>
</tbody>
</table>

View the list of approvers for a publication

If a publication article has been sent for review, you can see the assigned approvers on the Publication form.

Role required: sn_publications.author or sn_publications.admin

1. Navigate to one of the following:
   - Targeted Communications > Active Publications
   - Targeted Communications > Draft Publications
2. Open the desired publication.
3. Click the tab for the Approvers related list.
   The Approvers list includes the users with the publications approver role that have been added as approvers to the publication workflow.

Track a publication

Access a list of recipients for a publication and see which recipients have viewed the content.

Role required: sn_publications.author or sn_publications.admin

1. Navigate to Targeted Communications > Active Publications.
2. Open the desired publication.
3. Click the Publication Recipients related list.
For each recipient on this list, you can see if the email notification bounced and if the customer viewed the article or any attachments.

### Expire a publication

Expire a published article before it reaches the **Expire Date**.

Role required: sn_publications.author or sn_publications.admin

1. Navigate to **Targeted Communications > Active Publications**. 
2. Select an article that has been published. 
3. Click *Expire*.

   The publication **Expire Date** is set to the current date. The publication is removed from the Active Publications list and appears on the Expired Publications list.

### Cancel a publication

Cancel a pending publication before it reaches the publish date.

Role required: sn_publications.author or sn_publications.admin

You can cancel a publication in any of the following stages: **Author**, **Review**, or **Ready to Publish**.

1. Navigate to one of the following:
   - **Targeted Communications > Active Publications**
   - **Targeted Communications > Draft Publications**

2. Select the desired publication.
3. Click *Cancel*.

   The stage of the publication changes to **Cancelled**.

### View a publication

Internal customers can view the details of a publication from the Targeted Communications menu.

Role required: none

1. Navigate to **Targeted Communications > My Publications**.
2. Select a publication from the Publications list.

### Time recording for Customer Service Management

Record time worked on cases and case tasks. Time worked entries automatically generate time cards and time sheets for manager approval.

Customer service agents (users with the sn_customerservice_agent role) can record time worked on case-related activities, create time cards and time sheets, and submit for approval. Managers can approve time sheets, define cost rates for different types of activities, and convert to expense lines.

The time recording feature extends the functionality of the **Time Card Management** application to Customer Service Management. Agents can record time worked on cases and tasks directly from the Case or Case Task form and time spent on other activities, such as meetings or training, from the Time Worked form. Time worked entries automatically create time cards for each task and selected work category. Time cards are automatically included in a weekly time sheet.
The time recording feature also extends the functionality of the Cost Management application to Customer Service Management. Customer service managers can create labor rate cards, which define different cost rates for different activities. Time sheets use labor rate cards to determine costs and to generate expense lines.

Agents can modify the hours recorded on time cards. Once a time sheet is approved and a time card is processed, the agent can still go back and modify the time worked. The time sheet reverts to the Pending state and new time cards are created. If an agent adds more time worked records to an approved time sheet for the same week, a new time sheet record is created for the current week.

Managers can view time worked records, time cards, and time sheets for agents in their assignment groups, as well as approve and reject time sheets. After a time sheet is approved, the system processes the time cards and uses rate cards based on the time card category to create expense lines.

**Time recording plugin**

The time recording feature requires the Customer Service Management plugin (com.sn_customerservice) and the Time Recording for Customer Service plugin (com.snc.csm_time_recording).

**User roles**

The time recording feature adds the following roles.

<table>
<thead>
<tr>
<th>Role</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time card user</td>
<td>Record time worked on cases and tasks. View, modify, and delete time worked entries on time cards and submit time sheets for approval.</td>
</tr>
<tr>
<td>(timecard_user)</td>
<td>Users with the customer service agent (sn_customerservice_agent) role inherit the timecard_user role.</td>
</tr>
<tr>
<td>Time card administrator</td>
<td>Review, approve, and reject time sheets for customer service agents.</td>
</tr>
<tr>
<td>(timecard_admin)</td>
<td>Users with the customer service manager role (sn_customerservice_manager) inherit the timecard_admin, timecard_approver, and timecard_manager roles.</td>
</tr>
</tbody>
</table>

**Note:** This role restricts access to the time sheets, time cards, and time worked records created by the agent.

**System properties**

The time recording feature adds the following properties.
Time Sheet policy

The time recording feature uses the Default time sheet policy.

For users with the sn_customerservice_agent role, creating time worked records automatically creates or modifies time cards regardless of the setting for the com.snc.time_card.time_worked system property. The time sheet policy controls this functionality. The system administrator can disable the auto-creation of time cards for a specific user with the sn_customerservice_agent role by creating a separate time sheet policy for that user.

Labor rate cards

The time recording feature provides one labor rate card: CSM Rate Card (Default).

If needed, system administrators can create additional labor rate cards. Navigate to Cost > Costs > Labor Rate Cards and click New to create a labor rate card.

Record time worked for a case or activity

Customer service agents can record time worked on a case or case task as well as time spent on other activities.

Role required: sn_customerservice_agent

An agent can record time worked directly from a case or case task by clicking Record Time on the form. Time worked can be recorded regardless of the case or task state. An agent can also record time spent on other activities from the Time Worked list by creating a new time worked record, recording the time, and selecting a category.

When an agent creates a time worked record, a time card and time sheet are automatically created for the week based on the work date. The time card is created for the task and the category type. The total hours recorded on each time card are then recorded on the current time sheet in the Time Cards related list.

1. To record time worked for a task or an activity:
   - Navigate to a case or case task and click Record Time. This action opens a Time Worked form with the Task and User field already populated.
   - Navigate to Time Sheets > My Time Worked and click New. This action opens a Time Worked form with the User field already populated.

2. If necessary, select the case number in the Task field.
3. Select the Work Date.
4. Select a Category for the time being recorded.
5. Fill in the Time worked.
6. Provide any additional information in the Comments field and click Submit.

The Time Worked form is saved and added to the Time Worked list (Time Sheets > My Time Worked) and to the Time Worked related list on the Case or Case Task form.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>com.snc.time_card.time_worked</td>
<td>Enables the time recording feature for Customer Service Management. The default setting is false.</td>
</tr>
<tr>
<td>com.snc.time_card.default_rate</td>
<td>The default hourly rate used when processing time cards if a rate from a labor rate card is not available.</td>
</tr>
</tbody>
</table>
• If this entry is the first time worked entry for the selected category, a time card is created for that category. The time worked record is added to the time sheet (Time Sheets > Current Time Sheet) in the Time Cards related list.
• If a time card for the category already exists, the time worked record is added to that card.

Review time worked for a case or activity
Customer service agents can review time worked on cases and case tasks.
Role required: sn_customerservice_agent
The Time Worked related list on the Case and Case Task form displays the time worked records that have been created for the case or task. From this related list, agents can review their recorded time, add new time worked records, and also delete records.
1. Navigate to the desired case or case task.
2. Go to the Time Worked related list.
3. To view a time worked record, click the Comments for that record.

Modify or delete time worked entries for cases or activities
Agents can modify and delete existing time worked entries and create new entries after a time sheet has been approved.
Role required: sn_customerservice_agent
An agent can modify or delete time worked entries for an approved time sheet. Any changes to these entries update existing time cards, creates new time cards if needed, and generates an updated time sheet.

Note: Do not manually edit time cards. Edit the original time worked entries, which generate updated time cards and timesheets.

1. To modify or delete a time worked entry:
   • Navigate to the desired case or case task, click the Time Worked related list, and click the desired entry.
   • Navigate to Time Sheets > My Time Worked and click the desired entry.
2. To modify the entry, change the desired fields and click Update.
3. To delete the entry, click Delete.

Review a time card
Customer service agents can review time cards created from time worked records.
Role required: sn_customerservice_agent
The Time Worked related list on the Case and Case Task form displays the time worked records that have been created for the case or task. This list also displays the time cards created from the time worked records.
1. Navigate to the desired case or case task.
2. Go to the Time Worked related list.
3. To view a time card, click the Time Card for that record.
The time card provides a breakdown of the time worked for this case or case task by day.
Review and submit a time sheet for a customer service agent

Agents can review and submit time sheets to managers for approval.

Role required: sn_customerservice_agent

The total hours worked for each category are recorded on the time card and on the time sheet. From the time sheet, you can see total hours by day and by category.

2. If desired, review the time cards associated with the time sheet in the Time Cards related list.
3. Click Submit Time Sheet.

The time sheet is submitted to the manager for approval. The state of the time sheet changes from Pending to Submitted and the form becomes read-only. The state of the associated time cards also changes to Submitted.

Review and approve time sheets for customer service agents

Managers can review time cards and time sheets for agents in their assignment groups.

Role required: sn_customerservice_manager

When a time sheet is approved, the time cards are processed and used to create expense lines that reference the defined labor rate cards.

1. Navigate to Customer Service > Manager > Time Sheets - Pending Approval.
2. Select a time sheet.
3. If necessary, review the time cards associated with this time sheet in the Time Cards related list.
4. Click one of the available actions:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Approve</td>
<td>The state of the time sheet and the associated time cards changes to Processed and these records become read-only.</td>
</tr>
<tr>
<td>Reject</td>
<td>The state of the time sheet and the associated time cards changes to Rejected. The customer service agent can modify the time sheet and submit again for approval.</td>
</tr>
</tbody>
</table>

Review expense lines created from time cards

Review the expense lines created from the time cards and time sheets submitted by customer service agents.

Role required: financial_mgmt_user

1. Navigate to Cost > Costs > Expense Lines.
2. Select the desired expense from the Expense Lines list and view the details.

Customer Service Management for Orders

This feature adds support for orders and order line items to the Customer Service Management application.

Customer Service Management for Orders enables customers and consumers to do the following through a self-service portal:
- View orders
- View and create cases for orders
- Contact a customer service agent to report an issue

Customer service agents can respond to customer and consumer requests and create cases for orders.

Plugins

To add support for orders to the Customer Service Management application, activate the Customer Service Management for Orders plugin (com.snc.csm.order). This plugin requires the Customer Service plugin (com.sn_customerservice).

This plugin adds the following modules to the Customer Service menu:
- **Orders**: displays a list of customer orders. Click an order to display the Order form.
- **Order Line Items**: displays a list of the individual items within each order in the Orders list. Click an item to display the Order Line Item form.

Creating a case for an order

When creating a case from the Customer or Consumer Service Portals, the end user can select the type of case to create. Based on the selection, the Create Case form includes fields specific to the selected case type.

- **Create Product Case**: includes the *Asset* and *Product* fields.
- **Create Order Case**: includes the *Order* field.

Create Case link

When creating a case from the Customer Service Management application, the customer service agent can select the type of case to create:

- **Product**: opens a new Case form for a product that includes the *Product* and *Asset* fields.
- **Order**: opens a new Case form for an order that includes the *Order* field.

Tables installed with Customer Service Management for Orders

Customer Service Management for Orders adds the following tables.
## Customer Service Performance Analytics Solutions

Customer Service Performance Analytics solutions contain preconfigured dashboards with actionable data visualizations to improve your business processes.

Use the Performance Analytics widgets on the dashboard to visualize data over time, analyze your business processes, and identify areas of improvement. With solutions, you can get value from Performance Analytics for your application with minimal setup.

**Note:**
- Solutions include some dashboards that are inactive by default. You can activate these dashboards to make them visible to end users according to your business needs.
- Out-of-the-box solutions and in-form analytics provide all the configuration records required to analyze default applications. Customize these records for use in your production environment.

Two Performance Analytics solutions are available for Customer Service:
- **Customer Service** (com.snc.pa.customer_service)
- **Customer Service Management - Advanced** (com.snc.pa.customer_service_advanced)

**Note:** Customer Service Performance Analytics solutions are an optional feature available for the Customer Service Management application. To use them, your subscription must also include Performance Analytics. Once you have the subscription, enable the Performance Analytics Premium for Customer Service and the Customer Service Performance Analytics solutions on the instances where you wish to leverage the enhanced functionality. For more information about getting the Performance Analytics subscription product, see [Get licensed Performance Analytics](#).

## Customer Service solution

The Customer Service solution adds the following features.

**Note:** Performance Analytics - Spotlight (com.snc.pa.spotlight) is automatically activated with this solution.

**Spotlight groups:**

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Orders (csm_order)</td>
<td>Stores the orders associated with an account and contact or with a consumer.</td>
</tr>
<tr>
<td>Order Line Items (csm_order_line_item)</td>
<td>Stores the individual line items within orders.</td>
</tr>
<tr>
<td>Order Cases (csm_order_case)</td>
<td>Stores information about customer service cases related to orders.</td>
</tr>
<tr>
<td>Order Case Line (csm_order_case_line)</td>
<td>Stores information about customer services cases related to orders and order line items.</td>
</tr>
</tbody>
</table>
Case Spotlight

Dashboards:
- Customer Service Agent
- Customer Service Manager
- Customer Service Executive

Customer Service Management - Advanced solution

The Customer Service Management - Advanced solution adds the following features.

Note: Performance Analytics - Spotlight (com.snc.pa.spotlight) is automatically activated with this solution.

Spotlight groups:
- Case Spotlight

Dashboards:
- Customer Service Agent - Advanced
- Customer Service Manager - Advanced
- Customer Service Executive - Advanced

These dashboards have all the information shown on the dashboards for the basic Customer Service solution, but also contain additional indicators for the following features. Activate all the plugins below in order to view the additional indicators.
- Major Issue Management
- Customer Service Case Action Status
- Customer Service with Request Management
- Customer Service with Service Management
- Agent Chat
- Advanced Work Assignment for CSM
- Performance Analytics - Content Pack - Advanced Work Assignment

Note: For more information about the Major Issue Management indicators, see Major issue management analytics.

The Customer Service Management - Advanced solution also adds additional Service Management indicators to the Analytics Hub. For more information, see CSM integration with Service Management analytics.

Enable Performance Analytics for Customer Service Management

To enable Performance Analytics for Customer Service Management, a user with the admin role can navigate to Performance Analytics > Guided Setup. Click Get Started and then scroll to the section for Customer Service. The guided setup takes you through the entire setup and configuration process.
Service Manager homepage

Use the Service Manager homepage to track and analyze customer service case data.

To view the Service Manager homepage, navigate to Customer Service > Overview.

The Service Manager homepage displays four case-related reports, which are created using the Reports application. You can drill down into these reports for more information about the related cases.
End users and roles

<table>
<thead>
<tr>
<th>End user and goal</th>
<th>Required role</th>
</tr>
</thead>
<tbody>
<tr>
<td>Customer service agent manager: Track status of cases and customer satisfaction.</td>
<td>sn_customerservice_manager</td>
</tr>
<tr>
<td>Customer service agent: Track status of cases and customer satisfaction.</td>
<td>sn_customerservice_agent</td>
</tr>
<tr>
<td>Customer service administrator: Can edit the dashboard.</td>
<td>sn_customerservice_admin</td>
</tr>
</tbody>
</table>

Reports

<table>
<thead>
<tr>
<th>Title</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cases by SLA stage</td>
<td>Pie Chart</td>
<td>Displays the number of cases by SLA stage.</td>
</tr>
<tr>
<td>Open Cases By Priority</td>
<td>Donut</td>
<td>Displays the number of open cases by priority.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Click a priority to show the case list.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Click a case from the list to view details.</td>
</tr>
<tr>
<td>Customer Satisfaction</td>
<td>Gauge</td>
<td>Displays the results of the customer satisfaction survey that a customer is asked to take after a case is closed.</td>
</tr>
<tr>
<td>Open Cases By Product</td>
<td>Semi-Donut</td>
<td>Displays the number of open cases for each product.</td>
</tr>
</tbody>
</table>

Customer Service Agent dashboard

The Customer Service Agent dashboard provides quick access to your cases based on criteria that help you prioritize your work. The dashboard also displays summary data on metrics for your organization.

To view the Customer Service Agent dashboard, navigate to Performance Analytics > Dashboards. Click the All tab and select Customer Service Management from the Group menu. Click the Customer Service Agent or Customer Service Agent - Advanced tile.

## End users and roles

<table>
<thead>
<tr>
<th>End user and goal</th>
<th>Required role</th>
</tr>
</thead>
<tbody>
<tr>
<td>Customer service agent: View and prioritize your assigned cases. View case trends for all agents.</td>
<td>sn_customerservice_agent</td>
</tr>
<tr>
<td>Customer service manager: View and prioritize your assigned cases. View case trends for all agents.</td>
<td>sn_customerservice_manager</td>
</tr>
<tr>
<td>Content administrator: Can edit the dashboard and manage users, groups, and roles for the dashboard.</td>
<td>pa_admin</td>
</tr>
<tr>
<td>Content creator: Can view the dashboard.</td>
<td>pa_viewer</td>
</tr>
</tbody>
</table>
My Work tab

Reports

<table>
<thead>
<tr>
<th>Title</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>My Open Cases</td>
<td>Cases assigned to me that are not resolved, closed, or canceled.</td>
</tr>
<tr>
<td>My Cases With Problems</td>
<td>Cases assigned to me that are part of a parent case that is assigned to a system admin.</td>
</tr>
<tr>
<td>Title</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>My New Cases</td>
<td>Cases that I have not yet responded to.</td>
</tr>
<tr>
<td>My Group's P1 Cases</td>
<td>P1 cases that are assigned to a member of my group.</td>
</tr>
<tr>
<td>My Group's Open Cases</td>
<td>Cases assigned to a member of my group that are not resolved, closed, or canceled.</td>
</tr>
<tr>
<td>My KBs Created</td>
<td>List of all KB articles that I created.</td>
</tr>
</tbody>
</table>
Organizational Trends tab
## Indicators

<table>
<thead>
<tr>
<th>Indicator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CSAT</td>
<td>Average customer satisfaction based on survey results. The percent change in the current period appears under the total percentage. For more information about CSAT, see <a href="#">Customer service satisfaction surveys</a>.</td>
</tr>
<tr>
<td>First Call Resolution</td>
<td>Percentage of cases that were resolved during first contact with the customer. The percent change in the current period appears under the total percentage.</td>
</tr>
<tr>
<td>Exceeding Chat Target</td>
<td>Percentage of all Chat work items that have exceeded the target wait time. For more information about the Chat service channel, see <a href="#">Advanced Work Assignment service channels</a>.</td>
</tr>
<tr>
<td>Note:</td>
<td>This indicator is only viewable on the Customer Service Agent - Advanced dashboard.</td>
</tr>
<tr>
<td>Exceeding Case Target</td>
<td>Percentage of all Case work items that have exceeded the target wait time. For more information about the Case service channel, see <a href="#">Advanced Work Assignment service channels</a>.</td>
</tr>
<tr>
<td>Note:</td>
<td>This indicator is only viewable on the Customer Service Agent - Advanced dashboard.</td>
</tr>
<tr>
<td>Avg. Time to Resolution</td>
<td>Average time for a case to be marked as closed or resolved.</td>
</tr>
<tr>
<td>Note:</td>
<td>On the Customer Service Agent - Advanced dashboard, this indicator is called Mean Time to Resolve.</td>
</tr>
<tr>
<td>Backlog Growth</td>
<td>Number of backlogged cases for all agents over time.</td>
</tr>
</tbody>
</table>

### Customer Service Manager dashboard

The Customer Service Manager dashboard displays charts and summary data on metrics like backlog, resolution rates, SLA, customer satisfaction, and per-agent KPIs.

To view the Customer Service Manager dashboard, navigate to **Performance Analytics > Dashboards.** Click the **All** tab and select **Customer Service Management** from the Group menu. Click the **Customer Service Manager** or **Customer Service Manager - Advanced** tile.

End users and roles

<table>
<thead>
<tr>
<th>End user and goal</th>
<th>Required role</th>
</tr>
</thead>
<tbody>
<tr>
<td>Customer service manager: View case metrics like backlog, resolution rates, SLA,</td>
<td>sn_customerservice_manager</td>
</tr>
<tr>
<td>customer satisfaction, and per-agent KPIs to understand the current performance</td>
<td></td>
</tr>
<tr>
<td>of customer service at your organization.</td>
<td></td>
</tr>
<tr>
<td>Content administrator: Can edit the dashboard and manage users, groups, and roles</td>
<td>pa_admin</td>
</tr>
<tr>
<td>Content creator: Can view the dashboard.</td>
<td>pa_viewer</td>
</tr>
</tbody>
</table>

Dashboard breakdowns

The Customer Service Manager dashboard uses the Case Assignment Group breakdown. Select one or more groups to view data for only those groups. By default, data from all groups is shown on the dashboard.
### Overview

<table>
<thead>
<tr>
<th>CSAT</th>
<th>First Call Resolution</th>
<th>Mean Time to Resolve</th>
</tr>
</thead>
<tbody>
<tr>
<td>92.86%</td>
<td>59%</td>
<td>0.49 days</td>
</tr>
</tbody>
</table>

#### Customers Impacted by Major Case

- **24**

#### Child Cases Auto Created from Major Case

- **8%**

#### Open Backlog - Blocked

<table>
<thead>
<tr>
<th>Name</th>
<th>Jun 18</th>
<th>Trend</th>
<th>Distribution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Blocked internally</td>
<td>2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Blocked by customer</td>
<td>2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Blocked internally and by customer</td>
<td>2</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

#### Open Backlog - Unblocked

<table>
<thead>
<tr>
<th>Name</th>
<th>Score</th>
<th>Trend</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open Unblocked</td>
<td>49</td>
<td></td>
</tr>
<tr>
<td>Resolved</td>
<td>8%</td>
<td></td>
</tr>
<tr>
<td>Unassigned Cases</td>
<td>5</td>
<td></td>
</tr>
</tbody>
</table>

#### Backlog Growth

- **May 20**
- Number of new cases: 87
- Click to open Analytics Hub

#### Date Range

- 13. May
- 14. May
- 15. May
- 16. May
- 17. May
- 18. May
- 19. May
- 20. May
### Customer Service Manager - Advanced

<table>
<thead>
<tr>
<th>Indicator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CSAT</td>
<td>Average customer satisfaction based on survey results. The percent change in the current period appears under the total percentage. For more information about CSAT, see Customer service satisfaction surveys.</td>
</tr>
<tr>
<td>First Call Resolution</td>
<td>Percentage of cases that were resolved during first contact with the customer. The percent change in the current period appears under the total percentage.</td>
</tr>
<tr>
<td>Mean Time to Resolve</td>
<td>Average time for a case to be marked as closed or resolved. The percent change in the current period appears under the total percentage.</td>
</tr>
<tr>
<td>Customers Impacted by Major Case</td>
<td>Number of customers impacted by major cases.</td>
</tr>
<tr>
<td>Child Cases Auto Created from Major Case</td>
<td>Percentage of child cases that are automatically created from a major case.</td>
</tr>
<tr>
<td>Open Backlog - Blocked</td>
<td>Number of cases that are blocked and are not resolved.</td>
</tr>
<tr>
<td>Open Backlog - Unblocked</td>
<td>Number of cases that are not blocked and are not resolved.</td>
</tr>
<tr>
<td>Backlog Growth</td>
<td>Number of backlogged cases for all agents over time.</td>
</tr>
</tbody>
</table>

### Customer Service Manager

<table>
<thead>
<tr>
<th>Indicator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CSAT</td>
<td>Average customer satisfaction based on survey results. The percent change in the current period appears under the total percentage. For more information about CSAT, see Customer service satisfaction surveys.</td>
</tr>
<tr>
<td>First Call Resolution</td>
<td>Percentage of cases that were resolved during first contact with the customer. The percent change in the current period appears under the total percentage.</td>
</tr>
<tr>
<td>Open Cases with Breached SLAs</td>
<td>Percentage of cases that have remained open past the time required by the Service Level Agreement (SLA).</td>
</tr>
<tr>
<td>Unassigned Open Cases</td>
<td>Number of open cases that are not assigned to an agent.</td>
</tr>
<tr>
<td>Avg. Time to Resolution</td>
<td>Average time for a case to be marked as closed or resolved. The percent change in the current period appears under the total percentage.</td>
</tr>
<tr>
<td>Backlog Growth</td>
<td>Number of backlogged cases for all agents over time.</td>
</tr>
<tr>
<td>Indicator</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Open Case Backlog</td>
<td>Chart of cumulative open cases and case age over time.</td>
</tr>
<tr>
<td>Open Backlog</td>
<td>Number of cases that are not resolved.</td>
</tr>
</tbody>
</table>

### Analysis tab

Trend chart of case backlog over time. Click and move your cursor to view data for any date. Indicators display data for the selected date.
## Analysis indicators

<table>
<thead>
<tr>
<th>State</th>
<th>Indicator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open Backlog - Unblocked</td>
<td>% Not Updated in 5 Days</td>
<td>Percentage of open cases that agents have not updated within the last 5 days.</td>
</tr>
<tr>
<td></td>
<td>% Marked as Major</td>
<td>Percentage of open cases that are major.</td>
</tr>
<tr>
<td></td>
<td>% with Breached SLAs</td>
<td>Percentage of open cases that have remained open past the time required by the SLA.</td>
</tr>
<tr>
<td></td>
<td>% with Priority P1</td>
<td>Percentage of open cases that are critical priority.</td>
</tr>
<tr>
<td></td>
<td>% Escalated</td>
<td>Percentage of open cases that have been escalated.</td>
</tr>
<tr>
<td></td>
<td>% with Problem</td>
<td>Percentage of open cases connected to a problem.</td>
</tr>
<tr>
<td></td>
<td>% Agent Reassignment</td>
<td>Percentage of open cases where the Assigned to field has changed at least once.</td>
</tr>
<tr>
<td></td>
<td>% of Major Candidates</td>
<td>Percentage of open cases that have been proposed as major case candidates.</td>
</tr>
<tr>
<td></td>
<td>% Re-opened At Least Once</td>
<td>Percentage of open cases where the State was previously Resolved.</td>
</tr>
<tr>
<td></td>
<td>% with Request</td>
<td>Percentage of open cases connected to a request.</td>
</tr>
<tr>
<td>Resolved or Closed</td>
<td>% with Problem</td>
<td>Percentage of closed cases connected to a problem.</td>
</tr>
<tr>
<td></td>
<td>% Caused by Change</td>
<td>Percentage of closed cases caused by a change.</td>
</tr>
<tr>
<td></td>
<td>Closed in Same Day</td>
<td>Number of cases that were closed on the same day they were created.</td>
</tr>
<tr>
<td></td>
<td>% Re-opened At Least Once</td>
<td>Percentage of closed cases that were reverted to the open State at least once.</td>
</tr>
<tr>
<td></td>
<td>% Resolved Major Cases</td>
<td>Percentage of closed cases that are major cases.</td>
</tr>
<tr>
<td></td>
<td>% Re-assigned</td>
<td>Percentage of closed cases that are reassigned.</td>
</tr>
<tr>
<td></td>
<td>% with Breached SLAs</td>
<td>Percentage of closed cases that remained open past the time required by the SLA.</td>
</tr>
<tr>
<td></td>
<td>% with Change</td>
<td>Percentage of closed cases connected to a problem.</td>
</tr>
<tr>
<td>State</td>
<td>Indicator</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>----------------</td>
<td>--------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>% with Incident</td>
<td>Percentage of closed cases connected to an incident.</td>
</tr>
<tr>
<td></td>
<td>% with Request</td>
<td>Percentage of closed cases connected to a request.</td>
</tr>
</tbody>
</table>

**Analysis breakdowns**

Select a breakdown to view cases grouped by that breakdown.

Cases in the Open Backlog - Unblocked state can be grouped by the following breakdowns.

- Case Assignment Group
- Case Assigned To
- Account
- Product
- State
- Priority
- Category
- Channel

Cases in the Open Backlog - Blocked state can be grouped by the following breakdowns.

- Blocked Action Status
- Case Assignment Group

Cases in the Resolved or Closed state can be grouped by the following breakdowns.

- Case Assignment Group
- Case Assigned To
- Account
- Product
- Age
- Priority
- Category
- Contact

**Case Spotlight tab**
Case Spotlight breakdowns

Select values for the breakdowns to filter the data shown on the dashboard.

- Assignment Group
- Case State
- Case Priority
- Opened
## Case Spotlight reports

<table>
<thead>
<tr>
<th>Title</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cases Above Spotlight Threshold</td>
<td>Number of cases that exceed the Case Spotlight threshold. Every case where <strong>State</strong> is New, Open, or Awaiting info is scored based on priority and last updated date. The score is compared against the threshold value to put cases with high priority in the spotlight.</td>
</tr>
<tr>
<td><strong>Note:</strong> You can edit the Case Spotlight spotlight group threshold and criteria to put different types of cases in the spotlight based on your organization’s needs.</td>
<td></td>
</tr>
<tr>
<td>Spotlight Cases P1 - Critical</td>
<td>Number of cases that exceed the Case Spotlight threshold and are Priority 1.</td>
</tr>
<tr>
<td>Spotlight Cases - Unassigned</td>
<td>Number of cases that exceed the Case Spotlight threshold and are not assigned to an agent.</td>
</tr>
<tr>
<td>Case Spotlight</td>
<td>List of cases that exceed the Case Spotlight threshold.</td>
</tr>
</tbody>
</table>

### Agent Analysis tab

© 2019 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
### Mean Time to Resolve

<table>
<thead>
<tr>
<th>Name</th>
<th>Time</th>
<th>Distribution</th>
</tr>
</thead>
<tbody>
<tr>
<td>IT Admin</td>
<td>0.29</td>
<td>53%</td>
</tr>
<tr>
<td>IT Agent</td>
<td>0.35</td>
<td>53%</td>
</tr>
<tr>
<td>System Administrator</td>
<td>0.99</td>
<td>53%</td>
</tr>
<tr>
<td>User 1</td>
<td>2.02</td>
<td>53%</td>
</tr>
<tr>
<td>User 2</td>
<td>2.02</td>
<td>53%</td>
</tr>
<tr>
<td>User 3</td>
<td>2.02</td>
<td>53%</td>
</tr>
<tr>
<td>User 4</td>
<td>2.02</td>
<td>53%</td>
</tr>
</tbody>
</table>

### First Call Resolution

<table>
<thead>
<tr>
<th>Name</th>
<th>Resolution</th>
<th>Distribution</th>
</tr>
</thead>
<tbody>
<tr>
<td>IT Admin</td>
<td>72%</td>
<td>53%</td>
</tr>
<tr>
<td>IT Agent</td>
<td>72%</td>
<td>53%</td>
</tr>
<tr>
<td>System Administrator</td>
<td>99%</td>
<td>53%</td>
</tr>
<tr>
<td>User 1</td>
<td>72%</td>
<td>53%</td>
</tr>
<tr>
<td>User 2</td>
<td>72%</td>
<td>53%</td>
</tr>
<tr>
<td>User 3</td>
<td>72%</td>
<td>53%</td>
</tr>
<tr>
<td>User 4</td>
<td>72%</td>
<td>53%</td>
</tr>
</tbody>
</table>

### CSAT

<table>
<thead>
<tr>
<th>Name</th>
<th>CSAT</th>
<th>Distribution</th>
</tr>
</thead>
<tbody>
<tr>
<td>System Administrator</td>
<td>33%</td>
<td>53%</td>
</tr>
<tr>
<td>IT Admin</td>
<td>33%</td>
<td>53%</td>
</tr>
<tr>
<td>User 1</td>
<td>33%</td>
<td>53%</td>
</tr>
<tr>
<td>User 2</td>
<td>33%</td>
<td>53%</td>
</tr>
<tr>
<td>User 3</td>
<td>33%</td>
<td>53%</td>
</tr>
<tr>
<td>User 4</td>
<td>33%</td>
<td>53%</td>
</tr>
</tbody>
</table>

### Agent Efficiency Trend (Mean Time to Resolve)
## Agent analysis indicators

<table>
<thead>
<tr>
<th>Indicator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Avg. Time to Resolution</td>
<td>Average time for a case to be marked as closed or resolved for each agent. Ranked from fastest to slowest.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> On the Customer Service Manager - Advanced dashboard, this indicator is called Mean Time to Resolve.</td>
</tr>
<tr>
<td>First Call Resolution</td>
<td>Percentage of cases for each agent that were resolved during first contact with the customer. Ranked from highest to lowest.</td>
</tr>
<tr>
<td>CSAT</td>
<td>Average customer satisfaction for each agent based on survey results. Ranked from highest to lowest. For more information about CSAT, see Customer service satisfaction surveys.</td>
</tr>
<tr>
<td>Agent Efficiency Trend (Mean Time to Resolve)</td>
<td>Average time for a case to be marked as closed or resolved for each agent shown over time.</td>
</tr>
<tr>
<td>Closed Cases by Agent and Account.</td>
<td>Number of cases closed by each agent for each account.</td>
</tr>
</tbody>
</table>
Work Assignment Analytics tab

Note: The Work Assignment Analytics tab can only be viewed on the Customer Service Manager - Advanced dashboard. Advanced Work Assignment for CSM (com.sn_csm.awa) and Performance Analytics - Content Pack - Advanced Work Assignment (com.snc.pa.awa) must be activated on your instance.

Work Assignment Analytics reports

<table>
<thead>
<tr>
<th>Report</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Average Chat Wait Time - Last Hour</td>
<td>Average amount of time that customers have spent waiting for an agent response in the past hour for chat work items.</td>
</tr>
</tbody>
</table>
### Average Case Wait Time - Last Hour

Average amount of time that customers have spent waiting for an agent response in the past hour for case work items.

<table>
<thead>
<tr>
<th>Indicator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Exceeding Target Work Items</td>
<td>Percentage of all work items that have exceeded the target wait time.</td>
</tr>
<tr>
<td>Assigned Work Items</td>
<td>Percentage of all work items that are assigned to agents.</td>
</tr>
<tr>
<td>Abandoned Work Items</td>
<td>Percentage of all work items that agents have abandoned.</td>
</tr>
</tbody>
</table>
Text Analytics tab
Note: The Text Analytics tab is visible only if the Performance Analytics Premium for Customer Service plugin (com.snc.pa.premium.cs) is installed.

Text Analytics displays a word cloud of most frequently used words and phrases in the short descriptions of open cases, providing insight into emerging issues reported by users.

- Drill down on a word to view other words associated with cases that contain that keyword.
- Search the word cloud for specific terms.

Trend line: Shows the frequency of top keywords over time. Click and move your cursor to view data for any date. Related Records: List of cases containing the keywords you selected from the word cloud.

Customer Service Executive dashboard

The Customer Service Executive dashboard provides a view of the operation and trends of the Customer Service function for your organization.

To view the Customer Service Executive dashboard, navigate to Performance Analytics > Dashboards. Click the All tab and select Customer Service Management from the Group menu. Click the Customer Service Executive or Customer Service Executive - Advanced tile.


End users and roles

<table>
<thead>
<tr>
<th>End user and goal</th>
<th>Required role</th>
</tr>
</thead>
<tbody>
<tr>
<td>Customer service executive: View an overview of customer service cases at your organization to see areas that are doing well and areas that need attention.</td>
<td>sn_customerservice_manager</td>
</tr>
<tr>
<td>Content administrator: Can edit the dashboard and manage users, groups, and roles for the dashboard.</td>
<td>pa_admin</td>
</tr>
<tr>
<td>Content creator: Can view the dashboard.</td>
<td>pa_viewer</td>
</tr>
</tbody>
</table>
Overview tab
## Overview indicators

<table>
<thead>
<tr>
<th>Indicator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CSAT</td>
<td>Average customer satisfaction based on survey results. The percent change in the current period appears under the total percentage. For more information about CSAT, see <a href="#">Customer service satisfaction surveys</a>.</td>
</tr>
<tr>
<td>Avg. Time to Resolution</td>
<td>Average time for a case to be marked as closed or resolved. The percent change in the current period appears under the total percentage.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> On the Customer Service Executive - Advanced dashboard, this indicator is called Mean Time to Resolve.</td>
</tr>
<tr>
<td>Open Backlog</td>
<td>Number of cases that are not resolved. The percent change in the current period appears under the total percentage.</td>
</tr>
<tr>
<td>Customer Satisfaction Stats</td>
<td>Summary statistics for customer satisfaction.</td>
</tr>
<tr>
<td>Closed Case Stats</td>
<td>Summary statistics for closed cases.</td>
</tr>
<tr>
<td>Open Case Stats</td>
<td>Summary statistics for open cases.</td>
</tr>
<tr>
<td>Affected Customers and Deployments</td>
<td>Number of affected customers and deployments.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This indicator is only viewable on the Customer Service Executive - Advanced dashboard.</td>
</tr>
</tbody>
</table>
At Risk Accounts tab

At Risk Accounts indicators

<table>
<thead>
<tr>
<th>Indicator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CSAT</td>
<td>Accounts with the lowest customer satisfaction.</td>
</tr>
<tr>
<td>Avg. Time to Resolution</td>
<td>Accounts with the worst average case resolution time.</td>
</tr>
</tbody>
</table>

**Note:** On the Customer Service Executive - Advanced dashboard, this indicator is called Mean Time to Resolve.

| Open Case Backlog       | Accounts with the highest number of unresolved cases.      |

Product Overview tab
Product Overview indicators

<table>
<thead>
<tr>
<th>Indicator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CSAT</td>
<td>Products with the lowest customer satisfaction.</td>
</tr>
<tr>
<td>Avg. Time to Resolution</td>
<td>Products with the worst average case resolution time.</td>
</tr>
<tr>
<td><strong>Note:</strong> On the Customer Service Executive - Advanced dashboard, this indicator is called Mean Time to Resolve.</td>
<td></td>
</tr>
<tr>
<td>Open Case Backlog</td>
<td>Products with the highest number of unresolved cases.</td>
</tr>
</tbody>
</table>

Cost Information tab

**Note:** The Cost Information tab is visible only if the Performance Analytics - Content Pack - Financial Management for Customer Service plugin (com.snc.pa.fm.csm) is installed.

Cost Information indicators

<table>
<thead>
<tr>
<th>Indicator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Total Cost</td>
<td>Total cost for all cases.</td>
</tr>
<tr>
<td>Cost Per Case - By Channel</td>
<td>Cost per case grouped by channel.</td>
</tr>
<tr>
<td>Cost Per Case - By Product</td>
<td>Cost per case grouped by product.</td>
</tr>
<tr>
<td>Cost Per Case - By Account</td>
<td>Cost per case grouped by account.</td>
</tr>
</tbody>
</table>
Text Analytics tab

**Note:** The Text Analytics tab is visible only if the Performance Analytics Premium for Customer Service plugin (com.snc.pa.premium.cs) is installed.

Text Analytics displays a word cloud of most frequently used words and phrases in the short descriptions of open cases, providing insight into emerging issues reported by users.

- Drill down on a word to view other words associated with cases that contain that keyword.
• Search the word cloud for specific terms.

**Trend line**: Shows the frequency of top keywords over time. Click and move your cursor to view data for any date. **Related Records**: List of cases containing the keywords you selected from the word cloud.

**Proactive Customer Service Operations dashboard**

The Proactive Customer Service Operations dashboard helps managers track key performance indicators (KPIs) to understand how proactive they were in identifying and communicating issues that impact customers.
End user and roles

<table>
<thead>
<tr>
<th>End user and goal</th>
<th>Required role</th>
<th>Benefits</th>
</tr>
</thead>
<tbody>
<tr>
<td>Customer Service Manager</td>
<td>sn_customerservice_manager</td>
<td>Can view the dashboard.</td>
</tr>
<tr>
<td>Content administrator</td>
<td>pa_admin</td>
<td>Can edit the dashboard and manage users, groups, and roles for the dashboard.</td>
</tr>
<tr>
<td>Content creator</td>
<td>pa_viewer</td>
<td>Can view the dashboard.</td>
</tr>
</tbody>
</table>

Indicators

The Proactive customer monitoring dashboard provides the following key performance indicators:

**Proactive Cases**
Number of active cases with critical and acknowledged alerts.

**Alerts that led to Proactive Case**
Percentage of critical or acknowledge alerts that triggered case creation.

**Affected Customers and Install Base Items**
Number of customers affected per month.

**Proactive Cases Promoted to a Major Case**
Percentage of proactive cases promoted to a major case.

Breakdowns

The following breakdowns apply to the indicators on the dashboard:

- Proactive
- Account
- Configuration items
- Product model

CSM integration with Service Management analytics

The Customer Service Management - Advanced Performance Analytics solution provides indicators for incident, problem, change, and request records associated with customer service cases.

The Customer Service Management - Advanced Performance Analytics solution adds additional indicators. Some of these indicators are automatically displayed on the Customer Service Manager dashboard in the Analysis tab. All the indicators can be viewed in the Analytics Hub or can be manually added to a dashboard.

**Note:** To view the indicators, you must activate the Customer Service with Service Management plugin (com.sn_cs_sm) and the Customer Service with Request Management plugin (com.sn_cs_sm_request).

Incident indicators:
- Number of Open Cases with Incident
- Number of Closed Cases with Incident

Problem indicators:
- Number of Open Cases with Problem
- Number of Closed Cases with Problem

Change indicators:
- Number of Open Cases with Change
- Number of Closed Cases with Change

Request indicators:
- Number of Open Cases with Request
- Number of Closed Cases with Request

Caused By Change indicators:
- Number of Open Cases Caused By Change
- Number of Closed Cases Caused By Change

To view the indicators in the Analytics Hub, navigate to Performance Analytics > Analytics Hub and search for any of the above indicators.

To add an indicator to a dashboard, a user with the role pa_admin can navigate to the desired dashboard and then click the Add Widgets icon at the top right of the dashboard. Select Performance Analytics from the drop down menu, then click Insights in the list below. Search for the indicator using the search bar. Click the indicator, and then click Add.

**Major issue management analytics**

Provides indicators on the Customer Service dashboards for major cases and child cases.

Action indicators are available on the Customer Service dashboards when the Performance Analytics - Content Pack - Customer Service Management - Advanced plugin (com.snc.pa.customer_service_advanced) is activated.

---

**Note:** Activate the Major Issue Management plugin (com.sn_majorissue_mgt) to view the related indicators. Without this plugin, the indicators may not display correctly.

Indicators:
- Number of Open Major Cases (by day, week, month)
- Percentage of Resolved Major Cases (by day, week, month)
- Number of Cases which are Child of Major Case
- Percentage of Major Case Candidates (by day, week, month)
- Percentage of Child Cases which are Auto Created from Major Case
- Number of customers impacted by major issue

**Major issue management**

Major issue management enables customer communication for issues that impact a wider audience. Use this feature to proactively identify impacted customers, provide information to these customers, and manage the resolution process.
This feature enables you to efficiently manage the communication and resolution process for issues that impact multiple customers. With major issue management, you can identify impacted customers who have not yet reported an issue and proactively create cases for these customers.

Major issue management introduces the concept of a major case which contains the details about a particular issue. Child cases can easily be created for a major case, with one child case created for each customer affected by the issue. These child cases contain the customer-specific information.

Identify affected customers by creating a recipients list of accounts or consumers and attaching it to the major case. Create this list using the Targeted Communications application. Build a recipients list by identifying dynamic conditions, running a script, or importing customer information into a template. Once attached to a major case, use the recipients list to create a child case for each customer included in the list.

A major case is created in one of two ways:

- A customer service manager can create a major case.
- A customer service manager or major issue manager can promote a major case candidate.

Major case candidates are created either by promoting an existing customer service case (for customer reported issues) or by creating a candidate case directly (for non-customer reported issues). Candidate cases require approval before being promoted to major cases.

Major issue management also provides properties that enable automatic synchronization from a major case to the associated child cases. Use these properties to enable synchronization and to identify the synchronized fields.

**Identifying issues and creating major cases**

Customer service agents, managers, and major issue managers can use the following process to identify potential issues, create major cases, and identify impacted customers.

1. Create a major case candidate or flag an existing customer service case as a major case candidate.
2. Review the major case candidate and either approve it as a major case or reject it.
   - If approved, the candidate case becomes a child case of the major case.
   - If rejected, the candidate case returns to a normal case.
3. Associate other cases reported for the same issue as child cases of the major case.
4. Identify other customers impacted by the issue by creating a recipients list and attaching it to the major case.
5. Create child cases for the customers included in the recipients list.
6. Manage the issue to resolution using the major case.
   - Update the major case as needed, which automatically updates the child cases.
   - Close the major case when the issue is resolved. Closing the major case automatically closes all the child cases.

**Activate Major Issue Management**

You can activate the Major Issue Management plugin (com.sn_majorissue_mgt) if you have the admin role.
ServiceNow    New York    Customer Service Management

Role required: admin

This plugin requires:

- Customer Service (com.sn_customerservice)
- Targeted Communications (com.sn_publications)
- Task Communications Management (com.snc.task_communication_management)

This plugin adds the Major Issue Management menu to the application navigator.

1. Navigate to **System Definition > Plugins**.
   A banner notifies you that you are in the All Applications page, which contains plugins and ServiceNow Store applications.

   **Note:**
   To redirect to the legacy list view for plugins, click the link.

   1. You have been redirected to All Applications. To see the Plugins list click here

2. Find the plugin using the filter criteria and search bar.
   You can search for the plugin by its name or ID. If you cannot find a plugin, you may have to request it from ServiceNow personnel. To request a plugin, follow the steps in **Request a plugin**.

3. Activate the plugin.
   You can activate the plugin directly from the All Applications page or you can view more details about the plugin before you activate it.
   - If you are certain that you have the correct plugin, click **Install**, and when you see the dialog box, click **Activate**.

   ![Activate Plugin](image)

   - To view plugin details before activation:
     1. Click the plugin name.
     2. On the form, click the **Activate/Update** related link.
3. In the dialog box, review the dependent plugins. If your plugin requires dependent plugins, they are activated automatically when you activate your plugin if they are not active already.

4. If demo data is available and you want to install it, click **Load demo data**. Some plugins include demo data, which are sample records that describe plugin features for common use cases. Load demo data when you first activate the plugin on a development or test instance. You can always load demo data later by clicking **Load demo data only** on the plugin form.

5. Click **Activate**.

### Major, candidate, and child cases

Major issue management uses major case candidates to identify potential customer issues. Approved candidate cases become major cases, which you can use to manage issues to resolution. Child cases are created for customers impacted by an issue and are associated with a major case.

### Major cases

A major case contains information about a specific issue that impacts customers. It is not associated with any accounts, contacts, or consumers. This customer-specific information resides in the associated child cases.

The recipients list associated with the major case identifies customers impacted by the issue. Select a list in the **Affected Customers** field in the Major Case Information form section of the Major Case form. After adding the list, you can automatically create child cases for all customers on the list. These cases are added to the **Child Cases** related list on the major case form.

With synchronization enabled, updates to a parent case are automatically synchronized to the associated child cases. When a major case is closed, the associated child cases in the following states are also closed: New, Open, Awaiting Customer Info.

To identify major cases in the list view, check the value in the **Major case state** field.

- Major cases have a state of Accepted.
- Major case candidates have a state of either Proposed or Rejected.
- Regular cases have a blank value.

In the form view, major cases and major case candidates display the Major Case Information form section.

---

**Note:** Related links on a major case form do not synchronize to associated child cases.

### Major case candidates

A customer service agent uses a candidate case to flag an issue that may be a wider problem impacting multiple customers. An agent can create a major case candidate:

- By promoting an existing customer service case with a reported issue.
- By creating a major case candidate directly.
A major case candidate requires the approval of the customer service manager or major case manager before being promoted to a major case. When a major case candidate is approved, a major case is created.

- If the major case candidate was promoted from an existing case, a major case is created and the candidate case becomes a child case of that parent.
- If the major case candidate was created directly, that same case becomes the major case.

If a major case candidate is rejected, it reverts to a regular case.

Child cases

Child cases are associated with a major case. One child case is created for each account (B2B) or consumer (B2C) impacted by the major case issue. Child cases are created from the recipients list on the major case and can also be added manually by the major issue manager.

When child cases are created, the short description from the major case is copied to each of the child cases. Duplicate child cases are not created. If a child case already exists for an account or consumer, it is not created again.

As child cases are created, you can enter text in a pop-up window that is added to the Additional comments field on the child case form. These comments are added only to the newly created child cases. The major case and any existing associated child cases are not updated.

The primary contact for an account is the contact on the child case and is automatically added to the child case watchlist.

Synchronization between major cases and associated child cases

The system administrator can set system properties that enable or disable the synchronization between the major case and associated child cases and also define the fields to synchronize. Synchronization occurs from the major case to the child cases. If the state of a child case is Resolved, Closed, or Canceled, the synchronization does not take place.

A major case and the associated child cases maintain synchronization on the fields identified by the **sn_customerservice.case_fields_to_sync** property. This property specifies the list of fields to synchronize from the major case to the associated child cases. By default, these fields include:

- Priority
- State
- Comments
- Work notes
- Close notes
- Resolution code

If the **State** field is synchronized from the major case to the child cases, the **Close notes** and **Resolution code** fields must also be synchronized.

**Note:** Child cases can be manually added to a major case at any time. There is no retroactive synchronization for newly added child cases.

When synchronization is enabled, saving changes to a major case results in a pop-up window. Verify the update by clicking **OK**.
Recipients lists

Use recipients lists that contain account or consumer information to create the child cases for a major case.

Major issue managers and customer service managers can select the desired list in the Affected Customers field on the Major Case form. Clicking Create Child Cases then creates a child case for each account or consumer in the recipients list.

Managers can change the recipients list before child cases are created. After child cases are created, the Affected Customers field becomes read only.

Creating recipients lists

Recipients lists are created using the Targeted Communications application. With this application, managers can select the type of list to create and the method used to create the list: by uploading files, selecting dynamic conditions, or using scripts.

The Targeted Communications application creates several types of recipients lists, including accounts, contacts, consumers, and internal users. The recipients list for a major case must be of type accounts or consumers. Recipients lists are limited to one specific type and cannot contain mixed types, for example accounts and consumers.

Note: The Major Issue Management plugin is dependent on the Targeted Communications plugin. If Targeted Communications is active, recipients lists can be created for internal users. If Targeted Communications and Customer Service Management are both active, recipients lists can also be created for accounts, contacts, and consumers.

Manually editing a recipients list

Major issue managers and customer service managers can manually add or remove accounts or consumers from a recipients list by navigating to the Recipients List form, clicking Edit in the Recipients related list, and then using the arrows to add or remove records.

The Recipients related list includes the Dynamically Added column which displays either True or False, depending on how a record was added:

- True for records that are dynamically generated, either by using the condition builder or by running a script.
- False for records that are added manually, either by using the Edit button on the Recipients related list or by file upload.

The Active Communication column is set to True by default for both dynamically and manually added records. This field indicates whether or not the recipient requires active communication.

Refreshing a recipients list

Refresh a recipients list by clicking Refresh Recipient List on the Recipients List form. For major issue management, the following guidelines apply to refreshing a recipients list:

- Refreshing a recipients list does not impact manually created records.
- If you remove a manually created record from a recipients list, it does not reappear when the list is refreshed unless it meets the dynamic conditions used to filter the list.
- If you remove a dynamically generated record from a recipients list, it may reappear when the list is refreshed if it meets the dynamic conditions used to filter the list.

© 2019 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
- If the **Active Communication** field is set to false for a record, this setting does not change when a recipients list is refreshed.
- If created using the Upload File method, you do not need to refresh the recipients list.

**Major Case form view**

Major issue management provides the Major Case form view, which includes the Major Case Information form section and the Child Cases related list.

The Major Case form view does not display account-related information because a major case is not linked to a specific account, contact, or consumer. This information is stored in the child cases associated with a major case.

**Major Case Information form section**

Major cases and major case candidates include the Major Case Information form section which includes the following fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Major case state</td>
<td>A major case can be in one of these states:</td>
</tr>
<tr>
<td></td>
<td>- <strong>Proposed</strong>: the initial state when a candidate case is created or proposed by an agent or manager.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Accepted</strong>: the initial state when a major case is created by a manager or when a candidate case is promoted by a manager.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Rejected</strong>: the candidate case is rejected by a manager.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Cancelled</strong>: the case is cancelled.</td>
</tr>
<tr>
<td>Business impact</td>
<td>The business impact of the issue identified in the major case.</td>
</tr>
<tr>
<td>Probable cause</td>
<td>The probable cause of the issue identified in the major case.</td>
</tr>
<tr>
<td>Affected Customers</td>
<td>The recipients list selected for the major case. Child cases are created for the accounts or consumers included in the recipients list. This field is only visible when the major case state is Accepted.</td>
</tr>
</tbody>
</table>

Customer service agents can update the **Business impact** and **Probable cause** fields as well as add **work notes**. Major issue managers can update the **Business Impact** and **Probable Cause** fields and attach a recipients list. The **Affected Customers** field is only visible when the major case state is Accepted.

The **Work notes** field on the major case form is updated when a major case is proposed or a candidate case is created manually. The **Work notes** field on associated child cases is updated when a major case is accepted.

When a major issue manager rejects a candidate case, the **Major Case State** field is set to **Rejected** and the **Work notes** field is updated with the case state. The candidate case reverts to a regular case.
Child Cases related list

Major issue management adds the Child Cases related list to the Customer Service Case form. All child cases associated with a major case are added to this list. Child cases are created automatically from the recipients list and can also be added or removed manually.

Configure case synchronization

Configure the major issue management system properties to enable synchronization between major cases and associated child cases.

Role required: admin

1. Navigate to Customer Service > Administration > Properties.
2. Enable the Synchronize fields from parent to child case property.
3. In the Comma separated list of fields that synchronize from parent to child cases property, add a comma-separated list of fields that synchronize from the major case to each of the associated child cases.
4. Optional: The Processes SLA asynchronously during parent to child case creation and synchronization property is enabled by default. Set this property to false to process the SLA synchronously.
5. Click Save.

Propose a case as a major case candidate

Users with the customer service agent role can propose an existing customer service case as a major case candidate.

Role required: sn_customerservice_agent, sn_customerservice_manager, sn_majorissue_mgt.major_issue_manager

Cases in these states can be proposed as a major case candidate:

- New
- Open
- Awaiting Info

Cases that are Resolved, Closed, or Canceled cannot be proposed as a major case candidate.

When proposing a case as a major case candidate, agents can specify the reason or justification for the case in the Propose Major Case popup window. Information provided in the Work notes and Business Impact fields are added to the Case form.

Users with the major issue manager role receive a notification email when a case is proposed as a major case candidate. These users can click the link in the notification email to open the major case candidate in the platform interface.

1. Navigate to the desired customer service case.
2. Click Propose Major Case in the Additional Actions menu on the Case form.
3. In the Propose Major Case pop-up window, enter a reason for the proposal in the Work notes field. If desired, enter the business impact of the selected case in the Business Impact field. This information is added to the Case form in the Work notes field and the Business Impact field in the Major Case Information section.
4. Click Propose.
An entry is added to the **Work notes** on the Case form that the case was proposed as a major case candidate. The information entered in the Propose Major Case pop-up window is also added to the Case form.

### Create a major case candidate

Users with the customer service agent role can create a major case candidate.

Role required: sn_customerservice_agent, sn_customerservice_manager, sn_majorissue_mgt.major_issue_manager

Users with the major issue manager role receive a notification email when a major case candidate is created. These users can click the link in the notification email to open the major case candidate in the platform interface.

1. Navigate to **Major Issue Management > Create Major Case Candidate**.
2. Enter a description in the **Short description** field.
3. In the Major Case Information form section, enter the relevant information in the **Business impact** and **Probable cause** fields.
4. Click **Submit**.

### Approve or reject a major case candidate

Users with the major issue manager role can approve or reject a major case candidate.

Role required: sn_customerservice_manager, sn_majorissue_mgt.major_issue_manager

1. Navigate to **Major Issue Management > Candidates**.
2. Select the desired candidate case.
3. Select one of the following from the Case form context menu.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Approve Major Case Candidate</strong></td>
<td>Approves the current major case candidate as a major case.</td>
</tr>
<tr>
<td></td>
<td>Upon approval:</td>
</tr>
<tr>
<td></td>
<td>• If the candidate case was proposed from an existing case, a major case is created and the candidate case becomes a child case of that major case.</td>
</tr>
<tr>
<td></td>
<td>• If the candidate case was created directly, the candidate case becomes the major case.</td>
</tr>
<tr>
<td><strong>Reject Major Case Candidate</strong></td>
<td>Rejects the current major case candidate as a major case.</td>
</tr>
<tr>
<td></td>
<td>If rejected, provide a reason for rejecting the case in the Rejection Reason pop-up window. This information is added to the <strong>Work notes</strong> on the Case form.</td>
</tr>
</tbody>
</table>

4. Click **Update**.

### Create a major case

Users with the customer service manager role can create a major case.
Role required: sn_customerservice_manager

1. Navigate to Major Issue Management > Create Major Case.
2. Fill in the fields on the Case form.
3. In the Major Case Information form section, fill in the Business impact and Probable case fields.
4. Click Submit.

Create child cases for a major case

Users with the customer service manager role can create a child case for each of the customers included in the major case recipients list.

Role required: sn_majorissue_mgt.major_issue_manager, sn_customerservice_manager

The Create Child Cases button on the Major Case form creates a child case for each account or consumer in the recipients list selected in the Affected Customers field. If a child case for an account or consumer already exists, the system does not create a duplicate child case.

Note: Use caution when selecting the recipients list for a major case. Selecting the wrong recipients list can have a serious impact by creating a large number of cases for incorrect accounts or consumers. Ensure that you have selected the correct recipients list before clicking Create Child Cases.

Once child cases have been created, you cannot change the recipients list. Any additional recipients must be added manually. After manually adding recipients to the list, click Create Child Cases again to create child cases for these new recipients.

Creating child cases copies information from the major case to each of the child cases. The field values that are copied to the child cases are identified by the sn_customerservice.case_fields_to_sync system property.

1. Open the desired major case.
2. In the Major Issue Management form section, select a recipients list in the Affected Customers field.
3. Click Update.
4. Click Create Child Cases.
5. In the Create Child Cases pop-up window, enter information about the major case.
   This information is added as additional comments to each of the newly created child cases. If child cases for this major case already exist, these child cases are not updated.
6. Click Continue.
   The child cases are created and added to the Child Cases related list.

Add an existing case as a child to a major case

Users with the customer service manager role can add an existing customer service case as a child to a major case.

Role required: sn_majorissue_mgt.major_issue_manager, sn_customerservice_manager

Identify and narrow a list of cases, then select the desired case or cases to add to the major case.

- Filter and narrow down the child case list.
- Select one or more cases and add as child to major case.
- Add work notes/activity log when a parent is added or removed.
Messages on pop-up window:
1. Open the desired major case.
2. In the Child Cases related list, click Add to display the Add Child Cases pop-up window.
   The Add Child Cases pop-up window displays a list of customer service cases that are not major cases.
3. Optional: Use the filters to narrow the list of cases displayed in the window.
4. Select the cases to add to the major case by enabling the check box for each case.
5. Click Submit.
   The system evaluates the selected cases and adds none, some, or all of the cases to the Child Cases related list. A message on the major case form informs the user of the results by displaying one of the following:
   - No selected cases were added as child cases.
   - (x) of (y) selected cases were added as child cases.
   - All (y) selected cases were added as child cases.

A work note is added to the Activities field for each child case added to the major case.

Components installed with Major Issue Management
Several types of components are installed with the major issue management feature.

Roles installed with Major Issue Management
Major Issue Management provides these roles.

<table>
<thead>
<tr>
<th>Role title (name)</th>
<th>Description</th>
<th>Contains Roles</th>
</tr>
</thead>
</table>
| Major issue manager (sn_majorissue_mgt.major_issue_manager) | Users with this role can:  
- Approve or reject major case candidates  
- Add or remove child cases from major cases  
- Add or remove impacted accounts (B2B) or consumers (B2C)  
The customer service manager role (sn_customerservice_manager) contains the major issue manager role. |  
- sn_customerservice_agent  
- sn_customerservice_consumer_agent  
- sn_publications_recipients_user  
- sn_publications_recipients_list_user |

Properties installed with Major Issue Management
Major Issue Management provides these properties.

To access these properties, navigate to Customer Service > Administration > Properties.

**Note:** To open the System Property (sys_properties) table, enter sys_properties.list in the navigation filter.
### Tables installed with Major Issue Management

Major Issue Management adds the following tables.

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Case Communication Task</td>
<td>Stores details about case communication tasks.</td>
</tr>
<tr>
<td>(case_comm_task)</td>
<td></td>
</tr>
<tr>
<td>Case Communication Plan</td>
<td>Stores details about case communication plans.</td>
</tr>
<tr>
<td>(case_comm_plan)</td>
<td></td>
</tr>
</tbody>
</table>

### Use the Customer Service Portal

Search for information about a question or an issue, or request assistance from a customer service agent.

Your Customer Service Portal activity usually begins on the homepage. Organizations usually customize their homepages, and logged-in users often see different information than users who are not logged in.

From the Customer Service Portal homepage, you can access and use the following features:
### Customer Service Portal homepage for logged-in users

<table>
<thead>
<tr>
<th>UI component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Knowledge</td>
<td>Clicking <strong>Knowledge</strong> on the header or the main page takes you to the Knowledge home page. You can search the knowledge base or view a list of top-rated or most viewed knowledge base articles.</td>
</tr>
<tr>
<td>Requests</td>
<td>Displays all your requests. You can also request items and services from the catalog.</td>
</tr>
<tr>
<td>My Lists</td>
<td>Lists all your cases.</td>
</tr>
<tr>
<td>Case</td>
<td>Provides access to all cases and quick links to create a product or order case.</td>
</tr>
<tr>
<td>Support</td>
<td>Navigate to appointments, contacts, work orders, and other quick links.</td>
</tr>
<tr>
<td>Notification</td>
<td>Displays notifications sent for resolved cases, cases awaiting information, publications, and approvals.</td>
</tr>
<tr>
<td>Tours</td>
<td>View a tour for additional guidance on how the Customer Service Management application works. Your administrator determines whether tours appear on pages.</td>
</tr>
<tr>
<td>Live Chat</td>
<td>Click <strong>Live Chat</strong> to chat with a virtual agent or a customer service agent.</td>
</tr>
<tr>
<td>Profile menu</td>
<td>Click your profile photo to either view your profile or log out.</td>
</tr>
<tr>
<td>Search</td>
<td>Enables you to search. Either enter a keyword to use the type-ahead search or enter one or more words to view all search results.</td>
</tr>
<tr>
<td>Ask the Community</td>
<td>Provides access to the ServiceNow Community homepage where you can ask questions and get answers fast, connect with people who share similar expertise, and join forums and participate in discussions.</td>
</tr>
<tr>
<td>Get help</td>
<td>Click <strong>Get help</strong> to make a request or report a problem by opening a case.</td>
</tr>
<tr>
<td>Request something</td>
<td>Request items and services from the catalog.</td>
</tr>
<tr>
<td>Most viewed articles</td>
<td>View a list of the most viewed articles.</td>
</tr>
<tr>
<td>Featured articles</td>
<td>View featured Community content.</td>
</tr>
<tr>
<td>Most useful articles</td>
<td>View the most useful knowledge articles based on the usage count of the articles.</td>
</tr>
</tbody>
</table>

The following components are available if you have installed communities:

| Recent solved discussion  | View a list of recently solved discussions.                                                                                                                                                                |
| Recent community blog     | View a list of recently published community blogs.                                                                                                                                                         |
| Community featured content| View a list of featured community content.                                                                                                                                                                  |
**Note:** You can view the metadata for each entry in the widgets, such as the number of views, number of days from the time the article or feature was published, and rating for the article.

---

**Portal usage calculation**

Portal usage enables you to track how your customers and employees are using the portal. The Customer Portal Usage dashboard provides information about portal visits by your customers and employees, resulting in session counts.

To view the Customer Portal Usage dashboard, navigate to **Customer Service > Admin > Portal Usage**.

A user session is a period of activity on the Customer or Consumer Service Portal by one of the following users:

- Internal: an internal user, typically an employee, who is logged in.
- External: an external user, typically a customer or consumer, who is logged in.
- Anonymous: a user who is not logged in.

A user session times out after a specific period of inactivity.

User access to the self-service portals is tracked as follows: per session, per day, and per portal. If the same user logs in from multiple browsers or devices, each login is counted as a separate visit. Each first call of a portal page starts a session and, at midnight (server time), the system restarts another session. This means that a user cannot have a session longer than 24 hours.

The default session timeout is 30 minutes. This setting can be adjusted using a system property. For more information about modifying the session timeout setting, see **Manage user sessions**.

### Site visit calculation examples

A user logs in, logs out, and then logs in again:

<table>
<thead>
<tr>
<th>Step</th>
<th>User activity</th>
<th>Billable count incremented</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>User visits the portal as an anonymous or guest user</td>
<td>Yes</td>
</tr>
<tr>
<td>2</td>
<td>User logs in</td>
<td>No</td>
</tr>
<tr>
<td>3</td>
<td>User logs out</td>
<td>No</td>
</tr>
<tr>
<td>4</td>
<td>User logs in immediately after logging out</td>
<td>Yes</td>
</tr>
</tbody>
</table>

A user logs in and continues the session past midnight:

<table>
<thead>
<tr>
<th>Step</th>
<th>User activity</th>
<th>Billable count incremented</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>User visits the portal as an anonymous or guest user</td>
<td>Yes</td>
</tr>
<tr>
<td>2</td>
<td>User logs in</td>
<td>No</td>
</tr>
<tr>
<td>3</td>
<td>User session continues past midnight</td>
<td>Yes</td>
</tr>
<tr>
<td>4</td>
<td>User logs out</td>
<td>No</td>
</tr>
</tbody>
</table>
## Customer Service Portal user roles

Several different roles allow customers to create and edit cases and manage users from the customer portal.

### Customer Service Portal user roles

<table>
<thead>
<tr>
<th>User role</th>
<th>What this user can do on the Customer Service Portal</th>
</tr>
</thead>
<tbody>
<tr>
<td>Customer (sn_customerservice.customer)</td>
<td>• Create a case for this user's account.</td>
</tr>
<tr>
<td></td>
<td>• View a list of cases created by this user.</td>
</tr>
<tr>
<td></td>
<td>• Edit cases created by this user.</td>
</tr>
<tr>
<td></td>
<td>• View a list of assets belonging to this user's account.</td>
</tr>
<tr>
<td></td>
<td>• Search for information.</td>
</tr>
<tr>
<td>Customer case manager (sn_customerservice.customer_case_manager)</td>
<td>• Create a case for this user's account and for child accounts.</td>
</tr>
<tr>
<td></td>
<td>• View a list of cases created by this user and view cases for child accounts.</td>
</tr>
<tr>
<td></td>
<td>• Edit cases created by this user and edit cases for child accounts.</td>
</tr>
<tr>
<td></td>
<td>• View a list of assets belonging to this user's account and to child accounts.</td>
</tr>
<tr>
<td></td>
<td>• Search for information.</td>
</tr>
<tr>
<td></td>
<td>• Create a case on behalf of another contact in this account.</td>
</tr>
<tr>
<td></td>
<td>• View a list of cases belonging to this account.</td>
</tr>
<tr>
<td></td>
<td>• Edit cases belonging to the account.</td>
</tr>
</tbody>
</table>

**Note:** The customer case manager role is not automatically added to the `sn_customerservice.contact_role_assignment` system property. To expose this role to customer and partner administrators, navigate to **Customer Service > Administration > Properties** and add it to this property.

<table>
<thead>
<tr>
<th>User role</th>
<th>What this user can do on the Customer Service Portal</th>
</tr>
</thead>
<tbody>
<tr>
<td>Customer administrator (sn_customerservice.customer_admin)</td>
<td>• Create a case for this user's account.</td>
</tr>
<tr>
<td></td>
<td>• Create a case on behalf of another contact for this account.</td>
</tr>
<tr>
<td></td>
<td>• View a list of cases belonging to this account.</td>
</tr>
<tr>
<td></td>
<td>• Edit cases belonging to this account.</td>
</tr>
<tr>
<td></td>
<td>• View a list of assets belonging to this user's account.</td>
</tr>
<tr>
<td></td>
<td>• Search for information.</td>
</tr>
<tr>
<td></td>
<td>• Manage users for this account.</td>
</tr>
<tr>
<td>Partner (sn_customerservice.partner)</td>
<td>• Create a case for this user's account.</td>
</tr>
<tr>
<td></td>
<td>• Create a case on behalf of customer accounts.</td>
</tr>
<tr>
<td></td>
<td>• View a list of cases belonging to this user.</td>
</tr>
<tr>
<td></td>
<td>• Edit cases belonging to this user.</td>
</tr>
<tr>
<td></td>
<td>• View a list of assets belonging to this user's account.</td>
</tr>
<tr>
<td></td>
<td>• Search for information.</td>
</tr>
<tr>
<td>User role</td>
<td>What this user can do on the Customer Service Portal</td>
</tr>
<tr>
<td>-----------------------------------------------</td>
<td>------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Partner administrator (sn_customerservice.partner_admin)</td>
<td>• Create a case for this user's account.</td>
</tr>
<tr>
<td></td>
<td>• Create a case on behalf of customer accounts.</td>
</tr>
<tr>
<td></td>
<td>• View a list of cases belonging to this account and to customer accounts.</td>
</tr>
<tr>
<td></td>
<td>• View a list of assets belong to this account and to customer accounts.</td>
</tr>
<tr>
<td></td>
<td>• Edit cases belonging to this account and to customer accounts.</td>
</tr>
<tr>
<td></td>
<td>• Manage users for this account and for customer accounts.</td>
</tr>
</tbody>
</table>

**Limit access to product model data on the Customer Service Portal**

Use a system property to limit customer access to data in the Product Models table.

From the Customer Service Portal, product model data can be accessed by external users with the sn_esm_user role. System administrators can use the `csm_cmdb_model.customer_visible_flag` system property and the **Customer Visible** field on the Product Models table (cmdb_model) and child tables to limit this access.

The `csm_cmdb_model.customer_visible_flag` system property enables the **Customer Visible** field for the tables listed below. By default, this property is set to false. When set to true, the system uses the setting in the **Customer Visible** field to determine access to product model data on the Customer Service Portal.

- Product Models table (cmdb_model)
- Software Models table (cmdb_software_product_model)
- Application Models table (cmdb_application_product_model)
- Consumable Models table (cmdb_consumable_product_model)
- Facility Models table (cmdb_facility_product_model)
- Hardware Models table (cmdb_hardware_product_model)

The Model Categories table (cmdb_model_category) does not have a **Customer Visible** field. Access to model categories data is restricted by using the **Customer Visible** field on the Product Model table. Only the categories for the products which are visible in the Product Model table will be visible in the Model Categories table.

For upgrades from Jakarta to madrid, the **Customer Visible** field is added to each record in the Product Models table and set to false.

To limit access:

1. Set the `csm_cmdb_model.customer_visible_flag` system property to true.
2. Customize the Product Models table (cmdb_model) and add the **Customer Visible** column.
3. Set the value of the **Customer Visible** field to true for the product models that should be visible to external customers.

External users can see these product using these product models if the products are linked to the customer account.
Manage contacts from the customer portal

Users with the customer administrator role can create and update customer contacts; assign roles to contacts; and create, enable, or disable contact logins from the customer portal.

Administrators can also reset a password for a contact from the customer portal based on the Content Management System (CMS). The Customer Service Portal does not support the password reset feature. The system administrator can change and reset passwords using the ServiceNow Password Reset and Password Change applications.

Note: The Related Links section at the bottom of the Contacts page includes several Service Portal links that are not currently supported by the Customer Service Portal.

Create a customer contact

Create a customer contact from the customer portal.

Role required: sn_customerservice.customer_admin, sn_customerservice.partner_admin, or admin

1. Click Support > Contacts in the portal header.
2. From the Contacts list, click New.
3. Fill in the fields on the Contact form, as appropriate.

Contact form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>First name</td>
<td>Customer’s first name.</td>
</tr>
<tr>
<td>Last name</td>
<td>Customer’s last name.</td>
</tr>
<tr>
<td>Title</td>
<td>Customer’s job title.</td>
</tr>
<tr>
<td>Language</td>
<td>The language for this customer.</td>
</tr>
<tr>
<td>Time zone</td>
<td>The time zone for this customer’s location.</td>
</tr>
<tr>
<td>Account</td>
<td>The user’s account.</td>
</tr>
<tr>
<td>Email</td>
<td>Customer’s email address</td>
</tr>
<tr>
<td>Business phone</td>
<td>Customer’s business phone.</td>
</tr>
<tr>
<td>Mobile phone</td>
<td>Customer’s mobile phone.</td>
</tr>
<tr>
<td>Notification</td>
<td>Enable or disable notifications for this customer. This field is displayed after you click Submit and create the contact.</td>
</tr>
<tr>
<td>User ID</td>
<td>A unique identifier for this user. The user ID should follow the format firstname.lastname. This field is displayed after you click Submit and create the contact.</td>
</tr>
</tbody>
</table>

4. Click Submit.
   After you create a new contact, you can create a login for the contact and enable or disable notifications.

Create a login for a new contact

After creating a new contact, you can create a login for that contact.
Role required: sn_customerservice.customer_admin, sn_customerservice.partner_admin, or admin

1. Click Manage Users in the portal header.
2. Select the new contact from the Contacts list.
3. Click the Create Login related link.
   The system creates a login for this contact and fills in the User ID field on the Contact form with the user's first and last name in this format: firstname.lastname
   In the event that you create a new contact with the same first and last name as an existing contact, the User ID field is left blank and the Create Login related link does not appear on the contact form.
   To create a login for this contact, enter a unique login in the User ID field on the Contact form and click Update.

**Update contact information for a user**

Update the contact information for a user from the customer portal.

Role required: sn_customerservice.customer_admin, sn_customerservice.partner_admin, or admin

1. Click Support > Contacts in the portal header.
2. Select a user from the Contacts list.
3. Make the desired changes to the fields on the Contact form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>First name</td>
<td>Customer’s first name.</td>
</tr>
<tr>
<td>Last name</td>
<td>Customer’s last name.</td>
</tr>
<tr>
<td>Title</td>
<td>Customer’s job title.</td>
</tr>
<tr>
<td>Language</td>
<td>The language for this customer.</td>
</tr>
<tr>
<td>Time zone</td>
<td>The time zone for this customer’s location.</td>
</tr>
<tr>
<td>Account</td>
<td>The user’s account.</td>
</tr>
<tr>
<td>Email</td>
<td>Customer’s email address</td>
</tr>
<tr>
<td>Business phone</td>
<td>Customer’s business phone.</td>
</tr>
<tr>
<td>Mobile phone</td>
<td>Customer’s mobile phone.</td>
</tr>
<tr>
<td>Notification</td>
<td>Enable or disable notifications for this customer.</td>
</tr>
<tr>
<td>User ID</td>
<td>A unique identifier for this user. The user ID should follow the format firstname.lastname.</td>
</tr>
</tbody>
</table>

4. Click Update.

**Enable or disable the login for a contact**

Enable or disable the login for a contact.

Role required: sn_customerservice.customer_admin, sn_customerservice.partner_admin, or admin

1. Click Manage Users in the portal header.
2. Select a contact from the Contacts list.
3. Click one of the following related links:
   - Disable login
   - Enable login

   If the login for this contact is currently enabled, the Disable login related link is displayed. If currently disabled, the Enable login related link is displayed.

   The system enables or disables the login for this contact and returns you to the Contact list. A disabled contact cannot access the customer portal.

**Assign a user role to a contact**

Assign one or more user roles to a contact from the customer portal.

Role required: sn_customerservice.customer_admin, sn_customerservice.partner_admin, or admin

Use the Edit Role pop-up window to manage the roles for a contact. Contacts must have at least one assigned user role. If there are no roles in the Selected column on the pop-up window, you cannot update the record.

---

**Note:** The roles available in the Edit Role pop-up window are configured using the sn_customerservice.contact_role_assignment property.

---

1. Click Contacts in the Customer Service Portal header.
2. Select a user from the Contacts list.
3. Click the Edit Roles related link.
4. In the Edit Role pop-up window, select a role in the Available column and move it to the Selected column.
5. Click Update on the Edit Role pop-up window.

   **Note:** If there are no roles in the Selected column, the system displays an error message and the column resets to display the originally assigned roles.

6. Click Save on the Contact form.

**Reset a password for a contact**

Reset a password for a contact from the customer portal.

Role required: admin

When you reset a password for a contact, the system sends an email to the contact that includes a new temporary password. The customer is asked to change this temporary password at the next login.

---

**Note:** Administrators can reset a password for a contact from the customer portal based on the Content Management System (CMS). The Customer Service Portal does not support the password reset feature.

---

1. Click Manage Users in the portal header.
2. Select a contact from the Contacts list.
3. Click the Reset a password related link.
   
   This brings up the Password Reset Assistance dialog box.
4. Ensure that the correct user name is displayed in the Select User field.
5. Select a process in the Select process field.
6. Click Verify Identity.

Manage customer registration requests

Users with the customer administrator role can approve or reject registration requests that customers submit from the Customer Service Portal.

Approve a registration request with a valid registration code

Approve a registration request from a user that was submitted from the Customer Service Portal with a valid registration code.

Role required: sn_customerservice.customer_admin
1. Navigate to the customer portal.
2. Click Approvals.
   The Approvals list displays registration requests with these states: Requested and No Longer Required.
3. Click a request in the Approvals list with a state of Requested.
4. If desired, add any Comments to this request.
5. Click Approve.
   A user account is created and an email is sent to the contact’s email address with a user ID and temporary password. The user is also assigned these roles: sn_esm_user and snc_external.

Approve a registration request with an invalid registration code

Approve a registration request from a user that was submitted from the Customer Service Portal with an invalid registration code.

Role required: sn_customerservice.customer_admin
1. Navigate to Customer Service > Administration > Pending Contact Registrations.
2. Select a registration request with a state of Pending.
3. Select an Account for the requester.
4. Click Update.
   The registration request is sent to the customer administrator of the assigned account.

Reject a registration request

Reject a registration request from a user that was submitted from the Customer Service Portal.

Role required: sn_customerservice.customer_admin
1. Navigate to the customer portal.
2. Click My Approvals.
3. Click a request in the Approvals list with a state of Requested.
4. Click Reject.
   An email regarding the rejection is sent to the requestor’s email address.

Assign a contact to an asset from the customer portal

Users with the customer administrator role can assign a contact to an asset from the customer portal.
Role required: sn_customerservice.customer_admin

1. Log in to the customer portal.
2. Click Support > Assets from the portal header menu.
3. Click the desired asset.
4. Click New in the Asset Contacts related list.
   This displays a new Asset Contact form. The Asset field displays the selected asset and is read-only.
5. Select a Contact.
   The contacts available for selection are the contacts from the asset’s account.
6. Click Submit.
   The contact is added to the Asset Contacts related list.

Search for information using the customer portal

Use the search feature on the customer portal to find information about a question or an issue.

Role required: sn_customerservice.customer, sn_customerservice.customer_admin,
sn_customerservice.partner, or sn_customerservice.partner_admin

The portal has a search feature that you can use to search for information across several repositories. Enter a search term in the Search field and then click Search to display a list of related articles.

1. Enter a search term into the Search field.
2. Click Search.
   A list of articles related to the search term is displayed.
3. Click a link to view an article.

Search the knowledge base

Use the customer portal to search the knowledge base or view a list of popular knowledge base articles.

Role required: sn_customerservice.customer, sn_customerservice.customer_admin,
sn_customerservice.partner, or sn_customerservice.partner_admin

The customer service portal includes a link to the knowledge base that you can use to search for information, read and rate articles, and submit feedback. Under this link, the portal displays a list of popular knowledge base articles. If the information that you need is not included in this list, you can search the knowledge base for the desired information.

1. Navigate to the customer service portal.
2. Click Knowledge.
   The knowledge page displays a separate category for each of the products purchased by this customer. It also displays lists of articles by:
   - Featured content
   - Most useful
   - Most viewed
3. Do one of the following:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Click a product to display more specific information</td>
<td>Displays a list of categories on the left and articles on the right. Click a category to drill down even further.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------------------</td>
<td>--------------------------------------------------</td>
</tr>
<tr>
<td>Click a link from one of the lists</td>
<td>Displays the article.</td>
</tr>
<tr>
<td><strong>Type a topic in the Search field and press the Enter key</strong></td>
<td>Displays a list of related articles. Click a link to display the desired article.</td>
</tr>
</tbody>
</table>

**Search the customer service community**

Use the customer service portal to search the community site or view a list of recent discussion topics.

Role required: sn_customerservice.customer, sn_customerservice.customer_admin, sn_customerservice.partner, or sn_customerservice.partner_admin

1. Navigate to the customer service portal.
2. Click **Ask the Community**.
   - This brings up the Ask a Question page.
3. Enter a question in the **Title** field.
4. Select a knowledge base in the **Knowledge Base** field.
5. If desired, select a category in the **Category** field.
6. If desired, add one or more tags to your question in the **Tags** field.
7. Click **Post Question**.
   - The question appears on the search results page under the **Questions** category.

**Deflect cases with knowledge and community content**

Enable customers to search for information from the knowledge base and community and find solutions to their issues.

Role required: sn_customerservice_customer or sn_customerservice_consumer

The Service Portal Case form displays contextual search results based on text entered in the Subject field. These search results provide targeted solutions to customers. Customers can search for information that is related to a case when opening a case. If the search results in any related content, the customer can preview the content.

---

**Note:** By default, search results include knowledge articles, solved community questions and blogs, and pinned articles.

1. Navigate to the Customer Service Management Service Portal and then **Support > New Cases**.
2. Click **Product Case** or **Order Case**.
3. Start typing in the **Subject** field.
   - If there are any search results that match, they are displayed in the **Related Search Results** widget.

   **Note:** If embedded search has been enabled, the results are displayed inline in the Case form in a **Knowledge results** section and are read-only.

4. Perform one of the following actions.
   - Click one of the content links in the **Related Search Results** widget to enter the content directly.
   - Click one of the content links in the embedded **Knowledge results** section to open the content inline as read-only.
5. Optional: Click **This helped** to mark the content as helpful for resolving the associated case.
6. Click **Submit**.

### View asset information from the Customer Service Portal

View a list of assets for the current user's account.

Role required: sn_customerservice.customer, sn_customerservice.customer_admin, sn_customerservice.partner, or sn_customerservice.partner_admin

1. Click **Support > Assets** in the portal header.
   This displays a list of assets that belong to the current user's account, including the name and serial number of the asset and the product model category and account to which it belongs.
2. Click one of the following to view more information.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display name</td>
<td>Displays the asset information.</td>
</tr>
<tr>
<td>Account</td>
<td>Displays the account information.</td>
</tr>
<tr>
<td>Model category</td>
<td>Displays the product model information for this asset.</td>
</tr>
</tbody>
</table>

3. Click the Back button to return to the list of assets.

### View or update customer contact information

View or update your contact information from the customer portal.

Role required: sn_customerservice.customer, sn_customerservice.customer_admin, sn_customerservice.partner, or sn_customerservice.partner_admin

1. Click your user name in the portal header to display your contact information.
2. Make any desired changes to the fields on the Contact form.

**Contact form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>First name</td>
<td>Customer's first name.</td>
</tr>
<tr>
<td>Last name</td>
<td>Customer's last name.</td>
</tr>
<tr>
<td>Title</td>
<td>Customer's job title.</td>
</tr>
<tr>
<td>Language</td>
<td>The language for this customer.</td>
</tr>
<tr>
<td>Time zone</td>
<td>The time zone for this customer's location.</td>
</tr>
<tr>
<td>Account</td>
<td>The user's account.</td>
</tr>
<tr>
<td>Email</td>
<td>Customer's email address</td>
</tr>
<tr>
<td>Business phone</td>
<td>Customer's business phone.</td>
</tr>
<tr>
<td>Mobile phone</td>
<td>Customer's mobile phone.</td>
</tr>
<tr>
<td>Notification</td>
<td>Enable or disable notifications for this customer.</td>
</tr>
<tr>
<td>User ID</td>
<td>A unique identifier for this user. The user ID should follow the format <strong>firstname.lastname</strong>.</td>
</tr>
</tbody>
</table>
3. Click Update.

Customer notification preferences

Customers can add devices and specify phone numbers and email addresses to be used for notifications. Customers can also set preferences for email notifications.

Customers can add the following types of devices:
- Email
- Push
- SMS
- Voice

After adding a new device, customers can configure the device to receive notifications. Customers can also set several email notification preferences which control email notifications that are sent to the customer when an agent performs one of the following case activities:
- Opens a case for a customer
- Comments on a customer’s case
- Provides a resolution for a customer’s case
- Closes a customer’s case

Add a device for customer notifications

Customers can add devices to be used for notifications.

Role required: sn_customerservice.customer, sn_customerservice.customer_admin, sn_customerservice.partner, or sn_customerservice.partner_admin

1. Click your user name in the portal header to display the user profile information.
2. Click the Notification Preferences related link to display the Notification Preferences form.
3. Click the New Device button in the form header to display the New Device form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the device.</td>
</tr>
<tr>
<td>Type</td>
<td>The type of notification device:</td>
</tr>
<tr>
<td></td>
<td>- Email</td>
</tr>
<tr>
<td></td>
<td>- Push</td>
</tr>
<tr>
<td></td>
<td>- SMS (default)</td>
</tr>
<tr>
<td></td>
<td>- Voice</td>
</tr>
<tr>
<td></td>
<td>Different fields are displayed depending on the type of device selected.</td>
</tr>
<tr>
<td>Phone number</td>
<td>The user’s phone number.</td>
</tr>
<tr>
<td>Service provider</td>
<td>The user’s service provider.</td>
</tr>
<tr>
<td>Email address</td>
<td>The user’s email address.</td>
</tr>
<tr>
<td>Push application</td>
<td>The push application to be used for notifications.</td>
</tr>
<tr>
<td>User</td>
<td>The user’s name.</td>
</tr>
</tbody>
</table>
4. Enter a name for the device in the **Name** field.
5. Select the type of device in the **Type** field.

   The remaining fields displayed depend on the type of device selected.
   - If **Email**, enter an address in the **Email address** field.
   - If **Push**, select an application in the **Push Application** field.
   - If **SMS**, enter a phone number in the **Phone number** field and select a provider in the **Service provider** field.
   - If **Voice**, enter a phone number in the **Phone number** field.

6. If desired, select a different user in the **User** field.
7. Enter a number in the **Order** field.
8. Enable the **Active** checkbox.
9. Click **Submit**.

### View or update notification preferences

Customers can add devices and specify email addresses to be used for notifications.

Role required: sn_customerservice.customer, sn_customerservice.customer_admin, sn_customerservice.partner, or sn_customerservice.partner_admin

1. Click the user name or profile photo in the portal header to display the user profile information.
2. Click the **Notification Preferences** related link to display the Notification Preferences page.
3. Select a device from the Notification Preferences list.
4. Make any desired changes to the fields on the device form.
5. Click **Update**.

### Set email notification preferences

Customers can set preferences for email notifications that are sent when customer service agents perform different actions on cases.

Role required: sn_customerservice.customer, sn_customerservice.customer_admin, sn_customerservice.partner, or sn_customerservice.partner_admin

1. Navigate to the customer service portal.
2. Click your user name or photo in the portal header to display your user profile information.
3. Click the **Notification Preferences** related link to display the Notification Preferences form.
4. Enable or disable the following email notifications for your primary email address. An option is enabled when the switch appears green and is toggled to the right.
   - Case closed
   - Case commented
   - Case opened for me
   - Case resolved
5. Click **Save**.
Change your password directly from the Customer Service Portal

Change your password directly from the Customer Service Portal.

Role required: admin

**Note:** Users with the required roles can change their passwords from the Customer Service Portal. The system administrator can change and reset passwords using the ServiceNow® Password Reset and Password Change applications.

1. Click your user name in the portal header to display the user profile information.
2. Click **Change Password**.
3. Fill in the fields on the Change Password form.

**Change Password form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Old Password</td>
<td>The current password. This field is automatically filled in.</td>
</tr>
<tr>
<td>New Password</td>
<td>The new password, which must meet the following requirements:</td>
</tr>
<tr>
<td></td>
<td>• Be a minimum of eight characters long</td>
</tr>
<tr>
<td></td>
<td>• Include at least one uppercase and one lowercase letter</td>
</tr>
<tr>
<td></td>
<td>• Include at least one number</td>
</tr>
<tr>
<td>Retype Password</td>
<td>The new password.</td>
</tr>
</tbody>
</table>

4. Click **Change Password**.

**Contact self-registration**

The self-registration feature enables new customer contacts to submit registration requests from the customer portal.

Once the request is submitted, it goes through an approval process and is either accepted or rejected. If accepted, a user account is created and the contact receives an email with a user ID and a temporary password. When logging in to the portal for the first time, the contact is asked to change the temporary password. If rejected, the contact receives an email with this information.

A customer contact can submit a registration request with or without a registration code:

- If a request is submitted with a valid registration code, the contact’s account information is automatically detected and added to the contact record. The request is then sent to the customer administrator of that account for approval. If an account has multiple customer administrators, they all receive the registration request but only one is required to approve it. After a request has been approved, the state of the request changes to **No Longer Required** for the other customer administrators.
- If a request is submitted without a registration code or if the code is incorrect, the request is sent to the system administrator, who fills in the account information. Once this information is filled in, the request is sent to the customer administrator of that account for approval.
The system administrator creates a unique registration code for each account and stores it in the Registration Code field on the Account form. Once this code is created, customer administrators can distribute the code to customers as needed.

Submit a self-registration request

Submit a registration request from the Customer Service Portal.

Role required: none

1. Navigate to the customer portal login page.
2. Request a login by clicking **Register** from the portal header.
3. Fill in your **First Name**, **Last Name**, and **Business Email**.
4. If you have a registration code, enter it in the **Registration Code** field.
5. Enable the check box to agree to the privacy policy and to the community terms and conditions.
   Click the links to access more information about these policies.
6. Enable the Security Code check box, complete the CAPTCHA validation, and click **Verify**.

   The Customer Service application uses the Google re-CAPTCHA service.
7. Click **Submit**.

   You are returned to the portal login page.

   If you entered a valid registration code, you see this message: “Your request has been submitted and is pending review. You will receive an email when your request is processed.”

   If you did not enter a registration code or if the code was incorrect, you see this message: “Incorrect Registration Code.” Your request is submitted and is sent to the system administrator to complete the account information.

Request a password reset

If you forget your password, you can request a new password from the customer portal login screen.

Role required: none

1. Navigate to the customer portal login page.
2. Click the **reset your password here** link.
3. Enter your **User name** and **Email address**.
4. Click **Reset Password**.

   The user name and email address are validated. If they match, the system generates a temporary password and sends it to the user’s email address.
5. Log in to the customer portal using the temporary password.
   You are required to create a new password before continuing.
6. Enter the new password in the **Password** field.
7. Enter the new password again in the **Validate Password** field.
8. Click **Submit**.

Log in to the Customer Service Portal for the first time

After a registration request is approved, the customer contact receives an email with a user ID and temporary password. When logging in for the first time, the contact is asked to change the password.

Role required: none

1. Navigate to the Customer Service Portal login page.
2. Enter your user ID in the User name.
3. Enter your temporary password in the Password field.
4. Click Login.
   You are prompted to change your password.
5. Enter your temporary password in the Current Password field.
6. Enter your new password in the New Password field.
7. Re-enter your new password in the Confirm New Password field.
8. Click Submit.

Create a case for install base from the Customer Service homepage

Create a case about a question or issue on your install base from the Customer Service homepage.

Role required: sn_customerservice.customer, sn_customerservice.partner, sn_customerservice.customer_admin, or sn_customerservice.partner_admin

Install base enables you to track which instances have been provisioned for your account and the products and services that run on them.

1. Navigate to the Customer Service homepage.
2. Click Create Case for Install Base.
3. Fill out the fields on the form, as required.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Product</td>
<td>The sold product you have a question on or issue with.</td>
</tr>
<tr>
<td>Install Base</td>
<td>The install base item you have a question on or issue with.</td>
</tr>
<tr>
<td>Priority</td>
<td>The assigned priority:</td>
</tr>
<tr>
<td></td>
<td>· 1 — Critical</td>
</tr>
<tr>
<td></td>
<td>· 2 — High</td>
</tr>
<tr>
<td></td>
<td>· 3 — Moderate</td>
</tr>
<tr>
<td></td>
<td>· 4 — Low (default)</td>
</tr>
<tr>
<td>Subject</td>
<td>A brief description of the question, issue, or problem.</td>
</tr>
<tr>
<td>Description</td>
<td>A more detailed description of the customer question, issue, or problem.</td>
</tr>
</tbody>
</table>

4. Click Submit.
   The case is created, assigned a case number, and added to the user’s case list. Click My Cases at the top of the customer portal to view the Cases list.

View install base information from the Customer Service homepage

View a list of install base to track the instances provisioned for your account and which products or services run on them.
Role required: sn_customerservice.customer, sn_customerservice.customer_admin, sn_customerservice.partner, or sn_customerservice.partner_admin

1. Navigate to the Customer Service homepage.
2. Click Support > Install Base in the header menu.
   A list of install base that belongs to your account, including the contact and when it was created, is displayed.
3. Click an install base to view the details and any cases created on the install base in the last 30 days.
4. Optional: You can also create a case directly from the install base details.

**View product information from the Customer Service homepage**

View a list of products to track the products or services sold to your account.

Role required: sn_customerservice.customer, sn_customerservice.customer_admin, sn_customerservice.partner, or sn_customerservice.partner_admin

1. Navigate to the Customer Service homepage.
2. Click Support > Products in the header menu.
   A list of products or services that have been sold to your account is displayed.
3. Click a product to view the details and any cases created on the product in the last 30 days.
4. Optional: You can also create a case directly from the product details.

**Create a product case from the Customer Service homepage**

Create a case about a question or issue on a product from the Customer Service homepage.

Role required: sn_customerservice.customer, sn_customerservice.partner, sn_customerservice.customer_admin, or sn_customerservice.partner_admin

1. Navigate to the Customer Service homepage.
2. Right-click in the form header and choose Case > Create Product Case.

**Note:** Depending on your role, you might not see the Account and Contact fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Account</td>
<td>The account for which the case is being created.</td>
</tr>
<tr>
<td>Contact</td>
<td>The name of the customer contact for this case.</td>
</tr>
<tr>
<td>Asset</td>
<td>The asset tag number or the serial number of the asset associated with this case.</td>
</tr>
<tr>
<td>Product</td>
<td>The product model of the asset. A model is a specific version or configuration of an asset (for example, Apple Mac Book Pro). If you select an asset in the Asset field, this field is auto-populated if the associated product information is available in the asset record. A product may be associated with multiple assets.</td>
</tr>
</tbody>
</table>
## ServiceNow New York Customer Service Management

### Field | Description
--- | ---
Priority | The available assigned priorities are:
   - 1 - Critical
   - 2 - High
   - 3 - Moderate
   - 4 - Low (default)
Subject | A brief description of the customer question, issue, or problem.
   - **Note:** When you start entering the subject, the application searches for relevant content in the knowledge bases configured for the portal. The results are displayed in the Related Content list.
Description | A detailed description of the customer question, issue, or problem.

3. **Click Submit.**
   
The case is created, assigned a case number, and added to the creator’s case list. To view this list, click **My Cases** at the top of the customer portal.

### Chat with an agent from the Customer Service Portal

Chat with a virtual agent or a customer service agent from the Customer Service Portal to resolve issues quickly.

Role required: sn_customerservice.customer, sn_customerservice.customer_admin, sn_customerservice.partner, sn_customerservice.partner_admin

1. **Click** the chat icon ( ) in the Customer Service Portal to start a conversation.
   
A virtual agent or a customer service agent responds.

2. Optional: To talk to a person instead of a virtual agent, click ( )
   
and then **Contact Support**.

3. When you are finished with the chat, click **End Conversation**.

If the agent creates a new case or links the discussion to an existing case, you can view these cases from the customer portal by clicking on **My Cases** and displaying the case list.

### View or modify a case from the Customer Service Portal

View or modify the information in a selected customer service case.

Role required: sn_customerservice.customer, sn_customerservice.customer_admin, sn_customerservice.partner, sn_customerservice.partner_admin

Depending on the role of the current user, the Case list displays:
- Cases created by the current user (sn_customerservice.customer)
- Cases related to the current user’s account (sn_customerservice.customer_admin)
- Cases related to the current user’s account as well as partner accounts (sn_customerservice.partner, sn_customerservice.partner_admin)

1. Click **Case > All Cases** in the portal header.
   Cases are ordered in the list with the most recently updated at the top.
2. Click the desired case number to open the Case form.
3. Make any necessary changes to the **Short description** or **Additional comments** fields.
   All other fields on the form are read-only.
4. Click **Update**.

**View a publication on the Customer Service Portal**

View the details of a publication on the Customer Service Portal and download any attachments.
Role required: sn_customerservice.customer

The **Publications** link on the customer service portal displays a list of current publications. You can filter the publications on this list by category and you can further filter the list to show all publications or only those that are unread. You can sort the list by publish date or expiration date. You can also search for a specific term.

After a publication reaches its **expiry date**, it is automatically removed from the Publications list.

1. Navigate to the customer service portal.
2. Click **Support > Publications** in the portal header.
   This displays a list of current publications. The information displayed for each publication includes the title, publish date, expiration date, and a brief description.
3. If desired, filter or sort the Publications list.
   - Select a category in the upper-left corner or select **All Categories**.
   - Select either **All Publications** or **Unread Publications** in the upper-right corner.
   - Select either **Publish Date** or **Expiry Date** in the Sort by field.
4. If desired, search the Publications list by entering the search term in the **Search Publications** field.
5. Click a publication name to open.
6. If the publication has attachments, click **Attachments** in the upper-right corner.
7. Select the attachments to download from the pop-up window.
8. Close the pop-up window.
9. Click the return arrow at the top of the publication to return to the Publications list.

**Complete a customer service satisfaction survey**

After accepting a proposed solution for a case, complete a customer service satisfaction survey.

When a customer accepts a proposed solution for a case by clicking **Accept Solution** on the case form, a satisfaction survey is displayed in the portal. The customer has the option of completing or skipping the survey. Either choice returns the customer to the list of cases on the self-service portal.

To complete the survey:
1. Answer each of the survey questions.
2. Click **Submit**.
Request an item or service from the Customer Service Portal

Browse the catalog and create a request from the Customer or Consumer Service Portals.

Role required: sn_customerservice.customer_admin, sn_customerservice.partner, sn_customerservice.customer_case_manager, sn_customerservice.customer, sn_customerservice.consumer, sn_customerservice.proxy_contact

Customers and consumers can make requests from the Customer and Consumer Service Portals. Customer administrators, partners, and case managers can also make requests.

Note: Creating a request from the Customer and Consumer Service Portals requires activation of the Customer Service with Request Management plugin (com.sn_cs_sm_request). It also requires that the system administrator provide external customers with access to request records.

1. Do one of the following to create a request:
   - Click the Request Something link on the portal landing page.
   - Click Requests > Request Something in the portal menu header.

2. Browse the service catalog and select the desired item or service. You can also use the Category filters to filter the available items.

3. Fill in any necessary information related to the request.

4. Click Submit.
   The system processes the request, creates the request and any other related records, and displays the details in the Related Records widget on the case view page.

View records related to a case from the Customer and Consumer Service Portals

View records related to a case, such as requests, changes, or problems, from the Customer or Consumer Service Portals.

Role required: sn_customerservice.customer_admin, sn_customerservice.partner, sn_customerservice.customer_case_manager, sn_customerservice.customer, sn_customerservice.consumer

If a case has one or more related records, you can see a list in the Related Records widget on the case view page. Click a record to view the details.

Note: If a case does not have any related records, the Related Records widget does not appear on the case view page.

1. Navigate to the Customer or Consumer Service Portal.

2. Click My Lists in the portal header and then select a case.
   You can use the My Lists filter to narrow the list of records before selecting a case.

3. In the Related Records widget, click a record to view the details in a pop-up window.

4. Optional: For request records, expand the Stage field to display more details about the request process.

5. Click the X in the upper corner to close the pop-up window.

Close a case from the Customer Service Portal

Customers and consumers can close cases from the Customer and Consumer Service Portals.
Role required: sn_customerservice.customer, sn_customerservice.consumer

This feature is available for the Customer Service Portal (B2B) for product and order cases and for the Consumer Service Portal (B2C).

The Close Case button is not available for cases in the Resolved or Closed states.

1. Click Cases in the portal header to open the Case list.
2. Open the desired case.
3. In the Actions section, click Close Case.
4. In the confirmation pop-up window, click Close Case.

When a case is closed from the portal:
- The case status in the Case details section is updated to Closed.
- The case additional comments and resolution notes are updated with Closed by customer.
- The case resolution code is set to Solved by customer.
- A message at the top of the portal confirms that the case has been closed.
- The system displays a customer satisfaction survey.

5. Complete the customer satisfaction survey.
   You can also choose to skip the survey. Either choice returns you to the case list on the portal.

Get help using virtual agent conversations

Use the pre-built Customer Service Virtual Agent chatbot conversations designed to help your customers complete common self-service tasks, such as getting help with a product or checking the status of a case. Use pre-defined NLU with your virtual agent chatbot topics to enable the chatbot to assess the intent of the user input and provide the best response based on the context of the conversation.

If you are an anonymous user not logged into the application, you can get help by entering keywords for an issue and choose to get transferred to a live agent.

Role required: sn_customerservice.customer, sn_customerservice.consumer

A user with a proxy_contact role can also check the case status for a customer.

The information exchanged during the conversation flow (user inputs and bot responses) enables the chatbot to fulfill a user request or assist a user in completing a task. If the user has a question or an issue with an existing product or order, the virtual agent searches the keyword and displays relevant knowledge articles that can help resolve the issue. If there are no relevant articles, it creates a case.

When you use ServiceNow NLU, it enables discovery of the chatbot topics based on either the keywords entered in the chat or the user-intent and matches an entity with the user input. It also makes the entity available to the topic if there is a match.

1. Navigate to the Customer Service Management portal.
2. Click Chat.
   You can click Show Me Everything to display all available topics or enter keywords to narrow down the display for relevant topics.
3. If you are a logged-in user, enter keywords to get help on a case, an issue, or an order.
   - If NLU is enabled, it will guide you through the right topic based on the utterance.
   - If NLU is not enabled, it will display topics based on the match for the entered keywords.
   You can make a selection from all available topics displayed.

**Note:** Contact your system administrator to determine if the topics are NLU-enabled.
4. Do any of the following:

<table>
<thead>
<tr>
<th><strong>To</strong></th>
<th><strong>Follow these steps</strong></th>
</tr>
</thead>
</table>
| **Check the status of a case** | 1. Do one of the following:  
   - If you are using the virtual agent conversation without enabling NLU, click **Check Case Status**.  
   - If you are using NLU in your virtual agent conversation, enter an utterance to check the status of a case.  
     **Note:** If you provide a case number, you will be presented with the details of the case.  
   
2. Select a case from the case list that you would like to get help for.  
3. When the case information displays, you can do one of the following:  
   - Add a comment  
   - Attach a picture  
   - Check another case  
   - Contact an agent.  
   
To exit the chat conversation, click **I’m done**.  

| **Get help with a product** | When you enter a keyword, the chatbot returns a list of related knowledge articles. If there are no matching articles associated with the description, a case is automatically created and displays the following information:  
   - Case identification number  
   - Short description  
   - State  
   - Priority  
   
Take any of the following additional actions:  
   - Update the product and asset  
   - Add a comment  
   - Attach a picture  
   - Contact an agent  
   
To exit the chat conversation, click **I’m done**. |
To get help with an order, follow these steps:

1. Do one of the following:
   - If you are using the virtual agent conversation without enabling NLU, click **Get Help with Order**.
   - If you are using NLU in your virtual agent conversation, enter an utterance to get help on an order.

   **Note:** If you provide an order number, you will be presented with the details of the order.

2. Select an order from the list of your orders that you would like to get help for.

3. Take any of the following additional actions:
   - Add a comment
   - Attach a picture
   - Contact an agent

To exit the chat conversation, click **I'm done**.

**Get help**

If you are an anonymous user not logged into the application, enter keywords on an issue. The chatbot returns a list of related knowledge articles that have been made public. If there are no matching articles that would help resolve the issue, you can choose to be transferred to a live agent.

---

**Use the Consumer Service Portal**

The Consumer Service Portal is a web interface that your company can use to provide information and support to consumers.

The Consumer Service Portal is based on the ServiceNow Service Portal application. Consumers can use the portal to search for information, get their questions answered by other registered members, or request assistance from a customer service agent.

From the Consumer Service Portal, consumers can:

- Search for information, browse knowledge articles, and engage with the community.
- Start a chat session with a customer service agent
- Register, create a login, and create a user profile.

After registering and logging in to the Consumer Service Portal, consumers can:

- Edit user profile information and change passwords.
- Register new products and view a list of currently registered products.
- Contact a customer service agent about a question or issue.
- Create cases and view a list of current cases.
- Accept or reject proposed case solutions.

Your consumer service portal activity usually begins on the consumer service portal homepage. If you are a logged in user, you see different information than non-logged in users. Your organization can customize the homepage.
### Consumer Service Portal homepage for logged in users

<table>
<thead>
<tr>
<th>UI component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Knowledge</td>
<td><strong>Knowledge</strong> on the header and the main page takes you to the kb_home page. The knowledge home page allows you to search the knowledge base or view a list of top-rated or most viewed knowledge base articles.</td>
</tr>
<tr>
<td>Requests</td>
<td>Displays all your requests and you can also request from the catalog for items and services.</td>
</tr>
<tr>
<td>My lists</td>
<td>Lists all your cases.</td>
</tr>
<tr>
<td>Get help menu</td>
<td>Click <strong>Get Help</strong> to open a product or order case.</td>
</tr>
<tr>
<td>Support menu</td>
<td>Navigate to cases, orders, my products, and other quick links.</td>
</tr>
<tr>
<td>Tours</td>
<td>View a tour for additional guidance on how the Customer Service Management application works. Tours appear when your administrator creates them on certain pages.</td>
</tr>
<tr>
<td>Chat</td>
<td>Click <strong>Chat</strong> to chat with a virtual agent or a customer service agent.</td>
</tr>
<tr>
<td>Profile menu</td>
<td>Click your profile photo to either view your profile or logout.</td>
</tr>
<tr>
<td>Search</td>
<td>Enter a search term and click <strong>Search</strong> to view the search results.</td>
</tr>
<tr>
<td>Ask the Community</td>
<td>Click <strong>Ask the Community</strong> to access the Community homepage.</td>
</tr>
<tr>
<td>Get help</td>
<td>Click <strong>Get help</strong> to make a request or report a problem by opening a case.</td>
</tr>
<tr>
<td>Most viewed articles</td>
<td>View a list of most viewed articles.</td>
</tr>
<tr>
<td>Featured articles</td>
<td>View featured community content.</td>
</tr>
<tr>
<td>Most useful articles</td>
<td>View most useful articles based on the usage count of the articles.</td>
</tr>
<tr>
<td>The following components are available if you have installed communities.</td>
<td></td>
</tr>
<tr>
<td>Recent solved discussion</td>
<td>View a list of recently solved discussions.</td>
</tr>
<tr>
<td>Recent community blog</td>
<td>View a list of recently published community blogs.</td>
</tr>
<tr>
<td>Community featured content</td>
<td>View a list of featured community content.</td>
</tr>
</tbody>
</table>

**Note:** Metadata for each entry in the widgets such as the number of views, number of days from the time the article or feature was published, and rating for the article is displayed.

### Customizing the Consumer Service Portal

To customize this portal, navigate to **Service Portal > Portals** and click **Consumer Service Portal**. See **Service Portal** for more information about creating a custom interface.
Portal usage calculation

Portal usage enables you to track how your customers and employees are using the portal. The Customer Portal Usage dashboard provides information about portal visits by your customers and employees, resulting in session counts.

To view the Customer Portal Usage dashboard, navigate to **Customer Service > Admin > Portal Usage**.

A user session is a period of activity on the Customer or Consumer Service Portal by one of the following users:
- **Internal**: an internal user, typically an employee, who is logged in.
- **External**: an external user, typically a customer or consumer, who is logged in.
- **Anonymous**: a user who is not logged in.

A user session times out after a specific period of inactivity.

User access to the self-service portals is tracked as follows: per session, per day, and per portal. If the same user logs in from multiple browsers or devices, each login is counted as a separate visit. Each first call of a portal page starts a session and, at midnight (server time), the system restarts another session. This means that a user cannot have a session longer than 24 hours.

The default session timeout is 30 minutes. This setting can be adjusted using a system property. For more information about modifying the session timeout setting, see **Manage user sessions**.

Site visit calculation examples

A user logs in, logs out, and then logs in again:

<table>
<thead>
<tr>
<th>Step</th>
<th>User activity</th>
<th>Billable count incremented</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>User visits the portal as an anonymous or guest user</td>
<td>Yes</td>
</tr>
<tr>
<td>2</td>
<td>User logs in</td>
<td>No</td>
</tr>
<tr>
<td>3</td>
<td>User logs out</td>
<td>No</td>
</tr>
<tr>
<td>4</td>
<td>User logs in immediately after logging out</td>
<td>Yes</td>
</tr>
</tbody>
</table>

A user logs in and continues the session past midnight:

<table>
<thead>
<tr>
<th>Step</th>
<th>User activity</th>
<th>Billable count incremented</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>User visits the portal as an anonymous or guest user</td>
<td>Yes</td>
</tr>
<tr>
<td>2</td>
<td>User logs in</td>
<td>No</td>
</tr>
<tr>
<td>3</td>
<td>User session continues past midnight</td>
<td>Yes</td>
</tr>
<tr>
<td>4</td>
<td>User logs out</td>
<td>No</td>
</tr>
</tbody>
</table>

Register for the Consumer Service Portal

Register for the Consumer Service Portal to gain access and create a consumer profile.

Role required: none

1. Navigate to the Consumer Service Portal.
2. Click **Register** in the portal header.
3. Fill in the fields on the registration form.
   Your email address must be unique. If you enter an address that is already in the system, you receive an error message. Try again with a different email address.

4. Enable the **Security Code** check box, complete the CAPTCHA validation, and click **Verify**.

5. Select the check box to agree to the privacy policy and to the community terms and conditions.

6. Click **Sign Up**.
   A verification email is sent to the email address you provided.

7. Click the link in the email to verify your email address.
   Your registration is complete. You can now log in to the Consumer Service Portal.

---

**Log in to the Consumer Service Portal**

Use the name and password that you created during the registration process to log in to the Consumer Service Portal.

Role required: sn_customerservice.consumer

1. Navigate to the Consumer Service Portal.
2. Click **Login** in the portal header.
3. Fill in the fields on the Login popup window.
4. Click **Login**.
   You are logged in to the Customer Service Portal and your name appears in the portal header.

---

**Change your password from the Consumer Service Portal**

Change your password from the consumer portal.

Role required: sn_customerservice.customer

1. Click your user name in the portal header to display the user profile information.
2. Click **Change Password**.
3. Fill in the fields on the Change Password form, as appropriate.

<table>
<thead>
<tr>
<th>Change Password form fields</th>
</tr>
</thead>
<tbody>
<tr>
<td>Field</td>
</tr>
<tr>
<td>Current Password</td>
</tr>
<tr>
<td>New Password</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>Confirm Password</td>
</tr>
</tbody>
</table>

4. Click **Change**.
View or edit a consumer profile

Registered users with the consumer role can view their consumer profiles, edit the information as needed, and change passwords.

Role required: sn_customerservice.consumer

1. Log in to the Consumer Service Portal.
2. Click your user name in the portal header and then click Profile.
3. To add a picture to your profile, click Upload Picture and select the desired image.
4. To update the personal information in your profile, including name, contact information, and address:
   a) Click the desired field.
   b) Enter the new information in the popup window.
   c) Click Save.
5. To change your password, click Change Password.

The Change Password link appears on the consumer profile when the Self Service Password Reset plugin (com.snc.password_reset) is activated.
6. Fill in the fields on the Change Password popup window and click Update.

Register a product from the Consumer Service Portal

Users with the consumer role can register their products from the Consumer Service Portal.

Role required: sn_customerservice.consumer

1. Log in to the Consumer Service Portal.
2. Click Products in the portal header and then click Register Product.
3. Type a search term in the search field and press Enter to display a list of products.
4. Click the Select button on the card for the desired product.
5. Enter the Serial Number and the Purchase Date for the selected product.
6. Click Register.

After the product is successfully registered, it appears in the My Products list, which includes the products registered to the current user.

View a list of products from the Consumer Service Portal

Users with the consumer role can view a list of their registered products from the Consumer Service Portal.

Role required: sn_customerservice.consumer

1. Log in to the Consumer Service Portal.
2. Click Support > My Products in the portal header.
   This displays a list of products registered to the current user.
3. If desired, click a product to display more information about the product.

Create a case from the Consumer Service Portal

Users with the consumer role can create cases from the Consumer Service Portal.
Role required: sn_customerservice.consumer

1. Log in to the Consumer Service Portal.
2. Click **Get Help** in the portal header.
3. Choose between **Get Product Help** and **Get Order Help**.
4. Enter or search for a customer.
5. Enter a product or an order depending on what you selected above.
6. Enter a brief description in the **Subject** field.

   **Note:** When you start entering the subject, the application searches for the relevant content in the knowledge bases configured for portal and is displayed in the **Related Content** list.

7. If desired, add a more detailed **Description** and any attachments.
8. Click **Submit**.
   The new case is created and added to the Cases list. To view the case, click the link in the case creation message or click **Cases** in the portal header and then click the case number.

### View a case from the Consumer Service Portal

Users with the consumer role can view a list of cases from the Consumer Service Portal and select individual cases to see more detail.

Role required: sn_customerservice.consumer

Selecting a case opens a form with the following sections:

- A conversation that displays the interaction between the consumer and the customer service agent.
- The action that needs to be taken on the consumer's part, such as accepting or rejecting a solution.
- The case details, including the case number and current status.
- Any attached files.

1. Log in to the Consumer Service Portal.
2. Click **Support > Cases** in the portal header to view a list of cases related to the current user.
3. Click the case number to view more information about the case.
4. If desired, type a message to the agent and click **Send**.
   Your message becomes part of the case conversation. All responses from the agent are also included in the conversation.

### Accept or reject a case solution from the Consumer Service Portal

Users with the consumer role can accept or reject the proposed solution for a case from the Consumer Service Portal.

Role required: sn_customerservice.consumer

When an agent proposes a solution to a consumer's case, buttons for accepting or rejecting the solution appear in the section of the form that shows the consumer actions.

1. Log in to the Consumer Service Portal.
2. Click **Support > Cases** in the portal header to view a list of cases related to the current user.
3. Click a case number to view more information about the case.
4. Click one of the following buttons:
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accept Solution</td>
<td>Accepts the solution proposed by the agent and changes the case state to <strong>Closed</strong>.</td>
</tr>
<tr>
<td>Reject Solution</td>
<td>Rejects the solution proposed by the agent and changes the case state to <strong>Open</strong>.</td>
</tr>
</tbody>
</table>

**Chat with an agent from the Consumer Service Portal**

Chat with a virtual agent or a customer service agent from the Consumer Service Portal to resolve issues quickly.

Role required: `sn_customerservice.consumer`

1. Click the chat icon (Chat) in the Consumer Service Portal to start a conversation.
   A form opens that requests the type of issue and a brief description of the issue.
2. Fill in the information and click **Submit**.
   A virtual agent or a customer service agent responds.
3. Optional: To talk to a person instead of a virtual agent, click and then **Contact Support**.
4. When you are finished with the chat, click **End Conversation**.

If the agent creates a new case or links the discussion to an existing case, you can view these cases from the Consumer Service Portal by clicking **Cases** and displaying the case list.

**Chat anonymously with an agent from the Consumer Service Portal**

Users that are not logged in can chat anonymously with an agent from the Consumer Service Portal to resolve issues more quickly.

Role required: none

1. Click the chat icon (Chat) in the Consumer Service Portal to start a conversation.
   A form opens that requests some basic user information.
2. Fill in the information and click **Submit**.
   A virtual agent or a customer service agent responds.
3. Optional: To talk to a person instead of a virtual agent, click and then **Contact Support**.
4. When you are finished with the chat, click **End Conversation**.
View a publication on the Consumer Service Portal

View the details of a publication on the Consumer Service Portal and download any attachments.

Role required: sn_customerservice.consumer

The Support > Publications link on the Consumer Service Portal displays a list of current publications. You can filter the publications on this list by category and you can further filter the list to show all publications or only those that are unread. You can sort the list by publish date or expiration date. You can also search for a specific term.

After a publication reaches its Expiry Date, it is automatically removed from the Publications list.

1. Navigate to the Consumer Service Portal.
2. Click Publications in the portal header. This displays a list of current publications. The information displayed for each publication includes the title, publish date, expiration date, and a brief description.
3. If desired, filter or sort the Publications list.
   - Select a category in the upper-left corner or select All Categories.
   - Select either All Publications or Unread Publications in the upper-right corner.
   - Select either Publish Date or Expiry Date in the Sort by field.
4. If desired, search the Publications list by entering the search term in the Search Publications field.
5. Click a publication name to open.
6. If the publication has attachments, click Attachments in the upper-right corner.
7. Select the attachments to download from the pop-up window.
8. Close the pop-up window.
9. Click the return arrow at the top of the publication to return to the Publications list.

Reference information

Reference topics provide additional information about Customer Service Management cases, including lists and forms.

Customer service cases list

The Cases list displays a list of customer service cases for the current user.

Users with the sn_customerservice_agent or sn_customerservice_manager roles can view the Cases list in the Customer Service Management application. The default view of the Cases list includes the following columns:

- Number
- Short description
- Contact
- Account
- Channel
- State
- Priority
- Assigned to
- Updated
Case Report (add a column to access this table if needed)

External customers can view a list of cases from the customer portal. For external users with the sn_customerservice.customer or sn_customerservice.customer_admin roles, the Cases list displays a subset of case information, including:

- Number
- Short description
- Product
- Priority
- State
- Updated

For external users with the sn_customerservice.partner or sn_customerservice.partner_admin roles, the Account column is also displayed.

The cases included in this list are determined by user role.

<table>
<thead>
<tr>
<th>User Role</th>
<th>Cases Included in Case List</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_customerservice_admin, sn_customerservice_manager, sn_customerservice_agent</td>
<td>All cases</td>
</tr>
</tbody>
</table>
| sn_customerservice.customer | - Cases opened by the customer  
- Cases opened by an agent for the customer |
| sn_customerservice.customer_admin | Cases opened for the same account as the customer admin's account |
| sn_customerservice.partner | - Cases opened by the partner  
- Cases opened by an agent for the partner  
- Cases opened for the same account  
- Cases opened from a partner account |
| sn_customerservice.partner_admin | - Cases opened for the same account  
- Cases opened for the partner admin's account |

Customer service case form

The Case form displays detailed information about a customer issue or problem.

A customer service agent creates a case to identify a customer's question or issue and to track the activities related to resolving the issue. An agent also uses a case to track communication to and from the customer, including the communication channels being used.

Case activities include any action that is taken to resolve an issue. This can include phone calls or emails, knowledge base research, conversations with subject matter experts, and dispatch requests to field service agents, as well as other activities.

From the Case form, an agent can associate and store the related information, such as the customer's name, phone number, and company; account information; product and asset information; service contract and entitlement details, and any associated service level agreements (SLAs).

There are several key features to a case.
• Communication between an agent and the customer or an agent and other employees within the organization. Details of all internal and external communication are recorded on the Case form.

• Any additional tasks that result from a case, such as a work order. Tasks are tracked from a related list on the Case form. These tasks may be internal to the organization or they may involve the customer.

• Information from the case that can be included in the knowledge base and used to help resolve other cases.

There are two different Case form views: a detailed view that is available to agents and agent managers in the Customer Service Management application and a simplified view that is available to external customers from the Customer and Consumer Service Portals.

**Agent view**

The agent view of the Case form includes the following components:

• A timeline that provides a visual display of case activities.

• Referenced entities for the case including account and contact information, product and asset information, service contract and service entitlement details, and any pertinent SLAs. Except for SLAs, this information exists in the system and can be associated with the case by the agent or agent manager.

• All communication about the case, both external and internal. This information is stored in the Additional comments field (external communication), the Work notes field (internal communication), the Resolution notes field. The Resolution notes field stores details about the case resolution, and the Activity field, which stores all communication in a chronological list.

Agents and managers can view a Case form by navigating to Customer Support > Cases and selecting one of the following menu options:

• **My Cases**
• **All**
• **Open**
• **Unassigned**

From the Case list, click a case number to display the Case form.

<table>
<thead>
<tr>
<th>Customer Service Case form (agent view)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Field</td>
</tr>
<tr>
<td>-------------</td>
</tr>
<tr>
<td>Number</td>
</tr>
<tr>
<td>Channel</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>Field</td>
</tr>
<tr>
<td>-----------------------</td>
</tr>
<tr>
<td>Contact Local Time</td>
</tr>
<tr>
<td>Contact time zone</td>
</tr>
<tr>
<td>Account</td>
</tr>
<tr>
<td>Contact</td>
</tr>
<tr>
<td>Product</td>
</tr>
<tr>
<td>Asset</td>
</tr>
<tr>
<td>Partner Contact</td>
</tr>
<tr>
<td>Field</td>
</tr>
<tr>
<td>---------------------</td>
</tr>
<tr>
<td>Follow the sun</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td><strong>Note:</strong> Enable the <strong>Follow the sun</strong> check box on the Customer Service case form by setting the value of the property <code>sn_customerservice.FTS_flag_enabled</code> to <strong>true</strong>. Configure the form layout to add this field to the Case form.</td>
</tr>
<tr>
<td>Short description</td>
</tr>
<tr>
<td>Opened</td>
</tr>
<tr>
<td>Priority</td>
</tr>
</tbody>
</table>
|                     | · 1 — Critical  
|                     | · 2 — High      
|                     | · 3 — Moderate  
|                     | · 4 — Low (default)                                                                                                                                          |
| State               | Customer service case states:                                                                                                                                                                                 |
|                     | · New           
|                     | · Open          
|                     | · Awaiting Info 
|                     | · Resolved      
|                     | · Closed        
<p>|                     | · Canceled                                                                                                                                                    |
| <strong>Note:</strong> Configure the form layout to add this field to the Case form                                                                                                                                      |
| Assignment group    | The assigned customer service agent group.                                                                                                                                                                   |
| Assigned to         | The assigned agent. If a group is selected in the <strong>Assignment group</strong> field, the assigned agent must belong to this group.                                                                                  |
| Assigned on         | The date and time when the case is assigned.                                                                                                                                                                  |
|                     | This field is updated when a user is added or changed in the <strong>Assigned to</strong> field.                                                                                                                             |
| Contract            | The contract number associated with this case.                                                                                                                                                               |</p>
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Entitlement</td>
<td>The entitlement associated with this case. The entitlements available for selection in the reference list channel matches the case creation channel. The available entitlements are filtered by the settings in the <strong>Account</strong>, <strong>Contract</strong>, <strong>Product</strong>, <strong>Asset</strong> fields. If only one entitlement is available for this case, it is automatically added to the <strong>Entitlement</strong> field.</td>
</tr>
<tr>
<td>Partner</td>
<td>The name of the partner company.</td>
</tr>
<tr>
<td>Notes</td>
<td></td>
</tr>
<tr>
<td>Watch list</td>
<td>Users who receive notifications about this case when additional comments are added or if the state of a case is changed to <strong>Resolved</strong> or <strong>Closed</strong>. Click the add me icon to add yourself to the watch list.</td>
</tr>
<tr>
<td>Work notes list</td>
<td>Internal users who receive a notification about this case when work notes are added. You can only add internal users to the work notes list. Click the add me icon to add yourself to the work notes list.</td>
</tr>
<tr>
<td>Additional comments</td>
<td>Customer-viewable comments. Each comment is inserted into the <strong>Activity</strong> field when the user clicks the <strong>Post</strong> button.</td>
</tr>
<tr>
<td>Work notes</td>
<td>Information about how to resolve the case, or steps taken to resolve it, if applicable. Internal users who have been added to the Work notes list receive the Case work notes added notification containing the work notes when added. You can configure the notification, as required. The notes are viewable by the admin, agent, and agent manager.</td>
</tr>
<tr>
<td>Activities</td>
<td>Records all activity associated with this case.</td>
</tr>
<tr>
<td>Resolution Information</td>
<td></td>
</tr>
<tr>
<td>Resolved by</td>
<td>The agent to whom the case is assigned when the case is resolved.</td>
</tr>
<tr>
<td>Closed by</td>
<td>The name of the user who closed the case.</td>
</tr>
<tr>
<td>Resolution Code</td>
<td>Choice list indicating the resolution states for the case. This field is mandatory when an agent proposes a solution for a case.</td>
</tr>
<tr>
<td>Cause</td>
<td>Details about the cause of the resolution.</td>
</tr>
<tr>
<td>Resolution notes</td>
<td>Details about how the case was closed. This field is mandatory if a customer service agent or agent manager closes a case. If a customer closes a case, it is not mandatory.</td>
</tr>
</tbody>
</table>
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add resolution notes to comments</td>
<td>A check box to determine if the resolution notes are added to customer-viewable comments when the case is resolved. If selected, the resolution notes are added to the Additional comments (customer-visible) field. By default, the check box is cleared.</td>
</tr>
<tr>
<td>Resolved</td>
<td>The date and time that the case was resolved.</td>
</tr>
<tr>
<td>Closed</td>
<td>The date and time that the case was closed.</td>
</tr>
</tbody>
</table>

### Customer view

Customers can view a Case form by clicking **My Cases** on the customer portal and then clicking a case number from their Case list.

The customer view of the Case form includes the following components:

- A process flow formatter that indicates the current state of the case.
- The related entity information, including account and contact information, product and asset information, and service contract information.
- An **Activity** field that stores all communication for the case in a chronological list.

### Customer service case timeline

The timeline provides a visual display of case activities. The timeline appears at the top of the Case form when viewed by an agent or manager in the Customer Service Management application.

The timeline uses blue circles to represent case state changes and markers to represent case activities. The information included in the timeline is also shown on the Case form in the **Activity** history.

![Customer Service Case Timeline](image)

**Customer Service Case Timeline**

**Header**

The timeline header displays the time that the case began. It also displays the time that the case was either last updated or closed.
State changes and case activities

Each state change for a case is represented by a blue circle on the timeline. Pointing to these circles provides more information about the state change in a tooltip. For example, pointing to the first blue circle that represents the New state displays the name of the user who created the case and the approximate time that the case was created.

Activity lines above and below the timeline represent other case activities, including comments, information requests, close notes, email, and phone calls. Activities performed by an agent are shown above the timeline and activities performed by a customer are shown below. Pointing to these activities on the timeline displays additional information.

Overlapping states and conversations are represented by thicker borders and thicker lines. Pointing to overlapped states and conversations results in grouped tooltips.

If a case is ongoing, the end of the timeline shows the last updated activity or state change. If a case is closed, the end of the timeline shows a blue circle that represents the Closed state.

Time metric

The metric to the right of the timeline tracks the amount of time that a case is open. The date and time that the case was opened is used as the start of the time calculation. When a case is ongoing, the current time is used as the end time calculation. When a case is closed, the close time is used as the end time calculation.

The metric breaks down the time by the number of minutes and hours that a case is with the agent or with the customer. A case is considered to be with the agent when it is in the New, Open, or Closed state.

When a case is in the Awaiting Info or Resolved state, it is considered to be with the customer.

Use the Customer Service case timeline with other applications

You can use the Customer Service case timeline with other ServiceNow applications by creating a configuration for each application and adding the ResolutionShaper field to the desired form.

Role required: admin

1. Ensure that the Customer Service plugin (com.sn_customerservice) has been activated.
2. Navigate to the Resolution Shaper Configs page (<instance>sys_resolutionshaper_config_list.do) and click New.
3. Select a table in the Task Table field.
4. Add the desired states in the Requestor States field using a comma-separated list. For example, New, Active, Resolved, Closed.
5. Make any necessary changes to the remaining fields and click Submit.
6. Navigate to the desired form.
7. Right-click the form header and select Configure > Form Layout.
8. Using the slushbucket, select ResolutionShaper and move it to where you want the timeline to appear.
9. Click Save.

Customer service case process flow formatter

The process flow formatter indicates the current state of a case at the top of a Case form that is viewed from the customer portal.
The process flow formatter highlights the current state of the case with a blue line and checks off the states that a case has passed through. For customers viewing a case from the customer portal, the following states are displayed:

- New
- Open
- Resolved
- Closed

### Customer service case form related lists

The Case form includes related lists that store case information and that agents can use to perform case-related tasks.

<table>
<thead>
<tr>
<th>Related List</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SLAs</td>
<td>The service level agreements that are associated with this case.</td>
</tr>
<tr>
<td>Tasks</td>
<td>Tasks that have been created for this case by the customer service agent or agent manager. When you create a task or change the state of a task, the information is recorded in the case Activity field. When you create a case task, the system generates a task number with a prefix. Following upgrade to the New York release:</td>
</tr>
<tr>
<td></td>
<td>• New case tasks use the CSTASK prefix.</td>
</tr>
<tr>
<td></td>
<td>• Existing tasks, regardless of state, use the TASK prefix.</td>
</tr>
<tr>
<td>Phone</td>
<td>The case phone log. A list of incoming or outgoing phone calls associated with this case.</td>
</tr>
<tr>
<td>Appointments</td>
<td>Appointments that the customer service agent makes with the customer or others as part of resolving this case. When you create an appointment, an appointment creation message is recorded in the case Activity field. The user selected in the To field on the appointment form receives an email with the appointment details.</td>
</tr>
<tr>
<td>Related List</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Emails</td>
<td>The case email log. A list of the emails that are sent or received as part of resolving this case. The customer service agent or agent manager can send email from within the case, such as updates and inquiries to customers or other employees. A change in the state of the case triggers an automatic email to be sent to the customer. Customer contacts can create and update cases by email as well as receive updates from customer service agents.</td>
</tr>
<tr>
<td>Related Cases</td>
<td>A list of cases created for the same account or contact.</td>
</tr>
<tr>
<td>Problems</td>
<td>A list of problems related to this case.</td>
</tr>
<tr>
<td>Work Orders</td>
<td>A list of work orders created for this case.</td>
</tr>
<tr>
<td>Social Logs</td>
<td>A list of the communication with customers or consumers that takes place through social media channels. The Social Log form includes the Social Profile of the user that created the communication and the Social URL for the conversation. Click the URL to open the conversation in a new tab.</td>
</tr>
<tr>
<td>Attached Knowledge</td>
<td>Knowledge articles attached as a proposed solution to the case.</td>
</tr>
<tr>
<td>Knowledge Gaps</td>
<td>Feedback tasks that are created when a knowledge gap is reported.</td>
</tr>
<tr>
<td>Escalations</td>
<td>A list of escalation records that are related to this case.</td>
</tr>
<tr>
<td>Child Cases</td>
<td>A list of child cases associated with this case</td>
</tr>
<tr>
<td>Requests</td>
<td>A list of requests associated with this case.</td>
</tr>
<tr>
<td>Blocked by</td>
<td>A list of blocking tasks that have been created for this case.</td>
</tr>
</tbody>
</table>

**Customer service case states**

A customer service case can be in one of several states.
## Customer service case states

<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
</table>
| New           | The initial state for a new case, which is created through any one of the channels: customer portal, email, chat, telephone, or from the Customer Service application. Actions the agent can take:  
  - **Assign to me**: The case is assigned to the agent and the state changes to **Open**.  
  - **Accept**: If assigned by the customer service manager, the agent accepts the case and the state changes to **Open**.  
  - **Update**: updates the case.  
  - **Close Case**: Closes the case.  
  - **Delete**: Deletes the case. Actions the customer can take:  
  - **Update**: updates the case.  
  - **Close Case**: Closes the case. |
| Open          | The case is assigned to an agent and the agent clicks **Accept** or an agent opens a case and clicks **Assign to me**. Both of these actions change the state from **New** to **Open**. Actions the agent can take:  
  - **Update**: Updates the case.  
  - **Request Info**: The agent requests additional information from the customer. The state changes to **Awaiting Info**.  
  - **Propose Solution**: The agent proposes a solution for the case. Note: The Resolution Code and Resolution notes must be entered in the Resolution Information tab. The state changes to **Resolved**.  
  - **Close Case**: Closes the case.  
  - **Delete**: Deletes the case. |
| Awaiting Info | An agent clicks **Request Info**, changing the state from **Open** to **Awaiting Info**. Actions the agent can take:  
  - **Open Case**: Changes the state back to **Open**.  
  - **Update**: Updates the case  
  - **Close Case**: Closes the case.  
  - **Delete**: Deletes the case. Actions the customer can take:  
  - **Update**: Once the customer updates the case, the state changes to **Open**.  
  - **Close Case**: Closes the case. |
<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
</table>
| Resolved | An agent provides a resolution code and enters resolution notes in the Resolution Information tab and clicks Propose Solution, changing the state from Awaiting Info to Resolved.  
                   The Resolution code and Resolution notes fields are mandatory when an agent proposes a solution for the case.  
                   Actions the agent can take:  
                   - **Update**: Updates the case  
                   - **Close Case**: Closes the case.  
                   Actions the customer can take:  
                   - **Accept Solution**: The customer accepts the solution proposed by the agent. The state changes to Closed and a survey is displayed.  
                   - **Reject Solution**: The customer rejects the solution proposed by the agent and the state changes to Open.  
                   - **Delete**: Deletes the case. |
| Closed   | After proposing a solution, an agent waits for the customer to respond.  
                   - If the customer clicks Accept Solution, the state changes from Resolved to Closed.  
                   - If the customer clicks Reject Solution, the state changes from Resolved to Open.  
                   An agent, agent manager, or a customer can close a case at any time, except when it is in the Resolved state. When it is in the Resolved state, only a customer can accept or reject the proposed solution.  
                   When an agent or agent manager closes a case, details must be included in the Resolution notes. This is not required when a customer closes a case.  
                   A case cannot be updated once it is closed. |

**Components installed with Customer Service Management**

Several types of components are installed with the Customer Service Management application.

**Tables installed with Customer Service Management**

Tables are added with activation of Customer Service Management.

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Account Relationship Access (sn_customerservice_account_relationship_access)</td>
<td></td>
</tr>
<tr>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>-------</td>
<td>-------------</td>
</tr>
<tr>
<td>Account Relationship Type (sn_customerservice_account_relationship_type)</td>
<td>Stores the relationship types that are created for bi-directional account relationships.</td>
</tr>
<tr>
<td>Account Team Member (sn_customerservice_team_member)</td>
<td>Stores the team members that are assigned to account teams.</td>
</tr>
<tr>
<td>Agent Token (sn_customerservice_agent_token)</td>
<td></td>
</tr>
<tr>
<td>Appointment (sn_customerservice_appointment)</td>
<td>Stores appointments that have been created for customer service cases.</td>
</tr>
<tr>
<td>Asset Contact (sn_customerservice_m2m_asset_contact)</td>
<td>Stores asset contact relationship records.</td>
</tr>
<tr>
<td>Case (sn_customerservice_case)</td>
<td>Stores customer service case records.</td>
</tr>
<tr>
<td>Channel Configurations (sn_customerservice_channel_config)</td>
<td>Stores customer service email channel configuration records.</td>
</tr>
<tr>
<td>Consumers (csm_consumer)</td>
<td>Stores consumer records.</td>
</tr>
<tr>
<td>Consumer Users (csm_consumer_user)</td>
<td>Stores consumer registration records that are created when consumers complete the self-registration process from the Consumer Service Portal. This table extends the Users table (sys_user).</td>
</tr>
<tr>
<td>Contact Relationship (sn_customerservice_contact_relationship)</td>
<td>Stores contact relationship records.</td>
</tr>
<tr>
<td>Customer Interaction (sn_customerservice_customer_interaction)</td>
<td></td>
</tr>
<tr>
<td>Customer Service Case Flow (sn_customerservice_sf_case)</td>
<td>Stores customer service case state flows.</td>
</tr>
<tr>
<td>Registration Request (sn_customerservice_registration)</td>
<td>Stores the customer portal self-registration requests.</td>
</tr>
<tr>
<td>Responsibility Definition (sn_customerservice_responsibility_def)</td>
<td>Stores the responsibility definitions that are created to support customer accounts.</td>
</tr>
<tr>
<td>Task (sn_customerservice_task)</td>
<td>Stores tasks that have been created for customer service cases.</td>
</tr>
</tbody>
</table>

**Properties installed with Customer Service Management**

Properties are added with activation of Customer Service Management.
**Note:** To open the System Property (sys_properties) table, enter `sys_properties.list` in the navigation filter.

You can also navigate to Customer Service > Administration > Properties to view a list of the most frequently used properties that you can configure for Customer Service Management.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
</table>
| glide.cs.email.case_queue_address | Email case queue address.  
Type: string  
Default value: none  
Location: Customer Service > Administration > Email Properties |
| glide.cs.email.new_case_prefix | Email subject prefix format for new case.  
Type: string  
Default value: Case:  
Location: Customer Service > Administration > Email Properties |
| sn_customerservice.email.create_case_for_non_matched_user | Create case for non matched user.  
Type: true | false  
Default value: false  
Location: Customer Service > Administration > Email Properties |
| glide.cs.company_name | Your company name.  
Type: string  
Default value: none  
Location: System Property (sys_properties) table |
| glide.ui.activity.email_roles | Roles that can view mail in the Activity formatter when including "Sent/Received Emails"  
Type: string  
Default value: itil, sn_customerservice_agent  
Location: System Property (sys_properties) table |
| glide.ui.sn_customerservice_case_activity.fields | Case activity formatter fields  
Type: string  
Default value: assigned_to,asset,product, state,priority,short_description,comments,entitlement,contract,*Email*,work_notes  
Location: System Property (sys_properties) table |
| sn_customerservice.FTS_flag_enabled | Enable the follow the sun flag on the Customer Service Case form.  
Type: true | false  
Default value: false |
<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
</table>
| `sn_customerservice.glide.script.block.client.globals` | - **Type**: true | false  
- **Default value**: false  
- **Location**: System Property (sys_properties) table |
| `sn_customerservice.shn_asset` | Special Handling Notes for assets  
- **Type**: true | false  
- **Default value**: false  
- **Location**: Special Handling Notes > Properties |
| `sn_customerservice.shn_contact` | Special Handling Notes for contacts  
- **Type**: true | false  
- **Default value**: false  
- **Location**: Special Handling Notes > Properties |
| `sn_customerservice.shn_product` | Special Handling Notes for products  
- **Type**: true | false  
- **Default value**: false  
- **Location**: Special Handling Notes > Properties |
| `sn_customerservice.shn_account` | Special Handling Notes for accounts  
- **Type**: true | false  
- **Default value**: false  
- **Location**: Special Handling Notes > Properties |
| `sn_customerservice.shn_case` | Special Handling Notes for cases  
- **Type**: true | false  
- **Default value**: false  
- **Location**: Special Handling Notes > Properties |
| `sn_customerservice.portal.chat_queue` |  
- **Type**: string  
- **Default value**: none  
- **Location**: System Property (sys_properties) table |
| `csm.captcha.google.enabled` | Enable the Google Captcha tool on the customer portal self-service portal self-registration form.  
- **Type**: true | false  
- **Default value**: true  
- **Location**: System Property (sys_properties) table |
<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
</table>
| sn_customerservice.use_asset_contact_relationship | Restrict assets based on the contacts assigned to the assets  
  - **Type**: true | false  
  - **Default value**: false  
  - **Location**: Customer Service > Administration > Properties |
| sn_customerservice.account_relationship_access_roles | Roles which need to be shown in the reference qualifier for the Account Relationship Access table (sn_customerservice_account_relationship_access).  
  - **Type**: string  
  - **Default value**: none  
  - **Location**: Customer Service > Administration > Properties |
| sn_customerservice.contact_role_assignment | External roles that can be assigned to contacts from the Customer Service Portal. The roles stored in this property are displayed in the Available column on the Edit Role pop-up window.  
  - **Type**: string  
  - **Default value**:sn_customerservice.partner_admin, sn_customerservice.partner,sn_customerservice.customer  
  - **Location**: Customer Service > Administration > Properties |
| sn_customerservice.registration_workflow_id | The default registration workflow sys_id.  
  - **Type**: string  
  - **Default value**: 9b6cf2dac31302003a657bfaa2d3aee8  
  - **Location**: System Property (sys_properties) table |
| consumer_max_attachments_per_record | Maximum consumer attachable items per record.  
  - **Type**: integer  
  - **Default value**: 5  
  - **Location**: Customer Service > Administration > Email Properties |
| consumer_max_open_cases | Maximum open cases per consumer.  
  - **Type**: integer  
  - **Default value**: 10  
  - **Location**: Customer Service > Administration > Email Properties |
<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>consumer_max_products</td>
<td>Maximum registered products per consumer.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Type</strong>: integer</td>
</tr>
<tr>
<td></td>
<td>- <strong>Default value</strong>: 25</td>
</tr>
<tr>
<td></td>
<td>- <strong>Location</strong>: Customer Service &gt; Administration &gt; Email Properties</td>
</tr>
<tr>
<td>consumer_max_new_cases_daily</td>
<td>Maximum new cases per consumer per day.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Type</strong>: integer</td>
</tr>
<tr>
<td></td>
<td>- <strong>Default value</strong>: 10</td>
</tr>
<tr>
<td></td>
<td>- <strong>Location</strong>: Customer Service &gt; Administration &gt; Email Properties</td>
</tr>
<tr>
<td>consumer_max_comments_per_case_daily</td>
<td>Maximum consumer comments per case per day.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Type</strong>: integer</td>
</tr>
<tr>
<td></td>
<td>- <strong>Default value</strong>: 25</td>
</tr>
<tr>
<td></td>
<td>- <strong>Location</strong>: Customer Service &gt; Administration &gt; Email Properties</td>
</tr>
<tr>
<td>com.snc.cs_base.last.generated.code.tree.path</td>
<td>This property gets created by the system when the first customer_account record is inserted into an instance. It stores the Account Code value for the most recently created customer account in the Account (customer_account) table.</td>
</tr>
<tr>
<td></td>
<td>- When a new customer account record is created, the system uses this property to determine a unique account code value for the account. The property is then updated with this latest assigned value so that the next account code value can be set as a unique value for the next account record insert. See <a href="#">Import customer account information</a> for more details.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Type</strong>: string</td>
</tr>
<tr>
<td></td>
<td>- <strong>Default value</strong>: none</td>
</tr>
<tr>
<td></td>
<td>- <strong>Location</strong>: System Property (sys_properties) table</td>
</tr>
<tr>
<td>sn_customerservice.enable_knowledge_kcs</td>
<td>Enable Knowledge Centered Services (KCS) for Customer Services Management</td>
</tr>
<tr>
<td></td>
<td>- <strong>Type</strong>: true</td>
</tr>
<tr>
<td></td>
<td>- <strong>Default value</strong>: false</td>
</tr>
<tr>
<td></td>
<td>- <strong>Location</strong>: Customer Service &gt; Administration &gt; Properties</td>
</tr>
<tr>
<td>skills_management.migration</td>
<td>Lists the task tables to migrate to the Task Skills (task_m2m_skill) table when an admin runs the Migrate Skills to Task Skill M2M script.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Type</strong>: choice list</td>
</tr>
<tr>
<td></td>
<td>- <strong>Default value</strong>: wm_task,customerservice_case,wm_order</td>
</tr>
<tr>
<td></td>
<td>- <strong>Location</strong>: System Property (sys_properties) table</td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
</tr>
<tr>
<td>----------</td>
<td>-------------</td>
</tr>
<tr>
<td>com.snc.skills_management.task_skill_migrated_tables</td>
<td>Contains a list of tables for which the Skills field has already been migrated to the Task Skills (task_m2m_skill) table. If the table name is listed in this property, the data has been migrated and will not be migrated again.</td>
</tr>
<tr>
<td>case_fields_to_sync</td>
<td>Comma-separated list of fields that synchronize from parent case to child cases.</td>
</tr>
<tr>
<td>parent_child_case_sync</td>
<td>Synchronize fields from parent to child cases.</td>
</tr>
<tr>
<td>glide.ui.sn_customerservice_escalation_activity.fields</td>
<td>Escalation activity formatter fields.</td>
</tr>
</tbody>
</table>

**Roles installed with Customer Service Management**

Roles are added with activation of Customer Service Management.

**Note:** Customer Service Management includes both internal and external user roles. Internal user roles are for agents and agent managers using the Customer Service Management application. External user roles are for customers and partners using the customer portal.
<table>
<thead>
<tr>
<th>Role title (name)</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
</table>
| Agent (sn_customerservice_agent) | A customer service agent who assists customers and partners with questions, issues, and problems. This user creates cases, views and edits cases, and works with customers and subject matter experts to resolve cases. An agent typically supports a specific set of products across one or more communication channels. An agent can belong to one or more agent groups. | - knowledge  
- chat_admin  
- sn_customerservice.deescalation_requester  
- timecard_user  
- template_editor  
- sn_esm_agent  
- sn_shn.editor  
- domain_expand_scope |

**Note:** The sn_esm_agent role contains the cmdb_read role.

| Agent manager (sn_customerservice_manager) | A customer service agent with the additional responsibility for managing agents or agent groups and overriding agent actions. | - sn_customerservice_agent  
- timecard_manager  
- timecard_approver  
- skill_admin  
- sn_app_cs_social_social_profile_user  
- sam  
- approval_admin  
- sn_customerservice.consumer_agent  
- asset  
- sn_shn.admin  
- sn_publications.approver  
- contract_manager  
- sn_app_cs_social_log_user |

| Customer (sn_customerservice.customer) | A customer role for researching questions, issues, or problems. Customers can create cases and view and edit existing cases for their own accounts. They can also view a list of assets belonging to their accounts. | - sn_esm_user  
- sncc_external |
<table>
<thead>
<tr>
<th>Role title (name)</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Customer case manager</td>
<td>A customer role for managing all of the cases in an account and any related child accounts. The customer case manager role includes the privileges of the customer role and adds the following privileges: - Create a case on behalf of another contact in the account - View a list of cases belonging to the account - Edit cases belonging to the account.</td>
<td>• sn_customerservice.customer</td>
</tr>
<tr>
<td>Customer administrator</td>
<td>An administrator role for a customer account. This user has access to all the data within the account.</td>
<td>• sn_customerservice.customer • sn_esm_user_admin</td>
</tr>
<tr>
<td>Partner</td>
<td>A partner who is serving customer accounts. A partner can create a case for their own account or on behalf of a customer account. A partner can also view or edit existing cases for their own account or for customer accounts.</td>
<td>• sn_customerservice.customer • sn_esm_partner</td>
</tr>
<tr>
<td>Partner administrator</td>
<td>An administrator role for a partner account. This user has access to all the data within the partner account as well as the customer accounts. This user can also manage users for the partner account and for customer accounts.</td>
<td>• sn_customerservice.partner • sn_customerservice.customer_admin • sn_esm_partner_admin</td>
</tr>
<tr>
<td>Consumer</td>
<td>A consumer role for researching questions, issues, or problems. Consumers can create cases and view and edit existing cases for products that they have purchased. They can also view a list of their products.</td>
<td>• sn_esm_user • snc_external</td>
</tr>
<tr>
<td>Role title (name)</td>
<td>Description</td>
<td>Contains roles</td>
</tr>
<tr>
<td>------------------</td>
<td>-------------</td>
<td>---------------</td>
</tr>
</tbody>
</table>
| Consumer Agent   | A consumer service agent who assists consumers with questions, issues, and problems. This user creates, views, and edits cases and works with consumers to resolve cases. An agent typically supports a specific set of products across one or more communication channels. An agent can belong to one or more agent groups. | · sn_esm_agent  
· chat_admin  
· sn_shn.editor  
· template_editor  
· knowledge |
| Proxy case creator | A user who can create a case from a community discussion. | |
| Escalation requester | Can request an escalation for a case or account. | · sn_customerservice.consumer_agent |
| De-escalation requester | Can de-escalate a case or account. | · sn_customerservice.escalation_requester |

### Roles installed with the Customer Service Base Entities plugin

<table>
<thead>
<tr>
<th>Role title (name)</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
</table>
| Service management agent | | · assignment_workbench  
· wrm_read  
· cmdb_read  
· agent_schedule_user  
· interaction_agent |
| Service management partner | | · sn_esm_user |
| Service management user admin | | · sn_esm_user |
| Service management admin | None | |
| Service management user | | · snc_external  
· sn_apptmnt_booking.appointment_booking_user |
| Service management partner admin | | · sn_esm_user_admin  
· sn_esm_admin |

© 2019 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Role title (name)</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Role for REST APIs related to CSM web services (csm_ws_integration)</td>
<td></td>
<td>• snc_internal</td>
</tr>
</tbody>
</table>

### Explicit Roles in CSM

You can give both internal users and external users access to your instance. However, you might not want both types of users to have the same level of access. To provide added security, every user must have at least one role so that the instance can distinguish between internal and external users.

External users must obtain, at minimum, the snc_external role. The snc_external role indicates that the user is external to your organization and should not have any access to resources unless explicitly allowed through ACLs for the snc_external role or additional roles that inherit the snc_external role. By default, users with the snc_external role cannot access:

- Scripted REST API resources that are not marked external.
- Tables without the role that inherits the snc_external role or the public role.
- Non-record type resources, such as processors and UI pages without the snc_external role or a role that inherits the snc_external role.

Do not mark the snc_internal role as elevated. Otherwise, internal users cannot access the instance.

**Note:** You can Set up encryption contexts with the snc_internal and snc_external roles. However, adding encryption contexts to more detailed roles is recommended.

### Recommended CSM roles for internal and external users

Customers (external users) using the Customer Service Management application should be assigned either the sn_customerservice.customer or the sn_customerservice.consumer role. Customer service agents (internal users) should be assigned either the sn_customerservice_agent or sn_customerservice_consumer_agent role. Make sure that the same user is not assigned both a customer (external) and agent (internal) role.

**Note:** Assigning both external and internal roles to external users can create security issues as well as performance issues.

### Explicit Roles plugin

The Explicit Roles plugin (com.glide.explicit_roles) provides the snc_external and snc_internal roles. When the plugin is activated:

- All users must have either the snc_internal role to access internal resources or the snc_external role to access external resources.
- All existing users are automatically assigned the snc_internal role. This role does not change existing access levels or system behavior. Instead, it provides a category to differentiate internal users from external users. All internal users maintain the same level of access as before the plugin was activated.
Tip: To prevent changing existing functionality for users, activating the Explicit Roles plugin assigns the snc_internal user role to all existing users in the instance, including any external users added before the Explicit Roles plugin was activated. After the Explicit Roles plugin is activated, do the following for all external users added before the Explicit Roles plugin was activated:

- Remove the snc_internal role.
- Add the snc_external role.

This ensures that external users added before activating the Explicit Roles plugin do not have access to internal resource that should be available only to internal users.

- Newly created users are automatically assigned the snc_internal role when they first attempt to log in to the instance, unless they have been explicitly assigned the snc_external role. You can add the snc_external role to a new user before they first log in to the instance to provide external user rights.

Note: The snc_internal and snc_external roles can be added or removed at any time to change user rights.

- All existing ACLs that do not have a role requirement are automatically assigned the snc_internal role. Because both existing ACLs and roles are assigned the snc_internal role, existing access levels do not change.
- Newly created ACLs that do not have a role requirement are automatically assigned the snc_internal role. This role assignment does not apply to a newly created ACL with a role assigned.
- For all existing Processor (sys_processor) records or newly created Processor (sys_processor) records with Type=script, the snc_internal role is automatically added to the Roles field if the field is empty.
- To restrict access to UI pages to internal users, the plugin automatically assigns the snc_internal role to the * ACL with a Type of ui_page.
- To restrict access to processors to internal users, the plugin automatically assigns the snc_internal role to the * ACL with a Type of processor.
- External users must obtain, at minimum, the snc_external role to access the instance. This role is automatically assigned to external Customer Service Portal contacts. If the Customer Service Portal is not activated, this role must be manually granted to external users. Access to records is granted through ACLs.

Note: You can use the isPublic() function in scripts for Customer Service Portal to change the privacy setting for a single client-callable script include. For more detail, see Script includes

- Content Management System site access is also affected. CMS is set up with Sites (content_site), Pages (content_page), and other resources. Some of the sites may have the Login page configured.
  - If CMS sites do not have the Login page configured, the public role is automatically added to the Read Roles field on Pages (content_page) if the field is empty.
  - If CMS sites have the Login page configured, the snc_internal role is automatically added to the Read Roles field on Pages (content_page) if the field is empty.

- Service Portal site access is also affected.
  - The snc_internal role is not automatically added to sp_page, sp_widget or sp_instance records. If desired, you can give new records the role by assigning snc_internal as a default
value in the Roles field for these records. For details on this process see Specify a default field value.

Do not move System update sets among instances with and without the Explicit Roles plugin enabled.

---

**Note:** This plugin also requires the Contextual Security Manager plugin.

---

### Providing table access to external users

You can Provide external users access to a table by adding a role to the table that inherits the snc_external role.

---

#### The hasRoles() method

The hasRoles() method is still available, but is deprecated in the Geneva release. Use the hasRole(role name) method instead.

If you do use the hasRoles() method, note these changes:

- This method automatically excludes the default snc_internal role when it checks for roles. This means that if a user has only the snc_internal role, the hasRoles() method still returns **false**.
- If the user has the snc_external role, the method returns **false** because the instance considers external users to be without a role.

---

#### Provide external users access to a table

To enable users with only the snc_external role to access the list view of a table, you must create a series of ACLs.

**Role required:** security_admin

1. **Elevate to the security_admin role.**
2. **Create a new ACL** with the following settings:
   - **Type:** ui_page
   - **Operation:** read
   - **Name:** {table_name}_list
   - **Required role:** snc_external
3. On the default **read** ACL for the table, add snc_external in the Required role list. Create the ACL if it does not already exist.
4. **Use these settings to create another ACL:**
   - **Type:** ui_page
   - **Operation:** read
   - **Name:** {table_name}
   - **Required role:** snc_external
5. **Use these settings to create another ACL** to give the user write access to a field in the table:
   - **Type:** record
   - **Operation:** create
   - **Name:** {table_name} {column_name}
Creating custom user roles

System administrators can create custom roles or modify the access of existing roles by using script includes and extension points/instances.

The Customer Service Management application utilizes platform ACLs and query business rules to restrict data access based on user roles. If needed, users with the system administrator role can create custom roles or modify the access of existing roles by using script includes and extension points/instances.

- Script includes store JavaScript functions and classes to handle the role access control logic.
- Extension points/instances designate places where custom scripts can be called and then processed to extend base functionality.

The system administrator can use the extension points/instances to create their own role access constants file similar to CSQueryBRUtilOOBConstants.

The system administrator can create a new extension instance for the existing extension point and use it to define custom role configuration constants. The following are included with Customer Service Management:

- global.CSQeryExtensionPoint: the provided extension point for CSM role configuration
- instance.CSQueryExtensioninstanceOOB: the provided extension instance for CSM role configuration

To create a new role:

1. Create a new constant file to hold the configurations for the new role similar to CSQueryBRUtilOOBConstants. For example:

   ```javascript
   CSQueryBRUtilOOBConstantstest.ROLE_PERMISSIONS_POOL = {
   'sn_customerservice.customer_new_role': {'sn_customerservice_case':
   {'condition': ['my_new_condition']}
   },
   }
   ```

2. Create a new extension instance to hold the logic returning this new constant file to CSQueryBRUtil.
3. Make sure this role is on the instance and contains the sn_esm_user role.
4. Assign this new role to a contact.
5. Create or modify the ACLs and query business rules for this role as necessary.

For more information about modifying ACLs and query business rules, see KB0685767.

Script includes installed with Customer Service Management

Script includes are added with activation of Customer Service Management.

<table>
<thead>
<tr>
<th>Script include</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CSEMailUtil</td>
<td>Used for customer service case email actions and notifications.</td>
</tr>
</tbody>
</table>
### Script include

<table>
<thead>
<tr>
<th>Script include</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CSPortalUtil</td>
<td>Helper functions for the customer self-service portal.</td>
</tr>
<tr>
<td>AccountTeamUtil</td>
<td>Util APIs for the Customer Service Management account responsibility module.</td>
</tr>
<tr>
<td>AjaxCustomerServiceSearch</td>
<td>Ajax class that provides the knowledge base search results.</td>
</tr>
</tbody>
</table>

### Client scripts installed with Customer Service Management

Client scripts are added with activation of Customer Service Management.

<table>
<thead>
<tr>
<th>Client script</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Channel and State readonly for customer</td>
<td>Case (sn_customerservice_case)</td>
<td>Sets the Channel and State fields to read-only on the Case form that the customer can view from the customer portal.</td>
</tr>
<tr>
<td>Check Contextual Security Installed</td>
<td>Contact (customer_contact)</td>
<td>Checks if the Contextual Security plugin (com.glide.role_management) is installed before creating a customer contact.</td>
</tr>
<tr>
<td>Customer Case View</td>
<td>Case (sn_customerservice_case)</td>
<td>Hides certain elements in the Case form for ESS view.</td>
</tr>
<tr>
<td>Empty Case form on Account Change</td>
<td>Case (sn_customerservice_case)</td>
<td>When a user makes a change to the value in the Account field on the Case form, the values in the following fields are cleared: Partner, Partner contact, Asset, Entitlement, Contract, and Contact.</td>
</tr>
<tr>
<td>Empty Partner Contact on Partner Change</td>
<td>Case (sn_customerservice_case)</td>
<td>When a user makes a change to the value in the Partner field on the Case form, the Partner contact field is also cleared.</td>
</tr>
<tr>
<td>Hide Activity Stream</td>
<td>Contact (customer_contact)</td>
<td>Hides the activity stream on top of the form header.</td>
</tr>
<tr>
<td>Hide attachment icon</td>
<td>Registration Request (sn_customerservice_registration)</td>
<td>Hides the attachment icon on top of the form header.</td>
</tr>
<tr>
<td>Hide Icons Form Header</td>
<td>Case (sn_customerservice_case)</td>
<td>Hides the email icon from the more options menu and the activity stream icon at the top of the form header. Also hides the book icon next to the Short Description field on the form.</td>
</tr>
<tr>
<td>Hide Suggestion next to Short Description</td>
<td>Case (sn_customerservice_case)</td>
<td>Hides the suggestion icon next to the Short description field.</td>
</tr>
<tr>
<td>Client script</td>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------------</td>
<td>--------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Make field readonly</td>
<td>Account Relationship Type (sn_customerservice_account_relationship_type)</td>
<td>Sets the <strong>From</strong> and <strong>To</strong> fields to read only once a record is created in the Account Relationship Type table (sn_customerservice_account_relationship_type).</td>
</tr>
<tr>
<td>Open the glide list for new</td>
<td>Appointment (sn_customerservice_appointment)</td>
<td>Opens the glide list to select the user for an appointment for new records.</td>
</tr>
<tr>
<td>appointment</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Populate Contact Company</td>
<td>Case (sn_customerservice_case)</td>
<td>When a user name is selected in the <strong>Contact</strong> field, the <strong>Account</strong> field is populated with the contact's account information.</td>
</tr>
<tr>
<td>Populate Contract</td>
<td>Case (sn_customerservice_case)</td>
<td>Populates the <strong>Contract</strong> field when the <strong>Account</strong> field is filled.</td>
</tr>
<tr>
<td>Populate contract and entitlement</td>
<td>Case (sn_customerservice_case)</td>
<td>Populates the <strong>Contract</strong> and <strong>Entitlement</strong> fields when the <strong>Account</strong> field is filled.</td>
</tr>
<tr>
<td>Populate Entitlement</td>
<td>Case (sn_customerservice_case)</td>
<td>Populates the <strong>Entitlement</strong> field when the <strong>Account</strong> field is filled.</td>
</tr>
<tr>
<td>Populate Product</td>
<td>Case (sn_customerservice_case)</td>
<td>When an asset is selected in the <strong>Asset</strong> field, the <strong>Product</strong> field is populated with the asset's product model.</td>
</tr>
<tr>
<td>Registration code read-only</td>
<td>Registration Request (sn_customerservice_registration)</td>
<td>Sets the <strong>Registration code</strong> field to read-only.</td>
</tr>
<tr>
<td>Set account read on load</td>
<td>Account Team Member (sn_customerservice_team_member)</td>
<td>Sets the <strong>Account</strong> field to read only for a new record when the account is not empty on form load.</td>
</tr>
<tr>
<td>Set asset readonly</td>
<td>Asset Contact (sn_customerservice_m2m_asset_contact)</td>
<td>Set the <strong>Asset</strong> field to readonly for a new form when the asset value is not empty.</td>
</tr>
<tr>
<td>Show partner field</td>
<td>Case (sn_customerservice_case)</td>
<td>Shows the <strong>Opened by</strong> field on the Case form.</td>
</tr>
<tr>
<td>Special Handling Notes for Case</td>
<td>Case (sn_customerservice_case)</td>
<td>Shows all of the Special Handling Notes with display type alert related to the current record.</td>
</tr>
<tr>
<td>Validate Product Entitlement</td>
<td>Entitlement (service_entitlement)</td>
<td>Displays a field warning message for the <strong>Per unit</strong> field if a product is selected but the <strong>Asset</strong>, <strong>Contract</strong>, and <strong>Account</strong> fields are empty.</td>
</tr>
</tbody>
</table>

**Business rules installed with Customer Service Management**

Business rules are added with activation of Customer Service Management.
<table>
<thead>
<tr>
<th>Business rule</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Account query for customer</td>
<td>Account</td>
<td>Queries the account for the customer contact.</td>
</tr>
<tr>
<td></td>
<td>(customer_account)</td>
<td></td>
</tr>
<tr>
<td>Account relationship display rule</td>
<td>Account Relationship</td>
<td>Displays the correct values in the bi-directional diagram on the Account Relationship form.</td>
</tr>
<tr>
<td></td>
<td>(account_relationship)</td>
<td></td>
</tr>
<tr>
<td>Add customer role to contacts</td>
<td>Contact</td>
<td>Adds the customer role (sn_customerservice.customer) to a customer contact after the contact has been assigned a user ID.</td>
</tr>
<tr>
<td></td>
<td>(customer_contact)</td>
<td></td>
</tr>
<tr>
<td>Add snc external role to contacts</td>
<td>Contact</td>
<td>Adds the snc_external user role to each contact.</td>
</tr>
<tr>
<td></td>
<td>(customer_contact)</td>
<td></td>
</tr>
<tr>
<td>Add Primary Contact to Asset Contact</td>
<td>Asset</td>
<td>When an asset is assigned a new primary contact, the primary contact is added to the asset contact.</td>
</tr>
<tr>
<td></td>
<td>(alm_asset)</td>
<td></td>
</tr>
<tr>
<td>Approver query for customer</td>
<td>Approval</td>
<td>Queries the approver for a customer contact.</td>
</tr>
<tr>
<td></td>
<td>(sysapproval_approver)</td>
<td></td>
</tr>
<tr>
<td>Asset query for customer</td>
<td>Asset</td>
<td>Queries the assets for a customer contact.</td>
</tr>
<tr>
<td></td>
<td>(alm_asset)</td>
<td></td>
</tr>
<tr>
<td>Auto assessment business rule</td>
<td>Case</td>
<td>Triggers a customer satisfaction survey when a case is set to Closed.</td>
</tr>
<tr>
<td></td>
<td>(sn_customerservice_case)</td>
<td></td>
</tr>
<tr>
<td>Case query for customer</td>
<td>Case</td>
<td>Queries the cases for a customer contact.</td>
</tr>
<tr>
<td></td>
<td>(sn_customerservice_case)</td>
<td></td>
</tr>
<tr>
<td>Case display rule</td>
<td>Case</td>
<td>A display business rule on the Case form which passes some values to the browser when a case is displayed.</td>
</tr>
<tr>
<td></td>
<td>(sn_customerservice_case)</td>
<td></td>
</tr>
<tr>
<td>Change Awaiting to Open</td>
<td>Case</td>
<td>Changes the case state from Awaiting Info to Open.</td>
</tr>
<tr>
<td></td>
<td>(sn_customerservice_case)</td>
<td></td>
</tr>
<tr>
<td>Check duplicate</td>
<td>Asset Contact</td>
<td>Checks for duplicate records before creating a new asset contact.</td>
</tr>
<tr>
<td></td>
<td>(sn_customerservice_m2m_asset_contact)</td>
<td></td>
</tr>
<tr>
<td>Check duplicate for responsibility</td>
<td>Contact Relationship</td>
<td>Checks for duplicate responsibilities before creating a new contact relationship.</td>
</tr>
<tr>
<td></td>
<td>(sn_customerservice_contact_relationship)</td>
<td></td>
</tr>
<tr>
<td>Check duplicate for responsibility</td>
<td>Asset Contact</td>
<td>Checks for duplicate responsibilities before creating a new asset contact.</td>
</tr>
<tr>
<td></td>
<td>(sn_customerservice_m2m_asset_contact)</td>
<td></td>
</tr>
<tr>
<td>Check snc_external roles exist</td>
<td>Contact</td>
<td>Checks if the com.glide.security_schema plugin is activated.</td>
</tr>
<tr>
<td></td>
<td>(customer_contact)</td>
<td></td>
</tr>
<tr>
<td>Contact query for customer</td>
<td>Contact</td>
<td>Queries the contacts for a customer.</td>
</tr>
<tr>
<td></td>
<td>(customer_contact)</td>
<td></td>
</tr>
<tr>
<td>Business rule</td>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------</td>
<td>------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Contract query for customer</td>
<td>Contract (ast_contract)</td>
<td>Queries the contracts for a customer.</td>
</tr>
<tr>
<td>Create bi-direction relationship</td>
<td>Account Relationship (account_relationship)</td>
<td>After an account relationship is created, this business rule creates the bi-directional account relationship record.</td>
</tr>
<tr>
<td>Delete Account Contacts and Assets</td>
<td>Account Relationship (account_relationship)</td>
<td>When an account relationship is deleted, this business rule deletes the corresponding account and asset contacts.</td>
</tr>
<tr>
<td>Delete relationship type</td>
<td>label (account_relationship_type)</td>
<td>Checks to see if any relationship records are using a relationship type before that relationship type is deleted.</td>
</tr>
<tr>
<td>Delete responsibility definition</td>
<td>Responsibility Definition (sn_customerservice_responsibility_def)</td>
<td>Checks to see if any account team members are using a responsibility definition before that responsibility definition is deleted.</td>
</tr>
<tr>
<td>Display request message</td>
<td>Registration Request (sn_customerservice_registration)</td>
<td>After registration request submittal, shows info message to user.</td>
</tr>
<tr>
<td>Display rule</td>
<td>Registration Request (sn_customerservice_registration)</td>
<td>Shows message to remind users to enter a correct registration code</td>
</tr>
<tr>
<td>Entitlement query for customer</td>
<td>Entitlement (service_entitlement)</td>
<td>Queries the entitlements for a customer contact.</td>
</tr>
<tr>
<td>Insert Case Work Notes</td>
<td>Appointment (sn_customerservice_appointment)</td>
<td>Updates the case work notes with the appointment details when an an appointment is created.</td>
</tr>
<tr>
<td>Populate company for case</td>
<td>Case (sn_customerservice_case)</td>
<td>Populates the Company field on the Case form based on the name entered in the Contact field.</td>
</tr>
<tr>
<td>Set First Response Time</td>
<td>Case (sn_customerservice_case)</td>
<td>When a case is created or updated, this rule sets the current time in the first_response_time field. Also used when a case is set to Resolved or Awaiting Info or when comments or close notes are added.</td>
</tr>
<tr>
<td>Update account based on reg code</td>
<td>Registration Request (sn_customerservice_registration)</td>
<td>Validates the registration registration code and assigns the account associated with the registration code.</td>
</tr>
</tbody>
</table>

Note: The first_response_time field is not used.
<table>
<thead>
<tr>
<th>Business rule</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Update account relationship labels</td>
<td>Account Relationship Type (sn_customerservice_account_relationship)</td>
<td>When the labels for an account relationship type are updated, this business rule updates all of the related account relationship records.</td>
</tr>
<tr>
<td>Update case entitlement on Close</td>
<td>Case (sn_customerservice_case)</td>
<td>Updates the associated entitlement when the state of a case is set to Closed.</td>
</tr>
<tr>
<td>Update Case Work notes</td>
<td>Appointment (sn_customerservice_appointment)</td>
<td>Adds work notes to the case when an appointment for the case is updated.</td>
</tr>
<tr>
<td>Update Case Work Notes</td>
<td>Knowledge (kb_knowledge)</td>
<td>Adds work notes to the case when a knowledge article associated with the case gets updated.</td>
</tr>
<tr>
<td>Update Parent Case for new task</td>
<td>Task (sn_customerservice_task)</td>
<td>Updates the case when a new case task is created.</td>
</tr>
<tr>
<td>Update Parent case for state change</td>
<td>Task (sn_customerservice_task)</td>
<td>Updates the case when a new case task is changed.</td>
</tr>
<tr>
<td>Update relationship label</td>
<td>Account Relationship (account_relationship)</td>
<td>Updates the relationship labels for bi-directional account relationships.</td>
</tr>
<tr>
<td>Update User Task State</td>
<td>Case (sn_customerservice_case)</td>
<td>Calculates the work load for the agent based on the number of cases assigned to the agent. Also updates the last assigned time. This rule is used by the matching rule engine.</td>
</tr>
<tr>
<td>Validate registration</td>
<td>Registration Request (sn_customerservice_registration)</td>
<td>Checks if the registration is valid based on the user’s email address. If the user exists in the system or a request has already been submitted and is in the pending state, the registration request is not allowed.</td>
</tr>
</tbody>
</table>

Components installed with additional plugins for Customer Service Management

Several types of components are installed with the additional plugins for the Customer Service Management application.

Components installed with Customer Service Management Demo Data

Several types of components are installed with Customer Service Management Demo Data.

Tables installed with Customer Service Management Demo Data

Tables are added with activation of Customer Service Management Demo Data.
<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enterprise Software</td>
<td></td>
</tr>
<tr>
<td>(cmdb_ci_enterprise_software)</td>
<td></td>
</tr>
<tr>
<td>Enterprise Software Asset</td>
<td></td>
</tr>
<tr>
<td>(alm_application_software)</td>
<td></td>
</tr>
</tbody>
</table>

**Business rules installed with Customer Service Management Demo Data**

Business rules are added with activation of Customer Service Management Demo Data.

<table>
<thead>
<tr>
<th>Business rule</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Demo-Add Support Manager to watchlist</td>
<td>Case</td>
<td>(sn_customerservice_case)</td>
</tr>
</tbody>
</table>

**Components installed with CTI Softphone**

Several types of components are installed with CTI Softphone.

**Tables installed with CTI Softphone**

Tables are added with activation of CTI Softphone.

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>User CTI Status</td>
<td>Stores the agent’s availability status.</td>
</tr>
</tbody>
</table>

**Script includes installed with CTI Softphone**

Script includes are added with activation of CTI Softphone.

<table>
<thead>
<tr>
<th>Script include</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CTIAjaxUtility</td>
<td>Ajax class that provides helper functions to set and get user states, get incoming call context, log a call, and queue and dequeue a call.</td>
</tr>
</tbody>
</table>

**Business rules installed with CTI Softphone**

Business rules are added with activation of CTI Softphone.

<table>
<thead>
<tr>
<th>Business rule</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Route available user for Incident Task</td>
<td>User CTI Status</td>
<td>(user_cti_status)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Demo business rule to dequeue a call based on matching rules whenever an agent becomes available.</td>
</tr>
</tbody>
</table>

**Components installed with Customer Service CTI Demo Data**

Several types of components are installed with Customer Service CTI Demo Data.

**Business rules installed with Customer Service CTI Demo Data**

Business rules are added with activation of Customer Service CTI Demo Data.
<table>
<thead>
<tr>
<th>Business rule</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Route available user for Case Task</td>
<td>User CTI Status (user_cti_status)</td>
<td>Used to dequeue a call whenever an agent becomes available.</td>
</tr>
</tbody>
</table>

**Components installed with OpenFrame**

Several types of components are installed with OpenFrame.

**Tables installed with OpenFrame**

Tables are added with activation of OpenFrame.

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Phone Log (sn_openframe_phone_log)</td>
<td>A log of the incoming and outgoing phone calls. This table can be used to log any phone call made or received.</td>
</tr>
<tr>
<td>OpenFrame Configuration (sn_openframe_configuration)</td>
<td>Stores the OpenFrame configuration. This is the configuration used to load the OpenFrame in the TopFrame.</td>
</tr>
</tbody>
</table>

**Roles installed with OpenFrame**

Roles are added with activation of OpenFrame.

<table>
<thead>
<tr>
<th>Role title (name)</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>User (sn_openframe_user)</td>
<td>The OpenFrame user role.</td>
<td>• None</td>
</tr>
</tbody>
</table>

**Script includes installed with OpenFrame**

Script includes are added with activation of OpenFrame.

<table>
<thead>
<tr>
<th>Script include</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>OpenFrameAjaxUtility</td>
<td>OpenFrame AJAX utility class providing functions to get the OpenFrame configuration and also to get and set the last opened frame location.</td>
</tr>
</tbody>
</table>

**Business rules installed with OpenFrame**

Business rules are added with activation of OpenFrame.

<table>
<thead>
<tr>
<th>Business rule</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set Agent</td>
<td>Phone Log (sn_openframe_phone_log)</td>
<td>Sets the agent in the Phone Log table as the current logged-in user if a phone call is logged without an agent.</td>
</tr>
<tr>
<td>One Default Configuration</td>
<td>OpenFrame Configuration (sn_openframe_configuration)</td>
<td>Checks that there is only one default OpenFrame configuration. You cannot have two OpenFrame configurations with the default flag set to true.</td>
</tr>
</tbody>
</table>
UI macros installed with OpenFrame

UI macros are added with activation of OpenFrame.
These macros are supported if:
- the doctype property is set and the device is not a tablet or mobile.
- the web browser is Internet Explorer 10 or above.

Components installed with Special Handling Notes

Several types of components are installed with Special Handling Notes.

Tables installed with Special Handling Notes

The tables included with the Special Handling Notes plugin (com.sn_shn).

The Special Handling Notes plugin adds the following tables.

Roles installed with Special Handling Notes

The user roles included with the Special Handling Notes plugin (com.sn_shn).
<table>
<thead>
<tr>
<th>Role</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_shn.admin</td>
<td>Can read, create, update, and delete special handling notes. This role contains the sn_shn.editor role. The sn_customerservice_manager role contains the sn_shn.admin role.</td>
</tr>
<tr>
<td>sn_shn.editor</td>
<td>Can read and update special handling notes. This role contains the sn_shn.user role. The sn_customerservice_agent role contains the sn_shn.editor role.</td>
</tr>
<tr>
<td>sn_shn.user</td>
<td>Can read special handling notes.</td>
</tr>
</tbody>
</table>

Properties installed with Special Handling Notes

The properties included with the Special Handling Notes plugin (com.sn_shn).

The Special Handling Notes plugin adds the following properties.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
</table>
| Maximum number of notes displayed in the Special Handling Notes pop-up window (sn_shn.max_num_alerts) | - **Type:** integer  
- **Default value:** 20  
- **Location:** Special Handling Notes > Properties  
- **Learn more:** Configure special handling notes properties                                                                |
| Display special handling notes only once per session (sn_shn.note_preferences) | Special handling notes are displayed each time you access a record. Enable this property to display special handling notes only once per session.  
- **Type:** true | false  
- **Default value:** false  
- **Location:** Special Handling Notes > Properties  
- **Learn more:** Configure special handling notes properties |
| Width of the Special Handling Notes pop-up window in pixels (sn_shn.popup_width) | The width of the Special Handling Notes pop-up window in pixels. The default width is 500. If you specify less than 300, the window automatically uses the minimum width of 300 pixels.  
- **Type:** integer  
- **Default value:** 500  
- **Location:** Special Handling Notes > Properties  
- **Learn more:** Configure special handling notes properties |

Business rules installed with Special Handling Notes

The business rules included with the Special Handling Notes plugin (com.sn_shn).

The Special Handling Notes plugin adds the following business rules.
Client scripts installed with Special Handling Notes

The client scripts included with the Special Handling Notes plugin (com.sn_shn).

The Special Handling Notes plugin adds the following client scripts.

<table>
<thead>
<tr>
<th>Client script</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>On Load Message</td>
<td>Special Handling Notes Configuration (sn_shn_configuration)</td>
<td>On Load Message describing what the Special Handling Notes Configuration table is for. Create a configuration by selecting a table for which special handling notes can be created and displayed. Include notes for related entities by selecting the desired fields and adding them to the configuration.</td>
</tr>
</tbody>
</table>

Script includes installed with Special Handling Notes

The script includes included with the Special Handling Notes plugin (com.sn_shn).

The Special Handling Notes plugin adds the following script includes.

<table>
<thead>
<tr>
<th>Script include</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SHNProcessor</td>
<td>A collection of APIs for special handling notes.</td>
</tr>
<tr>
<td>SHNTable</td>
<td>Provides a list of tables for which the user can create special handling notes.</td>
</tr>
</tbody>
</table>

Components installed with Targeted Communications

Several types of components are installed with the Targeted Communications application.

Tables installed with Targeted Communications

Tables are added with activation of Targeted Communications.

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Recipients (Users) (sn_publications_recipientslist_user_m2m)</td>
<td>Stores recipients lists of type Internal Users.</td>
</tr>
<tr>
<td>Recipients (Accounts) (sn_publications_recipientslist_account_m2m)</td>
<td>Stores recipients lists of type Accounts.</td>
</tr>
</tbody>
</table>
### Table

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
</table>
| Recipients (Consumers)  
(sn_publications_recipientslist_consumer_m2m) | Stores recipients lists of type Consumers. |
| Publication Recipients  
(sn_publications_publication_contact_m2m) | Stores recipients lists of type Contacts. |
| Workflow Config  
(sn_publications_workflow_config) | Workflow configuration page. |
| Publication  
(sn_publications_publication) | Stores all of the publications. |
| Recipients List  
(sn_publications_recipients_list) | Stores the recipient lists. |
| Recurrence  
(sn_publications_recurrence) | Stores all of the publication recurrences. |

### Business rules installed with Targeted Communications

Business rules are added with activation of Targeted Communications.

<table>
<thead>
<tr>
<th>Business rule</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
</table>
| Create email notification | Publication  
(sn_publications_publication) | Generates the email notification after a new publication is created. |
| Create publication recipients | Publication  
(sn_publications_publication) | Builds the recipient list after the state of a publication changes to Published. |
| Create Recurrence Publications | Recurrence  
(sn_publications_recurrence) | Generates duplicate publications from the original publication and calculates the start and end dates for each recurrence. |
| Date validation | Publication  
(sn_publications_publication) | Validates the publication and expiration dates. Also validates that the start and end dates for a recurring publication is within the range of the specified recurrence. |
| Delete email notification | Publication  
(sn_publications_publication) | Deletes the email notification if a publication is deleted, cancelled, or expired. |
| Delete Recipients List | Recipients List  
(sn_publications_recipients_list) | Prevents a recipient list from being deleted if the list has one or more associated publications. |
| Fields validation | Recurrence  
(sn_publications_recurrence) | |
<table>
<thead>
<tr>
<th>Business rule</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Initialize Publication</td>
<td>Publication</td>
<td>Changes the stage of a publication to <strong>Author</strong> and the <strong>visited_state</strong> field to empty whenever a new publication is created.</td>
</tr>
<tr>
<td></td>
<td>(sn_publications_publication)</td>
<td></td>
</tr>
<tr>
<td>Make approver list required</td>
<td>Workflow Config</td>
<td>Makes the <strong>Approver</strong> field mandatory for articles that require approval prior to publishing.</td>
</tr>
<tr>
<td></td>
<td>(sn_publications_workflow_config)</td>
<td></td>
</tr>
<tr>
<td>Make recipient list required</td>
<td>Publication</td>
<td>Makes the <strong>Recipient list</strong> field mandatory and ensures that the recipient list is populated.</td>
</tr>
<tr>
<td></td>
<td>(sn_publications_publication)</td>
<td></td>
</tr>
<tr>
<td>Reset error state</td>
<td>Publication</td>
<td>Resets the <strong>error_state</strong> field to false when a publication is updated.</td>
</tr>
<tr>
<td></td>
<td>(sn_publications_publication)</td>
<td></td>
</tr>
<tr>
<td>Restrict User Access</td>
<td>Publication</td>
<td>Restricts access to published articles to a targeted set of users.</td>
</tr>
<tr>
<td></td>
<td>(sn_publications_publication)</td>
<td></td>
</tr>
<tr>
<td>Show error state message:</td>
<td>Publication</td>
<td>Displays an error message at the top of the form when a publication’s <strong>error_state</strong> field is true.</td>
</tr>
<tr>
<td></td>
<td>(sn_publications_publication)</td>
<td></td>
</tr>
<tr>
<td>Show state message</td>
<td>Publication</td>
<td>Displays a status message when the recipient list is being generated.</td>
</tr>
<tr>
<td></td>
<td>(sn_publications_publication)</td>
<td></td>
</tr>
<tr>
<td>Start publication workflow</td>
<td>Publication</td>
<td>Starts the workflow after a publication is generated.</td>
</tr>
<tr>
<td></td>
<td>(sn_publications_publication)</td>
<td></td>
</tr>
<tr>
<td>Track Customer Publication</td>
<td>Publication</td>
<td>Updates when a user has viewed the article.</td>
</tr>
<tr>
<td>Views</td>
<td>(sn_publications_publication)</td>
<td></td>
</tr>
<tr>
<td>Update Recipients</td>
<td>Recipients List</td>
<td>Builds or updates a recipient list for a publication.</td>
</tr>
<tr>
<td></td>
<td>(sn_publications_recipients_list)</td>
<td></td>
</tr>
<tr>
<td>Update Visited States on state change</td>
<td>Publication</td>
<td>Updates the stage changes as a publication moves through the creation, review, and approval process.</td>
</tr>
<tr>
<td></td>
<td>(sn_publications_publication)</td>
<td></td>
</tr>
</tbody>
</table>

**Roles installed with Targeted Communications**

Roles are added with activation of Targeted Communications.
### Role title (name)

<table>
<thead>
<tr>
<th>Role title (name)</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
</table>
| Publications administrator (sn_publications.admin) | The publications administrator can:  
· read all publications  
· create, update, and delete publications  
· create recurring publications  
· create recipient lists  
· add or remove approvers to workflows | · sn_publications.author  
· sn_publications.approver  
· workflow_publisher  
· image_admin |
| Publications author (sn_publications.author) | The publications author can:  
· read all publications  
· create, update, and delete publications  
· create recurring publications  
· create recipient lists  
· sn_publications_recipients_list_user  
· sn_publications_recipients_user  
· workflow_publisher  
· image_admin  
· sn_esm_agent | |
| Publications approver (sn_publications.approver) | The publications approver can approve publications. | approver_user |
| Recipients list user (sn_publications_recipients_list_user) | The recipients list user can create and view recipient lists. | None |
| Recipients user (sn_publications_recipients_user) | The recipients user can view recipient lists. | None |

### Client scripts installed with Targeted Communications

Client scripts are added with activation of Targeted Communications.

<table>
<thead>
<tr>
<th>Client script</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
</table>
| Set Conditions Table/Field onchange | Recipients List (sn_publications_recipients_list) | For recipient lists:  
· If the type is Internal Users, this script assigns the User (sys_user) table to the Table field and sys_id to the User Field field.  
· If the type is Customers, this script assigns the Customer Product (customer_products) table to the Table field sys_id to the User Field field. |
<table>
<thead>
<tr>
<th>Client script</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
</table>
| Set Conditions Table/Field onload | Recipients List (sn_publications_recipients_list) | For recipient lists:  
- If the type is **Internal Users**, this script assigns the User (sys_user) table to the Table field and sys_id to the User Field field.  
- If the type is **Customers**, this script assigns the Customer Product (customer_products) table to the Table field sys_id to the User Field field. |

| Switch Publication View | Approval (sysapproval_approver) |  |

| Validate start date | Publication (sn_publications_publication) | Validates that the start date of a publication is after the current date and before the end date. |
| Validate end date | Publication (sn_publications_publication) | Validates that the end date of a publication is after the start date. |
| Validate start date | Recurrence (sn_publications_recurrence) | Validates that the start date of a recurrence publication is after the current date and before the end date. |
| Validate end date | Recurrence (sn_publications_recurrence) | Validates that the end date of a recurrence publication is after the start date. |

**Script includes installed with Targeted Communications**

Script includes are added with activation of Targeted Communications.

<table>
<thead>
<tr>
<th>Script include</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PublicationAjax</td>
<td></td>
</tr>
<tr>
<td>RecipientsListApi</td>
<td></td>
</tr>
<tr>
<td>RecipientsListApi.getRecipientsListCount</td>
<td>Calculates the total number of recipients for a publication.</td>
</tr>
<tr>
<td>RecipientsListApi.buildRecipientsList for Publication</td>
<td>Builds the recipient list for a publication based on the recipient list's type and condition.</td>
</tr>
<tr>
<td>PublicationsApi</td>
<td>API functions for publications functionality</td>
</tr>
<tr>
<td>PublicationsQueryProcessor</td>
<td>Ajax helper for showing publications listing.</td>
</tr>
</tbody>
</table>

**Properties installed with Targeted Communications**

Properties are added with activation of Targeted Communications.

**Note:** To open the System Property (sys_properties) table, enter `sys_properties.list` in the navigation filter.
### Component installed with Knowledge Product Entitlements

Several types of components are installed with the Knowledge Product Entitlements application.

### Business rules installed with Knowledge Product Entitlements

Business rules are added with activation of Knowledge Product Entitlements.

<table>
<thead>
<tr>
<th>Business rule</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Knowledge Product Entitlement</td>
<td>Knowledge (kb_knowledge)</td>
<td>Implements the needed access controls for users with the sn_customerservice.customer role.</td>
</tr>
<tr>
<td>KB Product Entitlements</td>
<td>Knowledge Base (kb_knowledge_base)</td>
<td></td>
</tr>
</tbody>
</table>

### Properties installed with Knowledge Product Entitlements

Properties are added with activation of Knowledge Product Entitlements.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>kb_product_entitlement.knowledge_base.enable</td>
<td>Enable access control of Knowledge Bases based on product entitlements.</td>
</tr>
<tr>
<td></td>
<td>If enabled, customers can access all of the knowledge bases related to the products for which they have entitlements.</td>
</tr>
<tr>
<td></td>
<td>• Type: true/false</td>
</tr>
<tr>
<td></td>
<td>• Default value: false</td>
</tr>
<tr>
<td></td>
<td>• Location: Knowledge Product Entitlements &gt; Properties</td>
</tr>
<tr>
<td>kb_product_entitlement.knowledge_base.allow_empty_products</td>
<td>Allow access to Knowledge Bases with empty Related Products field.</td>
</tr>
<tr>
<td></td>
<td>If enabled, customers can access all knowledge bases even if no products have been specified in the Related Products field on the Knowledge Base form.</td>
</tr>
<tr>
<td></td>
<td>• Type: true/false</td>
</tr>
<tr>
<td></td>
<td>• Default value: false</td>
</tr>
<tr>
<td></td>
<td>• Location: Knowledge Product Entitlements &gt; Properties</td>
</tr>
</tbody>
</table>
### Components installed with Self Service Password Reset

Several types of components are installed with Self Service Password Reset.

### Script includes installed with Self Service Password Reset

Script includes are added with activation of Self Service Password Reset.

<table>
<thead>
<tr>
<th>Script include</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PasswordResetAJAX</td>
<td>AJAX Script to process a password reset from a UI Page as guest.</td>
</tr>
<tr>
<td>ResetPwdAjaxProcessor</td>
<td></td>
</tr>
</tbody>
</table>

### Computer telephony integration (CTI)

Computer Telephony Integration (CTI) enables the Customer Service application to support inbound and outbound telephone calls.

Customer service agents can do the following with CTI:

- Make an outgoing call to a phone number.
- Receive an incoming call from a phone number or from another user within the system.
- Transfer a call to another user within the system.
- Place a call on mute.
- Set their availability status.

CTI does not require any specific user role except the OpenFrame user (sn_openframe_user) role. Roles are based on the application using CTI.
OpenFrame overview

OpenFrame provides a communication frame that customer service agents use to place and receive customer calls.

Use OpenFrame to integrate telephony systems into the Now Platform®. Use the OpenFrame API to communicate between the Now Platform and the domain opened in the OpenFrame window.

OpenFrame includes these components:

- TopFrame, a ServiceNow application.
- OpenFrame API, which gets sourced from the partner application. This API communicates with TopFrame and controls the OpenFrame visual features.

The location of the API is `https://[servicenow instance]/scripts/openframe/1.0.5/openFrameAPI.min.js`. This minified version includes other needed libraries and should be used for integration.

For API reference, you can use the un-minified version: `https://[servicenow instance]/scripts/openframe/1.0.5/openFrameAPI.js`. This version cannot be used directly for integration purposes.

Note: To stay current with reference to the OpenFrame library, use the following resource URL: `https://[servicenow instance]/scripts/openframe/latest/openFrameAPI.min.js`.

Using the OpenFrame window

OpenFrame provides support for embedded and contextual phone conversations, including:

- Context identification: incoming calls maximize the OpenFrame window and display details about the caller, including the account, contact or consumer name, and phone number.
- Links to forms: use the openFrameAPI (openServiceNowForm) to create links to forms. When an incoming call is received, an agent can click the account, contact, consumer, or case number in the OpenFrame window to open the corresponding record.
  - In Agent Workspace, records open in either a primary tab or a sub-tab depending on the tab configuration.
  - In the platform interface, records open in TopFrame (i.e., the current page).
- Click-to-call capability: click phone number fields to make a call.
  - In Agent Workspace, agents can click phone number fields on forms and in the Customer 360 ribbon component to make a call.
  - In the platform interface, agents can click the phone icon next to the **Contact** or **Consumer** fields.
    - If a contact or consumer has one phone number, the call is placed to that number.
    - If a contact or consumer has more than one phone number, a dialog box displays the available numbers. Click a number to place the call.

- OpenFrame window actions:
Using OpenFrame in Agent Workspace

In Agent Workspace, you can integrate OpenFrame with the Interaction Management System (IMS) and interaction records. This allows agents to manage the phone interaction life cycle. For more information, see Integration with Interaction Management System (IMS).

Creating an OpenFrame configuration

With the admin role, you can create or modify an OpenFrame configuration. This configuration stores information about the OpenFrame window settings, including:

- The window height and width.
- The icon, title, and subtitle displayed in the window header.
- Users and groups that have access to the window.

OpenFrame user roles

The OpenFrame window is available to agents with the sn.open.frame_user role and who belong to one of the user groups specified in the OpenFrame configuration.
openFrameAPI

OpenFrame is an omni-present frame that communication partners can use to integrate their systems into the ServiceNow platform.

One of the core requirements is the ability to connect and serve code from different domains that can connect seamlessly with partner subsystems. This cross domain connection is required to keep connections and callbacks registered into communication systems without any cross domain issues.

OpenFrame has two significant parts: one that lives in the ServiceNow application (referred to as TopFrame) and this API that is sourced from the partner application. This API has the necessary methods to communicate with TopFrame and control the visual features of the OpenFrame.

Note: To stay current with reference to the OpenFrame library, use the following resource URI: https://[servicenow instance]/scripts/openframe/latest/openFrameAPI.min.js.

APIs not supported on Agent Workspace

The following functionalities are not supported on Agent Workspace:

- openServiceNowList
- OpenCustomURL

openFrameAPI - Init(Object config, function successCallback, function failureCallback)

Initialize OpenFrame, must be the first method called.

This method initializes communication to TopFrame and initializes any visual elements passed in the config parameter.

Parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>config</td>
<td>Object</td>
<td>An object of key value pairs. The possible keys are height, width, title, subTitle, and titleIcon. All keys are optional.</td>
</tr>
<tr>
<td>successCallback</td>
<td>function</td>
<td>The callback function used if the init method succeeds. The openframe configuration stored in the system is passed as a parameter to the callback function.</td>
</tr>
<tr>
<td>failureCallback</td>
<td>function</td>
<td>The callback function used if the init method fails.</td>
</tr>
</tbody>
</table>

Returns

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>void</td>
<td></td>
</tr>
</tbody>
</table>
```javascript
var config = {
  height: 300,
  width: 200
}
function handleCommunicationEvent(context) {
  console.log("Communication from Topframe", context);
}
function initSuccess(snConfig) {
  console.log("openframe configuration", snConfig);
  // register for communication event from TopFrame
  openFrameAPI.subscribe(openFrameAPI.EVENTS.COMMUNICATION_EVENT,
    handleCommunicationEvent);
}
function initFailure(error) {
  console.log("OpenFrame init failed..", error);
}
openFrameAPI.init(config, initSuccess, initFailure);

openFrameAPI.show()

- **openFrameAPI.show()**
  Makes the OpenFrame visible in the TopFrame.

**Parameters**

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Returns**

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>void</td>
<td></td>
</tr>
</tbody>
</table>

openFrameAPI.show()

**openFrameAPI.hide()**

- **Hides the OpenFrame in the TopFrame.**

**Parameters**

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Returns**

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>void</td>
<td></td>
</tr>
</tbody>
</table>
openFrameAPI.hide()

openFrameAPI - isVisible(function callback)
Checks to see if the OpenFrame is visible in the TopFrame.

Parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>callback</td>
<td>function</td>
<td>The callback function receives a parameter with a value of true or false. True if OpenFrame is visible and false if not visible.</td>
</tr>
</tbody>
</table>

Returns

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>void</td>
<td></td>
</tr>
</tbody>
</table>

function callback(isVisible) {
    console.log(isVisible)
}
openFrameAPI.isVisible(callback)

openFrameAPI - setTitle(String title)
Sets the OpenFrame title.

Parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>title</td>
<td>String</td>
<td>A string of 256 or fewer characters.</td>
</tr>
</tbody>
</table>

Returns

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>void</td>
<td></td>
</tr>
</tbody>
</table>

openFrameAPI.setTitle('Incoming Call');

openFrameAPI - setSubtitle(String subTitle)
Sets the OpenFrame subtitle.
Parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>subTitle</td>
<td>String</td>
<td>A string of 256 or fewer characters.</td>
</tr>
</tbody>
</table>

Returns

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>void</td>
<td></td>
</tr>
</tbody>
</table>

```java
openFrameAPI.setSubtitle('+18888888888');
```

`openFrameAPI - setSize(Number width, Number height)`
Sets the OpenFrame size.

Parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>width</td>
<td>Number</td>
<td>Should be greater than zero.</td>
</tr>
<tr>
<td>height</td>
<td>Number</td>
<td>Should be greater than zero.</td>
</tr>
</tbody>
</table>

Returns

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>void</td>
<td></td>
</tr>
</tbody>
</table>

```java
openFrameAPI.setSize(300, 370);
```

`openFrameAPI - setTitleIcon(Object icon)`
Sets the OpenFrame's title icon.

Parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>icon</td>
<td>Object</td>
<td>Object of key value pairs. Keys include imageURL, imageTitle, and any other context needed.</td>
</tr>
</tbody>
</table>

Returns

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>void</td>
<td></td>
</tr>
</tbody>
</table>

```java
openFrameAPI.setTitleIcon({'iconImage': 'path/to/image', 'iconTitle': 'My Title'});
```
openFrameAPI.setTitleIcon({'imageURL:'/my/image/path.png','imageTitle':'mute', id:101});

openFrameAPI.setTitleIcon({'imageURL':'https://mydomian.com/image/path.png','imageTitle':'mute', id:101});

**openFrameAPI - setIcons(Array icons)**

The OpenFrame header can include icons that are placed next to the close icon.

**Parameters**

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>icons</td>
<td>Array</td>
<td>A list of icon configurations, where each icon configuration is an object with key values <code>imageURL</code>, <code>imageTitle</code>, and any other needed context.</td>
</tr>
</tbody>
</table>

**Returns**

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>void</td>
<td></td>
</tr>
</tbody>
</table>


**openFrameAPI - subscribe(openFrameAPIEVENT event, function eventCallback)**

Subscribes to the event.

These events are available.

- `openframe_icon_clicked` -- this event occurs when any icon other than the close icon is clicked on the OpenFrame footer. The callback receives the icon object as a parameter. This event replaces `openframe_header_icon_clicked`.
- `openframe_header_icon_clicked` -- this event occurs when any icon other than the close icon is clicked on the OpenFrame header. The callback receives the icon object as a parameter. This event works but should be replaced with `openframe_icon_clicked`.
- `openframe_shown` -- this event occurs when the OpenFrame is shown.
- `openframe_hidden` -- this event occurs when the OpenFrame is hidden.
- `openframe_before_destroy` -- this event occurs before the TopFrame is unloaded.
- `openframe_communication` -- this event is application specific and can be customized.
- `openframe_communication_failure` -- this event occurs when communication to TopFrame fails.
- **openframe Collapse** -- this event occurs when the collapse icon is clicked on the OpenFrame header.
- **openframe Expand** -- this event occurs when the expand icon is clicked on the OpenFrame header.

The `openframe_header_icon_clicked` is split into two events:

- **openframe_icon_clicked**: this event occurs when any icon other than the close icon is clicked on the OpenFrame. The callback receives the icon object as a parameter.
- **openframe_title_icon_clicked**: this event occurs when the title icon is clicked on the OpenFrame. The callback receives the titleIcon object as a parameter.

**Note:** The `openframe_icon_clicked` event replaces `openframe_header_icon_clicked`, which works currently but is marked for retirement in a future release. Until that time, clicking an icon emits both `openframe_icon_clicked` and `openframe_header_icon_clicked`. Also, you can subscribe to either one but not both at the same time as it may execute the callback function twice. For example, if you are using `openframe_header_icon_clicked`, plan to change the code and subscribe to `openframe_icon_clicked` and/or `openframe_title_icon_clicked` based on your use case.

### Parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>event</td>
<td>openFrameAPIEVENT</td>
<td>One of the available events.</td>
</tr>
<tr>
<td>eventCallback</td>
<td>function</td>
<td>The method called when the specified event occurs.</td>
</tr>
</tbody>
</table>

### Returns

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>void</td>
<td></td>
</tr>
</tbody>
</table>

```javascript
function handleIconClick(context) {
  console.log("Icon was clicked", context);
}
openFrameAPI.subscribe(openFrameAPI.EVENTS.ICON_CLICKED,
  handleIconClick);
```

**openFrameAPI - openServiceNowForm(Object details)**

Opens a form URL.

When an agent receives an incoming call, the OpenFrame window displays information such as the account, contact, or consumer. Clicking a link in the OpenFrame window displays the corresponding record.

- In the platform interface, this API opens a form URL in TopFrame.
- For Agent Workspace, this API supports interaction tab management. In Agent Workspace, an interaction record opens in a parent tab and the specified entity record opens in a child tab under the interaction tab.
Parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>details</td>
<td>Object</td>
<td>Key-value pairs that identify the form URL to open.</td>
</tr>
<tr>
<td>details.entity</td>
<td>String</td>
<td>Table or entity name.</td>
</tr>
<tr>
<td>details.query</td>
<td>String</td>
<td>Query to identify the record to open, such as: query: 'sys_id=&lt;record_sys_id&gt;'.</td>
</tr>
<tr>
<td>details.interaction_sys_id</td>
<td>String</td>
<td>Optional. Sys ID of the interaction record to open as parent tab in Agent Workspace.</td>
</tr>
</tbody>
</table>

Note: In the platform interface the interaction_sys_id is ignored.

Returns

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>void</td>
<td></td>
</tr>
</tbody>
</table>

The following example shows basic usage in platform:

```javascript
openFrameAPI.openServiceNowForm({
  entity: 'customer_account',
  query: 'sys_id=447832786f0331003b3c498f5d3ee452',
  'interaction_sys_id': '3be092313b711300758ce9b534efc4dd'});
```

The following example shows how to use the query parameter to create a new record with a populated Name field in Workspace:

```javascript
openFrameAPI.openServiceNowForm({
  entity: 'sys_user',
  query: 'sys_id=-1&sysparm_query=first_name=Ivan' });
```

openFrameAPI.openServiceNowList(Object details)

Opens a list URL in TopFrame.

Note: This API is not supported on Agent Workspace.
Parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>details</td>
<td>Object</td>
<td>An object of key value pairs. The possible keys are</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- entity, the table name</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- query, an encoded query string</td>
</tr>
</tbody>
</table>

Returns

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>void</td>
<td></td>
</tr>
</tbody>
</table>

```javascript
openFrameAPI.openServiceNowList({entity:'case', query:'active=true'});
```

**openFrameAPI - version()**

Returns the OpenFrame API version.

Parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Returns

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>String</td>
<td>The OpenFrame API version</td>
</tr>
</tbody>
</table>

```javascript
var version = openFrameAPI.version();
console.log("API version " + version);
```

**openFrameAPI - openCustomURL(String details)**

Opens a custom URL in TopFrame.

**Note:** This API is not supported on Agent Workspace.
### Parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Url</td>
<td>String</td>
<td>A string of 2083 or fewer characters.</td>
</tr>
</tbody>
</table>

### Returns

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>void</td>
<td></td>
</tr>
</tbody>
</table>

```java
openFrameAPI.openCustomURL('10_cool_things.do');
```

### openFrameAPI - setHeight(height)

Sets the OpenFrame height.

#### Parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Height</td>
<td>Number</td>
<td>Height in pixels</td>
</tr>
</tbody>
</table>

#### Returns

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>void</td>
<td></td>
</tr>
</tbody>
</table>

```java
openFrameAPI.setHeight(100);
```

### openFrameAPI - setWidth(width)

Sets the OpenFrame width.

#### Parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Width</td>
<td>Number</td>
<td>Width in pixels</td>
</tr>
</tbody>
</table>

#### Returns

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>void</td>
<td></td>
</tr>
</tbody>
</table>
openFrameAPI.setWidth(100);

**openFrameAPI - setFrameMode(mode)**
Sets the OpenFrame mode.

The mode passed in this API:

- Sets the appropriate icon in the header: collapse or expand
- Raises the relevant event for CTI:
  - openFrameAPI.EVENTS.COLLAPSE
  - openFrameAPI.EVENTS.EXPAND

**Parameters**

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
</table>
| Mode   | String  | Set OpenFrame Mode. Enumerated options:  
  1. openFrameAPI.FRAME_MODE.COLLAPSE
  2. openFrameAPI.FRAME_MODE.EXPAND |

**Returns**

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>void</td>
<td></td>
</tr>
</tbody>
</table>

openFrameAPI.setFrameMode(openFrameAPI.FRAME_MODE.COLLAPSE);

**openFrameAPI - setPresenceIndicator(presence)**
Sets the presence indicator to display agent availability in a workspace.

For more information on configuring OpenFrame, refer to [Create an OpenFrame configuration](#)

**Parameters**

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
</table>
| state| String | Presence state of the agent. Default states:  
  - Available  
  - Away  
  - Offline  
  You can also specify custom states. |
<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>color</td>
<td>String</td>
<td>Presence indicator color on workspace. Supported colors: red, orange, grey, green</td>
</tr>
</tbody>
</table>

**Returns**

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>void</td>
<td></td>
</tr>
</tbody>
</table>

```javascript
openframeAPI.setPresenceIndicator('Available', 'green');
```

**openFrameAPI - openInteraction(interaction_sys_id)**

Supports the interaction tab.

In Agent Workspace, an interaction opens in a parent tab.

**Note:** In the platform interface, no action is performed.

**Parameters**

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>interaction_sys_id</td>
<td>String</td>
<td>Interaction to be opened as parent tab in Agent Workspace</td>
</tr>
</tbody>
</table>

```javascript
openFrameAPI.openInteraction('3be092313b711300758ce9b534efc4dd');
```

**CTI demo implementation**

Use the CTI demo implementation to test the phone communication channel between customer service agents and external customers in a non-production instance.

The CTI Softphone plugin enables softphone functions and call center capabilities. This plugin provides integration between the ServiceNow platform and the Twilio Voice service using the Notify application. This plugin can be activated any time after activating Notify.

The CTI Softphone plugin includes one OpenFrame configuration, called CTI. This configuration specifies the necessary OpenFrame window settings as well as the URL to be launched within OpenFrame.
### CTI demo installation and configuration

Before the phone communication channel between customer service agents and external customers can be used, the Notify, CTI Softphone, Customer Service Management, and Openframe plugins must be activated and configured, and a Twilio Voice account must be set up.

Role required: admin

1. **Activate the Notify plugin** (com.snc.notify).
2. Set up a Twilio Voice account.
   - You can create an account at [https://www.twilio.com](https://www.twilio.com).
3. **Configure Notify to use the Twilio Voice service**.
4. **Activate the CTI Softphone plugin** (com.snc.cti).
   - If you want to load the demo data for CTI Softphone, you must also activate the Customer Service CTI Demo Data plugin (com.snc.customerservice_cti_demo). This demo data includes sample workflows.
5. **Activate the Customer Service plugin** (com.sn_customerservice).
6. Activate the Openframe plugin (com.sn_openframe).
   - Activating the Customer Service Management plugin automatically activates the Openframe plugin.
7. Create an [OpenFrame configuration](https://[your_openframe_url]) or use the default CTI configuration by enabling the Default field.

### Answer an incoming call

Use the OpenFrame window to answer an incoming call.

Role required: sn_customerservice_agent, sn_customerservice.consumer_agent, sn_open_frame, or admin

The OpenFrame window displays the incoming call, including the phone number and the customer contact or consumer information.

1. Click **Accept**.
2. When the call is finished, click **End**.

### Make an outgoing call

Use the OpenFrame window to make an outgoing call.

Role required: sn_customerservice_agent, sn_customerservice.consumer_agent, sn_open_frame, or admin

1. Do one of the following:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Click the phone icon in the banner frame.</td>
<td>Enter the phone number in the <strong>Number</strong> field and click <strong>Call</strong>.</td>
</tr>
</tbody>
</table>
Click the phone icon next to the Contact or Consumer fields on the Case form.

Customer contacts and consumers can have multiple phone numbers.
- If only one phone field is populated, a call is placed to that number.
- If more than one phone field is populated, a dialog box displays the available numbers. Click the desired number to place the call and close the dialog box.

2. When finished with the call, click End.

Transfer a call
After accepting an incoming call, a customer service agent can transfer a call to another agent.
Role required: sn_customerservice_agent, sn_customerservice.consumer_agent, sn_open_frame, or admin
1. Answer an incoming call.
2. Click Transfer.
3. Select an agent from the drop-down list.
4. Click Call.

Set agent call status
Customer service agents can set their current call status.
Role required: sn_customerservice_agent, sn_customerservice.consumer_agent, sn_open_frame, or admin
1. Click the phone icon in the banner frame.
2. Select your availability.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Available</td>
<td>The agent is available to take a call.</td>
</tr>
<tr>
<td>Not Available</td>
<td>The agent is not available to take a call.</td>
</tr>
<tr>
<td>Busy</td>
<td>The agent is currently on a call with a customer.</td>
</tr>
<tr>
<td>Wrap Up</td>
<td>The agent is updating case information after completing a call.</td>
</tr>
<tr>
<td></td>
<td>After completing a call and the subsequent wrap up, an agent must manually change the status from Wrap Up to Available.</td>
</tr>
</tbody>
</table>

The Presence field in the OpenFrame > OpenFrame Agent Presence record is updated with the availability status set for the agent.

Computer Telephony demo integration with the Case form
Activating the CTI Softphone plugin enables call-related features on the Case form.
The customer service or consumer service agent can use the phone icon next to the Contact and Consumer fields on the Case form to make a phone call. The phone icon appears next to these fields if the entity record has at least one phone field (ph_number) and at least one of those phone fields contains a phone number.
The phone icon is a reference contribution that can be added to any reference field by modifying the dictionary and adding the following attribute: `ref_contributions=show_phone_customer_service`.

**Note:** If you are using a third-party provided CTI application, then you can integrate with the `show_phone` UI macro to make calls. For more information on UI macros, refer to [UI macros installed with OpenFrame](#).

Click the phone icon to place a call to a consumer or a contact.

- If only one phone field is populated, a call is placed to that number.
- If more than one phone field is populated, a dialog box displays the available numbers. Click the desired number to place the call and close the dialog box.

![Select Phone Number dialog box](image)

Incoming and outgoing calls are logged in the Phone Log (`sn_openframe_phone_log`) table. Call details are recorded in the **Activity** field on the Case form and in the **Phone** related list.

**CTI demo integration with case routing**

An incoming call from a customer contact or a consumer can be routed to an available customer service agent.

Similar to the other communication channels, incoming calls from customer contacts and consumers can be routed to a specific agent by using matching rules. If an agent is not available, the call can be placed in a queue. After the agent is free, the matching call in the queue with the longest wait time is rerouted to the agent.

Case routing is enabled as an activity in a workflow. In the Call Center demo workflow (available with the Customer Service CTI Demo Data plugin), a call is forwarded to an agent after the caller either creates a new case or enters a valid number for an existing case.

If no agents are available, the call goes into a queue and remains there until an agent becomes available. If a call is in the queue for longer than 10 minutes, it is forwarded to voice mail and the caller is asked to leave a message.

**Computer Telephone demo integration with tasks**

The CTI Softphone component can be integrated with other task entities on the Now Platform. A workflow can be implemented to operate on the Incident table.

**Note:** The Call Center for Incident Management workflow, a demo workflow, is available with the Customer Service CTI Demo Data plugin.

Incoming or outgoing calls are logged in the Phone Log (`sn_openframe_phone_log`) table. The call logs also appear in the activity history of the task.

**Associate a phone number with a workflow**

You can associate a Notify phone number with a workflow.

You must create a Twilio Voice account and configure Notify with Twilio Voice before you can associate a phone number with a number group and workflow.
A number group allows you to group Notify phone numbers and then share workflows across grouped numbers. For each number group, you can specify a workflow for incoming and outgoing calls.

The CTI Softphone demo data includes these sample workflows:

- Call Center, for use with the Customer Service Management application
- Call Center for Incident Management

The Call Center workflow uses several Notify workflow activities that determine workflow functionality. Each activity performs a different task, such as playing a message greeting or creating a list of user input options. Activities can succeed or fail, which can result in actions performed by other activities.

You can use the default Call Center workflow or modify this workflow as needed.

Role required: admin

1. Navigate to Notify > Numbers.
2. From the Notify Phone Numbers list, click the phone number that you want to edit.
3. Select a Notify Group that uses the incoming call workflow that you want to handle this phone number.
   The CTIDemo group uses the Call Center workflow for incoming calls.
4. Click Update.

Communities

With the ServiceNow® Communities application, connect, engage, and collaborate with your employees, customers, partners, and prospects. Your users get quick responses to their issues by posting questions, reviewing blogs or videos, and searching for previous discussions. It is an essential component of your self-service strategy along with Knowledge Base and Service Catalog.

**Explore**

- Communities roles
- Community content types
- Configure community forums
- Forum and user permissions management
- Community subscriptions
- Gamification
- Domain separation in Communities

**Set up**

- Activate Communities plugins
- Properties installed with Communities
- Community setup guide for admins

**Administer**

- Create a forum
- Create a forum user
- Create a forum permission
- Invite users to become members of a forum
- Configure the community profile
- Enable users to self-register to a community
- Enable knowledge harvesting
- View the Communities performance dashboard
- Make an announcement to community members
- Moderate a community
- Administer gamification

**Use**

- Community homepage features for logged in users

**Develop**

- Developer training
- Developer documentation

**Troubleshoot and get help**

- Search the Hi Knowledge Base for known error articles
Activate Communities plugins

Activate the Customer Communities plugin to use the Communities application.

Role required: sn_communities.admin

Communities is available for customers who are:
- Licensed for the Customer Service Management application.
- Licensed for HR Service Delivery.

To activate Communities, activate the Customer Communities plugin (com.sn_customer_communities). This plugin is not active by default.

When you activate the Customer Communities plugin, the following plugins automatically activate:
- External User Registration plugin (com.sn_external_user_register)
- Communities plugin (com.sn_communities)
- Gamification plugin (com.snc.gamification)
- Subscriptions and Activity Feed Framework plugin (com.snc.activity_subscriptions)

To activate Communities demo data, activate the Communities Demo Data plugin (com.sn_communities_demo).

To activate the Communities dashboard, activate the Performance Analytics — Content Pack — Communities plugin (com.snc.pa.communities).

1. Navigate to System Definition > Plugins.
2. Search for the plugin com.sn_communities.
3. Click Activate.
Properties installed with Communities

Community administrators can use properties to configure Communities behavior.

The following properties are available for further configuration. To list the properties, enter
sys_properties.list in the filter navigator and search for the property to configure.

**Note:** You can also view Community Properties and Forum Properties from the application
navigator. These modules contain a list of the most frequently used properties that you can
configure for your community.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_communities.adminNoReplyEmail</td>
<td>Email address for community-related notifications. When a notification for an activity is sent, this email address is displayed.</td>
</tr>
<tr>
<td></td>
<td>• Type: string</td>
</tr>
<tr>
<td></td>
<td>• Default value: <a href="mailto:communityadmin@servicenow.com">communityadmin@servicenow.com</a></td>
</tr>
<tr>
<td>sn_communities.blog_count</td>
<td>Number of blogs that a user can post per day.</td>
</tr>
<tr>
<td></td>
<td>• Type: integer</td>
</tr>
<tr>
<td></td>
<td>• Default value: 20</td>
</tr>
<tr>
<td>sn_communities.content.meta_description</td>
<td>When generating SEO data for an entity, the number of characters that are fetched from the meta_description column of the record to generate a portion of the SEO &lt;description&gt; tag for the record.</td>
</tr>
<tr>
<td></td>
<td>Typically, the SEO &lt;description&gt; tag for a Community entity is the combination of ‘forum name’, ‘topics’ and ‘meta description’ of the actual record in the following format: “&lt;forum&gt; - &lt;topics&gt; - &lt;sub string of configured length of the actual description&gt;”.</td>
</tr>
<tr>
<td></td>
<td>• Type: integer</td>
</tr>
<tr>
<td></td>
<td>• Default value: 100</td>
</tr>
<tr>
<td>sn_communities.content.views.count.limit</td>
<td>Number of views for content pages allowed per session within a time window specified by sn_communities.content.views.time.limit.</td>
</tr>
<tr>
<td></td>
<td>• Type: integer</td>
</tr>
<tr>
<td></td>
<td>• Default value: 50</td>
</tr>
<tr>
<td>sn_communities.content.views.time.limit</td>
<td>Duration, in seconds, during which a specific number of views are allowed. The number of views allowed during this time is set by sn_communities.content.views.count.limit</td>
</tr>
<tr>
<td></td>
<td>• Type: integer</td>
</tr>
<tr>
<td></td>
<td>• Default value: 3600</td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
</tr>
<tr>
<td>----------</td>
<td>-------------</td>
</tr>
<tr>
<td>sn_communities.disable_terms_conditions_role</td>
<td>Comma-separated list of roles that bypass the terms and conditions and profile name request.</td>
</tr>
</tbody>
</table>
| sn_communities.edit_content_explicit_role | Comma-separated list of roles with permission to edit existing content, but not to create content.  
  - Type: string  
  - Default value:  
    n_communities.community_moderator,  
    sn_communities.moderation_admin,  
    sn_communities.admin |
| sn_communities.enable_session_cache | Enables or disables session caching.  
  True: The permissions of any non-admin users of the community are stored as a part of the session. They are used to determine access to the various forums and community content. While the user is active in that particular session, any changes to the community permissions do not take effect until the user logs out.  
  False: The permissions of any non-admin users of the community are not stored as a part of the session.  
  - Type: boolean  
  - Default value: false |
| sn_communities.enable_topics | Enables or disables topics within a community. If the property is set to false and gamification is enabled, topic information does not appear on the leaderboard page.  
  - Type: true |false  
  - Default value: true |
| sn_communities.enable_user_mentions | Enables or disables the user-mentions functionality in Communities content. |
| sn_communities.glide.script.block.client.globals | Set the value to true to re-enable most of the inaccessible Client APIs in a scoped application.  
  - Type: boolean  
  - Default value: false |
<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
</table>
| sn_communities.implicit_access_mapping | Assign access implicitly to users based on the permissions they have. For example:  
- If a user is given forum_admin access, they can automatically administer, read, write to, and moderate the forum.  
- If a user is given forum moderation rights, they can read, write to, and moderate the forum for all content types.  
  - Type: string  
  - Default value: \{"forum_admin": ["forum_read", "forum_write", "forum_moderator", "forum_admin", "content_write"], "forum_moderator": ["forum_read", "forum_write", "forum_moderator", "content_write"], "content_write": ["content_read", "content_write"]} |
| sn_communities.instance_base_url | Vanity URL for your instance to be used in email notifications to redirect users to the community pages. Set a value only if you want the URL to be different to the instance name.  
  - Type: string  
  - Default value: none |
| sn_communities.is_content_write_allowed_for_guest_user | Determines whether Content_write access is allowed for a public or a guest user.  
False: Content_write access is not given to a public or guest user.  
True: Content_write access is given to a public or guest user.  
  - Type: boolean  
  - Default value: false |
| sn_communities.knowledge_base_id | All questions created in Communities are entered in this knowledge base.  
  - Type: string  
  - Default value: a4c9fb2e6703220071b89a6615af9 |
| sn_communities.logging.destination | Location of the log messages.  
  - Type: string  
  - Default value: db |
<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_communities.log.verbosity</td>
<td>Code Search log verbosity for the community. Set the value as required.</td>
</tr>
<tr>
<td></td>
<td>• 0: Show information that may be useful while debugging the application, such as the values of queries run. It includes info, warning, and error messages.</td>
</tr>
<tr>
<td></td>
<td>• 1: Show progress messages as the Code Search application searches for results. It also shows warnings and error messages.</td>
</tr>
<tr>
<td></td>
<td>• 2: Show warning which indicates possible unexpected changes in behavior.</td>
</tr>
<tr>
<td></td>
<td>• 3: Show only critical errors which may prevent the search from completing.</td>
</tr>
<tr>
<td></td>
<td>• Type: choice list</td>
</tr>
<tr>
<td></td>
<td>• Default value: 1</td>
</tr>
<tr>
<td>sn_communities.logging.verbosity</td>
<td>Category for writing log messages: Debug (0), Info (1), Warning (2), or Error (3).</td>
</tr>
<tr>
<td></td>
<td>• Type: choice list</td>
</tr>
<tr>
<td></td>
<td>• Default value: 1</td>
</tr>
<tr>
<td>sn_communities.max_topic_limit</td>
<td>Maximum number of topics that can be associated to any content type. The value of this property should not be set to greater than five.</td>
</tr>
<tr>
<td></td>
<td>• Type: integer</td>
</tr>
<tr>
<td></td>
<td>• Default value: 5</td>
</tr>
<tr>
<td>sn_communities.minimum_activity</td>
<td>Minimum number of activities required to make the activity feed the preferred feed.</td>
</tr>
<tr>
<td></td>
<td>• Type: integer</td>
</tr>
<tr>
<td></td>
<td>• Default value: 5</td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>sn_communities.portal_default_config</td>
<td>Community portal default configuration. Used in community-specific widgets. It is a JSON value.</td>
</tr>
<tr>
<td></td>
<td>- Type: string</td>
</tr>
<tr>
<td></td>
<td>- Default value: (&quot;uiPageMapping&quot;: [&quot;contentTypeld&quot;:&quot;5a2fcaa0dbd26600b16f78eaf9d19a8&quot;,&quot;icon&quot;:&quot;question-circle&quot;,&quot;internalName&quot;:&quot;question&quot;,&quot;contentArticle&quot;:&quot;a&quot;,&quot;pageId&quot;:&quot;&quot;]; &quot;contentTypeld&quot;:&quot;57f785863b220085f76b4ee3efc449&quot;,&quot;icon&quot;:&quot;video-camera&quot;,&quot;internalName&quot;:&quot;video&quot;,&quot;contentArticle&quot;:&quot;a&quot;,&quot;pageId&quot;:&quot;&quot;]; &quot;contentTypeld&quot;:&quot;cc3fcaa0dbd26600b16f78eaf9d192e&quot;,&quot;icon&quot;:&quot;quote-left&quot;,&quot;internalName&quot;:&quot;blog&quot;,&quot;contentArticle&quot;:&quot;a&quot;,&quot;pageId&quot;:&quot;&quot;]; &quot;contentTypeld&quot;:&quot;0764c981dbde6600b16f78eaf9d1990&quot;,&quot;icon&quot;:null,&quot;contentTypeld&quot;:&quot;8f0a215c6707220071b89a6617415aa7&quot;,&quot;icon&quot;:&quot;question-circle&quot;,&quot;internalName&quot;:&quot;answer&quot;,&quot;contentArticle&quot;:&quot;an&quot;,&quot;pageId&quot;:&quot;&quot;]; &quot;contentTypeld&quot;:&quot;3f86a8db97123200797a23363ac4a27&quot;,&quot;icon&quot;:&quot;file-text&quot;,&quot;internalName&quot;:&quot;document&quot;,&quot;contentArticle&quot;:&quot;a&quot;,&quot;pageId&quot;:&quot;&quot;]; &quot;contentTypeld&quot;:&quot;4c3a995ac30232002e45cb98d3ae0&quot;,&quot;icon&quot;:&quot;calendar&quot;,&quot;internalName&quot;:&quot;event&quot;,&quot;contentArticle&quot;:&quot;a&quot;,&quot;pageId&quot;:&quot;&quot;];</td>
</tr>
<tr>
<td>sn_communities.public_forum_user</td>
<td>sys_id of the public forum user. Used to calculate access permissions to forums.</td>
</tr>
<tr>
<td></td>
<td>- Type: string</td>
</tr>
<tr>
<td></td>
<td>- Default value: 88ef215593222005b963511e57fba6</td>
</tr>
<tr>
<td>sn_communities.registered_forum_user</td>
<td>sys_id of the registered forum user. This value is used to calculate access permissions to forums.</td>
</tr>
<tr>
<td></td>
<td>- Type: string</td>
</tr>
<tr>
<td></td>
<td>- Default value: 5dce99693232200d773511e57fbbcc</td>
</tr>
<tr>
<td>sn_communities.video_count</td>
<td>Number of videos a user can post per day.</td>
</tr>
<tr>
<td></td>
<td>- Type: integer</td>
</tr>
<tr>
<td></td>
<td>- Default value: 20</td>
</tr>
<tr>
<td>sn_communities.default_permission_for_forum_members</td>
<td>Sets the default permission for forum memberships. Specify a value to determine which permission is used as the default.</td>
</tr>
<tr>
<td></td>
<td>- Type: string</td>
</tr>
<tr>
<td></td>
<td>- Default value: ff73ee9893232200a8223511e57fbb0b</td>
</tr>
<tr>
<td>sn_communities.forumListBatchSize</td>
<td>Default number of forums to show on the topics list page on the community portal.</td>
</tr>
<tr>
<td></td>
<td>- Type: integer</td>
</tr>
<tr>
<td></td>
<td>- Default value: 12</td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>sn_communities.topicListBatchSize</td>
<td>Default number of topics to show on the topics list page on the community portal.</td>
</tr>
<tr>
<td></td>
<td>• Type: integer</td>
</tr>
<tr>
<td></td>
<td>• Default value: 12</td>
</tr>
<tr>
<td>sn_communities.disableForumInvitesForExternalEmails</td>
<td>Determines if forum invites from the forum page can be sent to external users.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Do not change this value manually because it may affect forum email invite functionality.</td>
</tr>
<tr>
<td></td>
<td>• Type: boolean</td>
</tr>
<tr>
<td></td>
<td>• Default value: true</td>
</tr>
<tr>
<td>sn_communities.attachments.document.max_size</td>
<td>Maximum attachment file size in MB. (1 MB = 1024 KB)</td>
</tr>
<tr>
<td></td>
<td>• string</td>
</tr>
<tr>
<td></td>
<td>• Default value: 5</td>
</tr>
<tr>
<td>sn_communities.attachments.file_extensions</td>
<td>Supported file extensions for community attachments.</td>
</tr>
<tr>
<td></td>
<td>• Type: string</td>
</tr>
<tr>
<td></td>
<td>• Default value: PPT,PPTX,XLS,XLSX,DOC,DOCX,TXT,PDF, PNG,BMP,JPG,JPEG,GIF</td>
</tr>
<tr>
<td>sn_communities.attachments.max_attachment_count</td>
<td>Maximum number of attachments that can be attached to community content.</td>
</tr>
<tr>
<td></td>
<td>• Type: string</td>
</tr>
<tr>
<td></td>
<td>• Default value: 3</td>
</tr>
<tr>
<td>sn_communities.attachments.max_file_size</td>
<td>Maximum attachment file size in MB. The maximum size is capped at 5 MB.</td>
</tr>
<tr>
<td></td>
<td>• Type: string</td>
</tr>
<tr>
<td></td>
<td>• Default value: 2</td>
</tr>
<tr>
<td>sn_communities.attachments.max_invalid_attempts</td>
<td>Maximum number of invalid attempts a user can make to upload an attachment.</td>
</tr>
<tr>
<td></td>
<td>• Type: string</td>
</tr>
<tr>
<td></td>
<td>• Default value: 3</td>
</tr>
<tr>
<td>sn_communities.attachments.max_total_size</td>
<td>Maximum total size (in GB) of attachments. (1 GB = 1024 MB)</td>
</tr>
<tr>
<td></td>
<td>• Type: string</td>
</tr>
<tr>
<td></td>
<td>• Default value: 500</td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
</tr>
<tr>
<td>----------</td>
<td>-------------</td>
</tr>
</tbody>
</table>
| sn_communities.attachments.total_size | Total size (in KB) of attachments in the community until date. (1 MB = 1024 KB, 1 GB = 1024 MB)  
  - Type: string  
  - Default value: 3680.04 |
| sn_communities.attachments.user.day_limit | Maximum number of attachments that can be attached to community content per user per day.  
  - Type: string  
  - Default value: 20 |
| sn_communities.days_to_keep_search_logs | Sets the number of days to keep the search log on an instance.  
  - Type: integer  
  - Default value: 180 |
| sn_communities.minimum_characters_to_search | Number of characters before a search engine starts working in a community. This number must be greater than or equal to 3.  
  - Type: integer  
  - Default value: 3 |
| sn_communities.search.blog.enable_acl | Sets how permissions are evaluated for blog type content.  
  True: Permission is evaluated for that specific content type and user.  
  False: Permission is evaluated at the forum and content level.  
  - Type: boolean  
  - Default value: false |
| sn_communities.search.discussion.enable_acl | Sets how permissions are evaluated for question and answer type content.  
  True: Permission is evaluated for that specific content type and user.  
  False: Permission is evaluated at forum and content level.  
  - Type: boolean  
  - Default value: false |
| sn_communities.search.document.enable_acl | Sets how permissions are evaluated for document type content.  
  True: Permission is evaluated for that specific content type and user.  
  False: Permission is evaluated at the forum and content level.  
  - Type: boolean  
  - Default value: false |
<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_communities.search.event.enable_acl</td>
<td>Sets how permissions are evaluated for event type content.</td>
</tr>
<tr>
<td></td>
<td>True: Permission is evaluated for that specific content type and user.</td>
</tr>
<tr>
<td></td>
<td>False: Permission is evaluated at the forum and content level.</td>
</tr>
<tr>
<td></td>
<td>• Type: boolean</td>
</tr>
<tr>
<td></td>
<td>• Default value: false</td>
</tr>
<tr>
<td>sn_communities.search.video.enable_acl</td>
<td>Sets how permissions are evaluated for video type content.</td>
</tr>
<tr>
<td></td>
<td>True: Permission is evaluated for that specific content type and user.</td>
</tr>
<tr>
<td></td>
<td>False: Permission is evaluated at the forum and content level.</td>
</tr>
<tr>
<td></td>
<td>• Type: boolean</td>
</tr>
<tr>
<td></td>
<td>• Default value: false</td>
</tr>
<tr>
<td>sn_communities.user.document_count</td>
<td>Number of documents a user can post per day.</td>
</tr>
<tr>
<td></td>
<td>• Type: integer</td>
</tr>
<tr>
<td></td>
<td>• Default value: 20</td>
</tr>
<tr>
<td>sn_communities.video_count</td>
<td>Number of videos a user can post per day.</td>
</tr>
<tr>
<td></td>
<td>• Type: integer</td>
</tr>
<tr>
<td></td>
<td>• Default value: 20</td>
</tr>
<tr>
<td>sn_communities.view_log_sources</td>
<td>JSON string that provides a mapping of view log source to a static source type. This static string stores the view source in the View Log (sn_communities_view_log) table.</td>
</tr>
<tr>
<td></td>
<td>• Type: string</td>
</tr>
<tr>
<td></td>
<td>• Default value:</td>
</tr>
<tr>
<td></td>
<td>{&quot;searchResult&quot;: &quot;search_result&quot;, &quot;contentFeed&quot;: &quot;content_feed&quot;, &quot;activityFeed&quot;: &quot;activity_feed&quot;}</td>
</tr>
<tr>
<td>sn_communities.knowledge.enable_harvesting</td>
<td>Enables knowledge harvesting from communities.</td>
</tr>
<tr>
<td></td>
<td>• Type: string</td>
</tr>
<tr>
<td></td>
<td>• Default value: true</td>
</tr>
</tbody>
</table>

**Activity Subscription properties**

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>com.snc.actsub.activities.api.fetch.limit</td>
<td>Number of activities in the activity feed.</td>
</tr>
<tr>
<td></td>
<td>• Type: integer</td>
</tr>
<tr>
<td></td>
<td>• Default value: 10</td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
</tr>
<tr>
<td>----------</td>
<td>-------------</td>
</tr>
</tbody>
</table>
| com.snc.actsub.activity.rate.count.limit | Number of activities that can be created within a certain time frame.  
- Type: integer  
- Default value: 100 |
| com.snc.actsub.activity.rate.time.limit | Duration, in seconds, during which activities can be created. Activities are no longer created after the limit.  
- Type: integer  
- Default value: 3600 |
| com.snc.actsub.activity.stream.user.limit | Enter the limit on number of activities stored for a user in the activity feed. The oldest activities are deleted when the limit is reached.  
- Type: integer  
- Default value: 2000 |
| com.snc.actsub.core.disable_plugin | Enable (true) or disable (false) the plugin functionality.  
- Type: boolean  
- Default value: false |

**External User Registration properties**

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
</table>
| sn_ext_usr_reg.allowed_email_domains | Comma-separated list of email domains that can be used to register. By default, the value is empty, indicating that all email domains are allowed.  
- Type: string  
- Default value: none |
| sn_ext_usr_reg.captchaEnabled | Enables Google re-CAPTCHA on the self-registration page.  
- Type: boolean  
- Default value: true |
| sn_ext_usr_reg.eur_user_role | Adds a role when a sys_user record is created through self-registration.  
- Type: string  
- Default value: sn_communities.community_user |
### ServiceNow | New York | Customer Service Management

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>sn_ext_usr_reg.Reg_link_expiration_days</code></td>
<td>Number of days that the registration link remains active. Links older than the specified number of days are deactivated and cannot be used for completing the registration process.</td>
</tr>
<tr>
<td></td>
<td>• Type: integer</td>
</tr>
<tr>
<td></td>
<td>• Default value: 3</td>
</tr>
<tr>
<td><code>sn_ext_usr_reg.request_count</code></td>
<td>Maximum number of times a registration link can be requested.</td>
</tr>
<tr>
<td></td>
<td>• Type: integer</td>
</tr>
<tr>
<td></td>
<td>• Default value: 3</td>
</tr>
<tr>
<td><code>sn_ext_usr_reg.Temp_user_record_purge_days</code></td>
<td>Number of days that a registration record is maintained in the User Registration Request (user_registration_request) table. Records older than the specified number of days are deleted.</td>
</tr>
<tr>
<td></td>
<td>• Type: integer</td>
</tr>
<tr>
<td></td>
<td>• Default value: 3</td>
</tr>
</tbody>
</table>

#### Gamification properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>sn_communities.enable_gamification</code></td>
<td>Enables or disables the gamification feature for the community and controls the appearance of gamification-related widgets on the Community portal.</td>
</tr>
<tr>
<td></td>
<td>• When set to false, no gamification components are displayed. User point totals and badge assignments are not affected.</td>
</tr>
<tr>
<td></td>
<td>• Type: boolean</td>
</tr>
<tr>
<td></td>
<td>• Default value: true</td>
</tr>
<tr>
<td><code>sn_communities.content.show_gamification_level</code></td>
<td>Controls the gamification level that is displayed next to the Community user's name on the Content pages.</td>
</tr>
<tr>
<td></td>
<td>• Type: choice list</td>
</tr>
<tr>
<td></td>
<td>• Choices:</td>
</tr>
<tr>
<td></td>
<td>• <code>none</code>: Do not display the user's level</td>
</tr>
<tr>
<td></td>
<td>• <code>sn_gamification_modules</code>: Show the user's level in the Community</td>
</tr>
<tr>
<td></td>
<td>• <code>sn_communities_forum</code>: Show the user's level for the forum to which the content belongs</td>
</tr>
<tr>
<td></td>
<td>• Default value: <code>sn_gamification_modules</code></td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>sn_gamification.days_to_keep_activity_records</td>
<td>Number of days to keep the gamification activity records in the database. Records created or updated prior to the specified number of days are purged.</td>
</tr>
<tr>
<td></td>
<td>• Type: integer</td>
</tr>
<tr>
<td></td>
<td>• Default value: 180</td>
</tr>
<tr>
<td>sn_gamification.enable_debug_logs</td>
<td>Enables the debug logs for the gamification feature.</td>
</tr>
<tr>
<td></td>
<td>• Type: boolean</td>
</tr>
<tr>
<td></td>
<td>• Default value: false</td>
</tr>
<tr>
<td>sn_gamification.levels_limit</td>
<td>Maximum number of levels that can be defined for the gamification feature.</td>
</tr>
<tr>
<td></td>
<td>• Type: integer</td>
</tr>
<tr>
<td></td>
<td>• Default value: 10</td>
</tr>
</tbody>
</table>

Questions to case properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn.communities.enable_csm_case_creation_from_question</td>
<td>This property provides access to the “Create Case” option on the Community Question widget and the “Question to Case” option on the Community header drop-down menu.</td>
</tr>
<tr>
<td></td>
<td>• Type: true</td>
</tr>
<tr>
<td></td>
<td>• Default value: true</td>
</tr>
</tbody>
</table>

Communities roles

Ensure that users can perform all necessary actions by assigning roles.

Roles

<table>
<thead>
<tr>
<th>Role</th>
<th>Description</th>
<th>Access via</th>
</tr>
</thead>
<tbody>
<tr>
<td>Community administrator (sn_communities.admin)</td>
<td>Administer and manage all sections in the community.</td>
<td>• Platform UI</td>
</tr>
<tr>
<td>Community moderator (sn_communities.community_moderator)</td>
<td>Moderate content associated with the community.</td>
<td>• Platform UI</td>
</tr>
<tr>
<td>Forum administrator (sn_communities.forum_admin)</td>
<td>Administer and manage forum permissions content types, and topics associated to the forum.</td>
<td>• Platform UI</td>
</tr>
<tr>
<td>Forum moderator (sn_communities.forum_moderator)</td>
<td>Moderate content within specified forums.</td>
<td>• Platform UI</td>
</tr>
<tr>
<td>Role</td>
<td>Description</td>
<td>Access via</td>
</tr>
<tr>
<td>--------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Moderation administrator</td>
<td>Administer moderation settings and moderate content associated forums.</td>
<td>Platform UI</td>
</tr>
<tr>
<td>(sn_communities.moderation_admin)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Gamification administrator</td>
<td>Administer gamification settings and configure gamification rules. Contains the sn_gamification.moderator role.</td>
<td>Platform UI</td>
</tr>
<tr>
<td>(sn_gamification.admin)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Gamification moderator</td>
<td>Review and edit the gamification points earned by community users.</td>
<td>Platform UI</td>
</tr>
<tr>
<td>(sn_gamification.moderator)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Community user</td>
<td>Any user who has signed up and accepted the community Terms &amp; Conditions. Their access to forums depends on the permissions set up for each specific forum.</td>
<td>Communities Portal</td>
</tr>
<tr>
<td>(sn_communities.community_user)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Knowledge harvester</td>
<td>A community user who can harvest knowledge articles from a community. Community administrators, and community moderators inherit this role by default. The knowledge harvester role must be granted to other users.</td>
<td>Communities Portal</td>
</tr>
<tr>
<td>(sn_communities.knowledge_harvester)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Proxy case creator</td>
<td>A community user who can create a customer service case from a community discussion.</td>
<td>Communities Portal</td>
</tr>
<tr>
<td>(sn_customerservice.proxy_case_creator)</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Community setup guide for admins**

Define your requirements with community and forum stakeholders and set up your forums for community users to start creating content.

**Requirements**

Role required: sn_communities.admin or sn_communities.forum_admin

**Before you begin**

**Meet with the stakeholders**

<table>
<thead>
<tr>
<th>Stakeholder</th>
<th>Responsibilities</th>
</tr>
</thead>
<tbody>
<tr>
<td>Forum administrators</td>
<td>Define and oversee the forum processes for day-to-day operations related to topic creation, user management, and moderation.</td>
</tr>
<tr>
<td>Community administrators</td>
<td>Configure advanced settings for Communities features.</td>
</tr>
</tbody>
</table>
With stakeholders, determine your community requirements

- Who are the consumers of the community content?
- Which content types can users contribute?
- Who can contribute content and who should have read-only access?
- What should the names of the initial forums be?
- Within these forums, what should the names of the initial topics be?
- Which keywords should be banned?
- How should the system moderate content and users?
- What should the default notifications that users receive for various community activities be?

What to do

Use the following steps as guidance to setting up your community.

1. Create a forum user
   *Create a forum user* to use to define memberships to a forum.

2. Create a permission
   *Create a permission* to use to define a user’s access to a forum and its content types.

3. Add access and content types to your permission
   *Add access types to a permission* to determine the access that users have to certain forums and content.

4. Create a forum
   *Create a forum* to provide a place for users to share content and configure the forum to allow registered users to request access to join.

5. Configure content types for a forum
   *Configure content types for a forum* to define which types of content to use in a particular forum.

6. Create a forum permission
   *Create a forum permission* by adding a forum user and a permission to a forum.

If required, perform the following actions:

- Invite users to join the forum
  *Invite users to become members of a forum* to encourage greater community involvement.

- Create permission exceptions
  *Create a permission exception* for users who require specific permissions for a forum.

- Copy permissions
  *Copy permissions from a forum* to copy all permissions and content types from one forum to another.
• **Copy permissions from a parent forum.**

**Debug user permissions**

*Debug user permissions* to investigate and diagnose problems with user access to forums.

**Next steps**

*Create a topic* for users to create and share content.

*Add a topic to a forum* so that users can associate content to that topic.

*Moderate a community* to set up how the system moderates content and users.

**Using guided setup to implement Communities**

Communities guided setup provides a sequence of tasks that help you configure Communities on your ServiceNow instance. To open Communities guided setup, navigate to **Community > Administration > Guided Setup**.

For more information about using the guided setup interface, see *Using guided setup*.

**Domain separation in Communities**

This is an overview of domain separation in Communities. Domain separation enables you to separate data, processes, and administrative tasks into logical groupings called domains. You can then control several aspects of this separation, including which users can see and access data.

**Overview**

**Support: Data only**

Domain separation in this application is supported at the **Data only** level, meaning it supports the data security model of separating visibility of data from one domain to another. To learn more, see *Application support for domain separation*.

**Quick start tests for Communities**

Validate that Communities still work after you make any configuration change such as apply an upgrade or develop an application. Copy and customize these quick start tests to pass when using your instance-specific data.

Communities quick start tests require activating the Customer Communities plugin (com.sn_customer_communities) and the Communities Demo Data plugin (com.sn_communities_demo).

<table>
<thead>
<tr>
<th>Test</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Post question and validate feed</td>
<td>Verify that a question is posted in the community and validate whether it appears in the content feed.</td>
</tr>
<tr>
<td>Post video</td>
<td>Verify that a video is posted in the community.</td>
</tr>
<tr>
<td>Test</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Forum membership approval</td>
<td>Verify that a membership request to a forum is approved.</td>
</tr>
<tr>
<td>Forum membership reject</td>
<td>Verify that a membership request to a forum is rejected.</td>
</tr>
<tr>
<td>Approve a moderation task</td>
<td>Verify that a moderation task is approved.</td>
</tr>
<tr>
<td>Reject a moderation task</td>
<td>Verify that a moderation task is rejected.</td>
</tr>
<tr>
<td>Topic subscription and activity feed validation</td>
<td>Verify that a topic is subscribed to and the topic activities appear in the activity feed.</td>
</tr>
<tr>
<td>Approve content approval workflow task on question</td>
<td>Verify the content approval workflow of a question.</td>
</tr>
<tr>
<td>Question auto-subscription and activity feed validation</td>
<td>Verify that the author is automatically subscribed to the question and the question activities appear in the activity feed.</td>
</tr>
<tr>
<td>Follow a user</td>
<td>Verify that a community user is able to follow another community user.</td>
</tr>
<tr>
<td>Reject content approval workflow task on question</td>
<td>Verify the content approval workflow of a question when content is rejected.</td>
</tr>
<tr>
<td>Gamification on video posting</td>
<td>Verify the gamification points gained when posting a video.</td>
</tr>
<tr>
<td>Forum subscription and activity feed validation</td>
<td>Verify that a forum is subscribed to and the forum activities appear in the activity feed.</td>
</tr>
<tr>
<td>Question subscription and activity feed validation</td>
<td>Verify that a question is subscribed to and the question activities appear in the activity feed.</td>
</tr>
</tbody>
</table>

**Configure a community**

You can configure various aspects of Communities based on the specific requirements of your organization.

Role required: sn_communities.admin or sn_communities.forum_admin

Access the Community menus and use the modules to configure your community.

1. Navigate to Community and choose the menu and module you require.
2. Configure one or more of the following aspects for your community.

**Community content types**

There are seven supported content types: Answer, Blog, Comment, Document, Event, Question, and Video.

Community administrators and forum administrators can configure content types at the community and forum levels.

User access to content is based on the permissions that users have. Community users can add content to the different content types and provide feedback on the content.
### Content types

<table>
<thead>
<tr>
<th>Content type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Question</td>
<td>Post a question about an issue or a challenge and get answers from other users. You can submit your question on the Community homepage and choose a forum or a topic to post it in. A question can be tagged to more than one topic.</td>
</tr>
<tr>
<td>Answer</td>
<td>Reply to a user question or another answer with a possible solution or statement.</td>
</tr>
<tr>
<td>Blog</td>
<td>Post a blog on a topic of interest to share with other users. You can include images and videos.</td>
</tr>
<tr>
<td>Comment</td>
<td>Enter a comment to express an opinion or to react to a video or a blog.</td>
</tr>
</tbody>
</table>
| Video        | Upload a video on a topic of interest for other users. Videos appear as web URLs that link to the most popular video sites. Communities supports playback from:  
  - YouTube – youtube.com  
  - Vimeo – vimeo.com  
  - DailyMotion – dailymotion.com  
  - Facebook – facebook.com  
|              | **Note:** Videos can be included in other types of content, including questions, answers, blogs, and comments. |
| Document     | Post a document to share with other community members. You can post your document from within a forum, choose a topic to post it in, and tag it to more than one topic. |
| Event        | Create an event that other community users can register for and attend. |

### Configure community content types

Configure content types, such as videos and blogs, for the community.

**Role required:** sn_communities.admin

You can configure content types at both the community and forum level. At the community level, content types are active by default. Based on your requirements, you can deactivate content types.

1. To configure content types at the community level, navigate to **Community > Administration > Content Types**.
2. Click a content type.
3. To deactivate a content type, clear the Active check box.
4. Click **Update**.
   The content type is no longer visible to the community.
5. To configure content types at the forum level, navigate to **Community > Administration > Forums**.
6. Click a forum.
7. Click the **Content Types** related list.
8. In the Active column, double-click a row.
9. To activate a content type, select True. To deactivate a content type, select False.

**Community feedback types**

There are two supported feedback types: Upvote and Helpful.

Community users can provide feedback on the content they have access to in the community.

<table>
<thead>
<tr>
<th>Feedback type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Helpful</td>
<td>Helpful feedback is associated to the following content types when a community user marks content as helpful: Blog, Video, Documents, Answer, Comment.</td>
</tr>
<tr>
<td>Upvote</td>
<td>Upvote feedback is associated to the Question content type when a community user marks a question as helpful.</td>
</tr>
</tbody>
</table>

**Community access types**

Access types are used to control access to a forum or a content type.

You can define the access types for a forum and a content type in a permission. There are four access types available by default.

<table>
<thead>
<tr>
<th>Access type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Forum Admin</td>
<td>Applies to forums.</td>
</tr>
<tr>
<td>Forum Moderator</td>
<td>Applies to forums.</td>
</tr>
<tr>
<td>Content Read</td>
<td>Applies to all content types.</td>
</tr>
<tr>
<td>Content Write</td>
<td>Applies to all content types. Content Read access is automatically included in Content Write.</td>
</tr>
</tbody>
</table>

*Note:* It is not recommended that you create your own access types. Advanced knowledge of Communities architecture and scripting code to support and interpret the new access type is required.

Contact ServiceNow Technical Support for further information.

To see all available access types, navigate to Community > Administration > Access Types.

**Configure video sources for a community**

Configure additional sources that can be used for uploading a video to the community.

Role required: sn_communities.admin

1. Navigate to Community > Administration > Video Configuration.
2. Click New.
3. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Host</td>
<td>A video source website, for example, youtube.com.</td>
</tr>
<tr>
<td>Domain</td>
<td>The domain is set to <strong>global</strong> by default.</td>
</tr>
<tr>
<td>Application</td>
<td>The application for the video source.</td>
</tr>
<tr>
<td></td>
<td>It is recommended that you enter Community.</td>
</tr>
<tr>
<td>Widget</td>
<td>A widget to render the videos from the source.</td>
</tr>
<tr>
<td></td>
<td>Enter Communities render video.</td>
</tr>
</tbody>
</table>

4. Click **Submit**.

**Configure community forums**

A forum is a place for users to share content, exchange notes, ask and answer questions, and so on. Before community users can contribute content, configure a forum with content types and permissions, and create and add topics to one or more forums.

Role required: sn_communities.admin or sn_communities.forum_admin

A forum is the container for user-created content. A forum must be configured with content types and permissions before becoming available for users to contribute content. Forums can be organized hierarchically using the **Parent** field. Once forums are set up, they are visible on the Community homepage based on user permissions.

A topic is an area of interest that users can discuss. Topics are visible from the Community homepage and also appear within forums. They can be organized hierarchically using the **Parent** field.

- The community admin creates topics and can associate a topic with one or many forums.
- Forum admins can associate topics with their own forums.
- If a user has access to a particular forum, they also have access to all its topics.

Configure one or more of the following for community forums and topics.

**Create a forum**

Create a forum to provide a place for users to share content. You can configure forums for membership that registered community users request access to join. You can also configure forums to convert unstructured conversations to structured knowledge articles.

Role required: sn_communities.admin or sn_communities.forum_admin

A forum can be configured in the following ways.

| Public | Visible to all users, including non-logged in users. All users have **content_read** access to questions and answers in public forums. Configure public forms by adding a **forum user** of the type public. |
Private

Visible only to users who have been assigned the required permissions in the forum. Configure private forums by adding a forum user of the type custom and adding specific users or user groups to that forum user.

Membership

The forum title is visible to registered community users. Community users must request membership to get full access to the content in the forum. Configure membership forums by selecting the Enable Membership for this Forum check box.

1. Navigate to Community > Administration > Forums.
2. In the Forums list, click New.
3. Fill in the fields on the form as appropriate.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the forum.</td>
</tr>
<tr>
<td>Description</td>
<td>A short description that defines the forum.</td>
</tr>
<tr>
<td>Image</td>
<td>An image that provides a visual reference to describe the forum.</td>
</tr>
<tr>
<td>Order</td>
<td>The order that forums are displayed in. By default, the display is alphabetical. Enter a numerical value to set the order that forums are displayed in. You can combine both options.</td>
</tr>
<tr>
<td>Parent</td>
<td>The parent forum, if required. This lists the forum as a sub forum of the parent forum.</td>
</tr>
<tr>
<td>Enable Membership for this Forum</td>
<td>Check box to make the forum membership only, and enable registered forum users to request to join the forum. If you select this check box, the forum title is visible to all registered community users. Community users must request access to join the forum to see the content.</td>
</tr>
</tbody>
</table>

Note: The Approval Workflow for Membership field appears when you select this check box.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Approval Workflow for Membership</td>
<td>The workflow for approving new members of a forum.</td>
</tr>
<tr>
<td>Knowledge Base used for harvesting</td>
<td>The knowledge base used for harvesting community discussions to knowledge articles.</td>
</tr>
</tbody>
</table>

4. To allow registered forum users to view and request to join a forum, select the Enable Membership for this Forum check box and complete the following steps.
   a) Right-click the form header and click Save.
      Two default permissions are added to the forum in the Forum Permissions related list.

• Default Permission for Memberships: Read and write access to questions and answers for users who are forum members.
• **Forum Visible**: Read access to the name and description of the forum for registered users. To access content, users must request forum membership.

b) If required, you can add a new forum permission and set it as the default using the `sn_communities.default_permission_for_forum_memberships` property.

If you want public users to view content in the forum to attract them to become members, create a forum permission as follows:

- **Forum User**: Public.
- **Permission**: Question & Answer Read.

c) In the **Approval Workflow for Membership** field, perform one of the following options.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Leave the Approval Workflow for Membership field blank.</td>
<td>Membership requests to the forum are automatically approved.</td>
</tr>
<tr>
<td>Select the preconfigured approval workflow Forum Membership Approval.</td>
<td>A task is created and sent to the community or forum administrator for approval.</td>
</tr>
<tr>
<td>Select a workflow that you have created.</td>
<td>A task is created and sent to the users defined in your workflow for approval.</td>
</tr>
</tbody>
</table>

5. Click **Update**.

**Configure content types for a forum**

Define which types of content to use in a particular forum and associate a workflow so that content is reviewed before becoming visible to other community users.

Role required: `sn_communities.forum_admin`

1. Navigate to **Community > Administration > Forums**.
2. Click a forum.
3. In the **Content Types** related list, click **New**.
4. In the **Content Types** list, select a **Content Type**.
5. Select an **Approval Workflow**.

You can select the **Community - Content Approval** workflow or a workflow that you have created.

6. Click **Submit**.

The selected content type is added to the **Content Types** related list in the forum. The following secondary content types are automatically added when creating a primary content type.

<table>
<thead>
<tr>
<th>Primary content type</th>
<th>Secondary content type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Question</td>
<td>Answer</td>
</tr>
<tr>
<td>Blog, Document, Event, Video</td>
<td>Comment</td>
</tr>
</tbody>
</table>

**Invite users to become members of a forum**

Invite users to become members of a particular forum to encourage greater community involvement.

Role required: `sn_communities.admin` or `sn_communities.forum_admin`

1. Navigate to **Community > Forums**.
2. Choose a forum from the list that has been configured for membership.
3. Select the **Invite Users to Join this Forum** related link.
4. Complete the following steps to invite internal and external users.
   a) If the users to send the email invitation to are internal, click **Edit Users**.
   b) If external user registration is enabled, the **Enter email address** field is shown. Enter the email addresses of the external users to send the email invitation to.

You can enter both internal and external users to your email invitation.
5. Enter **Comments** to personalize the text in the email invitation.
6. Click **Submit**.

An email is generated and sent to the users in the list. The approval workflow set in the forum determines the approval of membership from an email invitation. You can view all email invitations in the forum on the **Forum Email Invites** related list.

### Approve forum memberships

Manage forum membership approvals when registered community users request membership to a forum.

Role required: sn_communities.admin or sn_communities.forum_admin

There are two ways of approving forum memberships.

1. Perform one of the following actions.
   - Navigate to **Community > Forums**.
     1. Choose a forum from the list that has been configured for membership.
     2. Click the **Membership Approvals** related list.
   - Navigate to **Self-Service > My Approvals**.

2. Accept or reject the membership requests.
   Only one approval is required for each task.
   Once the task has been approved or rejected, an email notification is sent to the user.

### Create a topic

Create a topic for users to create and share content.

Role required: sn_communities.admin

1. Navigate to **Community > Administration > Topics**.
2. Click **New**.
3. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Topic form</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the topic.</td>
</tr>
<tr>
<td>Description</td>
<td>A short description to define what the topic is.</td>
</tr>
<tr>
<td>Parent</td>
<td>The parent topic, if required. If you enter a parent topic, the topic is listed as a subtopic of the parent topic.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Image</td>
<td>An image that provides a visual reference that describes the topic.</td>
</tr>
<tr>
<td>Knowledge category used for harvesting</td>
<td>The knowledge category used to categorize community discussions harvested to knowledge articles.</td>
</tr>
</tbody>
</table>

4. Click **Submit**.  
The topic is created and added to the list of topics.

Add a topic to a forum.

**Add a topic to a forum**

Add a topic to a forum so that users can associate content to that topic.

Role required: sn_communities.forum_admin

A topic can belong to more than one forum.

1. Navigate to **Community > Administration > Forums**.
2. In the list, click the forum name.
3. Click the **Forum Topics** related list.
4. Click **New**.
5. From the **Topic** list, select a topic.
6. Click **Submit**.  
The selected topic is added to the Forum Topics list in the forum. The topic is available to users in this forum.

**Disable topics in a community**

Disable the topics feature so that no topic information is visible in your community.

Role required: sn_communities.admin

The administrator can change the `sn_communities.enable_topics` property so that all topic information is hidden in the community. The data is not deleted.

1. Enter `sys_properties.list` in the filter navigator and search for the `sn_communities.enable_topics` property.
2. In the **Value** field, enter `false`.
3. Click **Update**.
   - No topic information is displayed in the **Activity Feed** or **Notifications and Subscriptions**.
   - No topic information is displayed on the **Forums** or **Topics** landing pages.
   - No topic information is displayed on Gamification pages and widgets.
   - Topic fields do not appear when creating, editing, or viewing content.
   - Topics do not appear in the search results page.

**Create a sub forum**

Create a sub forum and map it to a parent forum to establish a forum hierarchy.

Role required: sn_communities.forum_admin

There are two ways of creating a sub forum in Communities.

1. Navigate to **Community > Administration > Forums**.
- On the Forums list page, click **New**.
- Locate the forum to create a sub forum in, click its name, and then click the **Sub Forums** related list.

2. Fill in the fields on the form as appropriate.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the sub forum.</td>
</tr>
<tr>
<td>Description</td>
<td>A short description that defines the sub forum.</td>
</tr>
<tr>
<td>Image</td>
<td>An image that provides a visual reference to describe the sub forum.</td>
</tr>
<tr>
<td>Order</td>
<td>The order that sub forums are displayed in. By default, the display is alphabetical. Enter a numerical value to set the order that forums are displayed in. You can combine both options.</td>
</tr>
<tr>
<td>Parent</td>
<td>The parent forum. This lists the forum as a sub forum of the parent forum.</td>
</tr>
<tr>
<td>Enable Membership for this Forum</td>
<td>Check box to make the forum membership only, and enable registered forum users to request to join the forum. If you select this check box, the forum title is visible to all registered community users. Community users must request access to join the forum to see the content.</td>
</tr>
<tr>
<td>Approval Workflow for Membership</td>
<td>The workflow for approving new members of a forum.</td>
</tr>
<tr>
<td>Knowledge Base used for harvesting</td>
<td>The knowledge base used for harvesting community discussions to knowledge articles.</td>
</tr>
</tbody>
</table>

The forum hierarchy of forums and sub forums is displayed on the community home page, forum landing page, when creating questions, blogs, or events, and in the search filters.

**Move forum content**

Move community content posts from one forum to another.

Role required: sn_communities.admin, sn_communities.community_moderator, sn_communities.forum_admin, sn_communities.forum_moderator

Access to content is based on permissions to a specific forum. If content is moved, the author of the content and other community users might lose access to it, depending on their forum permissions.
Note: Draft content cannot be moved. If the content type is not supported in the new forum, it cannot be moved.

1. Navigate to the community homepage.
2. Click the content you want to move.
3. Click ... and **Edit**.
4. Select the forum you want to move the content to.
5. Click **Save**.
   An email notification is sent to the author of the content, subscribers to the content, and subscribers to the forum.

**Forum and user permissions management**

Community and forum administrators can give users and groups of users different levels of access to forums and forum content.

There are three components that make up the security settings for forums: forum users, permissions, and forums.

**Forum users**

A forum user is a logical group of users, user groups, or both. This group is used to define memberships to a forum.

**Permissions**

A permission is a combination of:

- access types for a forum
• access types for a given content type

You can create your own permission or use one of the default permissions that the Communities application delivers.

**Default permissions**

<table>
<thead>
<tr>
<th>Permission</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Blog Read</td>
<td>Read access to blogs.</td>
</tr>
<tr>
<td>Blog Read and Comment Write</td>
<td>Read access to blogs and write access to comments.</td>
</tr>
<tr>
<td>Blog Write</td>
<td>Write access to blogs.</td>
</tr>
<tr>
<td>Blog Write and Comment Write</td>
<td>Write access to blogs and comments.</td>
</tr>
<tr>
<td>Default Permission for Memberships</td>
<td>Default permissions for forums that are marked as Enable Membership for this Forum.</td>
</tr>
<tr>
<td>Default permissions for public user</td>
<td>Public access to forums.</td>
</tr>
<tr>
<td>Default permissions for registered user</td>
<td>Permissions for registered and logged in users.</td>
</tr>
<tr>
<td>Document Read and Comment Write</td>
<td>Read access to documents and write access to comments.</td>
</tr>
<tr>
<td>Document Write and Comment Write</td>
<td>Write access to documents and comments.</td>
</tr>
<tr>
<td>Event Read and Comment Write</td>
<td>Read access to events and write access to comments.</td>
</tr>
<tr>
<td>Event Write and Comment Write</td>
<td>Write access to events and comments.</td>
</tr>
<tr>
<td>Forum Admin</td>
<td>Full access to a forum.</td>
</tr>
<tr>
<td>Forum Moderator</td>
<td>Moderation access to a forum.</td>
</tr>
<tr>
<td>Forum Name and Description Read</td>
<td>Read access to the name and description of a forum. To access content or topics, other permissions are required.</td>
</tr>
<tr>
<td>Full Access</td>
<td>Write and read access to all content types.</td>
</tr>
<tr>
<td>Question and Answer Read</td>
<td>Read access to questions and answers.</td>
</tr>
<tr>
<td>Question and Answer Write</td>
<td>Write access to questions and answers.</td>
</tr>
<tr>
<td>Question Write</td>
<td>Write access to questions.</td>
</tr>
<tr>
<td>Video Read and Comment Write</td>
<td>Read access to videos and write access to comments.</td>
</tr>
<tr>
<td>Video Write and Comment Write</td>
<td>Write access to videos and comments.</td>
</tr>
</tbody>
</table>

**Forums**

A forum is the container for user-created content. A forum must be configured with content types and permissions before becoming available for users to contribute content.

To assign permissions to users and user groups, create associations between forum users and permissions for a specific forum.
Note: Forum permissions are not inherited in the forum hierarchy. Each subforum must be configured with its own set of permissions and content types.

- You can use forum users and permissions in multiple forums.
- You can add multiple forum users and permissions to one forum.
- You can copy permissions from a parent forum to a child forum or from another forum altogether.
- You can also define user-specific permission exceptions and debug user permissions.

Create a forum user

You can create forum users, which you then use to define memberships to a forum.

Role required: sn_communities.forum_admin

A forum user is a logical group of users, user groups, or both. Forum users are reusable. Multiple forum users can be used in any given forum.

Note: Before creating a forum user, check whether an existing forum user matches your requirements.
Types of forum user

<table>
<thead>
<tr>
<th>Public</th>
<th>Public users can view the community without logging in. By default, public users have <strong>content_read</strong> access to questions and answers in public forums.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Registered</td>
<td>Users who have signed up to the community and accepted the Terms &amp; Conditions. Once logged in, their access to forum content depends on the permissions set up for each specific forum.</td>
</tr>
<tr>
<td>Custom</td>
<td>Specific users and user groups that are added as members to the current forum user.</td>
</tr>
<tr>
<td>Membership</td>
<td>A group of members who have joined a specific forum. Once logged in, their access to forums depends on the permissions set up for each specific forum.</td>
</tr>
</tbody>
</table>

1. Navigate to **Community > Administration > Forum Users**.
2. Click **New**.
3. On the form, fill in the fields.

### Forum User form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the user.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the user.</td>
</tr>
<tr>
<td>User type</td>
<td>Type of user.</td>
</tr>
</tbody>
</table>

4. Click **Submit**.
   The forum user is created and added to the Forum Users list.

**Add members to a forum user**

Add members to a forum user. Members can be individual users or user groups.

Role required: sn_communities.forum_admin

1. Navigate to **Community > Administration > Forum Users**.
2. Click the forum user to add members to.
3. In the Members related list, click **New**.
4. On the form, fill in the fields.

### Members form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Forum User</td>
<td>Forum user name. The name is automatically filled.</td>
</tr>
<tr>
<td>Membership Type</td>
<td>Membership type. Choose either <strong>User</strong> or <strong>Group</strong>.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------</td>
<td>-------------</td>
</tr>
<tr>
<td>Member</td>
<td>User or user group to add to the forum user. If you selected <strong>Membership Type &gt; User</strong>, the <strong>Table name</strong> is automatically filled with <strong>sys_user</strong>. If you selected <strong>Membership Type &gt; Group</strong>, the <strong>Table name</strong> is automatically filled with <strong>sys_user_group</strong>. Enter your user or user group in the Document field.</td>
</tr>
</tbody>
</table>

5. Click **Submit**.

### Create a permission

Create a permission to use to define a user’s access to a forum and the content in the forum.

Role required: **sn_communities.admin**

Permissions are reusable. Before creating a permission, check if any existing permissions match your requirements.

1. Navigate to **Community > Administration > Permissions**.
2. Click **New**.
3. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name for the permission.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the permission.</td>
</tr>
</tbody>
</table>

4.  
5. Click **Submit**.

**Add access types to a permission**

Access types for a permission determine the access that users have to certain forums.

Role required: **sn_communities.forum_admin**

1. Navigate to **Community > Administration > Permissions**.
2. In the **Permissions** list, click the permission you created.
3. Click the **Forum Access** related list.
4. Click **New**.
5. Select an access type.
6. Click **Submit**.

Create a **forum permission**.

**Add content types to a permission**

Content types for a permission determine the access that users have to certain content in a forum.

Role required: **sn_communities.forum_admin**

1. Navigate to **Community > Administration > Permissions**.
2. In the Permissions list, click the permission you created.
3. Click the Content Type Access related list.
4. Click New.
5. Select a content type and an access type.
6. Click Submit.

Create a permission exception
Create a permission exception for users who require specific permissions for a forum.
Role required: sn_communities.forum_admin
Permission exception records are created for users who require specific permissions for a particular forum, for example, a forum manager. Any other permissions that the user has are no longer valid once an exception is created.

1. Navigate to Community > Administration > Forums.
2. Click a forum.
3. Click the Permission Exceptions related list.
   The list of users who have extra permissions for this forum is displayed.
4. Click New.
5. In the User field, enter the name of the user to create a permission exception for.
6. In the Permission field, enter a permission.
7. Click Submit.
   A permission exception is created and added to the list of Permission Exceptions on the forum.

Clone a permission
Clone a permission if an existing permission record cannot be modified and you require a permission record with similar settings.
Role required: sn_communities.forum_admin

1. Navigate to Community > Administration > Permissions.
2. Click the permission you want to clone.
3. Click the Clone related link.
   A new permission with the same access types as the source permission is created. The permission record name starts with Clone of.

Create a forum permission
Add a forum user and a permission to a forum to create a forum permission.
Role required: sn_communities.forum_admin
Forum permissions are a combination of a forum, forum users, and permissions. Associate forum users and permissions within a specific forum. You can add multiple combinations of forum users and permissions to a forum.

1. Navigate to Community > Administration > Forums.
2. Click a forum.
3. In the Forum Permissions related list, click New.
4. On the form, fill in the fields.
Forum Permissions

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Forum</td>
<td>Name of the forum.</td>
</tr>
<tr>
<td>Forum Users</td>
<td>User or group of users to give access to the forum.</td>
</tr>
<tr>
<td>Permission</td>
<td>Permission to give to the forum users in the forum.</td>
</tr>
</tbody>
</table>

5. Click Submit.

Copy permissions from a parent forum
You can copy permissions from a parent forum to a child forum.

Role required: sn_communities.forum_admin
1. Navigate to Community > Administration > Forums.
2. Click a forum.
3. Click the Copy Permissions from Parent Forum related link.
   All permissions and content types are copied from the parent to the child forum. A summary of the results is displayed at the top of the form.

Configure the forum users and permissions as required.

Copy permissions from a forum
You can copy all permissions and content types from one forum to another.

Role required: sn_communities.forum_admin

You can copy permissions from one source forum to multiple target forums.

1. Navigate to Community > Administration > Forums.
2. Click the name of the forum that you want to copy permissions from.
3. Click the Copy Permissions to Forum(s) related link.
4. On the form, fill in the fields.

Copy Permissions

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copy Permissions From</td>
<td>Name of the forum you want to copy permissions from. The name is automatically filled.</td>
</tr>
<tr>
<td>Copy Permissions To</td>
<td>Name of the forum you want to copy the permissions to. You can enter more than one forum.</td>
</tr>
</tbody>
</table>

5. Click Save.

Debug user permissions
Investigate and diagnose problems with user access to forums.

Role required: sn_communities.forum_admin
1. Navigate to Community > Administration > Forums.
2. Click the name of the forum to investigate.
3. Click the Debug Forum Permissions related link.
4. Enter the name of the user you want to check the permissions for. The forum user permissions information indicates which content and access types the user has for a particular forum.

**Configure the community profile**

Set up the community profile by configuring profile fields and deciding which fields to display in the personal information section of the community profile.

Role required: sn_communities.admin

Configure one or more of the following for the community profile.

**Create a persona for the community profile**

Create a persona and associate it to a role to manage which data users can modify.

Role required: sn_communities.admin

A persona is associated to a user role and can be mapped to specific fields for display on the community profile. The base system contains a default persona, which is not associated to a role and is used for all community users. You can create a new persona or add a role to the default persona.

1. Navigate to Community > User Profile > Persona.
2. Click New and then complete the Persona form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>A name for the persona.</td>
</tr>
<tr>
<td>Order</td>
<td>The order, in numerical value, in which the system should evaluate the roles for the persona.</td>
</tr>
<tr>
<td>Associated Role</td>
<td>The role to associate the persona to.</td>
</tr>
</tbody>
</table>

3. Click Submit.

**Create a community profile field**

Create a field to display on the community profile.

Role required: sn_communities.admin

1. Navigate to Community > User Profile > Profile Fields.
2. Click New and then complete the Profile Fields form.

<table>
<thead>
<tr>
<th>Field Label</th>
<th>A label for the field.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Field Name</td>
<td>A name for the field.</td>
</tr>
</tbody>
</table>

3. Click Submit.

**Configure persona field mapping for the community profile**

Configure which fields appear in the community profile and manage the settings associated with those fields.

Role required: sn_communities.admin

1. Navigate to Community > User Profile > Persona Field Mapping.
2. Click **New** and then complete the Persona Field Mapping form.

### Persona Field Mapping form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Persona</td>
<td>Name of the persona.</td>
</tr>
<tr>
<td>Source Value Table</td>
<td>Source table of the field to be added to the persona. Any table that is used as the <strong>Source Value Table</strong> should have a reference to the sys_user table.</td>
</tr>
<tr>
<td>Source User Field</td>
<td>Field from the source value table.</td>
</tr>
<tr>
<td>Privacy Read Only</td>
<td>Select the check box to allow the community user to change the display settings for this field in their community profile.</td>
</tr>
<tr>
<td>Profile Field</td>
<td>Display name of the community profile field.</td>
</tr>
<tr>
<td>Source Value Field</td>
<td>Name of the field from the source table.</td>
</tr>
<tr>
<td>Read Only</td>
<td>Select the check box to not allow the community user to edit the value of this field.</td>
</tr>
<tr>
<td>Privacy Default</td>
<td>Privacy default setting for the field.</td>
</tr>
</tbody>
</table>

3. Click **Submit**.

### Enable users to self-register to a community

Once users have accessed public forums and decided they want to join the community, they can self-register to the community. External user registration provides a way of validating users and requires them to accept the community Terms and Conditions.

Community administrators perform the following tasks to configure external user registration.

- Configure the **external user registration properties**.
- **Configure moderation filters** to enter banned words for the user name.
- **Configure the required strength for passwords**.
- **Change email templates** and content. The email template that you can change is `confirmation/link/sent.html`.
- If not already configured, create **Terms and Conditions** that each community user must review and accept. Communities delivers preconfigured Terms and Conditions that you can modify according to your needs.
- To enable external users to update their time zone when registering, add ACLs to external users in the User table (sys_user).

### Create community Terms and Conditions

Community members must follow the community rules of conduct. Create community Terms and Conditions and them share to build a successful community. Every community user must review and accept the Terms and Conditions before contributing to a community.

Role required: sn_communities.admin

The Communities application includes preconfigured Terms and Conditions that you can modify according to your needs.
You can disable Terms and Conditions using the `sn_communities.disable_terms_conditions_role` property.

1. Navigate to **Community** > **Administration** > **Communities Terms and Conditions**, click **New**, and then fill in the fields.

   **Terms and Conditions form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>An automatically generated number for your Terms and Conditions. If required, you can change the number.</td>
</tr>
<tr>
<td>Short Description</td>
<td>A short description for your Terms and Conditions.</td>
</tr>
<tr>
<td>Force acknowledgement for first time internal community users</td>
<td>Indicates that you want first-time users to the community to view and agree to the community terms and conditions and confirm or change their display name.</td>
</tr>
<tr>
<td>Content</td>
<td>The content of your Terms and Conditions.</td>
</tr>
</tbody>
</table>

2. Complete one of the following actions to save the Terms and Conditions.

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Submit</td>
<td>Click <strong>Submit</strong> to save your Terms and Conditions.</td>
</tr>
<tr>
<td>Activate</td>
<td>1. Click <strong>Activate</strong>. Your Terms and Conditions are activated and any existing Terms and Conditions are deactivated.</td>
</tr>
<tr>
<td></td>
<td>2. Select the check box on the warning message if you want all community users who log on to accept to the new Terms and Conditions. The check box is selected by default.</td>
</tr>
<tr>
<td></td>
<td>3. Deselect the check box if you want users to accept the new Terms and Conditions at a later point in time. You can then select your Terms and Conditions and click <strong>Prompt users to review and accept</strong>.</td>
</tr>
<tr>
<td></td>
<td>4. Click <strong>OK</strong>.</td>
</tr>
</tbody>
</table>

You can view which community users have accepted the Terms and Conditions and when. Navigate to **Community** > **User Profile** > **Community Profiles**. View or add, if necessary, the **Accepted TC**, **Accepted TC Date**, and **Accepted TC Number** fields.

**Community Service Portal**

The Community Service Portal is a web interface that is based on the ServiceNow Service Portal application.

The Community Service Portal is designed to allow you to have control over the behavior of your portal and help create an attractive and engaging user experience.

To customize this portal, navigate to **Service Portal** > **Portals** and click **Community**.
Configure Community Service Portal header menus

Configure Community Service Portal header menus to create a consistent user experience across all your end-user facing service portals using a modern interface and a unified navigation menu structure.

Role required: The admin role for your service portal, for example, sn_communities.admin.

Add a theme and header menu to your service portal to define its look and behavior.

1. Navigate to Service Portals > Portals and click the module for the portal you want to modify.
2. You have to be in the Global application to edit. If a message appears, click here to edit.
3. In the Theme field, enter CSM Default.
4. In the Main Menu field, enter CSM Unified Portal Header Menu.
5. Click the information icon next to the Main menu field and click Open Record.
6. Click the Settings icon and System Settings > Developer.
7. Change the Application to Customer Service Management Unified Theme and click the Refresh icon. You only have to change this setting once. The New button is displayed next to Menu Item.
8. To display the names of the menu items, personalize the Menu Items related list and add Display name.
9. Click New from the Menu Items related list.
10. Fill in the fields on the form.

Menu Item form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
<td>Name that appears for the item in the menu.</td>
</tr>
<tr>
<td>Parent Menu</td>
<td>This field should already contain the name of the menu you are adding items to. You can change the value as required to other menus.</td>
</tr>
<tr>
<td>Parent Menu Item</td>
<td>Use this field to nest menu items within other menu items.</td>
</tr>
<tr>
<td>Order</td>
<td>Value that determines where the item appears in the menu in relation to other menu items.</td>
</tr>
<tr>
<td>Type</td>
<td>The kind of page the item links to. For example, you can link to another page in the portal, or an external URL. Form fields vary depending on the option you select from this list.</td>
</tr>
<tr>
<td>Page</td>
<td>Name of the portal page the item links to.</td>
</tr>
<tr>
<td>Condition</td>
<td>Determines what conditions are required for menu items to show in the header.</td>
</tr>
<tr>
<td>Glyph</td>
<td>Icon that appears beside the menu item.</td>
</tr>
</tbody>
</table>

11. Click Submit.
Make an announcement to community members

Global announcements appear in the banner and broadcast messages to all community members. Forum announcements appear in the Announcements section on the forum page. You can also send the announcement by email.

Role required:

- sn_communities.admin can manage Global announcements and Forum announcements
- sn_communities.forum_admin can manage Forum announcements for own forums only. The announcement appears only in the forum that the admin owns.

This example shows how a community user experiences announcements and how you can configure the appearance and operation of announcements.
<table>
<thead>
<tr>
<th><strong>Announcement type</strong></th>
<th>Read-only. Set to <strong>Global Announcement</strong> or <strong>Forum Announcement</strong>, depending on what you are working on.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Active</strong></td>
<td>Select the check box to publish the announcement to members. Clear the check box to cancel the announcement.</td>
</tr>
</tbody>
</table>
| **Title**             | Display title of the announcement.  
  - The text appears above the **Summary** text.  
  - In email, the text is the subject of the message. |
| **Summary**           | Content of the announcement.  
  - The text appears below the **Title** text.  
  - In email, the text is the body of the message. |
| **From / To**         |  
  - **From**: Date and time that the announcement should appear.  
  - **To**: Date and time that the announcement should no longer appear. |
| **Send email notification** | Select the check box to send the announcement to members as an email message in addition to broadcasting the announcement. |
| **Display first**     | Select the check box to display the announcement as the first announcement in the list. |
| **Public**            | Select the check box to enable forum members that are not logged in to view the announcement. |
| **Portals**           | Portals that display the announcement. Default: **Community**.  
  **Note**: If no value is specified, the announcement does not appear in any portal. |
| **Click target**      | The **Click target** setting creates a link for the announcement.  
  - **None**: No link.  
  - **Page**: Opens a Service Portal page in the current browser tab.  
  - **URL in current browser tab**: Opens the specified URL in the current browser tab.  
  - **URL in new browser tab**: Opens the specified URL in a new browser tab. |
If you select a URL option for **Click target**, then enter the URL in the **Details URL** field.

**Details link text**

Appears only if **Click target** is not **None**.
- To display a link under the **Summary** text, enter the text of the link in the **Details link text** field.
- To use the **Title** text of the announcement as the link, leave **Details link text** blank.

**Forums**

This setting appears for Forum announcements only. Slushbucket of forums that you are admin for.

Move a forum into the **Selected** list to display the announcement on the forum.

**Dismiss options**

This setting appears for Global announcements only. Determines how the user can dismiss the announcement.

- To update an announcement, update any setting as needed and then click **Update**. If you specified **Send email notification**, then you are prompted to send the updated email message.
- To cancel an announcement, clear the **Active** check box.

### Add featured content in a community

Add or edit featured content in a community to appear in the Featured Content section on the community homepage, forum homepage, or both.

Set the following properties as required.

**Featured content properties**

<table>
<thead>
<tr>
<th>Property name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_communities.default_featured_days</td>
<td>Default number of days for content to be featured. End date is calculated from the date the content is featured on.</td>
</tr>
<tr>
<td>sn_communities.max_featured_limit</td>
<td>Maximum amount of featured content at forum or at global level.</td>
</tr>
<tr>
<td>sn_communities.featured_global_notify_user</td>
<td>Send notifications to community users when content is featured on the community homepage. This property is inactive by default.</td>
</tr>
</tbody>
</table>

*Note:* Notifications are always sent to community administrators and moderators.

To send out email notifications when featured content expires, set the Featured Content Expire scheduled job to **Active**.

Role required: sn_communities.admin, sn_communities.community_moderator, sn_communities.forum_admin, or sn_communities.forum_moderator

1. Navigate to the community homepage.
2. Click the content you want to feature.

   **Note:** Question and Answer content types are not enabled for featuring by default. To enable Question or Answer content types for featuring, navigate to Community > Administration > Content Types. Click the content type you want to enable and select the **Allow Featuring** check box. In the same way, you can also disable content types for featuring.

3. Click ... and **Mark as featured**.
4. On the Feature Content pop-up window, select whether to feature the content on the community homepage or in a specific forum.

   A notification that content has been featured is sent out to the author of the content, community users who commented on the post, and community users who are subscribed to the post. If featured content has expired or is removed from the featured content list by another user, community and forum administrators are notified.

### Email a community user

Send a private message to a community user directly from the community.

An email client must be configured.

**Role required:** sn_communities.admin, sn_communities.community_moderator, sn_communities.forum_admin, or sn_communities.forum_moderator

Uses for private messaging can include warning a user about use of a banned word, welcoming a new user, or informing users about incorrectly placed content in a forum. You can privately message a user from any community content, a comment, the Leaderboard, or the Community Profile page.

1. Navigate to the community homepage.
2. Point to the community user name.
3. Click **Email User**.

   **Note:** The email opens in your local email client.

### Community pages that support SEO data

To improve search results for community members using external search engines, the Communities application generates SEO meta tags and injects the tags into questions, topics, forums, and other page types.

   **Note:** If the auto-generated SEO tags in a page does not meet your needs, you can change the SEO tags. See [Modify SEO in community pages](#).

### Pages that include auto-generated SEO data

The Communities application auto-generates SEO meta tags for the following pages in the Community service portal. The table provides details on the data that is generated.

- community_question
- community_blog
- community_document
- community_video
- community_event
- community_forum
- community_topic

Auto-generated SEO tags

<table>
<thead>
<tr>
<th>Searchable page type</th>
<th>Auto-generated tags in the page</th>
</tr>
</thead>
</table>
| Question, Blog, Document, Video, and Event | - The **title** meta tag is populated with the text "<forum name> - <content short description>"  
- The **description** meta tag is populated with the text "<forum name> - <topic names> - <first 100 characters of the body of the content>" |
| Forum | - The **title** meta tag is populated with the text "<forum name>"  
- The **description** meta tag is populated with the text "<forum description>" |
| Topic | - The **title** meta tag is populated with the text "<topic name>"  
- The **description** meta tag is populated with the text "<topic description>" |
| Leaderboard page | The Title meta tag is populated with the text "<community name>" |

Modify SEO in community pages

If an auto-generated SEO meta tag does not meet your needs, you can modify or replace the tag.

Role required: sn_communities.admin

The source code for this example question page (ID community_question) shows the **description** meta tag (highlighted in yellow) that the Communities application injected into the page.
Router overheating after firmware upgrade

by George Warren
created 29d ago in Routing and Switching

My 5000 series router has been overheating since I upgraded the firmware couple of days ago. Anybody else facing a similar issue?
The description meta tag text is made up of three data fields that are taken from the community_question record. In the tag, the values are separated by a hyphen character.

- The first portion of the description meta tag is the value of the forum name field in the question record. In the example, the forum name is Routing and Switching.
- The second portion of the tag is the value of the topic field in the record — Tomahawk (5000 Series) in the example.
- The third portion of the tag is generated from the first 100 characters of the body field in the record — My 5000 series router has been overheating since I upgraded the firmware couple of days ago. Anybody...

In addition to the description meta tag for a question page, the Communities application injects a title tag (highlighted in blue). The title is generated dynamically using two values from the community_question record:
- Forum name (Routing and Switching in the example)
- Short description (Router overheating after firmware upgrade in the example)

1. Navigate to Service Portal > Pages.
2. In the list of portal pages, click the ID of the page to update (in the example, community_question).

   See the list of pages in Communities that support SEO data.

3. On the Page form:
   - Modify or add meta tags in the Meta tags related list.
   - Modify the Dynamic page title by modifying the structure of the title text or by modifying or replacing the variables that generate the text. The variable definitions appear in the Dynamic page title variables related list.
ServiceNow, the ServiceNow logo, New York, and Customer Service Management are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Out-of-the-box Performance Analytics Solutions for Communities

Out-of-the-box Performance Analytics Solutions contain preconfigured dashboards. These dashboards contain actionable data visualizations that help you improve your business processes and practices.

Use the Performance Analytics widgets on the dashboard to visualize data over time, analyze your business processes, and identify areas of improvement. With solutions, you can get value from Performance Analytics for your application with minimal setup.

**Note:** Solutions include some dashboards that are inactive by default. You can activate these dashboards to make them visible to end users according to your business needs.

To enable the solution for Communities, an admin navigates to System Definitions > Plugins and activates the Performance Analytics - Content Pack - Communities plugin.

View the Communities performance dashboard

The Communities dashboard displays up-to-date status on community usage, membership, content type and activity, and trends by forum and by topic.

Role required: pa_admin

1. Navigate to Performance Analytics > Dashboards.
2. In the list, select Community > Communities Dashboard.

On dashboard tabs:
- Content types are question, answer, comment, blog, video, or document.
- “Social activity” is any response (answer, comment, blog, video, or document) to a topic that is added by a user other than the originator.
- Content score data is for content created during the last 30 days.
- Click a scorecard to view detailed data or a trend chart.

<table>
<thead>
<tr>
<th>Overview tab</th>
<th>Scorecards</th>
</tr>
</thead>
<tbody>
<tr>
<td>In each scorecard, the percentage change in the current period appears under the total over the lifetime of the community.</td>
<td></td>
</tr>
<tr>
<td>Number of current members and total number of questions.</td>
<td></td>
</tr>
<tr>
<td>Percentage of questions that have been marked as Solved by the user who asked the question.</td>
<td></td>
</tr>
<tr>
<td>Percentage of questions that have not been answered.</td>
<td></td>
</tr>
<tr>
<td>Total number of attachments (blogs, videos, and documents).</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Charts</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Community Activity:</strong> new community members and total sessions for the month.</td>
</tr>
<tr>
<td><strong>New content</strong> of any type.</td>
</tr>
<tr>
<td><strong>Top 3 Forums and Topics by Social Activity:</strong> Topics and forums that have received responses from other members. Hold the cursor over an area to view the count of activity.</td>
</tr>
<tr>
<td>Tab</td>
</tr>
<tr>
<td>---------------------------------</td>
</tr>
<tr>
<td>Content Analytics tab</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>Forum Analytics tab</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>Topic Analytics tab</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>Admin Analytics tab</td>
</tr>
</tbody>
</table>

### Communities dashboard

The Communities dashboard displays up-to-date status on community usage, membership, content type and activity, and trends by forum, topic, and admin.
Communities Dashboard

Overview tab

- # of Members: 12 (Jun 19)
  - 6 (0.0%) Jun 18
  - ▼ 2 (-25.0%) May 2019

- # of Questions: 6 (Jun 19)
  - ▼ 2 (-25.0%) May 2019

- % Marked as Solved: 0% (Jun 19)
  - 0 (0.0%) May 2019

- % Not Answered: 83% (Jun 19)
  - ▲ 8 (11.1%) May 2019

- # of Blogs, Documents and Video: 3 (Jun 19)
  - 0 (0.0%) May 2019

Community Activity

- New Members: [Graph]
- Unique Sessions on Community: [Graph]

New Content by Month

- New Content: [Graph]
- Active Contributors: [Graph]

Top 3 Forums by Social Activity

- [Pie Chart]

Top 3 Topics by Social Activity

- No data to display
Content tab
### Communities Dashboard

#### Forum KPIs

<table>
<thead>
<tr>
<th>Forum Topic</th>
<th>Questions</th>
<th>% Not Answered</th>
<th>% Solved</th>
<th>% Non-question content</th>
<th>% With activity</th>
<th>Avg. # of comments per content</th>
<th>Avg. # of social activities per content</th>
<th># of contributors</th>
<th>New content this month</th>
<th>Avg. # of views per content</th>
<th># of posts moved from this forum</th>
<th># of posts moved to this forum</th>
</tr>
</thead>
<tbody>
<tr>
<td>Access right management</td>
<td>1</td>
<td>100%</td>
<td>9%</td>
<td>0</td>
<td>0.00%</td>
<td>0.00</td>
<td>0.00</td>
<td>1</td>
<td>0</td>
<td>1.00</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>DHCP request</td>
<td>0</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>DHCPv6</td>
<td>1</td>
<td>100%</td>
<td>9%</td>
<td>0</td>
<td>0.00%</td>
<td>0.00</td>
<td>0.00</td>
<td>1</td>
<td>0</td>
<td>0.00</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Fault tolerance</td>
<td>1</td>
<td>0%</td>
<td>9%</td>
<td>0</td>
<td>56.00%</td>
<td>0.50</td>
<td>0.50</td>
<td>2</td>
<td>0</td>
<td>5.50</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Firewalling</td>
<td>0</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Honey Pot Solutions</td>
<td>0</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Intrusion Prevention Systems</td>
<td>9</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>IPv6</td>
<td>0</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Forum tab**
### Topic tab

<table>
<thead>
<tr>
<th>Topic</th>
<th>Questions</th>
<th>% Not Answered</th>
<th>% Solved</th>
<th>Non-question content</th>
<th>% With activity</th>
<th># of comments per content</th>
<th># of social activities per content</th>
<th># of contributions</th>
<th>New content this month</th>
<th>Avg. # of views per content</th>
</tr>
</thead>
<tbody>
<tr>
<td>Patriot (3000 Series)</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0.00%</td>
<td>0.00</td>
<td>0</td>
<td>0.00</td>
<td>0</td>
<td>0</td>
<td>12.00</td>
</tr>
<tr>
<td>Scud (4000 Series)</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0.00%</td>
<td>0.00</td>
<td>0</td>
<td>0.00</td>
<td>0</td>
<td>0</td>
<td>9.00</td>
</tr>
<tr>
<td>Sidewinder (1500 Series)</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0.00%</td>
<td>0.00</td>
<td>0</td>
<td>0.00</td>
<td>0</td>
<td>0</td>
<td>9.00</td>
</tr>
<tr>
<td>Tomahawk (5000 Series)</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0.00%</td>
<td>0.00</td>
<td>0</td>
<td>0.00</td>
<td>0</td>
<td>0</td>
<td>9.00</td>
</tr>
<tr>
<td>Trident (3500 Series)</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0.00%</td>
<td>0.00</td>
<td>0</td>
<td>0.00</td>
<td>0</td>
<td>0</td>
<td>5.00</td>
</tr>
</tbody>
</table>
**Admin tab**

**End user and roles**

<table>
<thead>
<tr>
<th>End user</th>
<th>Required role</th>
</tr>
</thead>
<tbody>
<tr>
<td>Community moderator</td>
<td>sn_communities.community_moderator</td>
</tr>
<tr>
<td>End user</td>
<td>Required role</td>
</tr>
<tr>
<td>------------------------</td>
<td>---------------------------------------------------</td>
</tr>
<tr>
<td>Moderation administrator</td>
<td>sn_communities.moderation_admin</td>
</tr>
<tr>
<td>Community administrator</td>
<td>sn_communities.admin</td>
</tr>
<tr>
<td>Forum administrator</td>
<td>sn_communities.forum_admin</td>
</tr>
<tr>
<td>Forum moderator</td>
<td>sn_communities.forum_moderator</td>
</tr>
<tr>
<td>Content creator</td>
<td>pa_viewer, pa_admin</td>
</tr>
</tbody>
</table>

**Indicators**

The Communities dashboard presents the following key performance indicators:

**# of members**
Total number of members.

**# of Questions**
Number of questions created in the last 30 days.

**% Marked as Solved**
Number of questions created in the last 30 days, which are marked as solved.

**% Not Answered**
Number of questions created in the last 30 days, which were not answered.

**# of Blogs, Documents, and Video**
Number of blogs, documents, and videos created in the last 30 days.

**Non-question content**
Number of blogs, videos, and documents posted.

**% With activity**
Percentage of primary or secondary community content with at least one response or feedback.

**Avg. # of social activities per content**
Average number of activities (mark as helpful, upvote, comments, and replies) on any active primary or secondary community content.

**# of contributors**
Number of contributors.

**New content this month**
Number of new content posts in the last 30 days.

**Avg. # of views per content**
Average number of views of the content.

**Avg. # of comments per content**
Average number of comments of the content.

**# of featured content**
Number of content posts that have been featured.
# of Content moved from activities
Number of content posts moved from activities.

# of Content moved to activities
Number of content posts moved to activities.

Breakdowns
The following breakdowns apply to the indicators on the dashboard:
- Communities Content Type
- Communities Forum
- Communities Topic

Reports
The dashboards include the following reports:

<table>
<thead>
<tr>
<th>Title</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Community Activity</td>
<td>Column</td>
<td>View the number of new community members and total of sessions on the community per month.</td>
</tr>
<tr>
<td>New Content by Month</td>
<td>Column</td>
<td>View the number of new content posts per month.</td>
</tr>
<tr>
<td>Top 3 Forums by Social Activity</td>
<td>Pie</td>
<td>View forums that have received responses from other members. Social activity is any response (answer, comment, blog, video, or document) to a topic added by a user other than the user that originally posted the content.</td>
</tr>
<tr>
<td>Top 3 Topics by Social Activity</td>
<td>Pie</td>
<td>View topics that have received responses from other members.</td>
</tr>
<tr>
<td>New Content by Month</td>
<td>Single Score</td>
<td>View the amount of new content, forums, or topics created per month. For any chart, you can focus on the most popular content types, forums, or topics by selecting a Breakdown.</td>
</tr>
<tr>
<td>Total Content Views</td>
<td>Column</td>
<td>View the number of views for each content type per month.</td>
</tr>
<tr>
<td>Forum KPIs</td>
<td>Single Score</td>
<td>View different indicators for the forums.</td>
</tr>
<tr>
<td>Topic KPIs</td>
<td>Single Score</td>
<td>View different indicators for the topics.</td>
</tr>
</tbody>
</table>
### Migrate Social Q&A data to Communities

If you want to migrate existing Social Q&A content to Communities, you can use a script to migrate the data.

Role required: sn_communities.admin

The Customer Communities plugin (com.sn_customer_communities) must be activated.

1. Navigate to System Definition > Fix Scripts.
2. Search for the script Migrate Social QA to Community and open it.
3. To enable the script, select the Active check box and click Update. The script is deactivated by default.
4. Click Run Fix Script. The Run Fix Script popup appears.
5. Click Proceed in Background. Always use this option for long-running scripts, or if you do not know the expected execution time.
6. Check the status of the fix script and review the results from the Show Progress Workers related list.

Verify the following information.

- A new forum is created for every knowledge base that has Social Q&A content.
- All questions, answers, comments, helpful votes, and upvotes are migrated.
- All view counts, answer counts, and comment counts are migrated.
- The accepted solution to a question in Social Q&A is Marked as Correct Answer in Communities.
- Social Q&A is deactivated for every knowledge base that contained Social Q&A data. Social Q&A content is no longer visible for these knowledge bases.

### View community logs

Community logs display information about who has viewed or searched for content in a community. The list view displays all log entries, unless filtered.

Role required: sn_communities.admin

1. Navigate to Community > Administration > Search Logs or View Logs.
2. View the logs.
Community logs

<table>
<thead>
<tr>
<th>Log</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Search Log</td>
<td>View who has searched for what and where in the community.</td>
</tr>
<tr>
<td>View Log</td>
<td>View who has viewed what and where in the community.</td>
</tr>
</tbody>
</table>

**View community feedback and bookmarks tables**

View feedback and bookmarks tables to view which community content was given feedback or was bookmarked.

Role required: sn_communities.admin, sn_communities.community_moderator, sn_communities.moderation_admin, sn_communities.forum_admin, or sn_communities.forum_moderator

1. Navigate to **Community > Feedback**.
2. Choose one of the following options.
   - Click **Feedback** to view the content feedback was given for, the type of the feedback, and who provided it.
   - Click **Bookmarks** to view the content that was bookmarked and who added it.

**Create a case from a discussion**

In order to engage your internal experts to reply to discussion threads, you can create cases directly from community questions.

Creating cases from community questions requires activation of the Customer Service Management (com.sn_customerservice) plugin.

This feature is available for questions that have been posted by community users who are also contacts or consumers in the Customer Service Management application. Questions can be either answered or unanswered.

**Note:** Cases can be created only from questions.

Two sets of users can create cases from questions:

- Customer service agents, consumer service agents, and customer service managers.
- Users with the sn_customerservice.proxy_case_creator role. Community administrators and community moderators inherit this role.

**Administer create case from discussion**

Configure parameters for the case generated from the community discussion so that it can be routed accordingly.

Creating a case from a discussion requires a configuration that maps information from the question in the community to fields on the Case form. The **Create Case** configuration is included with the feature. This configuration defines the source and destination tables and maps source fields to destination fields. This configuration is stored in the CSM Table Map table (csm_table_map). The system administrator can modify this configuration as needed.
The Create Case configuration uses the Social Q&A Question table (kb_social_qa_question) as the source table and the Case table (sn_customerservice_case) as the destination table. It includes the following mapping information.

<table>
<thead>
<tr>
<th>Question information</th>
<th>Case information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Question</td>
<td>Short description</td>
</tr>
<tr>
<td>Question author</td>
<td>Contact or consumer</td>
</tr>
<tr>
<td>Question author’s account</td>
<td>Account</td>
</tr>
<tr>
<td>Opened by</td>
<td>Logged in community user</td>
</tr>
<tr>
<td>Priority</td>
<td>Low (priority = 4)</td>
</tr>
<tr>
<td>Channel</td>
<td>Community</td>
</tr>
</tbody>
</table>

To create additional mapping between these tables, add the additional fields to the Create Case configuration in the CSM Table Map table. Include these fields as needed on the Create case from question record producer.

Enable knowledge harvesting

Configure knowledge harvesting from a community to convert unstructured conversations to structured knowledge articles and make the information more accessible.

Community administrators perform the following tasks to configure knowledge harvesting.

- Enable the Knowledge Management Service Portal plugin (com.snc.knowledge_serviceportal).
- Add a knowledge base to a forum to store the knowledge article in a specific knowledge base.

  **Note:** You can only add one knowledge base to a forum. The same knowledge base can be used for multiple forums.

- Add a knowledge category to a forum topic to categorize the harvested content.

Moderate a community

Community moderators can manage content quality by reducing the inappropriate content that is posted on the community.

Role required: sn_communities.community_moderator, sn_communities.forum_moderator, or sn_communities.moderation_admin

1. Define your requirements for Community moderation.
   - Should first-time posters receive automatic moderation?
   - Which words should be banned from user content?
   - Should the system prevent content containing banned words from being posted?
   - Should users be able to report inappropriate content?
   - How many offenses can a user commit before the system bans them automatically?

2. Navigate to Community and choose the Moderation or Moderation Tasks menu and the module you require.

3. Configure one or more of the following aspects for your community.
Configure general moderation settings

Configure when to moderate content for users and user groups.
Role required: snCommunities.admin, or snCommunities.moderation_admin

1. Navigate to Community > Moderation > Moderation Settings.
2. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Users Never Moderated</td>
<td>Content is never moderated for these users.</td>
</tr>
<tr>
<td>Users Always Moderated</td>
<td>Content is always moderated for these users.</td>
</tr>
<tr>
<td>User Groups Never Moderated</td>
<td>Content is never moderated for these user groups.</td>
</tr>
<tr>
<td>User Groups Always Moderated</td>
<td>Content is always moderated for these user groups.</td>
</tr>
<tr>
<td>Hide content if user violates settings</td>
<td>Check box to hide content written by a user until a moderator approves it.</td>
</tr>
</tbody>
</table>

3. Click Update.

Configure moderation settings for a new user

Configure the system to prevent inappropriate user contributions.
Role required: snCommunities.admin or snCommunities.moderation_admin

1. Navigate to Community > Moderation > Moderation Settings.
2. Click the New User related list.
3. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>New User Content Threshold</td>
<td>Number of user posts to be moderated.</td>
</tr>
<tr>
<td>User Exception List</td>
<td>New users that are not included in the new user content threshold for moderation.</td>
</tr>
<tr>
<td>User Group Exception List</td>
<td>User groups that are not included in the new user content threshold for moderation.</td>
</tr>
</tbody>
</table>

4. Click Update.

Configure abuse reporting

Configure whether users can report content and profile abuse, set an abuse reporting threshold, and define reasons for abuse reporting.
Role required: snCommunities.admin or snCommunities.moderation_admin

1. Navigate to Community > Moderation > Moderation Settings.
2. Click the Abuse related list.
3. On the form, fill in the fields.

**Moderation Settings form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable Content Abuse Reporting</td>
<td>Check box to enable users to report inappropriate content.</td>
</tr>
<tr>
<td>Enable Profile Abuse Reporting</td>
<td>Check box to enable users to report inappropriate profiles.</td>
</tr>
<tr>
<td>Abuse Reporting Threshold</td>
<td>Number of abuse reports on a specific content (question, blog, video, answer, comment) that lead to the content being hidden from other users.</td>
</tr>
<tr>
<td>Content Abuse Reporting Reasons List</td>
<td>Phrases that are possible reasons for the user to report inappropriate content contributions. Separate each phrase using the pipe symbol</td>
</tr>
<tr>
<td>Profile Abuse Reporting Reasons List</td>
<td>Phrases that are possible reasons for the user to report an inappropriate user profile. Separate each phrase using the pipe symbol</td>
</tr>
</tbody>
</table>

4. Click **Update**.

**Configure user banning**

Set the number of offenses a user can make before they are banned from creating or editing content.

Role required: sn_communities.admin or sn_communities.moderation_admin

1. Navigate to **Community > Moderation > Moderation Settings**.
2. Click the **User Banning** related list.
3. On the form, fill in the fields.

**Moderation Settings form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable Banning Users</td>
<td>Check box to enable the banning of users.</td>
</tr>
<tr>
<td>Offense Threshold</td>
<td>Number of offenses a user can make before being automatically banned.</td>
</tr>
</tbody>
</table>

4. Click **Update**.

**Configure moderation filters**

Create moderation filters to manage how content is moderated.

Role required: sn_communities.admin or sn_communities.moderation_admin

1. Navigate to **Community > Moderation > Moderation Filters**.
2. Click **New**.
3. Click Banned Keyword Filter.
4. On the form, fill in the fields.

**Moderation Banned Keyword Filter form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Filter Name</td>
<td>Name of the filter.</td>
</tr>
<tr>
<td>Active</td>
<td>Check box to make the filter active.</td>
</tr>
<tr>
<td>Synchronous</td>
<td>Check box to automatically moderate content when it is submitted. Any content that includes the banned words defined in the filter is not posted. If the check box is cleared, the system creates a moderation task when banned words are used. The content is visible until it is moderated.</td>
</tr>
</tbody>
</table>

5. Click Submit.
6. From the Moderation Filters list, click the name of your filter.
7. Add a banned keyword word to the list:
   a) In the Keywords list, click New.
   b) In the Keyword field, enter your keyword.
   c) Click Submit.
   d) If required, repeat to add more keywords to the list.
8. Click Update.

**Ban a user**

You can ban a user from creating or editing content, for example, a user can be banned for posting inappropriate content.

Role required: sn_communities.admin, sn_communities.moderation_admin, or sn_communities.community_moderator

1. Navigate to Community > User Profile > Community Profiles.
2. Click the Preview icon next to the user and then click Ban User.
   The user is banned. In the Community Profiles list, the value in the Banned column is set to true.

**Revoke a user ban**

Revoke a user ban to allow a user to create and edit content again.

Role required: sn_communities.admin, sn_communities.moderation_admin, or sn_communities.community_moderator

1. Perform either of the following actions.
   - Navigate to Community > User Profile > Community Profiles.
   - Navigate to Community > Moderation > Users Banned by Moderation.
2. Click the Preview icon next to the user and then select Revoke User Ban.
The user ban is revoked. In the Community Profiles list, the value in the Banned column is set to false.

**Approve or reject content**

Approve or reject content that a user reported as inappropriate or that is associated with a particular community profile.

Role required: sn_communities.community_moderator, sn_communities.moderation_admin

A moderation task is generated when a community user reports inappropriate content or community profiles. By default, the system assigns the task to the community moderator group. You can also configure your system to always require content moderation for a particular user or group.

Each task requires the moderator to approve or reject the reported item. If the moderator rejects content, it is counted as an offense against the community user who contributed the content.

1. Navigate to **Community > Moderation Tasks > Assigned to me**.
2. Click a moderation task.
3. On the form, fill in the fields.

**Moderation Task form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assigned to</td>
<td>Person assigned to the task.</td>
</tr>
<tr>
<td>Moderation Notes</td>
<td>Notes entered by the user when reporting the content.</td>
</tr>
<tr>
<td>Resolution Notes</td>
<td>Your comment as you moderate the content.</td>
</tr>
<tr>
<td>Work Notes</td>
<td>Work notes entered by users working on the task.</td>
</tr>
<tr>
<td>Approve Content</td>
<td>Approve content that conforms to community rules. The content state changes to Closed Complete.</td>
</tr>
<tr>
<td>Reject Content</td>
<td>Reject content or a profile. The content state changes to Closed Complete and the content is hidden in the community.</td>
</tr>
</tbody>
</table>

**Note:** You can review the outcome of existing and past moderation tasks by navigating to **Community > Moderation > Moderation Outcomes**. Click a task to view the details of the moderation task.

**Remove content**

Remove content that does not meet community standards.

Role required: sn_communities.admin

1. Navigate to **Community > Content > Contents**.
2. Click the content to remove.
3. Click **Actions on selected rows > Delete** and confirm that you want to delete the item.
Use a community

Participate in your community by sharing content, asking and answering questions, creating events, giving feedback, and so on.

Role required: sn_communities.community_user

Use a community in one or more of the following ways.

Community homepage features for logged in users

Your community activity usually begins on the community homepage. If you are a logged in user, you see different information than non-logged in users. Your organization can customize the homepage.

Note: The Community Service Portal header menu is not enabled by default. For more information, see Configure Community Service Portal header menus.

From the community homepage, you can access and use the following features:

<table>
<thead>
<tr>
<th>UI component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Announcements</td>
<td>View announcements targeted to the entire community.</td>
</tr>
<tr>
<td>Community menu</td>
<td>Navigate to all forums and all topics and other quick links.</td>
</tr>
<tr>
<td>Tours</td>
<td>View a tour for additional guidance on how the Communities application works. Tours appear when your administrator creates them on certain pages.</td>
</tr>
<tr>
<td>Profile photo</td>
<td>Click your profile photo to either view your community profile or logout.</td>
</tr>
<tr>
<td>Search</td>
<td>Enter a search term. You can enter a keyword to use the type-ahead search or enter one or more words to view all search results.</td>
</tr>
<tr>
<td>Browse Forums</td>
<td>Click the + icon to view up to eight available forums. Click View all Forums to go to the Forums list page and search for the forum you require. If sub forums exist, they are listed on the parent forum tile along with a count of how many there are. Click the link to access a list of the sub forums.</td>
</tr>
<tr>
<td>Have a question? Click here to start typing and Post Content</td>
<td>Contribute to the community by posting a question. Click Question, Blog, Video, Document, or Event to add your content and assign it to a forum.</td>
</tr>
<tr>
<td>Featured Content</td>
<td>View featured community content.</td>
</tr>
<tr>
<td>UI component</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------------</td>
<td>-----------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Question filters</td>
<td>Filter by question to view solved, unsolved, and unreplied questions.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The content options are displayed according to the permissions you are assigned in the forum.</td>
</tr>
<tr>
<td>Content List and Activity Feed</td>
<td>Toggle between the Content List and Activity Feed. You can filter according to content type, forum, most recent or popular, and when the content was created.</td>
</tr>
<tr>
<td></td>
<td>• Content List: Lists all content added to the community. Displays when updates were made to replies, comments, and answers marked as correct and which user made the updates.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong></td>
</tr>
<tr>
<td></td>
<td>• Updates are not displayed for new or existing comments or replies due for moderation.</td>
</tr>
<tr>
<td></td>
<td>• Updates are displayed for approved changes made to comments or replies as a result of moderation.</td>
</tr>
<tr>
<td></td>
<td>• Activity Feed: Lists all activity in the community based on your posts and subscriptions.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong></td>
</tr>
<tr>
<td></td>
<td>• All activities per content item are grouped. Only the most recent activity is listed per content item. For example, an upvote to a question.</td>
</tr>
<tr>
<td></td>
<td>• To view all activity associated with a content item, click the content item. All activities, regardless of your subscriptions, are displayed.</td>
</tr>
</tbody>
</table>

**Navigating the activity feed**

The activity feed provides a central place for community users to view information and interact. It lists the most recent activity in the community based on your network, posts, and subscriptions. You can reply, comment, and give feedback directly from the activity feed.
Activity feed

<table>
<thead>
<tr>
<th>UI component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Levels</td>
<td>View the most recent levels you have earned in the community as a result of points accumulated. You can also view the most recent badge you have earned for your achievements or areas of expertise within the community.</td>
</tr>
<tr>
<td>Content added by another user</td>
<td>View the most recent contributions by another user that you are following or content that you have subscribed to.</td>
</tr>
<tr>
<td>Content added by you</td>
<td>View the most recent content that you created in the community.</td>
</tr>
<tr>
<td>Feedback</td>
<td>Provide feedback on content that you find useful. There are four supported types of content feedback: comment, upvote, helpful, and mark as correct answer.</td>
</tr>
<tr>
<td>Reply</td>
<td>Reply to a question or another reply.</td>
</tr>
</tbody>
</table>

Navigating the forum homepage

While in a forum, you can navigate the forum homepage and perform tasks, such as posting content.

Forum homepage

<table>
<thead>
<tr>
<th>UI component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Forum name and description</td>
<td>Displays the name and description of the forum. Click <strong>Show more</strong> to read more of the description.</td>
</tr>
<tr>
<td>Subscribe</td>
<td>Subscribe to content in the community.</td>
</tr>
<tr>
<td>Sub Forums</td>
<td>If sub forums exist, they are listed. Click a link to access a sub forum. If more than three sub forums exist, click <strong>View all</strong> to view the list of all sub forums and click the one you want to access.</td>
</tr>
<tr>
<td>Have a question? Click here to start typing</td>
<td>Contribute to the community by posting a question.</td>
</tr>
<tr>
<td>Question filter</td>
<td>Filter by question to view solved, unsolved, and unreplied questions.</td>
</tr>
</tbody>
</table>
### UI component Description

<table>
<thead>
<tr>
<th>Content List</th>
<th>Lists all content added to the community. Displays when updates were made to replies, comments, and answers marked as correct and which user made the updates. Filter according to content type or sort by most recent or popular, and when the content was created.</th>
</tr>
</thead>
</table>

**Note:**
- Updates are not displayed for new or existing comments or replies due for moderation.
- Updates are displayed for approved changes made to comments or replies as a result of moderation.

<table>
<thead>
<tr>
<th>Post Content</th>
<th>Click Question, Blog, Video, Document, or Event to add your content and assign it to a forum.</th>
</tr>
</thead>
</table>

**Note:** The content options are displayed according to the permissions you are assigned in the forum.

<table>
<thead>
<tr>
<th>Announcements</th>
<th>View forum-specific announcements.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Topics</td>
<td>Click a topic to navigate to a particular topic.</td>
</tr>
<tr>
<td>Leaderboard</td>
<td>View the leaderboard to find community experts for the forum.</td>
</tr>
<tr>
<td>Most viewed content</td>
<td>Displays the top three posts according to number of views.</td>
</tr>
</tbody>
</table>

### Community homepage features for non-logged in users

Your community activity usually begins on the Community homepage. If you are a non-logged in user, you see different information than logged in users. Your organization can customize the homepage.

#### Community homepage for non-logged in users

<table>
<thead>
<tr>
<th>UI component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Community announcement</td>
<td>View announcements targeted to the entire community.</td>
</tr>
<tr>
<td>Community menu</td>
<td>Navigate to all forums, all topics, and other quick links.</td>
</tr>
<tr>
<td>Sign up/Login</td>
<td>Sign up or log in to the community.</td>
</tr>
<tr>
<td>Search</td>
<td>Enter a search term. You can enter a keyword to use the type-ahead search or enter one or more words to view all search results.</td>
</tr>
<tr>
<td>UI component</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Browse community forums</td>
<td>Click the + icon to view up to eight available forums. Click View all Forums to go to the Forums list page and search for the forum you require. If sub forums exist, they are listed. Click a link to access a sub forum. If more than three sub forums exist, click View all to view the list of all sub forums and click the one you want to access.</td>
</tr>
<tr>
<td>Question filter</td>
<td>Filter by question to view solved, unsolved, and unreplied questions.</td>
</tr>
<tr>
<td>Content List</td>
<td>View content posted in public forums in the community. Filter according to content type or sort by most recent or popular, and when the content was created.</td>
</tr>
<tr>
<td>Why Join?</td>
<td>View some of the advantages of joining the community.</td>
</tr>
<tr>
<td>View Leaderboard</td>
<td>View the leaderboard to find community experts on specific forums or topics.</td>
</tr>
<tr>
<td>Ask a Question</td>
<td>Click Ask a Question and a message appears indicating that you must be a logged-in user to perform this action. You can Login/Sign Up directly from here.</td>
</tr>
<tr>
<td>Topics</td>
<td>Click a topic to navigate to a particular topic.</td>
</tr>
<tr>
<td>Show More</td>
<td>View an expanded list of content available in the community.</td>
</tr>
</tbody>
</table>

**Self-register to a community**

Once you have accessed a public forum and decided to join the community, you can self-register by signing up and accepting the community Terms and Conditions.

Role required: none

Every community user has to have a community account. Existing users who access a community for the first time have to accept the Terms and Conditions. An account is created once the Terms and Conditions have been accepted. New users sign up to the community and accept the Terms and Conditions.

If the community Terms and Conditions are updated, all community users are prompted to review and accept them when they log in the next time.

1. If you are a new user, navigate to the community homepage.
   a) Click Sign up/Login. The Sign Up screen opens.
   b) Fill out the fields on the Sign Up form.
### Sign Up form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Email address</td>
<td>The email address to send the email validation to.</td>
</tr>
<tr>
<td>Username</td>
<td>A user name for your account.</td>
</tr>
<tr>
<td>First Name</td>
<td>Your first name.</td>
</tr>
<tr>
<td>Last Name</td>
<td>Your last name.</td>
</tr>
<tr>
<td>Phone Number</td>
<td>Your phone number.</td>
</tr>
<tr>
<td>Password</td>
<td>A password for your account.</td>
</tr>
<tr>
<td>Confirm Password</td>
<td>A confirmation of your password.</td>
</tr>
<tr>
<td>I agree to the Community Terms and Conditions</td>
<td>A check box to agree to the community Terms and Conditions.</td>
</tr>
</tbody>
</table>

1. Navigate to the community homepage.
2. Press the Space key to use the type-ahead search and enter a keyword in the **Search Community** field.
3. Choose from the following options.
   a) Click a content item that matches your search.
   b) Select the check box to agree to the community Terms and Conditions. The **Welcome** pop-up opens.
   c) Confirm your time zone.
   d) Click **User Profile** or **Notification Preferences** to edit your community profile or your notification and subscription settings.

2. If you are an existing user, but visiting the community for the first time, click any community page.
   a) If required, change your **Display Name** on the **Setting up your account** pop-up.
   b) Select the check box to agree to the community Terms and Conditions. The **Welcome** pop-up opens.
   c) Confirm your time zone.
   d) Click **User Profile** or **Notification Preferences** to edit your community profile or your notification and subscription settings.

### Search the community

Enter a keyword to use the type-ahead search on the Community homepage or enter one or more words to view all search results.

Role required: sn_communities.community_user
b) To enter your question, blog, or video if no matching content is displayed, click **Ask the Community**.

c) To display all search results, click **View all Results**.

4. Alternatively, enter one or more keywords in the **Search Community** field and press the Enter key.
   A list of matching search results is displayed.

**Refine your search results**

Refine your search results to narrow down the content displayed.

Role required: sn_communities.community_user

1. Navigate to the community homepage.
2. Enter a keyword in the **Search** field.
3. From the search results page, choose from the following options.
   - To restrict results to one content type, click a **Content Type**. To reverse this action, click the x icon of the corresponding item. To remove all restrictions, click **Clear All**.
   - Select any item from the **Forums, Topics**, or **Authors** fields to filter by forum, sub forum, topic, or author. You can add multiple forums, sub forums, topics, and authors and click anywhere on the screen to display the results.
   - To filter by the time period that the content was posted, click any **Last Updated** item.
   - Click the - icon of any category to collapse the category and save space. Click the + icon to restore a collapsed category.

**Sort your search results**

Sort your community search results to narrow down the content displayed.

Role required: sn_communities.community_user

The search results are sorted according to **Relevance** by default.

1. Navigate to the community homepage.
2. Enter a keyword in the **Search** field.
3. To display the most recent results, click **Sort By: Newest**.
   The results are displayed in descending order.
4. To display the results in ascending order, click **Newest**.

**Use a community profile**

The community profile displays an overview of a user’s personal information as well as their contributions, network, achievements, expertise, and events they are attending. You can view and edit your own profile. You can also view another user’s profile and perform actions, such as following them or reporting inappropriate content.

Role required: sn_communities.community_user

Perform one or more of the following tasks from the community profile.

**Manage your community profile**

View and edit your own community profile, which displays your contributions, network, achievements, expertise, and events you are attending.
Role required: sn_communities.community_user

There are two ways of accessing your community profile.

1. From the Community homepage, perform one of the following actions.
   - Click the **Community** menu and then **Community Profile**.
   - Click your name or profile photo and then **Profile**.

2. View the sections on your community profile.

### Community profile

<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Profile header</td>
<td>An overview of your personal information.</td>
</tr>
<tr>
<td></td>
<td>· Click <strong>Edit Profile</strong> to change your profile photo and edit your personal information.</td>
</tr>
<tr>
<td></td>
<td>· Click <strong>Edit Profile</strong> to change your user preferences. Update your time zone to view when events are occurring in your selected time zone.</td>
</tr>
<tr>
<td></td>
<td>· Click the ... icon and then <strong>Display Settings</strong> to set your display settings and determine who can view which sections of your profile.</td>
</tr>
<tr>
<td></td>
<td>If the gamification feature is enabled, the profile header includes your current gamification achievements, including:</td>
</tr>
<tr>
<td></td>
<td>· The top three badges that you have been awarded</td>
</tr>
<tr>
<td></td>
<td>· The total number of points that you have earned</td>
</tr>
<tr>
<td></td>
<td>· The current level that you have achieved based on your point total (for example, Enthusiast or Champion)</td>
</tr>
<tr>
<td>Content tab</td>
<td>An overview of the published and draft content you have created and the content you have bookmarked.</td>
</tr>
<tr>
<td></td>
<td>· <strong>Authored</strong>: Content you contributed. You can select the content type and the forum, and sort by state.</td>
</tr>
<tr>
<td></td>
<td>· <strong>Drafts</strong>: Content you contributed that is in draft state. You can select the content type and the forum. Open a draft to publish it.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong>: You can only save content in draft for blogs and events.</td>
</tr>
<tr>
<td></td>
<td>· <strong>Bookmarks</strong>: Content that you have bookmarked. You can select the content type, the forum, and sort by recent or oldest. You can also remove bookmarks.</td>
</tr>
<tr>
<td>Activity tab</td>
<td>The most recent actions performed by you in the community, for example, commenting on a post or providing feedback.</td>
</tr>
<tr>
<td>Section</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Network tab</td>
<td>A record of your network in the community.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Followers</strong>: The users that are following you.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Following</strong>: The users that you are following.</td>
</tr>
<tr>
<td></td>
<td>- Click <strong>Follow</strong> to start following a user, who is following you.</td>
</tr>
<tr>
<td></td>
<td>- Point to <strong>Following</strong> and click <strong>Unfollow</strong> to stop following a user.</td>
</tr>
<tr>
<td>Achievements tab</td>
<td>An overview of your gamification achievements.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Levels</strong>: A list of the available levels that you can achieve, including the starting point value, with your current level highlighted in blue.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Badges</strong>: A list of the badges that you have been awarded as well as available badges. Awarded badges appear at the top of the list and available badges appear below. You can filter this list to view awarded badges or all badges.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Points</strong>: A history of the points that you have earned and the activities performed that earned the points. This information also includes the forum in which the activity was performed. This list includes your last 50 activities. Click <strong>Show more</strong> to display additional pages.</td>
</tr>
<tr>
<td>Events tab</td>
<td>A list of events that you created, are attending, or past events you have attended. Click an event to view the event details.</td>
</tr>
<tr>
<td>Contributions</td>
<td>The number of your content and feedback contributions to the community.</td>
</tr>
<tr>
<td>Forum Expertise</td>
<td>A display of your expertise at forum level. You can view your level within the forum and the number of points you have gained through contributing to that forum. Click the information icon to view the point ranges required to reach each forum level.</td>
</tr>
<tr>
<td>Topic Expertise</td>
<td>A display of your expertise at topic level. You can view your level within the topic and the number of points you have gained through contributing to that topic. Click the information icon to view the point ranges required to reach each topic level.</td>
</tr>
</tbody>
</table>

**View another user’s community profile**

View another user's community profile to see their contributions, network, expertise, and so on. You can also manage your network by following and unfollowing other community users.

Role required: `sn_communities.community_user` or `sn_communities.admin`

1. Click the user's name or profile photo for the community profile that you want to view.
2. View the sections of the user’s community profile.

<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Profile header</td>
<td>The sections of the community profile that the user has made visible.</td>
</tr>
<tr>
<td></td>
<td>• To start following the user, click <strong>Follow</strong>.</td>
</tr>
<tr>
<td></td>
<td>• To report any inappropriate content on the user’s community profile, click the ... icon and then <strong>Report Profile</strong>.</td>
</tr>
<tr>
<td></td>
<td>• To assign a user points for a specific contribution to the community as a community administrator, click the ... icon and then click <strong>Assign Points</strong>.</td>
</tr>
<tr>
<td></td>
<td>• To hide content from the community until it is corrected as a community administrator, click <strong>Display Settings</strong>. You can also click <strong>Ban User</strong> to ban a user from creating or editing content.</td>
</tr>
<tr>
<td>Content</td>
<td>• <strong>Authored</strong>: Content that the user contributed.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Featured</strong>: Content the user posted that has been featured.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Drafts</strong>: Content the user contributed that is in draft state.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong>: Only community administrators can view draft content of another user.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Bookmarks</strong>: Content that the user has bookmarked.</td>
</tr>
<tr>
<td>Activity</td>
<td>The most recent actions performed by the user in the community, for example, commenting on a post or providing feedback.</td>
</tr>
<tr>
<td>Network</td>
<td>• <strong>Followers</strong>: The users that are following the user’s community profile.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Following</strong>: The users that the community profile user is following.</td>
</tr>
<tr>
<td></td>
<td>• You can manage your own network from another user’s profile. To start following a user, click <strong>Follow</strong>. To stop following a user, point to <strong>Following</strong> and click <strong>Unfollow</strong>.</td>
</tr>
<tr>
<td>Section</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Achievements</td>
<td>An overview of the user’s gamification achievements.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Levels</strong>: A list of the available levels that the user can achieve, including the starting point value, with the user’s current level highlighted in blue.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Badges</strong>: A list of the badges that have been awarded to this user.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Points</strong>: A history of the points that this user has earned and the activities performed that earned the points. If the user has earned points in a forum that you do not have access to, the name of the forum is replaced with <strong>Private forum</strong>.</td>
</tr>
<tr>
<td>Events</td>
<td>A list of events that the user has created, is attending, or past events that the user has attended. Click an event to view the event details and respond.</td>
</tr>
<tr>
<td>Forum Expertise</td>
<td>A display of the user’s expertise at the forum level. You can view their level within the forum and the number of points they have gained through contributing to that forum. To view the point ranges required to reach each forum level, click the information icon.</td>
</tr>
<tr>
<td>Topic Expertise</td>
<td>A display of the user’s expertise at the topic level. You can view their level within the topic and the number of points they have gained through contributing to that topic. To view the point ranges required to reach each forum level, click the information icon.</td>
</tr>
<tr>
<td>Contributions</td>
<td>The contributions the user has made to the community.</td>
</tr>
</tbody>
</table>

**Follow a community user**

Manage your network by following other community users and tracking their activity in the community.

Role required: sn_communities.community_user

There are several ways of following users in the community.

1. From the Communities homepage, perform one of the following actions.
   - Click your profile name or photo.
   - Click your profile name or photo and then the **Network** tab.
   - Click another user’s profile name or photo and then the **Network** tab.

2. Click **Follow** for every user you want to follow.
   The state changes to **Following**. Your Activity Feed is updated with the activity those users have taken in the community.

3. Optional: Point to **Following** and click **Unfollow** to stop following a user.
Edit your community profile photo and personal information

You can change your community profile photo and edit your personal information. You can only edit your community profile if you are logged in to the community.

Role required: sn_communities.community_user

There are two ways of accessing your community profile.

1. From the Community homepage, perform one of the following actions.
   - Click the Community menu and then click Profile on the Community homepage.
   - Click your name or profile photo and then click Profile.

2. Click Edit Profile.
3. Click Change Profile Photo.
   A file system upload is initiated. Choose an image in .png or .jpg format.
4. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Country</td>
<td>The country in which you work or reside.</td>
</tr>
<tr>
<td>Title</td>
<td>Your job title.</td>
</tr>
<tr>
<td>Phone</td>
<td>The telephone number where people can reach you.</td>
</tr>
<tr>
<td>Company</td>
<td>Name of your employer.</td>
</tr>
<tr>
<td>Email</td>
<td>Your email address.</td>
</tr>
<tr>
<td>State</td>
<td>The state, province, or jurisdiction in which you work or reside.</td>
</tr>
<tr>
<td>City</td>
<td>The city in which you reside.</td>
</tr>
<tr>
<td>Display name</td>
<td>Your name as you want others to see it.</td>
</tr>
<tr>
<td>Bio</td>
<td>A short description about yourself.</td>
</tr>
</tbody>
</table>

5. Click Save.

Edit your community profile display settings

Edit your display settings to determine who can view each profile section.

Role required: sn_communities.community_user, sn_communities.admin or sn_communities.moderation_admin

You can edit your own display settings for your community profile. If a community administrator finds inappropriate content on your profile, they can edit your display settings to hide the content from the community until it is corrected.

1. On the community homepage, click the Community menu and then click Community Profile.
2. Click the ... icon and then click Display Settings.
3. Open the choice lists and select display settings for any section.
4. Choose the privacy level to apply.

<table>
<thead>
<tr>
<th>Privacy level</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Everyone</td>
<td>Visible to all users, including non-logged in users.</td>
</tr>
<tr>
<td>Only me</td>
<td>Visible to yourself and administrators. If an administrator finds inappropriate content on your profile, the administrator can change the display settings to Only me until the content is modified. You receive an email notification detailing the display settings that were modified for which sections. Update the content and adjust the display settings accordingly.</td>
</tr>
<tr>
<td>Everyone after logging in</td>
<td>Visible to all users who access the community after logging in.</td>
</tr>
<tr>
<td>Followers</td>
<td>Visible to users who are following your profile.</td>
</tr>
</tbody>
</table>

5. Click **Save Settings**.

**Report a community profile**

Report a community profile to alert community moderators that there is offensive or inaccurate information in the profile.

Role required: sn_communities.community_user

1. Click the name or photo of the user to report.
2. Click the ... icon and select **Report Profile**.
3. From the list, select the reason you are reporting the user and add **Additional Comments**.
4. Click **Submit**.
   - A confirmation message indicating that the abuse report has been received and will be reviewed is displayed.
   - A moderation task is created and assigned to a moderator for resolution.

**Community subscriptions**

Using subscriptions, you can choose specific areas of interest. Your activity feed and notifications are personalized according to your subscriptions.
Subscription types

<table>
<thead>
<tr>
<th>Subscription type</th>
<th>Description/Features</th>
</tr>
</thead>
</table>
| Subscription                      | • Subscribe or unsubscribe to forums, topics, and community content (questions, answers, blogs, and video).  
• Auto-subscribe: Whenever you post content, you are automatically subscribed to the content itself. You are also automatically subscribed when you post a reply or a comment. |
| Activity feed                     | • Displays activities based on your subscriptions with the most recent at the top.    |
| Notification settings              | • Manage your subscriptions using Notification Settings.  
• For each of your subscriptions, set email notifications using Notification Preferences. |

Subscribe to content

Subscribe to forums, topics, questions, blogs, and videos. You are automatically subscribed to content that you create.

Role required: sn_communities.community_user

1. To find the content of interest, use the search field or navigation to find the content of interest, such as a forum, topic blog, or video.
2. On the content page, click Subscribe.
   • A confirmation message indicating that you have successfully subscribed to the content is displayed at the top of the screen.  
   • You receive a notification whenever there is an update to this content, for example, an answer to a question or a comment on a blog entry.  
   • You can view updates in your activity feed.
3. Optional: To remove a subscription, return to the content and click Subscribed. When you point to this option, it becomes Unsubscribed. You can also view your subscriptions and enable or disable them from the Community homepage by clicking your photo or name and clicking Notification Settings. Toggle Receive Notifications to turn all notifications on or off.

Set notification preferences

Set notification preferences to receive updates via email on the content that you are following.

Role required: sn_communities.community_user

The Communities application separates the notion of subscriptions from notifications. It is possible to subscribe to an item and disable notifications. You can also turn off all notifications.

1. On the Community homepage, click Community > Notification Settings.
2. Click Notification Preferences.
3. To manage your notifications in those areas, choose your category, such as Forums, Topics, Blogs, or Videos.
Choose the **Network** category and then choose **View Network** to view the community users, who are following you, or the community users that you are following.

4. In the **Email** column, toggle any item that should or should not send updates.
5. Optional: To turn all notifications on or off, toggle **Receive Notifications**.

### Request membership to a forum

You must be a registered member of the community to request membership to a forum that is marked for membership only.

Role required: sn_communities.community_user

1. Perform either one of the following actions:
   - Navigate to **Community > Homepage**. Open **Browse Community Forums** and then select the forum.
   - Navigate to **Community > All Forums** and then select the forum in the list. If you requested membership earlier, the status of your request appears.

2. Click **Request Access**.

   If approval is required, **Status** changes to **Requested**. You receive an approval or rejection email. If approved, you are immediately subscribed to the forum and **Status** changes to **Private Member**.

   If no approval is required, the request is auto-approved and **Status** changes to **Private Member**.

3. Optional: To cancel a request, point to the **Requested** status and click **Cancel**.
4. Optional: To leave a forum, click ... within the forum and then select **Leave Forum**.
   **Status** changes to **Request Access**.

### Accept an invitation to join a forum

An invitation to join a forum is sent as an email message. The method that you use to accept an invitation depends on whether you are a registered community user.

Role required: none

1. Open the email invitation and click **Join Forum**.
   - If you are a registered and logged-in community user, the forum opens.
   - If you are a registered community user but have not accepted the community Terms & Conditions, a message appears to accept the Terms & Conditions. The forum opens after you accept the Term & Conditions.

2. If the login page appears, take one of the following actions:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>If you are a registered user and not logged in.</td>
<td>Enter your login credentials to access the forum.</td>
</tr>
</tbody>
</table>
If you are not a registered user.

1. Click **Sign Up** on the login page.
2. Enter your email address, a user name, and a password to create a community account.
3. The system sends a verification email. Click the verification link in the email to confirm your credentials.
4. Reopen the email invitation and click **Join Forum**.

Forum membership is auto-approved and you are subscribed to the forum. **Status** changes to **Leave Forum**.

### Post and respond to content in the community

Post and respond to content in the community to get answers or share information.

Role required: `sn_communities.community_user`

Perform one or more of the following tasks from the community homepage.

### Ask a question in the community

Ask a question in a forum to get an answer from other community users.

You can only ask a question in a forum if you have been assigned the correct permissions.

Role required: `sn_communities.community_user`

If you ask a question, you can edit or delete it. If you created the question and reply with an answer, your answer is labeled **Author**.

There are three ways of asking questions in Communities.

1. From the Communities homepage, perform one of the following actions.
   - Locate the forum to ask a question in, click its name, and then click **Have a question? Click here to start typing**. Type-ahead search shows related posts. Click to open a related post in another page.
   - Locate the forum to ask a question in and click **Post > Question**.
   - If you do not see a forum, click **Have a question? Click here to start typing**.

2. **Click Question**.

3. **On the form, fill in the fields**.

   **Ask a question form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Question</td>
<td>Your question.</td>
</tr>
<tr>
<td>Forum</td>
<td>Forum to add the question to.</td>
</tr>
</tbody>
</table>

   **Note:** If you created the question by clicking a forum from the Communities homepage, this forum is automatically entered in this field.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Topic (s) (optional)</td>
<td>Topic to add the question to.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> You can repeat this previous step as many times as you want. If</td>
</tr>
<tr>
<td></td>
<td>you change your mind about a particular topic, click its corresponding x</td>
</tr>
<tr>
<td>Description</td>
<td>icon.</td>
</tr>
</tbody>
</table>

To insert an image, click the **Insert Image** button ( ![Image](image.png) ), navigate to the .png or .jpg file, and then click **Open**.

To insert a video, click the **Insert Video** button ( ![Video](video.png) ), enter the video URL, and then click **Upload**.

**Add attachments**

To attach a file, click **Add attachments** and then drag the file into the **Attach Document** box or click the box and then navigate to the file.

- You can add up to three attachments.
- File types supported are PPT, PPTX, XLS, XLSX, DOC, DOCX, TXT, PDF, PNG, BMP, JPG, JPEG, GIF, ZIP.
- Maximum file size is 2 MB.
- Supported file types are listed.
- Click the X icon to delete an attached file.

**Note:** Your system administrator may have set a limit on the total number of attachments allowed across the community.

When you click **Add**, your attachments are added and displayed in the question. If a user attaches a file to your question, you receive an email notification.

**Note:** If antivirus protection is enabled, all attachments are automatically scanned for viruses once the question is posted.

4. **Click Post.**

- The question is added and is available to users in this forum. You are automatically subscribed to this question. When there is a reply, you receive a notification.
- Community users who are subscribed to the forum receive a notification that content has been posted. Activity and content feeds are updated accordingly.
- If you have added attachments to your question and your community administrator has enabled antivirus protection, a scan automatically runs in the background.

**Note:**

© 2019 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
If the scan is successful, the attachments are available to download.
If the scan is in process or unsuccessful, the file is unavailable for download.
Question authors and community administrators receive a notification that an attachment is infected.

- Click Edit to remove the infected file and upload the attachment again. You cannot add any more attachments until the infected file is removed.
- If you are a user whose content is due to be moderated, the content is not posted until approved by a community moderator.

Reply to a question in the community

Reply to a question or another reply.
You can only reply to a question or another reply in a forum or sub forum if you have been assigned the correct permissions.

Role required: sn_communities.community_user

1. To find the question or a reply to respond to, use search or navigation from the community homepage.
   You can also reply to a question or a reply from the activity feed on the homepage.
2. Click Reply.
3. Enter your reply.
4. Optional: If required, you can add an image to your reply.
   a) Click the Insert image-editing control.
   b) Choose your .png or .jpg format image file.
   c) Click Open.
5. Optional: If required, you can add a video to your reply.
   a) Click the Insert Video button (play button).
   b) Enter the video URL.
   c) Click Upload.
6. Optional: You can add attachments to your post.
   a) Click Add Attachments.
   b) Drag your file into the Add Attachments box or click Click to Upload.
   c) Click Add.
   Your attachment is added and displayed in your post. If a user attaches a file to your content, you receive an email notification.

Note:
- You can add up to three attachments per post.
- The maximum file size per attachment is 2 MB.
- Your system administrator may have set a limit on the total number of attachments allowed across the community.
- File types supported are PPT, PPTX, XLS, XLSX, DOC, DOCX, TXT, PDF, PNG, BMP, JPG, JPEG, GIF, ZIP
If antivirus protection is enabled, all attachments are automatically scanned for viruses once the reply is posted.

7. Click **Reply**.
The reply is added below the question and any other replies. The reply is available to users in this forum.

Community users who are subscribed to the forum receive a notification that content has been posted. Activity and content feeds are updated accordingly.

**Note:** If you are a user whose content is due to be moderated, the content is not posted until approved by a community moderator.

If you have added attachments to your reply and your community administrator has enabled antivirus protection, a scan automatically runs in the background.

- If the scan is successful, the attachments are available to download.
- If the scan is in process or unsuccessful, the file is unavailable for download.
- Reply authors and community administrators receive a notification that an attachment is infected.
- Click **Edit** to remove the infected file and upload the attachment again. You cannot add any more attachments until the infected file is removed.

---

### Post a blog in the community

Create a blog post and publish it immediately or save it as a draft.

You can only post a blog in a forum or sub forum if you have been assigned the correct permissions in the parent forum.

**Role required:** sn_communities.community_user

You can add attachments to your blog. If you create a blog, you can edit or delete it. If you comment on the blog that you create, your answer is labeled **Author**.

1. Locate the forum to create a blog in and click its name.
2. Click **Post** and then click **Blog**.
3. On the form, fill in the fields.

**Post a blog form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Blog Title</td>
<td>Title for your blog.</td>
</tr>
<tr>
<td>Forum</td>
<td>The forum or sub forum to add the blog to.</td>
</tr>
</tbody>
</table>

**Note:** If you created the blog by clicking a forum or sub forum from the Community homepage, this forum or sub forum is automatically entered in this field.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Topic (s) (optional)</td>
<td>Topic to add the blog to.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> You can repeat this step for as many topics as you want. If you change your mind</td>
</tr>
<tr>
<td></td>
<td>about a particular topic, click its corresponding icon.</td>
</tr>
<tr>
<td>Description</td>
<td>Content of the blog.</td>
</tr>
<tr>
<td></td>
<td>To insert an image, click the <strong>Insert Image</strong> button ( ), navigate to the .png or .jpg file,</td>
</tr>
<tr>
<td></td>
<td>and then click <strong>Open</strong>.</td>
</tr>
<tr>
<td></td>
<td>To insert a video, click the <strong>Insert Video</strong> button ( ), enter the video URL, and then click</td>
</tr>
<tr>
<td></td>
<td><strong>Upload</strong>.</td>
</tr>
<tr>
<td>Add attachments</td>
<td>To attach a file, click <strong>Add attachments</strong> and then drag the file into the <strong>Attach Document</strong></td>
</tr>
<tr>
<td></td>
<td>box, or click the box and then navigate to the file.</td>
</tr>
<tr>
<td></td>
<td>• You can add up to three attachments.</td>
</tr>
<tr>
<td></td>
<td>• File types supported are PPT, PPTX, XLS, XLSX, DOC, DOCX, TXT, PDF, PNG, BMP, JPG, JPEG, GIF, ZIP.</td>
</tr>
<tr>
<td></td>
<td>• Maximum file size is 2 MB.</td>
</tr>
<tr>
<td></td>
<td>• Supported file types are listed.</td>
</tr>
<tr>
<td></td>
<td>• Click the X icon to delete an attached file.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Your system administrator may have set a limit on the total number of attachments</td>
</tr>
<tr>
<td></td>
<td>allowed across the community.</td>
</tr>
<tr>
<td></td>
<td>When you click <strong>Add</strong>, your attachments are added and displayed in the blog. If a user</td>
</tr>
<tr>
<td></td>
<td>attaches a file to your blog, you receive an email notification.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> If antivirus protection is enabled, all attachments are automatically scanned for</td>
</tr>
<tr>
<td></td>
<td>viruses once the blog is posted.</td>
</tr>
</tbody>
</table>

4. Complete one of the following actions to save your blog.
<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
</table>
| **Save as Draft** | Review and publish your blog later. The blog appears as a draft on your profile page under Content > Drafts.  

**Note:** Community and forum administrators can edit, delete, and publish drafts. If a community or forum administrator edits, deletes, or publishes your draft, you receive an email notification. |

From your profile page, you have the following options.  
1. To review your blog before publishing, click **Edit**.  
2. • Click the ... icon (More options) and then **Publish**.  
   • Click ... (More options) and then **Delete**. |

| Post | Publish your blog directly.  

Community users who are subscribed to the forum receive a notification that content has been posted. Activity and content feeds are updated accordingly.  

**Note:** If you are a user whose content is due to be moderated, the content is not posted until approved by a community moderator.  

If you have added attachments to your blog and your community administrator has enabled antivirus protection, a scan automatically runs in the background.  

- If the scan is successful, the attachments are available to download.  
- If the scan is in process or unsuccessful, the file is unavailable for download.  
- Blog authors and community administrators receive a notification that an attachment is infected.  
- Click **Edit** to remove the infected file and upload the attachment again. You cannot add any more attachments until the infected file is removed. |

**Post a video in the community**  
Post a video in a forum or sub forum.  
You can only post a video in a forum or sub forum if you have been assigned the correct permissions in the parent forum.  
Role required: sn_communities.community_user
You can post videos on their own or add them to a question or a blog. If you are the creator of the video or a community administrator, forum administrator, forum moderator, or community moderator, you can edit the videos once posted.

1. While in a forum, click **Post > Video**.
2. On the form, fill in the fields.

### Post a video form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Click here to Insert a Video</td>
<td>• URL of your video.</td>
</tr>
<tr>
<td></td>
<td>• Click <strong>Upload</strong>. The video is added to your post.</td>
</tr>
<tr>
<td></td>
<td>• To edit and replace the current video with another one, click <strong>Select a different Video</strong>.</td>
</tr>
<tr>
<td>Video Title</td>
<td>Title for the video.</td>
</tr>
<tr>
<td>Forum</td>
<td>Read-only. The forum or sub forum is automatically entered in this field.</td>
</tr>
<tr>
<td>Topic (s) (optional)</td>
<td>Topic to add the video to.</td>
</tr>
<tr>
<td>Description (optional)</td>
<td>Description for your video.</td>
</tr>
</tbody>
</table>

**Note:** You can repeat this step for as many topics as you want. If you change your mind about a particular topic, click its corresponding **x** icon.

3. Click **Post**.
4. Optional: If you have permission to edit or delete the video, click a video, click the ... icon, and then click **Edit** or **Delete**.

Once a video is uploaded, other community users can comment on it, give feedback, subscribe to the video, bookmark it, and report any inappropriate content in the video.

### Comment on a blog or a video in the community

Comment on a blog or a video or comment on another comment.

You can only comment in a forum or sub forum if you have been assigned the correct permissions in the parent forum.

Role required: *sn_communities.community_user*

If you create a comment, you can edit or delete it. If you created the blog or video and add a comment, your comments are labeled **Author**.

1. To find the blog or video entry to comment on, use the search field or navigation.
2. Click **Comment**, and enter your answer.
3. You can add attachments to your post.
   a) Click **Add Attachments**.
   b) Drag your file into the **Add Attachments** box or **Click to Upload**.
   c) Click **Add**.
Your attachment is added and displayed in your post. If a user attaches a file to your comment, you receive an email notification.

**Note:**
- You can add up to three attachments per post.
- The maximum file size per attachment is 2 MB.
- Your system administrator may have set a limit on the total number of attachments allowed across the community.
- File types supported are PPT, PPTX, XLS, XLSX, DOC, DOCX, TXT, PDF, PNG, BMP, JPG, JPEG, GIF, ZIP.
- If the attachment size is large or you have a slow connection, a progress indicator is displayed.
- If antivirus protection is enabled, all attachments are automatically scanned for viruses once the reply is posted.

4. **Click Comment.**
   The comment is added below the blog or video entry and any other comments. The answer is available to users in this forum.

   Community users who are subscribed to the forum receive a notification that content has been posted. Activity and content feeds are updated accordingly.

   **Note:** If you are a user whose content is due to be moderated, the content is not posted until approved by a community moderator.

If you have added attachments to your comment and your community administrator has enabled antivirus protection, a scan automatically runs in the background.

- If the scan is successful, the attachments are available to download.
- If the scan is in process or unsuccessful, the file is unavailable for download.
- Comment authors and community administrators receive a notification that an attachment is infected.
- **Click Edit** to remove the infected file and upload the attachment again. You cannot add any more attachments until the infected file is removed.

**Post a document in the community**

If you have the proper permissions in a forum, you can share a document with colleagues, experts, or other community users. You can associate the document with as many topics as needed.

**Role required:** sn_communities.community_user

1. **While in a forum, click Post > Document** and then fill in the form:

<table>
<thead>
<tr>
<th><strong>Document title</strong></th>
<th>Enter a descriptive title for the document.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Forum</strong></td>
<td>Read-only. The current forum or sub forum is selected.</td>
</tr>
<tr>
<td><strong>Topics</strong></td>
<td>Select a topic from the list. Repeat for as many topics as needed.</td>
</tr>
</tbody>
</table>
Attach document

To attach a file, drag the file into the Attach Document box or click the box and then navigate to the file.

- You can attach only one document.
- Maximum file size is 5 MB.
- File types supported are PPT, PPTX, XLS, XLSX, DOC, DOCX, TXT, PDF, PNG, BMP, JPG, JPEG, GIF, ZIP.
- Click the X to delete an attached file.

Note: Your system administrator may have set a limit on the total number of attachments allowed across the community.

If antivirus protection is enabled, all attachments are automatically scanned for viruses when you click Post.

Description

Enter a useful description for the document.

2. Click Post.

- The document appears in the forum. The author of a document can edit or delete the post.
- Community users who are subscribed to the forum receive a notification that content has been posted. Activity and content feeds are updated accordingly.

Note: If you are a user whose content is due to be moderated, the content is not posted until approved by a community moderator.

If your community administrator has enabled antivirus protection, a scan automatically runs in the background.

Note:
- If the scan is successful, the attachments are available to download.
- If the scan is in process or unsuccessful, the file is unavailable for download.
- The user who posted the document and community administrators receive a notification that an attachment is infected.

Mention a user in the community

Draw attention to your content in the community by mentioning other community users in the post.

Role required: sn_communities.community_user

You can mention users in questions, blogs, events, comments, and answers.

Note: The user mentions feature is not enabled for document or video content types.

You can mention users in Communities in the following ways.

1. From the community, perform one of the following actions.

- Post content to the community and place your cursor in the script editor.
- Click the content you want to comment on or reply to.

2. Enter the @ symbol followed by the user's name.

   **Note:** You can mention multiple community users in the post.

An email notification is sent to the community users you selected and their followers. Any community users that follow the user. The activity feed is also updated.

   **Note:** Followers can set their notification preferences to enable or disable notifications of user mentions.

---

### Community events

Create, manage, and participate in events to encourage engagement across the community.

**Role required:** `sn_communities.admin` or `sn_communities.community_user`

Perform one or more of the following tasks.

**Post a community event**

You can create a community event that other community users, colleagues, or experts can register for and attend.

You must have permission to create events (Event Write and Comment Write) and be a member of the forum to create the event. The Event content type must be active in the forum for the event.

**Role required:** `sn_communities.community_user`

1. While in a forum, click **Post > Event** and then fill in the form.

**Create an event**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Event title</td>
<td>A title for your event.</td>
</tr>
<tr>
<td>Forum</td>
<td>Read-only. The forum is automatically entered in this field.</td>
</tr>
<tr>
<td>Topic(s) optional</td>
<td>A topic to add the event to.</td>
</tr>
</tbody>
</table>

   **Note:** You can add as many topics as needed. To remove a topic, click the x.

<p>| Set guest limit / Total allowed | Select the check box to specify the maximum number of guests that can attend in the Total allowed field. When the limit is reached, additional users are added to the wait list. |
| Display guest list to the public | Select the check box to enable forum members to view the guest list for the event. |</p>
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>This is an online event</td>
<td>Select the check box to specify the Web URL for an online event. Clear the check box to specify the Name of location, Address, City, State, Zip/Postal Code, and Country for the event.</td>
</tr>
<tr>
<td>Date and time</td>
<td>The date and time of the event. Date must be in the future. Note: If you change the Duration, the End Time is auto-updated. Click Change time zone to set the time zone for the event. Default: Your local time zone. The time zone changes according to the time zone of the user viewing the event.</td>
</tr>
<tr>
<td>Duration</td>
<td>The duration of the event. Note: If you change the End Time, the Duration is auto-updated. Default: 30 minutes</td>
</tr>
<tr>
<td>Send reminder to guests one day before the event</td>
<td>Select the check box to send an email reminder one day before the event to all users that responded Attend.</td>
</tr>
<tr>
<td>Description</td>
<td>The description of the event. To insert an image, click the Insert Image button ( <img src="image.png" alt="Insert Image" /> ), navigate to the .png or .jpg file, and then click Open. To insert a video, click the Insert Video button ( <img src="video.png" alt="Insert Video" /> ), enter the video URL, and then click Upload.</td>
</tr>
</tbody>
</table>
2. Perform one of the following actions:

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Save as Draft</strong></td>
<td>Click <strong>Save as Draft</strong> to save the event as a draft on your profile page under <strong>Content &gt; Drafts</strong>.</td>
</tr>
</tbody>
</table>

**Note:** Community and forum admins can edit and publish drafts. If a community or forum admin edits, deletes, or publishes the draft, you receive an email notification.

From your profile page, you have the following options.

1. Click **Edit** to review the event before publishing.

2. · Click ... and then click **Publish**.
   · Click ... and then click **Delete**.

**Publish**  

Click **Publish** to publish the event directly. As the author, you can edit or delete the event.

Community users who are subscribed to the forum receive a notification that content has been posted. Activity and content feeds are updated accordingly.

**Note:** If you are a user whose content is due to be moderated, the content is not posted until approved by a community moderator.
View and participate in a community event
You can view details for published events and perform tasks such as responding to the event or adding it to your calendar.

You must be a registered member of the community and have permission to read events (Event Read and Comment Write) to be able to respond to events.

Role required: sn_communities.community_user

1. From the community homepage, perform one of the following actions:
   - Navigate to the Content List.
   - Navigate to the Activity Feed.
   - Navigate to a forum or topic.
   - Navigate to the community profile of another user and click the Events tab.
   - Click Community > Events.

2. Click an event.
   The Event details page displays the following information.

<table>
<thead>
<tr>
<th>Event header</th>
<th>View the name of the event, who created it, and when.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>If the event organizer chose to display the guest list to the public, you can view how many community users have responded Attending or Maybe and click the numbers to see the names.</td>
</tr>
<tr>
<td></td>
<td>If the guest list is private, you can view how many community users have responded Attending or Maybe, but you cannot see the names.</td>
</tr>
<tr>
<td></td>
<td>View the number of spots still available in the event or your position on the waitlist.</td>
</tr>
<tr>
<td></td>
<td>If the event is taking place in the same time zone as you set in your user preferences, the Event time zone is displayed.</td>
</tr>
<tr>
<td></td>
<td>If the event is taking place in a different time zone to the one that you set in your user preferences, both Event time zone and Your time zone are displayed.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Event overview</th>
<th>When and where the event is taking place.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Description of the event.</td>
</tr>
<tr>
<td></td>
<td>Topics associated with the event.</td>
</tr>
<tr>
<td></td>
<td>Comments on the event.</td>
</tr>
<tr>
<td></td>
<td>Number of times the event has been viewed.</td>
</tr>
</tbody>
</table>

| Upcoming Events | Next five upcoming events. |

| Popular Past Events | Top five most popular past events and the number of community users that were interested in the event. Interested community users include users who either attended or were waitlisted for the event. |
3. Optional: Click **Attending**, **Maybe**, or **Declined** to view or search the guest list and their responses.

4. Optional: Click **Subscribe** to subscribe to the event and receive notifications when the event is updated.

   If your response is **Attending** or **Maybe**, you are auto-subscribed to the event.

5. Optional: Click **Respond** to indicate whether you are attending or maybe attending the event, to decline, or to add yourself to the waitlist.
   - You can also respond to an event directly from the Activity Feed.
   - If the event is full, a message stating that you can join the waitlist is displayed. The **Attend** option replaces **Waitlist**. If you are waitlisted, your position on the waitlist is displayed. Once a position becomes available in the event, you move up in the list.

Depending on your selection, the status changes to either **Attending**, **Maybe**, **Declined**, or **Waitlisted**. You can update your response as needed.

   - If an event creator or community admin deletes an event and you responded **Yes**, **Waitlist**, or **Maybe**, you receive an email notification based on your notification preferences.
   - If an event is updated, and you responded **Yes**, **Waitlist**, or **Maybe**, you receive an email notification based on your notification preferences.

6. Optional: Click ... to perform one of the following actions.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add to calendar</td>
<td>Downloads an .ics file that you can add to your calendar. The file includes</td>
</tr>
<tr>
<td></td>
<td>the title and description of the event, the event location, start and end</td>
</tr>
<tr>
<td></td>
<td>dates, the event time, and any attachments. If guests have chosen not to</td>
</tr>
<tr>
<td></td>
<td>share details, the information is not displayed in the file.</td>
</tr>
<tr>
<td>Bookmark</td>
<td>The event appears in your bookmarks list on your profile page. Click **</td>
</tr>
<tr>
<td></td>
<td>Remove Bookmark** to delete a bookmark.</td>
</tr>
<tr>
<td>Report content</td>
<td>Click <strong>Report content</strong> to report inappropriate content in the event.</td>
</tr>
</tbody>
</table>

*View the community events landing page*

The Events landing page provides an overview of all events that you have access to in the community. You can filter events, view your status for the event, see how many other community users are attending an event, and so on.

Community users must have permission to view events (**Event Read**).

Role required: `sn_communities.community_user`

1. Navigate to **Community > Events**.

   The Events landing page displays a list of all events that you have access to and a list of the five most popular past events.

2. Filter the list for events that you created or according to attendance status, by forum, and by date.

   The list displays the following information.
   - The event creator, last update, and location.
   - Your status, if you have already responded to the event.
   - The number of community users who are interested in the event. Interested community users include users who are attending or have been waitlisted for the event.
   - The number of community users who have viewed the event.
3. Click an event to perform tasks related to the event.

Manage a community event
View additional response information on the event, edit or delete events, and download a guest list.

You must be a registered member of the community and have permission to read events (Event Read and Comment Write) to be able to respond to events.

Role required: sn_communities.community_user who created the event or sn_communities.admin.

You can access published events from several places within the community.

1. From the community homepage, perform one of the following actions.
   - Navigate to the Content List.
   - Navigate to the Activity Feed.
   - Navigate to a forum or a topic.
   - Navigate to another user’s community profile and click the Events tab.
   - Click Community > Events.

2. Click an event.

   The Event details page displays the following information.

   Event header
   - View the name of the event, who created it, and when.
   - View how many community users are attending or maybe attending.
   - View how many community users declined the event.
   - View the number of spots still available in the event or your position on the waitlist.

   Event overview
   - When and where the event is taking place.
   - The description of the event.
   - The topics associated with the event.
   - Comments on the event.
   - The number of times the event has been viewed.

   Upcoming Events
   Shows the next five upcoming events.

   Popular Past Events
   Shows the top five most popular past events and the number of community users that were interested in the event. Interested community users include users who either attended or were waitlisted for the event.

3. Optional: Click the ... icon.

4. You have the following options.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Edit</td>
<td>Click Edit. The Update Event page opens. An email notification is sent to all community users who responded Yes, Maybe, or Waitlist.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Delete</td>
<td>Click <strong>Delete</strong>. A warning message appears asking if you are sure that to delete the event. An email notification is sent to all community users who responded <strong>Yes, Maybe, or Waitlist</strong>.</td>
</tr>
<tr>
<td>Add to calendar</td>
<td>An <code>.ics</code> file is downloaded that you can add to your calendar. The file includes the title and description of the event, the event location, start and end dates, the event time, and any attachments. If guests have chosen not to share their details, the information is not displayed in the file download.</td>
</tr>
<tr>
<td>Bookmark</td>
<td>The event appears in your bookmarks list on your profile page. If you have already bookmarked the event, you can click <strong>Remove Bookmark</strong>.</td>
</tr>
<tr>
<td>Report content</td>
<td>As a community admin, click <strong>Report content</strong> to report inappropriate content in the event.</td>
</tr>
<tr>
<td>Download Guest List</td>
<td>Download a <code>.csv</code> file of the guest list. View the file to see the list of community users attending the event, their RSVP status, and email address.</td>
</tr>
</tbody>
</table>

**Bookmark community content**

You can bookmark your favorite questions, blogs, videos, documents, and events. You cannot bookmark content in draft state or replies or comments.

Role required: sn_communities.community_user

1. Click the content to bookmark.
2. Click the ... icon and then select **Bookmark**.
3. The bookmarked content is added to the **Bookmarks** tab on your community profile.
4. To view your bookmarks, perform one of the following actions.
   - Navigate to your community profile and then click **Content > Bookmarks**.
   - Click your name or profile photo and then click **My Bookmarks**.
5. You can search for bookmarks and, if required, select a bookmark and then click **Remove Bookmark**.

**Provide feedback on community content**

Provide feedback on content that you find useful.

Role required: sn_communities.community_user

There are four supported types of content feedback: comment, upvote, helpful, and mark as correct answer. You can enter feedback directly in the Activity Feed on the Community homepage or navigate to the content you want to provide feedback on.

<table>
<thead>
<tr>
<th>Content Feedback</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Comment</td>
<td>Comment on blogs and videos. You can also comment on a comment. The count of comments is displayed.</td>
</tr>
</tbody>
</table>
Content feedback | Description
--- | ---
Upvote | Upvote questions. The count of upvotes is displayed.
Helpful | Mark answers, blogs, comments, and videos as Helpful. The count of helpful marks is displayed.
Mark as Correct Answer | If you are a community or forum administrator, community or forum moderator, or the author of the question, you can mark one answer as Mark as Correct Answer. There is only one correct answer for each question. If you later mark a different answer as correct, the current answer loses this status.

1. From the Community homepage, perform one of the following actions.
   - Click a forum and then click the content, for example, a blog or a question.
   - Use search and then click the content.
   - Navigate to the content on the homepage Activity Feed and provide your feedback directly from here.

2. Enter your feedback.
   The following feedback is displayed.

| Community homepage > Activity Feed | Feedback on any content that users are subscribed to. |
| Community homepage > Content List | Feedback entered by other users. |
| Your Community Profile > Activity tab. | Feedback entered by you. |

**Note:** The homepage activity feed is not automatically refreshed. If updates occur while viewing the activity feed, a New Updates Available message appears. You can click and view all new updates. If you are in the middle of making a comment and you click New Updates Available, a warning message appears asking if you want to continue.

Report inappropriate community content

Report content to alert community moderators that the content is inappropriate or spam.

Role required: sn_communities.community_user

1. Use the search field or navigation to find the content to report.
2. Click the ... icon and then click Report Content.
3. From the list, select the reason you are reporting the content from the list and add Additional Comments.
4. Click Submit.
   A moderation task is created and assigned to a moderator for resolution. Depending on the moderation settings created for your community, the content may be hidden until a moderator has reviewed it.
Harvest knowledge from a community

Harvest knowledge from a community and create structured knowledge articles from unstructured discussions around a question.

Knowledge harvesting must be enabled.

Role required: sn_communities.knowledge_harvester, sn_communities.admin, or sn_communities.moderation_admin

You can only harvest solved questions with accepted solutions into a knowledge article.

1. From the Communities homepage, perform one of the following actions.
   - Go to the Content List.
   - Click a forum.
   - Search for a discussion thread (Question and Answer).

2. Click **Question State > Solved** to filter for all discussions that can be converted into knowledge articles.

3. Click a question.

4. Click the ... icon and then **Harvest Knowledge**.

5. Fill in the fields on the Harvest Knowledge form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Short description</td>
<td>The original question is automatically entered in the <strong>Short description</strong> field. You can edit the short description, as required.</td>
</tr>
<tr>
<td>Attachments</td>
<td>All attachments associated with the question and accepted solution are automatically added to the knowledge article. You can add and remove attachments.</td>
</tr>
<tr>
<td>Text</td>
<td>The body of the original question and accepted solution is automatically entered in the <strong>Text</strong> field. You can edit the text, as required.</td>
</tr>
<tr>
<td>Knowledge base</td>
<td>The knowledge base to which the knowledge article has been added. It is added by default based on the knowledge base associated to the forum from which article was harvested. If required, you can change the knowledge base.</td>
</tr>
<tr>
<td>Category</td>
<td>The category of the knowledge article. It is entered by default based on the category associated to the topic from which the article was harvested. If required, you can change the category.</td>
</tr>
<tr>
<td>Number</td>
<td>A KB (Knowledge Base) number is automatically assigned to the article. You cannot edit the <strong>Number</strong> field.</td>
</tr>
</tbody>
</table>

6. Perform one of the following actions:
<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
</table>
| **Publish** | Click **Publish** to initiate the workflow associated with the knowledge base.  
A link to the knowledge article is displayed on the community question from which it was harvested.  
A link to the community question and to the community profile of the person who answered the question is displayed in the knowledge article.  
**Note:** You can only see the links if you are a logged-in community user and have been assigned the correct permissions in the forum. |
| **Save** | Click **Save** to save the knowledge article as a draft. To publish the knowledge article at a later point in time, navigate to the platform UI and then **Knowledge > Articles > Unpublished.** |
| **Delete** | Click **Delete** to delete the knowledge article and all records associated with the KB number. |

**View a list of questions and create a case**

To easily view questions that can potentially be converted to cases, the community portal provides a page with a list of questions created by contacts or consumers.

Role required: sn_customerservice_manager, sn_customerservice_agent, sn_customerservice.consumer_agent, sn_communities.admin, or a user with the proxy_case_creator role

This page displays questions from the forums to which the user has access.

1. From the community portal, click **Community > Questions to Case** to open the list of questions.  
This list includes questions that have been posted by a contact or a consumer and for which a case has not yet been created.
2. Use the filters on this page to filter the question list:
   - View questions for all forums or for the selected forum  
   - View questions posted within the selected time frame: 7, 15, or 30 days  
   - Sort by the most recent questions or older questions  
   - Sort by the question status: all, solved, unsolved, or unreplied
3. To create a case from one of the questions in the list, click a question to open the question page.
4. Click the overflow icon (...) and then click **Create Case** to open a Create Case form.  
The **Create Case** action is available if a case has not yet been created from a question. Once a case has been created, this action is no longer available.  
Information from the question is mapped to the fields on the case.
5. Enter any additional information in the fields on the Create Case form. For example, add **Description** for the case.
6. If necessary, attach a file to the case.
7. Click **Submit**.  
You are returned to the question content page. The case number appears in the question header after the case is created. The question author, the customer service agent or
consumer service agent, or any user with the proxy_case_creator role can see the case number.

The contact or consumer who posted the question can also view the case by navigating to **My Cases** on the Customer Service Portal or Consumer Service Portal.

### Gamification

Encourage users to participate and contribute content in the community by providing incentives in the form of points, achievement levels, and badges.

Use the gamification framework to:

- Configure point values associated with specific user activities.
- Define achievement levels based on earned points.
- Create and assign badges to recognize users.

Community administrators can:

- Create rules and configure points that users receive for activities on the community.
- Create tracks to logically separate points assigned in the communities into different areas.
- Create levels in the community where users can achieve expertise or a reputation and then configure level ranges within each level definition.
- Create badges to award to users for different achievements.

Community users can:

- Perform activities and accrue points.
- Achieve levels based on point totals.
- View leaderboards to find community experts on specific forums or topics.
- See their own standing within the community.
- See gamification achievements on their user profiles.

### Gamification components

The gamification feature includes several components, such as rules, levels, and tracks, that enable users to earn points and badges for community activities.

### Rules

Gamification rules allow you to configure points that users receive for activities on the community.

Gamification includes several pre-defined rules. The gamification administrator can use these rules, modify them as needed, or create new rules. These pre-defined rules include:

- Comment marked as helpful: 5 points
- Document marked as helpful: 5 points
- Video marked as helpful: 5 points
- Blog marked as helpful: 5 points
- Answer marked as helpful: 20 points
- Document bookmarked: 20 points
- Blog bookmarked: 20 points
- Video bookmarked: 20 points
- Answer marked correct for a question: 40 points
When a user performs an activity that has a gamification rule, the user profile identified in the rule receives points. Points received through a gamification rule can be configured to accumulate toward:

- Overall points across the entire community
- Points in forums associated with the activity
- Points in topics associated with the activity
- Points in a track
- Points assigned for a combination of forums, topics, and tracks

If users revert previous activities, the points associated with these activities are removed. As an example, if a rule has been defined and a user creates a blog, they are awarded points. The points are deducted when the blog is deleted. If a rule has not been defined and a user creates a blog, no points are awarded. If the user removes it once a rule has been defined, points are deducted even though none were awarded in the first place.

**Tracks**

Tracks provide a way to logically separate points assigned in the communities into different areas. Gamification includes two pre-configured tracks:

- Community Expertise
- Community Participation

While the application is configured to accumulate points by tracks, gamification does not currently display tracks in the community portal.

**Levels and level ranges**

Points accumulated by community users can help them achieve different reputation levels. The system is pre-configured with levels where community users can earn points and achieve expertise or a reputation:

- **Global**: overall points accumulated across the entire community
- **Forum**: points accumulated in forums associated with the activity
- **Topic**: points accumulated in topics associated with the activity

Gamification administrators can configure level ranges within each level. These level ranges progress from a starting point value to a higher value (point ranges do not overlap) and have unique, configurable names. For example, in the Global level, a user that has earned 100–499 points is a Newbie while a user that has earned 500–999 points is an Enthusiast.
# Gamification Level Definition

## Global Level

<table>
<thead>
<tr>
<th>Level Range Name</th>
<th>Points Start</th>
<th>Domain</th>
</tr>
</thead>
<tbody>
<tr>
<td>Newbie</td>
<td>100</td>
<td>global</td>
</tr>
<tr>
<td>Enthusiast</td>
<td>500</td>
<td>global</td>
</tr>
<tr>
<td>Contributor</td>
<td>750</td>
<td>global</td>
</tr>
<tr>
<td>Supporter</td>
<td>1,000</td>
<td>global</td>
</tr>
<tr>
<td>Comrade</td>
<td>10,000</td>
<td>global</td>
</tr>
<tr>
<td>Savior</td>
<td>25,000</td>
<td>global</td>
</tr>
<tr>
<td>Champion</td>
<td>50,000</td>
<td>global</td>
</tr>
<tr>
<td>Advocate</td>
<td>100,000</td>
<td>global</td>
</tr>
<tr>
<td>Patron</td>
<td>250,000</td>
<td>global</td>
</tr>
<tr>
<td>Sponsor</td>
<td>500,000</td>
<td>global</td>
</tr>
</tbody>
</table>

**Table Name:** Gamification Modules [sn_gamific...]

**Gamification Module:** Community
In the community portal, users can see level range names and point totals in the **gamification user interface components**.

- On the leaderboard page and leaderboard widgets
- At the top of a user's profile below the user name and title
- On the user profile page in the Achievements tab
- On content pages

**Badges**

Users can earn badges for achievements or areas of expertise within the community. Gamification moderators manually assign badges to users.

Gamification includes several predefined badges. Each badge includes:

- A name
- An icon
- A brief description

Gamification administrators and moderators can award badges to community users and also remove badges. A badge can be awarded to a user one time. If a badge is removed from a user, it can be awarded to that user again.

Earned badges are visible in the community portal in the **gamification user interface components**. Community users can see earned badges and available badges on their own user profile page in the Achievements tab.

**Points**

Users earn gamification points by performing activities in the community.

Users can earn points within a community, a forum, or a topic. As users accrue points, they achieve level ranges. Point totals appear on leaderboards and on user profiles, in the profile header, and in the Achievement tab. After points are awarded to a user, an entry appears at the top of the Points list and the user's point total is updated.

The Points list has a widget instance option to **Show points for private forum**.

- When set to true, the point record displayed in the user profile does not show the forum name if the user performing the action does not have forum access. It displays "Private Forum" in place of the forum name.
- When set to false, the point record does not display in the user profile.

The Points list also has a widget instance options for the **Page size**, which determines the number of results displayed in the list. If there are more results than the number specified in this option, a button to show additional results appears at the bottom of the points page.

**Gamification user interface components**

Gamification information appears on leaderboards, the user profile page, and content pages.

**Leaderboard page**

The leaderboard page displays the top contributors in the community, in a forum, or in a topic. Users appear on the leaderboard based on the number of earned points and are ranked in descending order. You can filter the leaderboard to display information for the current month or all-time and by a specific forum or topic.

To display the leaderboard, navigate to **Community > Leaderboard**. You can also click **Show Leaderboard** on the leaderboard widget. When navigating to the leaderboard from a
leaderboard widget on a forum/topic landing page, the leaderboard shows the top point earners for that forum/topic.
## Leaderboard

<table>
<thead>
<tr>
<th>Rank</th>
<th>User</th>
<th>Points</th>
<th>Level</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Alleen Mottem</td>
<td>1,267</td>
<td>Supporter</td>
</tr>
<tr>
<td>2</td>
<td>Kim Ross</td>
<td>900</td>
<td>Contributor</td>
</tr>
<tr>
<td>3</td>
<td>Larry Sanders</td>
<td>780</td>
<td>Contributor</td>
</tr>
<tr>
<td>4</td>
<td>Rick Weaver</td>
<td>720</td>
<td>Enthusiast</td>
</tr>
<tr>
<td>5</td>
<td>Alejandro Mascall</td>
<td>700</td>
<td>Enthusiast</td>
</tr>
<tr>
<td>6</td>
<td>Jim Daniels</td>
<td>680</td>
<td>Enthusiast</td>
</tr>
<tr>
<td>7</td>
<td>Adela Cervantsz</td>
<td>650</td>
<td>Enthusiast</td>
</tr>
<tr>
<td>8</td>
<td>Claudio Loose</td>
<td>600</td>
<td>Enthusiast</td>
</tr>
<tr>
<td>9</td>
<td>Fannie Steese</td>
<td>580</td>
<td>Enthusiast</td>
</tr>
<tr>
<td>10</td>
<td>Gracie Ehn</td>
<td>570</td>
<td>Enthusiast</td>
</tr>
</tbody>
</table>
For each user, the leaderboard displays:

- Rank: shows the rank depending upon the selected filters (time, forum or topic)
- Name
- Profile photo (if available) or initials
- Current level: shows global, forum, or topic level depending upon the selected filter

By default, the leaderboard displays 10 users per page. Users can use the pagination controls to view additional pages. Pointing to a user name in the leaderboard displays a pop-up window with more information about the user.

**Leaderboard widgets**

Leaderboard widgets appear on the Community homepage and on forum and topic landing pages. These widgets display the users with the highest point totals within the community, forum, or topic.

The leaderboard widget shows the top five users. If there are more than five users that have earned points within the community, forum, or topic, **Show Leaderboard** appears at the bottom. Click this button to display all of the users on the leaderboard page.

**Community forum leaderboard widget**

For forums and topics, the leaderboard widget header displays the forum or topic name. When navigating to the leaderboard page from a forum/topic, the leaderboard shows the top point earners for that forum/topic.

System administrators can configure settings for the leaderboard widget:

- The number of users displayed in the widget (default is 5, maximum is 10)
- The time period (overall or current month)
- The leaderboard type (community, forum, or topic)
- Anchor to a specific forum or topic (not recommended)
User profile page

The user profile page displays gamification information that showcases the user’s expertise.

The gamification information is shown in three sections of the user profile page:

- In the header area
- In the Achievements tab
- In the forum and topic expertise widgets

User profile header area

When the gamification feature is enabled, the user profile header area includes the user’s current gamification achievements. This information appears just below the user name and title:

- The top three badges that have been awarded to the user. Pointing to a badge displays the badge name.
- The total number of points earned by the user.
- The current global level achieved.

Achievements tab

Users can view details about gamification levels, badges, and points on the user profile page in the Achievements tab.

<table>
<thead>
<tr>
<th>Levels</th>
<th>A list of the levels available to the user, with the current level highlighted. This tab includes a link to the Community page How to Earn Points.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Badges</td>
<td>A list of the earned badges and available badges for the user. Earned badges appear at the top of the list. Earned badges are sorted by the most recently earned. Available badges appear below earned badges. Users can filter this list to view all badges or earned badges. When viewing another user’s profile, only the earned badges are displayed and are sorted by the most recently earned.</td>
</tr>
<tr>
<td>Points</td>
<td>A history of the points earned and the activities performed by the user. This list includes the last 10 activities. Click Show more to display additional pages. Gamification moderators can award and remove points for community users. This tab includes a link to the Community page How to Earn Points.</td>
</tr>
</tbody>
</table>

© 2019 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Forum and topic expertise widgets

The forum and topic expertise widgets on the user profile page provide a visual representation of the user’s top areas of expertise.

The number within the circle and the blue highlight around the circle represent the number of levels completed. For example, 2 of 5. The number below the circle indicates the total number of points that the user has earned within the forum or topic. The widget displays up to five items and the system administrator can configure the widget to show up to a maximum number of 10 items.

Clicking the info icon displays the forum or topic levels and the point ranges.

Community content pages

The user’s gamification level and badges are displayed on the content pages, so that other community users can view the reputation of the content contributor.
Pointing to a user name on content pages such as questions, blogs, and videos displays a pop-up window with gamification information including badges earned, point total, and level name. This information is available for the author or a user who has replied or commented on that content.

The community administrator can change the displayed level to show either the global level or the forum level. This display can be controlled by the `sn_communities.content.show_gamification_level` property.

Depending upon the information available, there can be three different versions for the pop-up:

- Profile photo and name
- Profile photo and name with global points
- Profile photo and name with global points and badges

**Gamification notifications**

Community users receive notifications about badge assignments and levels achieved through the activity feed.

This includes global, forum, and topic levels achieved. A user, or any of their followers, are notified through an activity feed update in the following scenarios:

- When a user advances a level (global, forum, or topic)
- When a user earns a badge

**How to earn points**

In order to be transparent to your users about gamification rules, you can share the points received for community activities.
Navigate to **Community > How to Earn Points** for a description of the activities that users can perform to earn points. This page has links to the user's profile page. If gamification rules are modified, then this page shows the updated information.

**Administer gamification**

Users with the gamification administrator role can create the rules and other entities that award points to users based on their participation within the community.

**Configure gamification properties**

Configure gamification properties to meet your company’s needs.

Role required: sn_gamification.admin

1. Navigate to **Community > Gamification Administration > Gamification Properties**.
2. Enter the number of days to store the gamification activity history. The default is 180 days. A scheduled job purges the points history that is older than 180 days. This purge does not delete the aggregated data.
3. Enter the maximum number of levels that can be defined.
4. Click **Save**.

Additional properties can be configured for the gamification feature. For more information, see **Gamification properties**.

**Create a gamification rule**

Create gamification rules so that users can earn points for community activities.

Role required: sn_gamification.admin

1. Navigate to **Community > Gamification Administration > Rules**.
2. Click **New**.
3. Fill in the fields on the Gamification Rule form as necessary.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rule Name</td>
<td>A descriptive name for the gamification rule.</td>
</tr>
<tr>
<td>Gamification Module</td>
<td>The application to which this rule applies. Click the lookup icon to select a module from the Gamification Modules list. The default is <strong>Community</strong>.</td>
</tr>
<tr>
<td>Activity Type</td>
<td>The user activity for which this rule applies. Click the lookup icon to select one of the available types from the Activity Types list.</td>
</tr>
<tr>
<td>Profile Receiving Points</td>
<td>The type of user profile that earns points for performing the activity defined in this rule. Click the lookup icon to select a profile corresponding to the activity.</td>
</tr>
<tr>
<td>Exclude Self-Award</td>
<td>Check box to ensure that the activity performer is not the same as the profile receiving points.</td>
</tr>
<tr>
<td>Active</td>
<td>Enable this check box to activate the rule. The default is set to active.</td>
</tr>
</tbody>
</table>
Create a gamification track

Create tracks to provide a logical way to separate points assigned in the communities into different areas.

Role required: sn_gamification.admin

1. Navigate to Community > Gamification Administration > Tracks.
2. Click New.
3. Fill in the fields on the Gamification Track form as necessary.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Track Name</td>
<td>A descriptive name for the gamification track.</td>
</tr>
<tr>
<td>Gamification Module</td>
<td>The module to which this track applies. Click the lookup icon to select a module from the Gamification Modules list. By default the module is set to Community.</td>
</tr>
<tr>
<td>Active</td>
<td>Enable this check box to activate the track. By default this field is set to active.</td>
</tr>
<tr>
<td>Application</td>
<td>The application to which this track applies. By default the module is set to Community.</td>
</tr>
<tr>
<td>Track Display Order</td>
<td>The order in which the track appears.</td>
</tr>
</tbody>
</table>

4. Click Submit.

The newly created track appears on the Gamification Tracks list.

Note: While tracks can be configured, it is not currently displayed anywhere on the Community portal.
Create a gamification badge

Create gamification badges that users can earn for achievements within the community.

Role required: sn_gamification.admin

The gamification feature includes several predefined badges.

1. Navigate to Community > Gamification Administration > Badges.
2. Click New.
3. Fill in the fields on the Gamification Badge form as necessary.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gamification Module</td>
<td>The application to which the badge applies. The default module is Community.</td>
</tr>
<tr>
<td>Badge Name</td>
<td>The name of the badge as it appears on the Community portal.</td>
</tr>
<tr>
<td>Badge Display Order</td>
<td>The order of the badge indicates the rank. If a community user has multiple badges assigned to them, this field determines the sequence in which the badges are displayed.</td>
</tr>
<tr>
<td>Active</td>
<td>Enable this check box to activate the badge.</td>
</tr>
<tr>
<td>Description</td>
<td>A brief description of the badge as it appears on the Community portal.</td>
</tr>
<tr>
<td>Badge Icon</td>
<td>The image file for the badge. Click to add the icon, choose the desired image file, and then click OK. Note: The recommended image size for ideal performance is 50 pixels by 50 pixels and less than 500KB.</td>
</tr>
</tbody>
</table>

4. Click Submit.
   The newly created badge appears on the Gamification Badges list.

Manage gamification levels

Manage the predefined levels for global, forum, and topic expertise.

Role required: sn_gamification.admin

Gamification includes predefined global, forum, and topic levels.

1. Navigate to Gamification > Configuration > Levels.
2. View the existing definitions for global, forum, and topic levels.
3. Change the Level Name if required.
4. Click Submit.

Adding new level definitions is not recommended unless there is a strong use case. If you need to add or modify level ranges in existing level definitions, see Manage gamification level ranges.
Manage gamification level ranges

Manage level ranges for a gamification level definition, to recognize the expertise level of your community users.

Role required: sn_gamification.admin

Gamification includes predefined global, forum, and topic levels. Each level definition can have several level ranges and the system is predefined with 10 ranges for global level and five ranges each for the forum and topic levels. Each range should not overlap and must have a unique start value.

1. Navigate to Gamification > Levels.
2. Select the desired level (global, forum, or topic).
3. Modify the Level Range Name.
4. Modify the Points Start field.
   Each range should not overlap and must have a unique start value.
5. Click Submit.
   Level ranges are updated on the Community portal.

Moderate gamification

Monitor points earned by users and award points and badges to users based on their participation within the community.

Award or remove points for a community user

Award points to a user to recognize their contributions to the community. Remove points for a user if you observe that they are cheating the gamification system.

Role required: sn_gamification.moderator

1. Navigate to the Community homepage.
2. Go to Community > Leaderboard.
3. Click the name of the user on the leaderboard to open the user profile.
4. Click the profile overflow icon (…) and select Assign Points.
5. In the Assign Points pop-up window, enter the number of Points, a Reason for awarding the points, and select a Track.
   a) To assign points, the points entered should be a positive value. For example, 100.
   b) To remove points, the points entered should be a negative value. For example, -100.
   The maximum number of points that can be awarded or removed at one time is 1000.
6. Click Assign Points.
   An entry for the point assignment activity shows at the top of the Points list and the user’s point total is updated.

Award a badge to a user

Award gamification badges to community users to recognize their community activities.

Role required: sn_gamification.moderator, sn_gamification.admin

A badge can be awarded to a user only once. If a badge is removed from a user, it can then be awarded to that user again.

1. Navigate to Community > Gamification Data > Profile Badges.
2. Click **New**.
3. Select a **Badge** from the Gamification Badges list.
4. In the **Live Profile** field, add the name of the user.
5. Click **Submit**.

   The badge is assigned to the user and it appears on the community portal.

---

**Remove a badge from a user**

Remove a gamification badge from a community user if it is no longer relevant for that user.

Role required: sn_gamification.moderator, sn_gamification.admin

1. Navigate to **Community > Gamification Data > Profile Badges**.
2. Select the **Active** field for the desired user and badge.
3. Change the **Active** field to false.
4. Click **Update**.

   The badge is removed for that user and is no longer visible on the community portal.
Index

A

Access types
  overview 395
account escalation 65, 65, 66, 67, 68, 70, 71, 71, 208, 208, 209, 210
account hierarchy
  create 38
  overview 36
account relationships
  account relationship records 33
  account relationship types 30
  create account relationship record 35
  create account relationship type 31
  delete account relationship record 35
  delete account relationship type 32
  edit account relationship type 32
  overview 30
  view account relationship records 34
account teams
  assign team members 172
  overview 40
  view team members 42, 172
ACLs
  explicit roles 341
  hasRoles() 341, 343
  internal and external users 341
  mandatory roles 343
  provide access to users 343
  snc_internal 341, 343
activate communities plugin 378
administer communities 377
agent calendar
  add event 219
  configure 214
  create config 214
  create personal event 216
  create schedule 218
  create user work schedule 216
  move event 221
  overview 210
  show or hide events 222
  use 219
Agent Workspace for CSM 151
anonymous chat
  create matching rule 119
  modify record producer 119
  overview 117
  start chat 120, 319
Anonymous Connect Support
  activate 11
asset contact relationships
  assign a contact 40, 298
  assign a primary contact 40
  overview 39
  set property 40
assignment workbench
  assign a case 168
create configuration 60
create criteria 59
matching criteria 56
matching rules 58
overview 52
properties 62

B

bookmarks 469

C

case escalation 65, 65, 66, 67, 68, 70, 71, 71, 208, 208, 209, 210
Communities
  clone permission 407
  create event 463
  external user registration 410
  follow community user 449
  gamification 473, 476, 483, 483, 483, 484, 485, 485, 486, 486, 486, 487
  manage event 468
  properties 379
  view and participate event 466
  view events homepage 467
  view logs 432
Communities configure 393
Communities forums
  overview 396
Communities forums (set up) 390
communities homepage
  logged in users 439
  non-logged in users 442
communities roles 389
Communities)
  create knowledge article from discussions 434
community
  post and respond to content 454
Community
  case management integration 433, 433, 472
  harvest knowledge 471
Consumer
  address 19, 181
Consumer Service Portal
  accept case solution 318
  anonymous chat 120
  change password 317
  chat 178
  create a case 317
  create case from anonymous chat 179
  create case from chat 180
  create consumer record from anonymous chat 180
  edit profile 317
  log in 316
  properties 95
  register 315
  register products 317
reject case solution 318
start a chat 319
view a case 318
view profile 317
view registered products 317
contact relationships
create a relationship 38
delete a relationship 39
overview 38
view relationships 39
Content types
overview 393
CSM Agent Workspace 151
CTI softphone
installed components
business rules 350
script includes 350
tables 350
CTI Softphone
activate 11
Customer Communities
accept invite forum 453
add content type forum 398
add member 405
add topic forum 400
add user 404
announcements 413
approve forum membership 399
approve reject content 438
ban user 437
configure abuse reporting 435
configure banning 436
configure general moderation settings 435
configure moderation filters 436
configure persona field mapping 409
configure profile 409
content types
enable 394
copy permissions from another forum 408
copy permissions from parent forum 408
create blog 457
create community profile field 409
create document 461
create forum 396
create forum permission 407
create permission 406
create persona 409
create question 454
create Terms and Conditions 410
create topic 399
customize profile 450
debug user permissions 408
define access type permission 406
define moderation new users 435
disable topics 400
events 463
forum and user permissions 402
invite users to a forum 398
manage display settings 450
manage permission exceptions 407
manage subscriptions 452
modify SEO 418
performance dashboard 423
post video 459
provide feedback 469
refine search 445
remove content 438
reply comment blog 460
reply question 456
request membership forum 453
revoke user ban 437
search 444
self-register 443
SEO data 417
sort 445
subscribe to content 452
use community profile 445
view another user's community profile 447
view user profile 445
Customer Communities Moderation
overview 434
customer portal
assign role to contact 297
change password 304
community 300
create a case 307
create contact 295
create contact login 295
customer satisfaction survey 309
email notification preferences 303
enable or disable contact login 296
knowledge base
restrict access 127
manage registration requests 298
manage users
update contact information 296
notification preferences 302, 302, 303
reset password for contact 297
search feature 299
self-registration
approve request 298, 298
login 305
password reset 305
reject request 298
submit request 305
view assets 301
view contact information 301
view or modify a case 308
customer service
account hierarchy
create 38
overview 36
agent calendar
create personal event 216
assignment workbench
properties 62
associated entities
contracts 20
entitlements 20
case form
timeline 327
case timeline
use with other applications 327
define SLA 24
entitlement 23
entitlements 22
service contract 21, 21
service level agreements 24
case form
   process flow formatter 327
   related lists 328
   timeline 326
case management 5
case routing
   create assignment rule 50
   create matching rule 48
   MatchingRuleProcessor API 51
   reverse matching 52
case states 329
case timeline 326
cases list 320
chat
   add agent to chat support assignment group 173
   configure chat queue 90
   create case from chat 179
   respond to chat request 176
   start chat with agent 308
close a case 187
configure email prefix 85
Configure Mandatory Skills Feature 127
consumer
   address 19, 181
consumer service portal
   accept case solution 318
   anonymous chat 120
   change password 317
   chat 178
   create a case 317
   create case from anonymous chat 179
   create case from chat 180
   create consumer record 19, 181
   create consumer record from anonymous chat 180
   edit profile 317
   log in 316
   register 315
   register products 317
   reject case solution 318
   start a chat 319
   view a case 318
   view profile 317
   view registered products 317
Consumer Service Portal
   anonymous chat 117, 119, 119, 120, 319
   properties 95
create a case
   from the application 173
   from the customer portal 307
create a contract 21
create a product model 24
create account
   customer account 17
   partner account 17
create an asset 25
create contact 18
create entitlement 22
create work order for case 180
CSM virtual agent chatbot topics 91
customer information 16
customer portal
   assign role to contact 297
   change password 304
   create contact 295
   create contact login 295
   enable or disable contact login 296
   manage registration requests 298
   manage users 295
   notification preferences 302, 302
   password reset 305
   reset password for contact 297
   self-registration 298, 298, 298, 304, 305
   update contact information 296
   view assets 301
   view case 308
   view contact information 301
customer portal search
   community 300
   knowledge base 127, 299
Customer Service Portal
   limit access to product model data 294
   user roles 293
define case SLA 24
domain separation 121, 123
e-mail address configuration 84
e-mail communication 83
e-mail properties 85
   entitlement
      associate with entity 23
Flow Designer actions 121
Get help using virtual agent conversations 311
import customer account information 18
installed components
   business rules 346
   client scripts 345
   properties 332
   roles 337
   script includes 344
   tables 331
installed components for additional plugins 349
integration with Field Service Management 98
integration with Financial Management 114
integration with Service Management 99, 111
list and form views 188
Mandatory skills 127
   matching rules 47
Migrate skills to the task skill table 129
openFrame configuration 88
phone communication
   answer incoming call 374
   configure workflow 376
   make outgoing call 374
   set call status 375
   transfer call 375
   phone configuration 88, 374
phone installation 374
portal
  notification preferences 303
relationships
  overview 29
Report a knowledge gap 187
resource matching engine 52
responsibility definitions
  create 41
  delete 41
service level agreements 24
set up communication channels 82
social media integration
  create social profile 171, 171
time recording 241, 243, 244, 244, 245, 245, 245, 245, 245
use the Customer Service Portal 290
Customer Service Management Demo Data
activate 11
Customer Service Management for Orders
activate 11
Customer Service Portal
  limit access to product model data 294
  use 290
  user roles 293

domain separation
  Customer Service Management 121, 123
field service
special handling note
  create 168
special handling notes
  business rules 353
  client scripts 354
  configuration 64, 64
  delete 170, 171
display on form 64
properties 65, 353
script includes 354
tables 352
update 187
user roles 352
Field Service Management
  integration with Customer Service Management 98
  integration with Financial Management 114
Flow Designer
  Customer Service Management actions 121
forum homepage
  logged in users 441

gamification
  components 473, 474, 474, 476, 476, 482
  UI components 476, 479, 480, 481, 482
Gamification
  administer 476, 483
  award points 486
configure properties 483
create level definition 485
create level range 486
disable 483, 484, 485, 486, 487
moderate 486

I
Incident Assignment Workbench Demo
activate 11

K
knowledge product entitlements
  add related products 126
  business rules 359
  installed components 359
  overview 125
  properties 126, 359
Knowledge Product Entitlements
activate 11

L
Lookup and Verify 151

M
major issue management
activate 280
approve or reject a major case candidate 287
configure case synchronization 286
create child cases 288, 288
create major case 287
create major case candidate 287
installed components 289
major case form view 285
major, candidate, child cases 282
properties 289
propose a major case candidate 286
recipient's lists 284
roles 289
tables 290
migrate social Q&A data
  communities 432
  moderate communities 377

O
OpenFrame
  installed components
    business rules 351
    roles 351
    script includes 351
tables 351
  UI macros 352
openFrameAPI
  hide() 364
  init(Object config, function successCallback,
  function failureCallback) 363
  isVisible(function callback) 365
openCustomURL(Object details) 370
openServiceNowForm(Object details) 368
openServiceNowList(Object details) 369
setFrameMode(mode) 372
setHeight(height) 371
setIcon(Array icons) 367
setPresenceIndicator(presence) 372
setSize(Number width, Number height) 366
setSubtitle(String subTitle) 365
setTitle(String title) 365
setTitleIcon(Object icon) 366
setWidth(width) 371
show() 364
subscribe(openFrameAPIEVENT event, function eventCallback) 367
version() 370

Performance Analytics - Content Pack - Customer Service
activate 11
Performance Analytics - Content Pack - Customer Service (New)
activate 11
Performance Analytics - Context Sensitive Analytics for Customer Service
activate 11

report community content
communities 470
report user profile
communities 451
responsibility definitions
create 41
delete 41
reverse matching
limit 52

self service password reset
installed components 360
Self Service Password Reset
activate 11
social media entry
create log entry 171
social media integration
create profile 171
overview 93
solution 247
Solutions 423
special handling notes
business rules 353
calculate scripts 354
configuration 64, 64
create 168
delete 170, 171
display on form 64

T

Targeted Communications
activate 11
Targeted Communications Demo Data
activate 11
Time recording for Customer Service Management
241, 243, 244, 244, 244, 245, 245, 245

U
c

use communities 377